
JANUS® G3
Automated Workstation

IVD User Manual

PerkinElmer, Inc.
68 Elm Street
Hopkinton, MA 01748 USA
https://www.perkinelmer.com

P/N CLS146039 Rev. L
Publication Date: April 27, 2022

For In Vitro Diagnostic Use



  2

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Copyright
This manual is published by PerkinElmer, Inc., 68 Elm Street, Hopkinton, MA 01748 U.S.A. 
Copyright 2005-2022, PerkinElmer, Inc., and its parent, affiliated, and subsidiary companies. All 
rights reserved, including but not limited to those rights to reproduce this publication or parts thereof. 
Reproduction of this publication or parts thereof, or the products it describes, by any means or in any 
form is expressly prohibited without the written permission of PerkinElmer.

Trademarks
PerkinElmer is a registered trademark of PerkinElmer, Inc. All other trademarks and registered 
trademarks are the property of their respective owners.

Contact Us
If you have a question about a product that is not answered in this manual or online Help, or if you 
need assistance, please contact the PerkinElmer Customer Care Center from 8:00 A.M. to 8:00 
P.M., Eastern Time, Monday through Friday:

Phone: (US Toll Free): 800-762-4000
(Worldwide): +1 203-925-4602

Fax: +1 203-944-4904 
Email: LASService@perkinelmer.com
Internet: https://www.perkinelmer.com

Before you call, have the following information available for the technical representative:
• Product serial number
• Software version (found by choosing About from the main Help menu)
• If applicable, the error number shown in the software, or in the log file.

Content
Any errors or omission which may have occurred in this publication despite the utmost care taken in 
its production will be corrected as soon as possible, but not necessarily immediately upon detection. 
PerkinElmer provides this publication “As Is” without warranty of any kind, either express or implied, 
including but not limited to the implied warranties of merchantability or fitness for a particular 
purpose. Some states or jurisdictions do not allow disclaimer of express or implied warranties in 
certain transactions; therefore, this statement may not apply to you. PerkinElmer reserves the right 
to revise this publication and to make changes from time to time in the content hereof without 
obligation of PerkinElmer to notify any person of such revision or changes. Further, PerkinElmer 
may make modifications to the product described in this manual at any time without any obligation to 
notify any person of such modifications.

CE
This device complies with all CE rules and requirements.

EC REP

https://www.perkinelmer.com


PerkinElmer, Inc. JANUS G3 User Manual 3 

Table of Contents

Chapter 1
Introduction ...................................................................................................................... 14

Intended Purpose..............................................................................................................................14
JANUS G3 System Features ............................................................................................................15
Purpose of this Manual .....................................................................................................................15

Additional System Documentation..............................................................................................15
Prerequisite Skills and Knowledge....................................................................................................16
Installation .........................................................................................................................................16
Conventions in this Document ..........................................................................................................16
Table of Symbols ..............................................................................................................................17
Revision History ................................................................................................................................18
Warranty Terms and Conditions .......................................................................................................18
Regulatory Compliance.....................................................................................................................19
FCC Compliance...............................................................................................................................19

Chapter 2
Overview............................................................................................................................. 20

Hardware Overview...........................................................................................................................20
Modular Design ..........................................................................................................................21
Available Configurations.............................................................................................................21

Mini Platform ........................................................................................................................21
Standard Platform ................................................................................................................22
Integrator’s Platform.............................................................................................................22
Expanded Platform...............................................................................................................23
Extended Platform................................................................................................................23
Configuration Guidelines......................................................................................................24

Deck Configurations ...................................................................................................................24
Deck Plates ................................................................................................................................24
Rail Configurations .....................................................................................................................26

JANUS G3 Instrument Description....................................................................................................27
JANUS G3 Connection Panel ......................................................................................................29
Varispan Pipetting Arm...............................................................................................................30

Peristaltic Pump Box Connection Panel...............................................................................30
MDT (Modular Dispense Technology) Pipetting Arm .................................................................31

Dispense Heads...................................................................................................................31
Head ID Tag.........................................................................................................................32
Docking Station ....................................................................................................................32
MDT Gripper ........................................................................................................................33

Gripper Arm ................................................................................................................................33
Options and Accessories ..................................................................................................................34

Enclosure Option ........................................................................................................................35



 Table of Contents 4

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

UV Light Option ..........................................................................................................................36
MDT Pipetting Arm Accessories.................................................................................................36

NanoHead ............................................................................................................................37
Serial Dilution Tools .............................................................................................................38
Pin Tools ..............................................................................................................................42

WinPREP Software Overview...........................................................................................................43
WinPREP Main Window .............................................................................................................43

Protocol Outline View...........................................................................................................44
Deck View ............................................................................................................................45
Toolbars ...............................................................................................................................46

JANUS Application Assistant Software Overview.............................................................................47
Labware Overview ............................................................................................................................48

Support Tiles ..............................................................................................................................48
Mapping Labware .......................................................................................................................48

Security Overview .............................................................................................................................49
System Specifications .......................................................................................................................50

Pipetting Precision......................................................................................................................50
Physical Dimensions for Cladded Instruments ...........................................................................51
Instrument Weights for Cladded Instruments (Approximate)......................................................51
Physical Dimensions for Instruments with Enclosure .................................................................52
Instrument Weights for Instruments with Enclosure (Approximate)............................................52
Compressed Air Requirements (for MDT Arm only) ...................................................................52
Environmental Requirements .....................................................................................................53

Operating Environment ........................................................................................................53
Storage Environment ...........................................................................................................53
Transport Environment.........................................................................................................53

Electrical Ratings........................................................................................................................54
Safety Recommendations .................................................................................................................54

Warnings and Precautions .........................................................................................................55
Chemical and Biological Safety ..................................................................................................56
Flammable and Combustible Materials ......................................................................................57

User Precautions..................................................................................................................57
UV Light Safety...........................................................................................................................58
Laser Safety ...............................................................................................................................58

Chapter 3
Protocol Tutorials.......................................................................................................... 59

Starting the WinPREP Software........................................................................................................59
Preparing the Instrument for Use......................................................................................................60

Calibrating the Deck.............................................................................................................60
Priming the Varispan Pipetting Arm .....................................................................................60

New Protocol Tutorial........................................................................................................................60
Varispan Single Liquid Transfer Tutorial ...........................................................................................61

Populate the Deck ......................................................................................................................61
Add the Procedures to the Protocol............................................................................................63
Map the Labware........................................................................................................................64

Varispan Mother-Daughter Transfer Protocol Tutorial ......................................................................71
Populate the Deck ......................................................................................................................71
Add the Procedures to the Protocol............................................................................................73



 Table of Contents 5

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Map the Labware........................................................................................................................75
MDT Plate Expansion Protocol Tutorial ............................................................................................82

Populate the Deck ......................................................................................................................82
Add the Procedures to the Protocol............................................................................................87
Map the Labware........................................................................................................................88

Gripper Arm Tutorial..........................................................................................................................96
Populate the Deck ......................................................................................................................96
Add the Procedures to the Protocol............................................................................................96
Map the Labware........................................................................................................................97

MDT Serial Dilution Tutorial ..............................................................................................................98
Calibrating the Deck ...................................................................................................................98
Selecting the Correct Support Tiles............................................................................................98
Selecting an Interchangeable Head and the Appropriate Tip Loading Pattern ........................100
Mapping Patterns .....................................................................................................................101

Controlling the Interior Lights ..........................................................................................................103
Using the UV Light ..........................................................................................................................104
Running a Protocol..........................................................................................................................107

Chapter 4
Creating and Editing Protocols............................................................................ 111

About Protocols...............................................................................................................................113
Nodes.................................................................................................................................113
Branch Box.........................................................................................................................113
Protocol Outline Node ........................................................................................................113
Compatibility with MultiPROBE II Tests .............................................................................114

About Procedures ...........................................................................................................................114
Integration Procedures .............................................................................................................115
Embedded Procedures.............................................................................................................115
Custom Procedures..................................................................................................................116

About Steps.....................................................................................................................................116
Creating a New Protocol .................................................................................................................116
Setting the Protocol Outline Parameters.........................................................................................117
Creating the Deck Layout................................................................................................................118

Labware Positioning Considerations ........................................................................................119
Accessible Deck Areas ......................................................................................................119
Docking Station Restrictions ..............................................................................................120
Tip Box Support Tile Restrictions.......................................................................................121
Tip Loading Restrictions (Serial Dilution Tools only)..........................................................122
Support Tile Restrictions ....................................................................................................123
Tipwash Bowl Restrictions .................................................................................................123
Waste Chute Restrictions...................................................................................................123
Labware Movement Restrictions........................................................................................123

Adding Labware to the Deck View............................................................................................123
Selecting Labware ....................................................................................................................126
Changing the Labware Name...................................................................................................126
Editing Labware Parameters ....................................................................................................127
Moving Labware .......................................................................................................................127
Duplicating Labware .................................................................................................................128
Deleting Labware......................................................................................................................129



 Table of Contents 6

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Viewing Labware Labels...........................................................................................................129
Sizing the Deck View................................................................................................................131

Adding Procedures to the Protocol .................................................................................................132
Adding a Step to a Custom Procedure .....................................................................................133
Adding a Transfer Group to a Custom Procedure ....................................................................134

Editing Nodes in the Protocol..........................................................................................................135
Editing Procedure or Step Parameters.....................................................................................135
Moving a Node .........................................................................................................................135
Renaming a Node.....................................................................................................................136
Copying a Node........................................................................................................................136
Copying a Node from Another Protocol ....................................................................................137
Deleting a Node........................................................................................................................138
Undo and Redo Changes .........................................................................................................138

Mapping the Labware......................................................................................................................139
About Well Maps ......................................................................................................................139

Varispan Arm and Well Map Order ....................................................................................139
MDT Arm and Well Map Order...........................................................................................141
Serial Dilution Tools Option and Well Map Order ..............................................................143

Mapping Labware to a Step......................................................................................................146
Modifying Well Maps ................................................................................................................146
View Labware Associations......................................................................................................147
Default Color Associations .......................................................................................................149
Creating Well Map Patterns......................................................................................................150

Evaluating a Protocol ......................................................................................................................151
Add the Protocol to a Protocol Category.........................................................................................153
Arranging the Protocols in the JANUS Application Assistant..........................................................154
Using Variables ...............................................................................................................................155

Ask User Variable.....................................................................................................................155
Calculate Variable ....................................................................................................................157
Select Variable .........................................................................................................................160
Prompting for a File Name at Runtime .....................................................................................160

Selecting a Procedure........................................................................................................160
Declaring a Variable...........................................................................................................160
Defining a File ....................................................................................................................161
Preparing the Pipetting Parameter.....................................................................................161
Defining the Runtime Parameter Requirements ................................................................161
Creating the Initial User Query Prompt ..............................................................................161
Creating the File Browser Window.....................................................................................162
Complete the Protocol Definition........................................................................................162
Running the Protocol..........................................................................................................162

Prompting for Labware IDs at Runtime ....................................................................................163
Layout Labware..................................................................................................................163
Define Labware Parameters ..............................................................................................163
Runtime Requirements ......................................................................................................163
Labware Change Requirements ........................................................................................163

Chapter 5
Running Protocols ...................................................................................................... 164

Starting JANUS Application Assistant.............................................................................................165



 Table of Contents 7

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Step 1: Select a Protocol.................................................................................................................166
Step 2: Gather Supplies ..................................................................................................................167
Step 3: Place the Labware on the Deck..........................................................................................167
Step 4: Run the Protocol .................................................................................................................169

Monitoring the Protocol Execution............................................................................................171
Progress Panel...................................................................................................................171

Pausing a Protocol ...................................................................................................................172
Stopping a Protocol ..................................................................................................................172
Using the System Pause Button...............................................................................................173

Step 5: Cleanup ..............................................................................................................................174
Execution Messages.......................................................................................................................175

Status Messages ......................................................................................................................175
Labware Change Request Panel .......................................................................................175
Reset Tip Boxes Tab..........................................................................................................175
Sample List Processing Results Panel ..............................................................................176
Verify Labware Location Panel ..........................................................................................176

Error Messages ........................................................................................................................177
Clot Detect Error ................................................................................................................177
Disposable Tip Warning .....................................................................................................178
Horizontal Motion Error ......................................................................................................178
Liquid Sense Error .............................................................................................................178
Tracking Error ....................................................................................................................179
Vertical Motion Error ..........................................................................................................179
Stack Space Error ..............................................................................................................180
Barcode Reader Scan Errors Pane....................................................................................181

Direct Control............................................................................................................................182

Chapter 6
Procedures and Steps............................................................................................... 184

Procedures......................................................................................................................................184
Varispan Procedures ................................................................................................................184

Single Liquid (Varispan) .....................................................................................................184
Reagent (Varispan) ............................................................................................................185
Panel (Varispan) ................................................................................................................185
Dilution (Varispan)..............................................................................................................185
Multiple Liquid (Varispan)...................................................................................................185
Flush/Wash (Varispan).......................................................................................................185
Park Arm (Varispan)...........................................................................................................186

MDT Procedures ......................................................................................................................186
Replicate Plate MDT ..........................................................................................................186
Reagent MDT.....................................................................................................................186
Expand Plate MDT.............................................................................................................186
Compress Plate MDT.........................................................................................................187
Dilution MDT ......................................................................................................................187
Multi-Liquid MDT................................................................................................................187
Custom Pipetting MDT.......................................................................................................188
Empty/Wash MDT..............................................................................................................188
Move Plate MDT ................................................................................................................188
Park MDT...........................................................................................................................188



 Table of Contents 8

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Non-Pipetting Procedures ........................................................................................................188
Loop ...................................................................................................................................188
Timer ..................................................................................................................................189
Time Marker .......................................................................................................................189
User Program.....................................................................................................................189
User Message ....................................................................................................................189
User Query.........................................................................................................................189
Initial User Query ...............................................................................................................190
Move Plate (Gripper)..........................................................................................................190
Bar Code Scan...................................................................................................................190

Procedure Parameters Window................................................................................................191
Open the Procedure Parameters Window .........................................................................191
Close the Procedure Parameters Window.........................................................................191

Steps...............................................................................................................................................192
Step Parameters Window.........................................................................................................192

Open the Step Parameters Window...................................................................................193
Close the Step Parameters Window ..................................................................................193

Customizing the Toolbars ...............................................................................................................193
Hiding Toolbars ........................................................................................................................194
Removing or Moving Buttons ...................................................................................................194
Adding Buttons to a Toolbar .....................................................................................................194
Renaming Buttons ....................................................................................................................195
Adding a Custom Image to a Toolbar Button ...........................................................................196
Resetting the Toolbar to Factory Settings ................................................................................197

Chapter 7
Bar Code Readers ....................................................................................................... 198

Bar Code Scan Files .......................................................................................................................199
Sample List Files.............................................................................................................................201
Use a Scan File as a Sample List ...................................................................................................202
Plate ID Bar Code Reader Protocols ..............................................................................................203

Creating a Protocol for the Plate ID Bar Code Reader.............................................................203
Creating Plate ID Bar Code Reader User Functions ................................................................204
Selecting the Plate ID Bar Code Reader (SBCR) Parameters .................................................206

Tube Bar Code Reader Protocols ...................................................................................................207
Create a Protocol for the Tube Barcode Reader ......................................................................208
Setting the Bar Code Scan Parameters ...................................................................................210
Tube Barcode Reader Supported Formats ..............................................................................210
Tube Bar Code Label Quality ...................................................................................................211
Loading the Test Tubes in the Cassettes .................................................................................212
Tube Bar Code Reader Example Protocol ...............................................................................213
Tube Bar Code Reader Scan Errors ........................................................................................215

Chapter 8
Worklists .......................................................................................................................... 216

Create and Edit a Worklist ..............................................................................................................217



 Table of Contents 9

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Using Excel to Edit a Worklist...................................................................................................217
Exporting CSV files from Excel ..........................................................................................217
Importing CSV files into Excel............................................................................................218

Using Worklists ...............................................................................................................................219
Statically Link a Worklist ...........................................................................................................221
Dynamically Link a Worklist ......................................................................................................224

Chapter 9
JANUS Security ............................................................................................................ 231

Security Levels................................................................................................................................232
Creating or Modifying User Accounts.................................................................................233

Assigning Local Users to JANUS Security Groups .........................................................................234
Assigning Domain Users to JANUS Security Groups .....................................................................238

Chapter 10
Reports.............................................................................................................................. 240

Protocol Activity Reports .................................................................................................................240
Adding Reports ...............................................................................................................................242
Viewing Reports ..............................................................................................................................243

Manually Viewing Reports ........................................................................................................243
Viewing Reports after each Run...............................................................................................244

Purge Protocol Reporting Data .......................................................................................................245
Custom Reports ..............................................................................................................................246
Writing Custom Queries ..................................................................................................................249

Chapter 11
Labware Libraries........................................................................................................ 250

Viewing the Labware in the Labware Library ..................................................................................251
Creating New Labware....................................................................................................................252

Copy an Existing Labware Definition........................................................................................252
Create a New Labware Definition.............................................................................................253

Defining New Plate/Rack Labware.....................................................................................255
Defining New Multi-Function Labware ...............................................................................257

Open the Labware Properties Window.....................................................................................259
Set the Labware Properties in the Details Tab .........................................................................261
Evaluate the Labware...............................................................................................................262

Editing Labware ..............................................................................................................................264
Creating Custom Labware Images .................................................................................................264

Hero Image Rules ..............................................................................................................265
Deck Image Rules..............................................................................................................266

Importing Labware Definitions.........................................................................................................267



 Table of Contents 10

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Chapter 12
Performance Files ....................................................................................................... 269

Using Performance Files.................................................................................................................269
Performance File Parameters...................................................................................................272

Selection Criteria................................................................................................................272
Performance Set ................................................................................................................272
Global Parameters .............................................................................................................274

Choosing a Performance File ...................................................................................................276
Creating Performance Files ............................................................................................................277
Editing Performance Files ...............................................................................................................280

Missing Performance Files .......................................................................................................281
Volume Compensation .............................................................................................................282
General Performance Guidelines .............................................................................................284

Liquid Level Sense Verification ..........................................................................................284
Tracking .............................................................................................................................284
Large Syringe Volumes......................................................................................................284

Chapter 13
Calibrating the System ............................................................................................. 285

Deck Calibration..............................................................................................................................285
Calibration Types ............................................................................................................................287

Uncalibrated Points ..................................................................................................................287
Initial/Reset...............................................................................................................................288
3 Point Calibration ....................................................................................................................289
Individual Point .........................................................................................................................291

Deck Calibration Coordinate System ..............................................................................................292
Calibration Procedures....................................................................................................................292

Selecting an Arm ......................................................................................................................293
Calibrating the Varispan Pipetting Arm.....................................................................................294
Calibrating the MDT Pipetting Arm ...........................................................................................297

Loading Dispense Heads and Tips ....................................................................................298
Unloading Dispense Heads and Tips.................................................................................304

Calibrating the MDT Arm for 1536-Well Microplates ................................................................307
Calibrating the JANUS G3 Deck for 1536-Well Microplates ................................................307

Calibrating the NanoHead ........................................................................................................311
Calibrating the MDT Gripper.....................................................................................................311
Calibrating the Gripper Arm......................................................................................................312

Calibrate the Deck for the Gripper Arm..............................................................................312
Teaching Off-Deck (or Special On-Deck) Locations ..........................................................319
Teaching Manifold Component Locations..........................................................................321

Calibrating the Tube Barcode Reader ......................................................................................323
Calibrating the Tube Barcode Reader Deck ......................................................................323
Teaching the Tube Barcode Reader Engage Position.......................................................326
Teaching Labware for the Tube Barcode Reader Cassettes .............................................327



 Table of Contents 11

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Chapter 14
System Configuration ............................................................................................... 329

JANUS G3 Instrument ......................................................................................................................329
Changing the Deck Configuration.............................................................................................330
Configuring the Status Lights ...................................................................................................330
Integrating Devices...................................................................................................................331

Installing and Registering Integration Devices ...................................................................331
Adding a Device to the Deck and Creating the Integration ................................................333
Using the Integration Toolbar Buttons................................................................................336

Initializing the System...............................................................................................................339
Parking the Arms ......................................................................................................................339

Varispan Pipetting Arm ...................................................................................................................340
Varispan Arm Configuration .....................................................................................................340

MDT Pipetting Arm..........................................................................................................................340
MDT Arm Configuration............................................................................................................340

Gripper Arm.....................................................................................................................................340
Speed Profiles....................................................................................................................341

Chapter 15
Example Protocols...................................................................................................... 342

Basic Varispan Example Protocols .................................................................................................343
Multiple Liquid...........................................................................................................................343
Disposable Tips ........................................................................................................................346
Serial Dilution ...........................................................................................................................349
Reagent Before Samples Protocol ...........................................................................................354
Reagent After Samples Protocol ..............................................................................................356
Embedded Controls Procedure ................................................................................................358

Basic MDT Example Protocols........................................................................................................361
Serial Dilution Tools Serial Dilution - Row ................................................................................361

Advanced Varispan Example Protocols ..........................................................................................366
Select Samples Using File........................................................................................................366
Dilutions Using a File................................................................................................................369
Top Off Wells............................................................................................................................376

Appendix A
Liquid Handling ............................................................................................................ 379

Movement of the Sampling Tip .......................................................................................................380
Prime the System with Reagent ...............................................................................................380
The Syringe Valve ....................................................................................................................381
Aspirate and Dispense Example ..............................................................................................384

Basic Liquid Handling Process (in brief) ............................................................................386
Accuracy and Precision...................................................................................................................386

Delays.......................................................................................................................................386
Blowout Mode...........................................................................................................................387
Multiple Dispenses ...................................................................................................................387
First Shot Effect ........................................................................................................................387



 Table of Contents 12

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

The Dilution Effect ....................................................................................................................388
Air Gaps .............................................................................................................................389
Sample Waste Volume.......................................................................................................390

The Elasticity Effect ..................................................................................................................391
Overloading the Varispan Syringe Volume...............................................................................392
Performance Files ....................................................................................................................392

Determining Aspirate and Dispense Rates .....................................................................................392
Aspirate Rates ..........................................................................................................................393
Dispense Rates ........................................................................................................................395
Liquid Viscosity.........................................................................................................................396

Meeting Your Requirements ..............................................................................................397

Appendix B
Caring for the System ............................................................................................... 398

Preventative Maintenance Procedures ...........................................................................................398
Daily Preventative Maintenance ...............................................................................................398

Flush the Varispan Pipetting Arm.......................................................................................399
Clean the Deck, Support Tiles, and Racks ........................................................................399
Check the Syringe Pump Outlet Tubing.............................................................................399
Empty the Waste Container ...............................................................................................400
Clean the Sampling Tips ....................................................................................................400

Weekly Preventative Maintenance ...........................................................................................400
Flush System if Unused For An Extended Period..............................................................400
Visually Check Tubing........................................................................................................400
Visually Check Syringes.....................................................................................................400

Monthly Preventative Maintenance ..........................................................................................401
Clean and Fill the System Liquid Container .......................................................................401

Quarterly Preventative Maintenance ........................................................................................401
Disinfect the Fluid Path ......................................................................................................401
Clean the Waste Tubing.....................................................................................................401

Preventative Maintenance Checklist ...............................................................................................402
Start-Of-Month ...................................................................................................................402
Start-Of-Week ....................................................................................................................402
Start-Of-Day .......................................................................................................................402
End-Of-Day ........................................................................................................................402
End-Of-Week .....................................................................................................................402
Quarterly ............................................................................................................................402

As-Needed Maintenance.................................................................................................................403
Check Deck Calibration ............................................................................................................403
Test the Syringes......................................................................................................................403
Test Tip Pickup.........................................................................................................................404
Test Liquid Level Sense ...........................................................................................................404
Syringe Replacement ...............................................................................................................404
Tubing Replacement ................................................................................................................405
Sanitize Drip Pans ....................................................................................................................406
Change the UV Lamp ...............................................................................................................406

Diagnostic Tests..............................................................................................................................408
Align Tips..................................................................................................................................409
Change Adapter .......................................................................................................................411



 Table of Contents 13

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Change Syringe........................................................................................................................413
Daily Cleaning ..........................................................................................................................414
Flush and Wash Tips................................................................................................................415
Liquid Sense Test.....................................................................................................................416
Pickup Tips Test .......................................................................................................................417
Random Move Test ..................................................................................................................419
Syringe Test .............................................................................................................................420
Random XY Tests ....................................................................................................................421
Reteach Barcode Read Position ..............................................................................................421
Barcode XY Test ......................................................................................................................423
Barcode Scan Test ...................................................................................................................423
Random XY Gripper Test .........................................................................................................424

Removal of Equipment from Use for Repair or Disposal ................................................................426

Appendix C
Troubleshooting........................................................................................................... 427

Liquid Handling Problems ...............................................................................................................427
Troubleshooting Drops on the Sampling Tip...................................................................................427
Troubleshooting Liquid Level Sense Problems...............................................................................428

Index ................................................................................................................................... 429



PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Chapter 1

Introduction
This section provides an introduction to the JANUS® G3 Automated Workstation 
and contains the following information:

• Intended Purpose on page 14
• JANUS G3 System Features on page 15
• Purpose of this Manual on page 15
• Prerequisite Skills and Knowledge on page 16
• Installation on page 16
• Conventions in this Document on page 16
• Table of Symbols on page 17
• Revision History on page 18
• Warranty Terms and Conditions on page 18
• Regulatory Compliance on page 19
• FCC Compliance on page 19

! NOTE For the purposes of this document the term Integration (and derivations 
thereof) are defined as establishing an interface between equipment that 
facilitates communication and interactions between the equipment without 
altering the structural and functional integrity of the equipment.

Intended Purpose
The JANUS G3 Automated Workstation is an automated, programmable liquid 
handling instrument suitable for use in clinical settings by trained laboratory 
personnel to facilitate the pipetting and dilution of fluids in sample preparation 
work flows. Liquid transfers can be performed in a multi-tipped mode from any 
combination of laboratory containers including 384- and 1536-well formats for 
complete assay automation. The JANUS G3 system is controlled by WinPREP®, 
a flexible, powerful, and intuitive software application running on a Windows 
compatible computer.
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JANUS G3 System Features
The following list describes the features of the JANUS system:

• Computer controlled Cartesian X-Y-Z robotic liquid handling system

• Varispan® arm, providing a choice of sampling probes, variable spacing 
between sampling probes and Independent Z drives

• Accusense®, patented independent liquid level sensing
• Modular Dispense Technology (MDT) pipetting arm, providing flexible pipetting 

throughput with Interchangeable Head technology

• Nanoliter (nL) pipette volumes with NanoHead® or Pin Tool options
• Positioning reproducibility
• Labware movement and manipulation with robotic Gripper arm
• Flexible and extensible deck layouts and deck configurations
• Integration with other laboratory equipment
• Various options and accessories

Purpose of this Manual
This manual provides a general overview of the JANUS G3 system and 
familiarizes you with its operation. Tutorials are included to introduce you to some 
of the more common setup and operation tasks.

Additional System Documentation

Refer to the following additional documentation as necessary:

• Online Help
The online help includes the contents of this manual and additional reference 
material describing the WinPREP software windows. Access the online help 
from the Help menu in WinPREP.

• Options and Accessories Manuals
Individual manuals are provided with many of the available options and 
accessories that you integrate with the JANUS G3 instrument. The Operation 
Manual for an option or accessory explains how to use the hardware and 
software. An Integration Manual may be included with some options to 
describe how to integrate the option into the system.
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Prerequisite Skills and Knowledge
To use this documentation, you must be familiar with the basic concepts of 
computer use and common software packages, such as Microsoft Windows and 
Excel. You must have a basic knowledge of Microsoft Windows.

You must also be familiar with basic liquid handling practices, such as pipetting, 
replicate dispenses, dilutions, etc. If you are not familiar with these concepts, or 
need a review, see Appendix A: Liquid Handling on page 379.

Ensure that all personnel involved with the operation of the instrument have:
• Received instruction in general safety practices for laboratories.
• Received instruction in specific safety practices for the instrument.
• Read and understood all related MSDSs.

Installation
To be installed only by qualified PerkinElmer personnel.

! WARNING Appliance inlet is disconnecting device. Place device or equipment in a 
manner so that disconnecting device is accessible at all times.

 NOTE Do not unpack the JANUS G3 shipping container prior to the arrival of the 
PerkinElmer Field Service Engineer. The JANUS G3 instrument must be 
installed by qualified PerkinElmer service personnel.

Conventions in this Document
The following conventions are used in this manual:

Convention Example Meaning

Type 100 in the Volume text box. This command means to type a specific string of 
characters as described in the instruction. The 
characters that you need to type are printed in Bold.

Select CSV (Comma Delimited) 
(*.csv) in the Files of Type drop-
down list.

This command means to select an item from a list, as 
described in the instruction. The option that you need to 
select is printed in Bold.

Click the Save button. An item on a window is printed in Bold Initial Caps (the 
first letter in the item is capitalized).

Select File > Save As on the main 
window. 

A greater than symbol separates each item in a menu 
selection. In this example, select the Save As command 
on the File menu.
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Table of Symbols
Symbol Explanation of Symbols

WARNING: Indicates situations that could result in personal 
injury to yourself or another person or damage to the 
instrument.
Warning (ISO 7000-0434B)
Risk of Electrical Shock (IEC 60417-6042)

Alternating current (IEC 60417-5032)

Protective Earth Ground (IEC 60417-5019)

On (Supply) (IEC 60417-5007)

Off (Supply) (IEC 60417-5008)

Biological Risks
(ISO 7000- 0659 (2004-01))

Fuse Label / (IEC 60417-5016)
Current Warning

Warning
High Leakage Current, 
Ensure Proper Grounding

Warning
Laser Product. Avoid Direct Exposure to Beam (ISO 3864)

Pinch Hazard

Hand Crush / Force From Above

Hot Surface (ISO 3864)

Fuse (IEC 60417-5016)

CE Compliance Mark

Warning
High Leakage Current, 

Ensure Proper Grounding
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Revision History

Warranty Terms and Conditions
Warranty terms and conditions for the JANUS G3 Automated Workstation are 
provided separately in a stand-alone document.

EC authorized representative (ISO 15223-1:2016)

Serial Number (ISO 7000-2498)

Catalog Number (ISO 7000-2493)

In vitro diagnostic device (ISO 15223-1:2016)

Symbol for “Manufacturer” adjacent to the name and address 
of the manufacturer. (ISO 7000-3082)

Waste Electrical & Electronic Equipment (EN50419:2005)

Warning Class II laser
Do not stare into beam

Table 1-1. Revisions CLS146039

Revision Description of Change

L Update for IVDR compliance.
• Added Revision History Table.
• Renamed Intended Use section to Intended Purpose.
• Revised Intended Purpose
• Added Serious Incident Reporting to Safety 

Recommendations.

Symbol Explanation of Symbols
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Regulatory Compliance
This equipment must be used only by trained personnel in a controlled laboratory 
environment.

Replace fuses only with the same type and rating.

Service should only be performed by a qualified PerkinElmer representative.

Refer to the JANUS G3 Quick Start Guide CD for translated Quick Start Guides.

This equipment must only be used with IEC listed accessories (computer, printer, 
monitor, etc.).

If the instrument is received in a damaged condition, request an immediate 
inspection by the carrier and local technical service representative. PerkinElmer is 
not responsible for damage occurring during transit. However, PerkinElmer will 
assist in ensuring a satisfactory settlement from the carrier.

Upon receipt of all damage/inspection reports, PerkinElmer will arrange for either 
instrument repair or replacement.

For proper ventilation of this equipment, a distance of 6 inches (15cm) must be 
maintained from this unit to any other surface.

FCC Compliance
This equipment complies with the limits of FCC Part 15 Class A.

Any changes or modifications not expressly approved by PerkinElmer could 
adversely affect compliance.

Note: This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to 
cause harmful interference in which case the user will be required to correct the 
interference at his own expense.
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Chapter 2

Overview
This chapter provides an overview of the main components of the system and 
includes important safety recommendations:

• Hardware Overview on page 20
• JANUS G3 Instrument Description on page 27
• Options and Accessories on page 34
• WinPREP Software Overview on page 43
• JANUS Application Assistant Software Overview on page 47
• Labware Overview on page 48
• Security Overview on page 49
• System Specifications on page 50
• Safety Recommendations on page 54

Hardware Overview
The JANUS G3 Automated Workstation supports independent modules that you 
can configure and expand as necessary for laboratory growth.

The modular system can be designed in a variety of hardware configurations to 
meet the application needs of your laboratory. All JANUS G3 systems use the 
WinPREP software to create protocols and the JANUS Application Assistant 
software to control the instrument and run protocols.

This section includes the following information:

• Modular Design on page 21
• Available Configurations on page 21
• Deck Configurations on page 24
• Deck Plates on page 24
• Rail Configurations on page 26



 Chapter 2: Overview 21

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Modular Design

The JANUS G3 system allows you to select the size of the JANUS G3 instrument 
and the desired system components including pipetting arms, robotic gripper 
arms, and deck layouts. This modular design provides a wide variety of 
configuration and expansion options.

Available Configurations

The sections below describe each of the platforms and the configurations 
supported on each platform. The required options are necessary for the 
instrument to function; however, you can choose from any of the listed optional 
components for a specific platform.

Mini Platform
The Mini Platform uses a small deck configuration and supports one pipetting arm: 
either a Varispan (4 or 8-tip) or MDT. The Mini Platform only includes a single 
pipetting arm. The Mini Platform has one deck plate.

Figure 2-1. Mini Platform with MDT Arm and Mini Platform with Varispan Arm
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Standard Platform
The Standard Platform uses a medium deck configuration and must contain at 
least one pipetting arm: either a Varispan (4 or 8-tip) or MDT. The Standard 
Platform supports the Varispan (4 or 8-tip) arm, the MDT arm, and the Gripper 
arm. The Standard Platform has two deck plates.

The Standard Platform can include up to three arms if equipped with the optional 
secondary rail, or two arms without the optional secondary rail.

Figure 2-2. Standard Platform with Varispan Arm and MDT Arm

Integrator’s Platform
The Integrator’s Platform is the same as the Standard Platform, but can include 
the following options: 

• Right Deck Extension to increase the deck capacity
• Extended Front, Primary, and Secondary Rail (for three-arm instruments) to 

allow the system to reach off-deck locations and integrate with other devices 
such as plate readers, incubators, etc.
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Expanded Platform
The Expanded Platform uses a large deck configuration and must contain at least 
one pipetting arm. The Expanded Platform supports the Varispan (4 or 8-tip) arm, 
the MDT arm, and the Gripper arm. The Expanded Platform has three deck 
plates.

The Expanded Platform can include up to three arms if equipped with the optional 
secondary rail, or two arms without the optional secondary rail.

Figure 2-3. Expanded Platform with Varispan Arm and MDT Arm

Extended Platform
The Extended Platform is the same as the Expanded Platform with additional 
reach to off-deck positions on the right side of the instrument. Extended front and 
primary rails enable the system to access off-deck positions on devices located to 
the right of the instrument.
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Configuration Guidelines
The following guidelines provide important information to consider when planning 
the system configuration:

• The system cannot contain multiple arms of the same type. A system can, at 
most, have one of each of the following arms:
— Varispan Pipetting
— MDT Pipetting
— Gripper

For instance, a system cannot contain two Varispan pipetting arms. Certain 
other system selections, such as deck length, influence the number of arms 
you can select for a system.

• Two integrated arms requires a Standard or Expanded primary rail 
configuration.

• The Mini Platform only supports a single arm.
• Dual pipetting arm configurations with the Gripper option require a secondary 

rail.

Deck Configurations

Deck configuration options provide several deck sizes. Deck plates are available 
for either MDT or Varispan arms. The arrangement of the deck plates on the 
instrument can be changed as desired to optimize the positioning of the labware.

The table below shows the microplate deck capacity for each platform.

* with optional Deck Expansion Module

Deck Plates

The JANUS G3 deck is made up of one or more deck plates, depending on the 
platform. These plates contain rows and columns of physical deck positions which 
form a grid; the intersection of a row and column identifies a position on the deck. 
The software uses these positions to locate labware you place on the deck.

Platform Mini Standard Integrator Expanded

Configuration

Varispan 12 24 24 (32)* 32

MDT 9 15 15 (21)* 21

Varispan + MDT Not Available 18 18 (24)* 29
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There are two standard types of deck plates available for JANUS G3: Varispan 
and MDT. The decks are optimized for use with the associated pipetting arm, so 
the column spacing differs slightly between the two deck plate types. Figure 2-4 
shows the differences between the spacing for each type of deck plate.

Figure 2-4. Deck Grid Layout Examples

Figure 2-4 shows the rows and columns on both types of deck plating. Rows are 
identified by letters and columns are identified by numbers. To identify a position 
on a deck plate, specify the row letter and then the column number. For example, 
A1 identifies the upper-left position on a deck plate: Row A, Column 1. Column 
numbering restarts for each separate deck plate so it is important to identify the 
deck plate in addition to the row and column. Typically, you identify deck plates by 
their positions on the instrument’s frame: Left, Middle, and Right. For example, to 
identify the upper-left position on the left deck plate you can refer to Left[A1]. The 
instrument tracks and identifies the labware you place on the deck using this 
information. When tracking the placement of labware, the software includes the 
plate type as well, and displays the location in the format Var-Left[A1] or MDT-
Right[D7].

Columns Column
Group

Inter-group
Space

Inter-column
Space

R
ow

s
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Row placement and spacing is the same for both types of deck plates. However, 
the arrangement and grouping of columns differs according to the deck plate type. 
Column groups, identified in Figure 2-4 by the outlined, shaded areas, are made 
up of three adjacent columns. Column groups include three columns because 
standard labware requires this amount of space on the deck. Inter-group spaces 
separate column groups, as shown in Figure 2-4. 

As Figure 2-4 illustrates, the inter-group space is the primary difference between 
deck plate types. The MDT deck plate has a larger inter-group space than a 
Varispan deck plate. This extra inter-group space is necessary to accommodate 
certain MDT-related labware such as docking stations, wash bowls, and tip load 
supports and helps prevent a piece of labware from obstructing more than the 
required three columns on the deck.

Note that pipetting arms and deck plates are completely compatible. You can use 
an MDT arm with a Varispan deck plate and a Varispan arm with an MDT deck 
plate. The differences in plate types is for deck space optimization only. Using an 
MDT arm with a Varispan deck plate decreases the amount of labware that will fit 
on the deck because the Varispan deck plate has a smaller inter-group space. 
Certain types of MDT labware will obstruct additional deck positions on the 
Varispan deck, resulting in a diminished labware capacity for the deck.

When placing labware on the deck, the MDT head requires the labware to be 
placed one row apart, not immediately next to each other, to prevent the head 
from coming into contact with other labware on the deck.

Rail Configurations

Each JANUS G3 instrument has two rails that provide travel support for the 
pipetting and gripper arms. The rail on the front of the instrument, just above the 
plastic safety shield, is the front rail. The rail in the back of the instrument is the 
primary or X-rail. Three arm systems - instruments with two pipetting arms and a 
Gripper arm - require a second rail on the rear of the system. This rail is located 
just above the primary rail and is the secondary rail. The rear rails provide support 
for the arms and the travel path for the robotic arms. The front rail primarily 
provides support for the arms.

The configuration of the primary and secondary rail provides integration options 
for the system. With a secondary rail configuration that is longer than the deck, 
liquid handling and gripper arms can access off-deck locations for integration with 
other laboratory equipment.

Secondary rails that are longer than the deck can be offset to either side of the 
instrument platform for greater flexibility. By moving one arm off the deck, the 
other arm can freely access the entire deck.
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JANUS G3 Instrument Description
All JANUS G3 systems have certain components in common, such as the status 
lights, front door, deck, and System Pause button. Figure 2-5 identifies the 
common components of all JANUS G3 systems.

Figure 2-5. JANUS G3 Instrument Components

Pipetting Arm - The arm(s) on the system that perform liquid handling 
operations. Figure 2-5 shows a Varispan arm. The arms that are supported on a 
system depend on the system platform. See Available Configurations on page 21 
for descriptions of each platform. For more information about each type of 
pipetting arm, see Varispan Pipetting Arm on page 30 or MDT (Modular Dispense 
Technology) Pipetting Arm on page 31.

Gripper Arm - (Not shown in Figure 2-5) The Gripper arm is used to transport 
labware to or from JANUS G3 deck locations or off-deck locations supported by 
the configuration of the system. For more information, see Gripper Arm on 
page 33.

Status Lights

Deck

Front Door

System Pause button

Pipetting Arm
(Varispan)
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Status Lights - The two status lights indicate the current status of the system. 
The status lights automatically dim after remaining in the same state for a 
specified time period. The colors displayed for each status and the time until the 
lights dim can be customized if desired. See Configuring the Status Lights on 
page 330 for instructions. The default colors of the status lights are:
• Green - The system is running a protocol. The lights remain green if the 

instrument is paused.
• Blinking Green - The system is waiting for user input.
• Blue - The system is idle or a protocol is complete.
• Red - The system has encountered an error.

Front Door - Grasp the middle of the handle and lift the handle up and slightly out 
away from the instrument to open the front door.
The doors are equipped with an interlock switch that prevents the system from 
moving while the doors are open. Opening a door while a protocol is running 
disables all arm X, Y, and Z motors immediately and displays a warning message 
in the software. If the door is opened during a Varispan aspirate or dispense 
operation, the system will finish the aspirate or dispense. If the door is opened 
during an MDT aspirate or dispense operation, the system will stop the aspirate or 
dispense immediately.

 Note: If the door is opened while an arm is moving in the X direction, the arm 
may continue to glide, without power, in the direction it was moving.

 Note: If possible, press the Pause button in the software to pause the system 
before opening the door to make resuming the protocol easier.

To continue running the protocol, close the door, if necessary use the Direct 
Control window to set up the instrument to continue the protocol, and then select 
the desired recovery option in the software.

Deck - Interchangeable deck plates used to accurately locate labware and 
support tiles. For information on the number of deck plates supported on each 
platform, see Available Configurations on page 21.

System Pause button - Pressing the System Pause button on the front of the 
instrument while a protocol is running disables all arm X, Y, and Z motors 
immediately and displays a warning message in the software. If the System 
Pause button is pressed during a Varispan aspirate or dispense operation, the 
system will finish the aspirate or dispense. If the System Pause button is pressed 
during an MDT aspirate or dispense operation, the system will stop the aspirate or 
dispense immediately. For information about restarting a protocol after pressing 
the System Pause button, see Using the System Pause Button on page 173.

Connection Panel - (Not shown in Figure 2-5) See JANUS G3 Connection Panel 
on page 29.
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JANUS G3 Connection Panel

The JANUS G3 instrument includes a connections panel (see Figure 2-6) on the 
left end of the instrument. This panel includes the main power, USB cable, and 
connection ports for several optional accessories. For Mini systems with an 8-Tip 
Varispan arm, the connection panel is located on the Remote Electronics Box.

Figure 2-6. JANUS G3 Connectors

Digital I/O port - Provides communication for optional accessories such as the 
Tube Barcode Reader. For more information about optional accessories, contact 
your PerkinElmer sales representative.

USB Cable - Uses a permanently-connected USB cable to connect the JANUS 
G3 to a USB port on the Windows computer running WinPREP. This is the only 
communication between WinPREP and the JANUS G3.

Barcode Port - Connects the optional Plate ID Barcode Reader to the JANUS G3 
system. This connection provides communication between the JANUS G3 and the 
Plate ID Barcode Reader accessory. This connection is not used if the system 
does not include the Plate ID Barcode Reader option.

Power Cable Connector - Connects the JANUS G3 instrument to an appropriate 
power outlet. This is the main power connector for the instrument. 

! WARNING Appliance inlet is disconnecting device. Place device or equipment in a 
manner so that disconnecting device is accessible at all times.

Power Switch - The main power switch for the instrument.

Fuse Cover - Contains the appropriate fuses. 

USB

Digital
I/O

Power Cable
Power

Connector
Switch

Plate ID Barcode
Connector

Fuse Cover
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Varispan Pipetting Arm

The Varispan pipetting arm provides sample access to individual sample positions 
on the deck, with each tip moving vertically and independently. The Varispan 
feature provides flexible spacing between the sampling tips. JANUS G3 supports 
either 4-tip or 8-tip Varispan pipetting arms. The Varispan arm supports both 
disposable and fixed tips. Fixed tips are the metal tips connected to the fluid path 
for the arm. Disposable tips are plastic tip adapters that fit over the system’s fixed 
tips. You can use either type of tips or combine them in the same protocol. 
Disposable tips are discarded after use in a procedure or protocol.

Each tip is supported by an independent liquid path and syringe pump, allowing 
maximum flexibility. The volume and the locations are independent, allowing you 
to select specific wells for each pipetting operation.

The Varispan arm provides Liquid Level Sensing (Liquid Level Sense) for each of 
the pipetting tips. Liquid Level Sensing enables the instrument to determine the 
level or depth of liquid in the labware wells and dynamically adjust the speed at 
which the tips move into or out of the liquid. This helps ensure the tips remain 
properly submerged in the liquid during pipetting operations.

The Varispan arm is available on select JANUS G3 configurations. You can also 
add the Varispan arm as an additional option on some existing JANUS G3 
platforms with an MDT arm. Contact PerkinElmer (see page 2) for more 
information.

Peristaltic Pump Box Connection Panel
The JANUS Peristaltic Pump (peri pump) Box, included with systems equipped 
with a Varispan arm, includes a connections panel on the back of the Peri Pump 
Box. This panel includes the main communication port, system liquid sensor port, 
and digital I/O port. Figure 2-7 shows the JANUS Peri Pump Box connections 
panel.

Figure 2-7. JANUS Peri Pump Connectors

D-Sub Port

Digital I/O Port

System Liquid Sensor
Connector
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D-SUB Port - Provides communication between the JANUS G3 and the peri 
pump. Connects to the Peri Pump Connector on the JANUS G3.

Digital I/O Port - Provides communication for optional accessories. For more 
information about optional accessories, contact your PerkinElmer sales 
representative.

System Liquid Sensor Connector - Connects the sensor in the system liquid 
container to the peri pump. This sensor uses a float mechanism to monitor the 
level of the system liquid fluid in the container.

MDT (Modular Dispense Technology) Pipetting Arm

The MDT (Modular Dispense Technology) pipetting arm is a flexible JANUS G3 
option for automated liquid handling of low to high throughput microplate 
applications. The patented interchangeable head design provides a convenient 
and flexible way to support many different head sizes on the MDT pipetting arm.

The MDT arm does not contain independent liquid paths for each tip. All tips 
aspirate and dispense in unison. You can, however, load a partial box of 
disposable tips, thereby selectively using some tips to aspirate and dispense 
samples. Liquid Level Sensing (Liquid Level Sense) is not available for the MDT 
arm.

The MDT arm is available on select JANUS G3 configurations. The MDT arm can 
be used with the Varispan and/or Gripper arm in certain JANUS G3 
configurations. See Available Configurations on page 21 for more information.

When placing labware on the deck, the MDT head requires the labware to be 
placed one row apart, not immediately next to each other, to prevent the head 
from coming into contact with other labware on the deck.

Dispense Heads
JANUS G3 supports several different MDT heads, including 96 and 384-tip 
dispense heads. These heads are capable of dispensing into 96, 384, and 1536-
well plates, and are fully interchangeable. Nanoliter dispensing can be performed 
using the optional NanoHead (50 nL to 1 µL) or the MDT Pin Tool (20 to 500 nL). 
You can switch MDT heads dynamically during a single protocol, providing an 
unprecedented level of flexibility to your assays.
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Head ID Tag
The Head ID tag is located on the top of each interchangeable head. This tag is 
used by the system to identify the head. When you place the head and docking 
station on the deck, this ID tag must always be oriented so that it is located to the 
right. The tag must line up with a sensor on the base of the tower. When the tower 
is lowered to retrieve the head from the docking station, the sensor reads the tag 
to identify the head that is being used. If the system cannot find the tag (this will 
happen if the head is reversed in the docking station), you will receive a message 
that the system cannot identify the head type.

Figure 2-8. Head ID Tag

Docking Station
The docking station is required for loading and unloading the interchangeable 
heads on the MDT arm. The NanoHead Docking Station Adapters must be used 
with the MDT Docking Station when storing or loading the NanoHead. See 
Docking Station Restrictions on page 120 for information on locating the docking 
station on the deck.

Figure 2-9. Docking Station
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MDT Gripper
The MDT arm can include an optional gripper for additional gripper functionality. 
The MDT Gripper can be used to move plates and tip boxes. The MDT Gripper 
moves in the same X, Y, and Z axes as the MDT arm, and also includes gripping 
(close and open) movements to provide outside grip and inside grip capabilities. 
Covers must be removed from tip boxes. The Gripper will not transport tip boxes 
with covers.

The MDT gripper is an extension of the MDT pipetting arm and is not offered as a 
stand-alone option.

Gripper Arm

The Gripper arm is a fully-integrated option that can be used to move labware 
from one deck location to another, move labware to off-deck locations, or 
assemble/disassemble multi-part labware components such as manifolds.

The Gripper arm can be mounted on the same rail as the pipetting head for a two 
arm configuration. It can also be mounted on the secondary rail as a second or 
third arm on systems configured with one or two pipetting arms, respectively.

The Gripper arm moves in the same X, Y, and Z axes as the liquid handling arms, 
and also can rotate 355 degrees (theta axis), allowing access to labware in any 
orientation on the deck. The Gripper also includes gripping (close and open) 
movements to provide outside grip and inside grip capabilities. The Gripper can 
securely grasp and move labware or special components such as Solid Phase 
Extraction manifold parts from inside a manifold where necessary.
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Options and Accessories
The following options and accessories are described in this manual:

• Enclosure Option on page 35
• UV Light Option on page 36
• MDT Pipetting Arm Accessories on page 36

The following options and accessories can be integrated with the JANUS G3 
instrument:

• PerkinElmer Victor
• PerkinElmer EnVision
• Enhanced Security software
• Plate ID Bar Code Reader
• Tube Barcode Reader

• PlateStak® System
• Solid Phase Extraction/Vacuum Filtration
• Several shakers and heaters
• Deck expansion modules
• Thermal Cycler integration
• Inheco On Deck Thermal Cycler (ODTC)
• FlexDrop integration
• PlateWash System integration
• Proteomics integration
• A variety of labware accessories

Individual manuals are provided with the options and accessories listed above. 
Refer to the user documentation included with the option or accessory for detailed 
operating instructions.
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Enclosure Option

An optional JANUS G3 Enclosure is offered to shield the instrument deck from 
dust and particulates. The enclosure is offered in two heights to accommodate the 
configuration of the JANUS G3 instrument. The shorter enclosures are compatible 
with systems that only include a Varispan arm. The taller enclosures are 
compatible with systems that include an MDT arm and/or a Gripper arm. Figure 2-
10 shows the two different enclosures for the JANUS G3 Mini Platform.

The Enclosure also includes interior lights to illuminate the JANUS G3 deck. See 
Controlling the Interior Lights on page 103 for more information.

Figure 2-10. JANUS G3 Mini with Varispan Arm Enclosure and JANUS G3 Mini with 
MDT Arm Enclosure

The UV Light option requires an enclosure option to be installed before the UV 
light can be operated. The enclosure blocks UV light from exiting the enclosure. 
Door switches turn off the UV light if any enclosure door is opened during 
operation and prevent the light from turning on when any door is open.
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UV Light Option

The optional JANUS G3 UV Light provides UVC light with a wavelength of 2,537 
Angstroms (254 nm) over the deck of the JANUS G3. A minimum UVC dose of 
5uW per square centimeter per second is provided. All items on the deck may 
need to be removed and the arms may need to be moved to expose the entire 
deck.

The UV Light option is offered in two sizes. The JANUS G3 UV Light, Mini is 
compatible with the JANUS G3 Mini platform. The JANUS G3 UV Light, Std/Exp is 
compatible with the JANUS G3 Standard or Expanded Platform.

! WARNING Unprotected eyes and skin can be seriously damaged by exposure to UVC 
radiation. Do not open any doors or covers while the UV Light is switched 
on.

• Close all enclosure doors and install covers on any tip chutes, tip box 
chutes, or open deck locations before operating the UV Light via Direct 
Control or in a protocol. The enclosure panels block the shortwave UV 
radiation. 

• Do not defeat the door interlock switches.

• See UV Light Safety on page 58 for additional important safety 
information.

The JANUS G3 UV Light option must be used with the optional enclosure (see 
page 35). The acrylic glass panels of the enclosure block the UV light. Interlock 
switches on the enclosure doors turn the UV light off if a door is opened while the 
light is on, and prevent the light from being turned on while a door is open.

The UV Light is controlled by the WinPREP and JANUS Application Assistant 
software. See the JANUS G3 User Manual and JANUS Help file for UV Light 
operating instructions.

MDT Pipetting Arm Accessories

The MDT arm can use several options and accessories. These include wash 
stations, docking stations, auto tip loaders, reagent containers, and various head 
configurations. Contact your PerkinElmer sales representative for a complete list 
of accessories available for the MDT arm.

The following MDT arm accessories are described in this manual:
• NanoHead (below)
• Serial Dilution Tools on page 38
• Pin Tools on page 42
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NanoHead
The NanoHead is a low volume 384-tip dispense head available for JANUS G3 
instruments equipped with an MDT arm. Using the NanoHead, you can pipette 
fluid volumes between 50 nanoliters (nL) and 1 microliter (µL). You can only use 
the NanoHead with 384-well and 1536-well plates because the head uses the 
384-well format. The NanoHead can only access plates with wells in multiples of 
384.

The NanoHead is especially useful for pipetting from stock compound plates 
directly into reaction plates. This requires fewer assay preparation steps and 
increases the overall accuracy of the assay. The NanoHead can be used for 
compound reformatting in high throughput screening, plate replication, and 
reagent addition, in applications such as PCR.
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Serial Dilution Tools
The optional Serial Dilution Tools (SDT) are a group of MDT dispense heads you 
use with the MDT arm to perform direct and serial dilutions. The Serial Dilution 
Tools can load a single row or single column of disposable tips from a standard full 
box of tips and includes protocols to perform a serial dilution.

Although you can perform serial dilutions using the MDT arm without the Serial 
Dilution Tools, this option streamlines the process and eliminates the need to use 
partially loaded tip boxes. It also allows you to perform multiple serial dilution 
operations by loading rows or columns of disposable tips from a standard tip box.

The Serial Dilution Tools include:
• SDT Heads on page 38
• SDT Tip Box Support on page 41
• SDT Docking Station on page 41

For tips on using the SDT Head, Docking Station, and Tip Box Support, see 
Labware Positioning Considerations on page 119.

SDT Heads
The Serial Dilution Tool Heads available are listed in the table below. Each head is 
described in more detail later in this section.

The row and/or column orientation refers to the pattern of mandrels on the SDT 
head itself and not to the orientation of the tips as they reside in the disposable tip 
box. When the SDT head moves to the tip box and columns are being accessed, 
the head starts at the right-most column of the tip box and moves across the tip 
box (one column at a time). When rows are being accessed, the MDT head starts 
at the bottom-most row of the tip box and moves up to the top-most row of the tip 
box (one row at a time). After the tips have been picked up and used in a protocol, 
they must be dropped in a waste chute. Do not return the used tips to the tip box.

Dispenser Head Configuration Compatible 
Tips

MDT I200RC Serial Dilution Tool column or row P200

MDT I50R Serial Dilution Tool row only P50
P20

MDT I50C Serial Dilution Tool column only P50
P20

MDT I30RC Serial Dilution Tool column or row P30
P10
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Serial Dilution Tools are available as an option on any current instrument 
equipped with an MDT arm. Existing instruments can be upgraded to include the 
option. Contact PerkinElmer (see page 2) for additional information.

MDT I200RC Serial Dilution Tool: Supports column or row pickup and is 
compatible with P200 tips. The mandrels on the MDT I200 RC Serial Dilution Tool 
are located around the entire perimeter of the head.

Figure 2-11. MDT I200RC Serial Dilution Head

MDT I50R Serial Dilution Tool: Supports row pickup and is compatible with P50 
and P20 disposable tips. The mandrels on the MDT I50R Serial Dilution Tool are 
located on the front edge of the head (the “front” becomes the “back” when you 
turn the head over).

Figure 2-12. MDT I50R Serial Dilution Head
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MDT I50C Serial Dilution Tool: Supports column pickup and is compatible with 
P50 and P20 disposable tips. The mandrels on the MDT I50C Serial Dilution Tool 
are located on the left edge of the head.

Figure 2-13. MDT I50C Serial Dilution Head

MDT I30RC Serial Dilution Tool: Supports column or row pick up and is 
compatible with P30 and P10 disposable tips. The tip holes on the MDT I30RC 
Serial Dilution Tool are located along the left edge and front edge of the head (the 
“front” becomes the “back” when you turn the head over).

Figure 2-14. MDT I30RC Serial Dilution Head
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SDT Tip Box Support
The SDT Tip Box Support is required for the JANUS Serial Dilution Tools. The 
SDT head can load disposable tips only from tip boxes in the SDT Tip Box 
Support Tile. See Tip Loading Restrictions (Serial Dilution Tools only) on page 122 
for information on locating the SDT Tip Box Support Tile on the deck.

Figure 2-15. Serial Dilution Tools Tip Box Support Tile

SDT Docking Station
The Serial Dilution Tools require an SDT Docking Station (Figure 2-16) to load and 
unload the interchangeable heads on the MDT arm. Four different SDT heads are 
available to support a total of five different disposable tip sizes. Refer to MDT 
(Modular Dispense Technology) Pipetting Arm on page 31 for more information 
about available SDT head options and supported tip sizes.

Figure 2-16. Serial Dilution Tools Docking Station
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Pin Tools
The MDT Pin Tools are optional MDT heads that allow controlled pipetting of 
volumes as small as 20 nanoliters (nL).

In contrast to the NanoHead head, the pins on the pin tool do not contain a liquid 
column. The pins are solid and mount directly to the base plate. The plate 
attaches to the arm by slipping over the dispense head. The tips are inserted into 
the labware wells. The pins transfer liquid when the liquid adheres to the sides 
and tips of the pins. The physical properties of the pin and the liquid being 
transferred directly affect the transfer volume. For example, the diameter of the 
pin, the surface tension of the pin’s coating, the surface tension of the liquid being 
transferred, the distance the pin is inserted into the liquid, and the speed at which 
the pins are withdrawn from the liquid all influence the transfer volume. When 
these variables are taken into consideration, the accuracy of the liquid transfer is 
very high, with a reliability of 95% or more.

PerkinElmer provides a wide variety of pin tool choices, based on the number of 
pins, desired pipetting volume, and construction material. Contact your 
PerkinElmer sales representative for a complete list of pin tools available for the 
MDT arm.
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WinPREP Software Overview
The JANUS G3 system uses two software applications to control the system: 
WinPREP and JANUS Application Assistant. 

• WinPREP is used to set up the system, calibrate the instrument, and to create, 
edit, and evaluate the protocols. See WinPREP Main Window for an overview 
of the WinPREP Main Window.

• JANUS Application Assistant is used to run protocols, run diagnostic tests, 
and run maintenance protocols. See JANUS Application Assistant Software 
Overview for an overview of the JANUS Application Assistant Main Window.

WinPREP Main Window

WinPREP makes protocol creation and development easier by providing an 
intuitive and easy-to-use graphical interface and many predefined procedures to 
create protocols. The Procedures already contain the required individual steps 
and can be combined and configured to construct more complex protocols. 
WinPREP also includes protocols that can be used as-is or as templates for 
developing similar protocols.

The main window of the WinPREP software, shown in Figure 2-17, is divided into 
two views that graphically represent the contents of the protocol.

The Protocol Outline View, on the left, defines the individual steps for the 
protocol. The Deck View, on the right, defines the labware on the deck and is 
used to specify the source and destination labware for the steps in the protocol. To 
adjust the relative size of the two views, drag the vertical divider between the 
views horizontally in the window.
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Figure 2-17. Protocol Outline View (Left) and Deck View (Right)

Multiple protocols can be open at the same time in the WinPREP main window. 
You can have several protocols open in WinPREP. The JANUS Application 
Assistant is used to run the protocol in the active window.

Protocol Outline View
The Protocol Outline View displays a visual representation of the protocol. The 
Protocol Outline uses a standard tree structure to show the order, hierarchy and 
organization of the operations in the protocol. The Protocol Outline View provides 
access to the parameter windows to define the parameters for each procedure 
and step in the protocol. Figure 2-18 shows an example of a protocol outline.

Figure 2-18.  Protocol Outline View
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For more information about the Protocol Outline view, see the JANUS Online 
Help. For detailed explanations of the available procedures and steps, see 
Procedures and Steps on page 184.

Mapping is the process of associating a node with the labware used by the node; 
mapping consists of linking a step in the protocol outline to a labware item on the 
deck. You cannot start a protocol until each liquid handling step or gripper step in 
the protocol outline is mapped to at least one labware item. The names of 
unmapped procedures or steps display in bold type in the protocol outline to 
signify their unmapped status. For more information about the mapping labware, 
see Mapping the Labware on page 139.

Deck View
The Deck View displays the physical deck layout for the protocol. The type of 
labware and the position of labware must be identified for the protocol. The deck 
view is a graphical representation of the labware position, type, and location on 
the deck. The deck view also indicates the labware mapped to a procedure or 
step selected in the protocol outline. The open space at the top of the deck can be 
used to temporarily hold labware. Labware can be stacked in the deck view.

Figure 2-19. Deck View (8-Tip and MDT System)

The arm icons at the top of the deck view display the arms that are installed on the 
system. Click an arm icon to select the arm and to display the deck calibration 
status for each arm. For more information about deck calibration, see Calibrating 
the System on page 285.
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Toolbars
The WinPREP software displays several toolbars at the top of the window. These 
toolbars provide quick, graphical shortcuts to commonly used menu functions and 
to procedures and steps used in protocols. Hovering the cursor over a button 
displays a tool tip that describes the function of the button.

Only the buttons that are appropriate for the current operation are enabled. 
Disabled buttons are indicated by the lack of color and a dim display. You can 
view or hide a toolbar by selecting the toolbar name on the View menu. You can 
customize the toolbar by adding, removing, or rearranging buttons. For more 
information, see Customizing the Toolbars on page 193.

Figure 2-20.  Toolbars

For more information about the WinPREP procedures and steps available on the 
toolbars, see Procedures on page 184 and Steps on page 192.

For detailed descriptions of the toolbars, see the JANUS online Help.
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JANUS Application Assistant Software Overview
The JANUS Application Assistant software is used to select and run protocols on 
the JANUS G3 system. The tabs along the top of the window allow you to easily 
select the protocol that you want to run, specify any parameters for the protocol, 
gather the labware, place the labware on the deck, run the protocol, and then 
clean up the instrument after the run. Maintenance and diagnostic protocols are 
also available in the JANUS Application Assistant.

For detailed instructions on running protocols, see Running Protocols on 
page 164.

Figure 2-21. JANUS Application Assistant Software

The JANUS Application Assistant Editor software is a utility used to set up 
protocol categories and assign protocols to each category. If a protocol is not 
assigned to a protocol category, the protocol is not displayed in the JANUS 
Application Assistant software. For more information about protocol categories, 
see Add the Protocol to a Protocol Category on page 153.

See the JANUS online help for complete descriptions of each tab in the JANUS 
Application Assistant.
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Labware Overview
WinPREP labware is an electronic representation of the physical laboratory 
equipment you use in a protocol. Labware consists of test tubes, test tube racks, 
microplates, support tiles, flush/wash stations, and many other types of common 
laboratory equipment. WinPREP groups similar types of labware into categories. 
You assign labware to categories in the labware library (see page 250). This 
organization makes it easier to find the labware.

The labware definition defines the number and organization of sample positions 
on the labware item. The labware definition also defines whether the labware 
contains positions for multiple reservoirs or troughs.

WinPREP provides an extensive library of predefined labware items. While the 
predefined labware will meet many of your needs, you might require a piece of 
labware not defined in the library. WinPREP includes the Labware Definition 
Wizard to easily define new or custom labware.

For more information about labware, see Creating the Deck Layout on page 118 
and Labware Libraries on page 250.

Support Tiles

Each labware support tile has an indicator showing where to read the grid 
coordinates for the labware position. For microplates, a cutout in the bottom of the 
support tile shows the coordinate ID of the plate. Other labware supports have 
their own coordinate indicators.

Mapping Labware

Each step or procedure that accesses labware must be mapped to the labware for 
the step or procedure. Mapping labware is the process of associating the plates, 
tubes, flush/wash stations, etc. to the actual procedures and steps in the protocol 
outline. 

Mapping labware requires an understanding of the Deck View. For more 
information about the deck view, and the process of mapping labware, see 
Mapping the Labware on page 139.
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Security Overview
System security for the JANUS G3 Automated Workstation, the WinPREP 
software, and the JANUS Application Assistant software is handled through the 
standard Windows User Account security. Security and privilege access is 
controlled through password protected user log in. Three levels of security access 
for user accounts are created when WinPREP is installed:

• Packard User
• Packard Administrator
• Packard TSE

Each security level allows increased accessibility to the system over the previous 
level, with Packard TSE having the greatest control. You can create as many 
users as necessary to maintain security and usability of the system. System 
administrators can create or modify User Accounts with the User Manager 
program, one of the standard Administrative Tools provided with the Windows 
operating system. For more information on the security levels and instructions on 
assigning users to a security group, see JANUS Security on page 231.

In addition to the standard Windows User Account security, PerkinElmer offers the 
JANUS Enhanced Security Option. The JANUS Enhanced Security option 
provides 21 CFR Part 11 compatibility.
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System Specifications
This section describes the physical specifications, the environmental 
requirements, and the electrical requirements of the JANUS G3 system. The 
actual size and weight of the system can vary, depending on the deck 
configuration, installed options, etc.

For In Vitro Diagnostic Use.

Pipetting Precision

Pipetting precision above is typical when using distilled water under controlled 
conditions.

Pipetting arm Tip/Head Volume % CV Condition

Varispan 20 uL disposable tip 5 uL < 2% Distilled water, 
500 uL syringe

Fixed tip 50 uL < 1% Distilled water, 
500 uL syringe

MDT P20 disposable tip on P50 96-tip Head 1 uL < 2%

P30 or P10 disposable tips on P30
384-tip Head 1 uL < 5%

P50 disposable tips on P50 96-tip Head 5 uL < 1%

P235 disposable tips on P235 96-tip 
Head 50 uL < 1%
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Physical Dimensions for Cladded Instruments

The sizes below are for the instrument only and do not include optional 
accessories.

Height x Width x Depth

Instrument Weights for Cladded Instruments (Approximate)

The weights below are for the instrument only and do not include any optional 
accessories. Add the weight of any optional accessories for total system weight.

Net Weight/Shipping Weight

Platform Mini Standard Integrator Expanded
Configuration
Varispan 34” (864 mm) x 34” (864 mm) x 34” (864 mm) x 34” (864 mm) x

31” (788 mm) x 47” (1194 mm) x 62” (1575 mm) x 62” (1575 mm) x
33” (838 mm) 33” (838 mm) 33” (838 mm) 33” (838 mm)

MDT 44” (1118 mm) x 44” (1118 mm) x 44” (1118 mm) x 44” (1118 mm) x
31” (788 mm) x 47” (1194 mm) x 62” (1575 mm) x 62” (1575 mm) x
33” (838 mm) 33” (838 mm) 33” (838 mm) 33” (838 mm)

Varispan + 
Gripper Arm

43” (1092 mm) x 43” (1092 mm) x 43” (1092 mm) x
Not Available 47” (1194 mm) x 62” (1575 mm) x 62” (1575 mm) x

33” (838 mm) 33” (838 mm) 33” (838 mm)
Varispan + MDT 44” (1118 mm) x 44” (1118 mm) x 44” (1118 mm) x

Not Available 47” (1194 mm) x 62” (1575 mm) x 62” (1575 mm) x
33” (838 mm) 33” (838 mm) 33” (838 mm)

Platform Mini Standard Integrator Expanded
Configuration
Varispan 210 lb (95 kg)/ 265 lb (120 kg)/ 290 lb (132 kg)/ 310 lb (141 kg)/

370 lb (168 kg) 435 lb (198 kg) 570 lb (259 kg) 590 lb (268 kg)
MDT 215 lb (98 kg)/ 255 lb (116 kg)/ 275 lb (125 kg)/ 295 lb (134 kg)/

350 lb (159 kg) 435 lb (198 kg) 570 lb (259 kg) 590 lb (268 kg)
Varispan + MDT Not Available 325 lb (148 kg)/ 355 lb (161 kg)/ 375 lb (170 kg)/

445 lb (202 kg) 580 lb (263 kg) 600 lb (272 kg)
Gripper Arm Not Available + 50 lb (23 kg) + 50 lb (23 kg) + 50 lb (23 kg)
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Physical Dimensions for Instruments with Enclosure

The sizes below include only the JANUS G3 instrument with the optional 
Enclosure.

Height x Width x Depth

Instrument Weights for Instruments with Enclosure (Approximate)

The weights below do not include any optional accessories. Add the weight of any 
optional accessories for total system weight.

Net Weight/Shipping Weight

Compressed Air Requirements (for MDT Arm only)

The MDT arm requires a clean, dry source of compressed air that meets the 
following specifications: 110-145 psi (8-10 bar) at 2.0 cubic feet (56.6 L) per 
minute.

Platform Mini Standard Integrator Expanded
Configuration
Varispan 8-Tip 
Short

38" (965 mm) x 38" (965 mm) x 38" (965 mm) x 38" (965 mm) x
38" (965 mm) x 55" (1400 mm) x 70" (1780 mm) x 70" (1780 mm) x
35" (890 mm) 35" (890 mm) 35" (890 mm) 35" (890 mm)

MDT Tall 46" (1170 mm) x 46" (1170 mm) x 46" (1170 mm) x 46" (1170 mm) x
38" (965 mm) x 55" (1400 mm) x 70" (1780 mm) x 70" (1780 mm) x
35" (890 mm) 35" (890 mm) 35" (890 mm) 35" (890 mm)

Varispan 8-tip + 
Gripper Arm Tall

46" (1170 mm) x 46" (1170 mm) x 46" (1170 mm) x
Not Available 55" (1400 mm) x 70" (1780 mm) x 70" (1780 mm) x

35" (890 mm) 35" (890 mm) 35" (890 mm)
Varispan + MDT 
Tall

46" (1170 mm) x 46" (1170 mm) x 46" (1170 mm) x
Not Available 55" (1400 mm) x 70" (1780 mm) x 70" (1780 mm) x

35" (890 mm) 35" (890 mm) 35" (890 mm)

Platform Mini Standard Integrator Expanded
Configuration
Varispan 8-Tip 
Short

275 lb (125 kg)/ 310 lb (141 kg)/ Not Available 345 lb (157 kg)/
410 lb (186 kg) 350 lb (159 kg) 640 lb (290 kg)

MDT Tall 335 lb (152 kg)/ 375 lb (171 kg)/ Not Available 420 lb (191 kg)/
470 lb (213 kg) 425 lb (193 kg) 715 lb (325 kg)

Varispan + MDT 
Tall

Not Available 445 lb (202 kg)/ Not Available 500 lb (227 kg)/
565 lb (256 kg) 725 lb (329 kg)

Gripper Arm Not Available + 50 lb (23 kg) Not Available + 50 lb (23 kg)
UV Light + 25 lb (12 kg) + 25 lb (12 kg) Not Available + 25 lb (12 kg)
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Environmental Requirements

Operating Environment
The environmental requirements for the JANUS G3 Automated Workstation are:

Storage Environment
The JANUS G3 Automated Workstation requires the following environmental 
conditions for storage:

Transport Environment
The JANUS G3 Automated Workstation requires the following environmental 
conditions during transport:

Temperaturea

a. Liquid DMSO freezes at 65ºF (18.5ºC) if used.

59-95ºF (15-35ºC)

Relative Humidity 15-85% at 85ºF (30ºC), non-condensing

Altitudeb

b. Contact PerkinElmer for higher altitude operation.

< 6500 ft. (2000 m)

For Indoor Use Only

Temperature -4 to 122ºF (-20 to 50ºC)
Relative Humidity 10 to 85%, non-condensing
Pressure 50 to 106 kPa

Temperature -4 to 122ºF (-20 to 50ºC)
Relative Humidity 10 to 85%, non-condensing
Pressure 50 to 106 kPa
Via air-ride truck or plane
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Electrical Ratings

The electrical ratings for the JANUS G3 Automated Workstation are:

Safety Recommendations
This section contains the following types of safety information:

• Warnings and Precautions on page 55
• Chemical and Biological Safety on page 56
• Flammable and Combustible Materials on page 57
• UV Light Safety on page 58
• Laser Safety on page 58

Rated Input Voltage, 
Frequency, and Power

Models: 
CJL4M01, CJI4M01, CJM4M01, CJL8M01, CJI8M01, CJM8M01
YJL4M01, YJI4M01, YJM4M01, YJL8M01, YJI8M01, YJM8M01

100, 120 VAC, 50-60 Hz, 525 VA
200, 230 VAC, 50-60 Hz, 525 VA

All other models:
100, 120 VAC, 50-60 Hz, 350 VA
200, 230 VAC, 50-60 Hz, 350 VA

Current 3.0 Amps at 120 VAC
1.5 Amps at 220 VAC

Fuse Rating 10 A T-250VAC at 100 to 130 VAC (5x20 mm fuse)
5 A T-250VAC at 200 to 260 VAC (5x20 mm fuse)

UV Light Input Voltage, 
Frequency (only if UV Light 
is installed)

100, 120 VAC, 50-60 Hz
200, 230 VAC, 50-60 Hz
(Power is included in system power above)

Over voltage Category II
Pollution Degree 2
Protection Class I
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Warnings and Precautions

The following general safety recommendations apply to the use of this system.

! WARNINGS
• For systems operating at voltages other than 120 VAC or 220 VAC, a 

locally-approved 3-prong plug may be required to properly power the 
system. Prevent electrical shock through the use of proper plugs and good 
earth ground connections. Proper Wiring specifications:
Live (L) - Brown Lead
Neutral (N) - Blue Lead
Earth (E) - Green/Yellow Lead

• The JANUS G3 system is very heavy. Do not attempt to move the system 
without sufficient assistance.

• Do not move the system fully assembled. Disconnect the computer, any 
accessories, and all external plumbing connections prior to moving the 
instrument.

• Use both hands when lifting or moving the system. Lift the system only 
from the bottom.

• Appliance inlet is disconnecting device. Place device or equipment in a 
manner so that disconnecting device is accessible at all times.

• Using the instrument in a manner other than that intended by the 
manufacturer can impair the instrument’s safety systems, potentially 
resulting in injury or death.

• Do not defeat the door interlock switches.

• Instrument components may move during operation. Always keep body 
parts, hair, jewelry, and clothing away from the instrument during 
operation.

• Always Pause or Stop the instrument before loading and unloading 
samples, reagents, or consumables. (Pause the instrument by clicking the 
Pause button in the software or by opening the front door of the 
instrument. Stop the instrument by clicking the Abort button in the 
software.)

• Only use consumables that are within their expiration date.

• Any serious incident that has occurred in relation to the device shall be 
reported to the manufacturer (see page 2) and the competent authority of 
the Member State in which the user is established.
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Chemical and Biological Safety

! WARNING Biological Risks

In some applications, chemicals or samples used with the JANUS G3 are 
potentially hazardous and can cause illness.

Read and understand the material safety data sheet (MSDS) provided by the 
chemical manufacturer before you store, handle, or work with any chemical or 
hazardous material.

Minimize contact with and inhalation of chemicals and chemical wastes. 

Wear appropriate personal protective equipment when handling chemicals or 
samples (e.g. safety glasses, gloves, or clothing). For additional safety guidelines 
consult the MSDS.

Handle all samples using good laboratory practices to prevent bio-hazards.

Be sure to use all standard laboratory precautions when handling used or 
contaminated disposable tips.

Do not leave chemical containers open. Use only with adequate ventilation, 
including a fume hood, if necessary.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
chemical manufacturer’s cleanup procedures as recommended on the MSDS.

Dispose of chemical or infectious waste in accordance with good laboratory 
practices and local, state/provincial, or national environmental and health 
regulations.

After emptying waste containers, seal the waste containers appropriately.

Comply with all local, state/provincial, or national laws and regulations related to 
chemical and waste storage, handling, and disposal.
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Flammable and Combustible Materials

There is a risk of fire if flammable materials are used in the fluid path. Caution is 
advised when doing so while operating this instrument. 

Before turning the power on, physically inspect the instrument fluid paths and 
verify there are no leaks.

Verify there is no interference between the instrument’s mechanical components 
and any liquid containers on the deck. 

User Precautions
When handling flammable liquids, follow these precautions: 

1. Keep all flammable liquids in covered containers when not in use.

2. When handling flammable or combustible liquids, promptly and safely dispose 
of leakage or spills.

3. Use a closed piping system, or a device drawing through the top, to transfer 
flammable or combustible liquids between vessels, containers, or portable 
tanks.

4. Transfer flammable or combustible liquids only in areas with adequate 
ventilation. Possible sources of ignition are not permitted in any areas where 
flammable vapors may travel.

5. Never transfer flammable or combustible liquids by means of air pressure on 
the container or portable tank. Doing so could exceed the maximum pressure 
rating for the container. Transferring flammable or combustible liquids by 
means of air pressure on the container could result in a flammable 
atmosphere in the container or tank. Such an atmosphere would be 
particularly sensitive to ignition due to the increased pressure.

To minimize the risk of ignition of flammable liquid or vapors, follow these 
precautions: 

1. Review the Material Safety and Data Sheet (MSDS) for the material you are 
using to understand the specific hazards involved.

2. Store flammable materials in a cool, well-ventilated area away from 
corrosives, oxidizers, and ignition sources. 

3. Label all containers and cabinets with appropriate “flammable materials” 
signs.

4. Never smoke in an area where flammable materials are used or stored. 

5. Minimize the amount of flammable materials used.

6. Use only approved containers or tanks to store flammable materials. 
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7. Ground and bond flammable material containers to prevent static charge 
buildup.

8. Dispose of flammable materials according to accepted, approved practices. 
Never pour flammable materials down a drain or sink. 

9. Dispose of empty flammable containers in an approved manner.

10. Wear appropriate personal protective equipment, such as splash aprons and 
goggles, when handling flammable liquids. 

UV Light Safety

! WARNING If the optional UV Light is installed on the JANUS G3, read the safety 
precautions below for important information on protection from ultraviolet 
radiation before operating the UV Light.

• Read the UV Light documentation that is included with the UV Light.

• Close all enclosure doors and install covers on any tip chutes, tip box 
chutes, or open deck locations before operating the UV Light via Direct 
Control or in a protocol. The enclosure panels block the shortwave UV 
radiation.

• Do not open any panel or cover while the UV Light is switched on.

• Unprotected eyes and skin can be seriously damaged by exposure to UVC 
radiation.

• Do not defeat the door interlock switches while the UV light is in operation.

• Cover any openings for tip chutes or waste chutes.

Laser Safety

If the optional barcode reader is installed, use caution when operating the barcode 
reader.

! WARNING BRIGHT LIGHT HAZARD. JANUS G3 systems may include a barcode 
reader. Read and follow the instructions and safety precautions in the 
barcode reader manual to prevent eye injury.
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Chapter 3

Protocol Tutorials
The tutorials in this chapter are intended to introduce you to the basic operation of 
the JANUS G3 system. If you are new to PerkinElmer automated liquid handling, 
this chapter will help you understand the basic steps required to create and run a 
protocol on the JANUS G3 system. You can follow the tutorials for each of the 
arms installed on the system.

This chapter includes the following procedures:
• Starting the WinPREP Software on page 59
• Preparing the Instrument for Use on page 60
• New Protocol Tutorial on page 60
• Varispan Single Liquid Transfer Tutorial on page 61
• Varispan Mother-Daughter Transfer Protocol Tutorial on page 71
• MDT Plate Expansion Protocol Tutorial on page 82
• Gripper Arm Tutorial on page 96
• MDT Serial Dilution Tutorial on page 98
• Controlling the Interior Lights on page 103
• Using the UV Light on page 104
• Running a Protocol on page 107

Follow the tutorials to understand the basic operation of the JANUS G3 system 
with the hardware options specific to the JANUS G3 system. For a more detailed 
description of creating and editing protocols, see Creating and Editing Protocols 
on page 111.

Starting the WinPREP Software
Use the WinPREP software to create and edit Protocols.

To start WinPREP:
1. Turn on the JANUS Workstation and all accessories.

2. Double-click the WinPREP for JANUS icon on the Windows desktop
OR
Select Start > All Programs > JANUS > WinPREP for JANUS on the 
Windows Start menu.
Wait for the software to start and the instrument to initialize.
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Preparing the Instrument for Use
Before running a protocol, initialize the system (select Utilities > Setup > 
Instrument > Initialize), verify the deck is calibrated, and prime the Varispan. Do 
not click or right-click in the WinPREP software while the instrument is initializing.

Calibrating the Deck
Calibrate the deck on a regular basis. PerkinElmer recommends you calibrate the 
instrument at least once a week. Closely monitor the system for calibration issues 
and recalibrate more often if necessary. For more information on calibrating the 
system, see Deck Calibration on page 285.

 Caution: The procedures in this chapter assume you have properly calibrated the 
deck for each arm on the system. If you have not calibrated the deck for 
the arms on the system, please do so before proceeding.

Priming the Varispan Pipetting Arm
You should prime the Varispan pipetting arm before each use. This is especially 
important after the instrument is idle for any length of time. Priming the system 
flushes and washes the tips and fills the liquid path with system liquid. Priming 
also helps clear the liquid path of growth, precipitates, and crystals that can form 
when liquid is stagnant. Use the Flush and Wash Tips diagnostic test to prime the 
system. For instructions, see Flush the Varispan Pipetting Arm on page 399.

New Protocol Tutorial
Each of the protocol tutorials in this section starts with a new empty protocol. Use 
this procedure to create a new protocol before starting each of the protocol 
tutorials.

To create a new protocol for the protocol tutorials:
1. Select File > New on the main menu. The Open a Protocol Template 

window opens.

2. Click the None button to create a new empty protocol (not based on an 
existing protocol). A new empty protocol opens in the Protocol Outline View.

3. Select File > Save As to save the file. The Save As window opens.

4. If necessary, navigate to the desired location. The default location is 
C:\Packard\JANUS\bin.

5. Type a unique name in the File Name text box.

6. Click the Save button. The new protocol opens in the Protocol Outline view.

Follow the desired tutorial procedures in this section to create simple protocols 
that demonstrate the functions available for each arm on the system.
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Varispan Single Liquid Transfer Tutorial
This section describes how to create a Single Liquid Transfer protocol using the 
Varispan arm. The Single Liquid procedure aspirates liquid from one source 
position per sample and dispenses liquid into one destination position on one or 
more plates, depending on the number of replicates defined. The Varispan 
protocol that is created in this section transfers 100 uL of liquid from 10 test tubes 
into 10 wells of a 96-well microplate.

This section contains the following procedures:
• Populate the Deck on page 61
• Add the Procedures to the Protocol on page 63
• Map the Labware on page 64

Populate the Deck

The Single Liquid Transfer protocol uses the labware listed below. If you are using 
different labware, make sure to select the correct labware in the Add Labware 
window.
• (1) Test Tube Rack (192 Position for 12mm tubes)
• (1) Solid Medium Support Tile
• (1) 96 Well Plate (PerkinElmer PICOPlate)
• (1) Flush/Wash Station (Washbowl and 2 troughs)

Note: This protocol uses deck locations for a Mini platform JANUS G3 with one 
deck plate. If the JANUS G3 system has multiple deck plates, you can choose 
another appropriate deck location if desired.

To populate the deck:
1. Select the Varispan icon in the upper-left corner of the instrument graphic on 

the Deck View.

2. Right-click on a clear area of the deck in the Deck View and select Add 
Labware. The Add Labware window opens.

3. Select 96 Well Plate in the Category drop-down list. The Labware, Support 
Tile, Name, and Rotation fields display default values based on the category.

4. Select 96 well PICOPlate (Packard) in the Labware drop-down list and click 
the Add Labware to Deck button. The cursor changes to indicate that you 
can place the new labware on the deck.

 Note: If you do not have any physical plates that match the labware selection, 
change the labware selection to match the physical plates you are using.
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5. Position the cursor near the middle of the left deck plate (C4 is recommended) 
and click to place the labware. The deck location should be Var-Left[C4].

6. Select Flush/Wash in the Category drop-down list on the Add Labware 
window. The Labware, Support Tile, Name, and Rotation fields display 
default values based on the category.

7. Select Washbowl + 2 Troughs in the Labware drop-down list and click the 
Add Labware to Deck button.

8. Position the cursor near the front right corner of the left deck plate (G7 is 
recommended) and click to place the labware. The deck location should be 
Var-Left[G7].

 Note: Place the Flush/Wash station near the front edge of the deck so that the 
drain tubing can reach the waste bottle.

9. Select Test Tube in the Category drop-down list on the Add Labware window. 
The Labware, Support Tile, Name, and Rotation fields display default 
values based on the category.

10. Select Rack 12mm Tube-Vial- 192 pos in the Labware drop-down list and 
click the Add Labware to Deck button.

11. Position the cursor over deck location B1 on the left deck and click to place the 
labware. The deck location should be Var-Left[B1]. Figure 3-1 shows the 
labware layout on the deck.

Figure 3-1. Labware Layout for Single Liquid Transfer

12. Close the Add Labware window.

13. See Add the Procedures to the Protocol on page 63.
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Add the Procedures to the Protocol

The Single Liquid transfer protocol requires two procedures: a Single Liquid 
procedure and a Flush/Wash procedure. The Single Liquid procedure is added to 
the protocol first as described below. The Single Liquid procedure aspirates 
100uL of liquid from each of the 10 the test tubes and dispenses 100uL of liquid 
into the first 10 wells of the microplate.

To add the Single Liquid procedure:
1. Select the End of Protocol node in the protocol outline.

2. Select Protocol > Add Procedure > Single Liquid from the menu bar or 
click the Single button on the Varispan toolbar. A Procedure Under 
Construction node is inserted in the protocol outline and the Overview tab on 
the Single Liquid Parameters window opens.

3. If desired, you can change the procedure name or procedure type in the 
Overview tab. This example uses the default values for all parameters unless 
specified.

4. Type 100 in the Dispense Volume (µL) field.

5. Select WaterWasteFT_1 ml.prf in the Performance File drop-down list (or the 
appropriate performance file for the Varispan syringe size).

6. Click OK to apply and save the parameters. The Single Liquid Parameters 
window closes and the Procedure Under Construction node is replaced with 
the Single Liquid_1 node in the protocol outline.

 Note: This example uses fixed tips on the Varispan arm. If you are using 
disposable tips, add the appropriate disposable tips to the deck view and 
then change the Tip and Performance File settings on the Overview tab 
in the Single Liquid Parameters window.

Add the Flush/Wash procedure before the Single Liquid procedure in the protocol 
outline as described below. Flushing and washing the tips before the Single Liquid 
procedure is precautionary and helps ensure the tips are clean and free from 
contamination before aspirating the first sample from the source labware. Note 
that the Single Liquid procedure includes a Flush/Wash cycle. This cycle is 
performed after the Dispense step and helps to prevent cross-contamination of 
the samples in the destination labware.

To add the Flush/Wash procedure before the Single Liquid procedure:
1. Select the Single Liquid_1 procedure node in the protocol outline.

2. Select Protocol > Add Procedure > Flush/Wash from the main menu or 
click the Flush/Wash button on the Varispan toolbar. A Procedure Under 
Construction node is inserted in the protocol outline and the Overview tab on 
the Flush/Wash Parameters window opens.
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3. Click OK to apply and save the default parameter settings. The Flush/Wash 
Parameters window closes and the Procedure Under Construction node is 
replaced with the Flush/Wash procedure in the protocol outline. Figure 3-2 
shows the current protocol.

Figure 3-2. Protocol Outline for Single Liquid Transfer

4. See Map the Labware on page 64 to specify the labware for each liquid 
handling step.

Map the Labware

In the previous steps, you populated the deck and set up and configured the 
protocol outline. However, the protocol will not run yet because the steps in the 
protocol outline are not linked with any labware. The aspiration step cannot 
aspirate liquid unless you specify the location of the liquid. The dispense step 
cannot dispense liquid unless you specify the destination labware. You must 
specify the specific labware for each protocol or step. You also need to specify 
whether to use all wells or only some of the wells in a piece of labware. Mapping 
the labware to a node lets you specify the wells in the labware that the node uses.

The node name for any unmapped node displays in bold type in the protocol 
outline to identify the nodes that require labware mapping.

Because you populated the deck with the necessary labware prior to adding 
procedures to the protocol outline, WinPREP automatically mapped some 
labware to its associated protocol outline steps. Specifically, the software mapped 
both flush and wash steps to the only flush/wash station on the deck. You do not 
need to manually map these nodes. This is possible because the flush and wash 
stations of the flush/wash labware have a single purpose. WinPREP cannot 
automatically map the aspirate and dispense nodes because, unlike the flush/
wash station, other types of labware can have multiple functions. To complete the 
protocol setup, you map the appropriate labware to the aspirate and dispense 
nodes in the protocol outline.
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To assign labware to protocol outline steps, drag the labware image from the deck 
view and drop it onto the desired node in the protocol outline to create the 
association.

To map the “source” and “destination” plates:
1. Expand the Single Liquid_1 node by clicking the plus (+) sign next to the 

node, if necessary. The node expands to display the individual aspirate and 
dispense steps in the procedure node.

2. Expand the aspirate and dispense nodes in the Transfer Group node under 
the Single Liquid_1 node. The End of Step markers display for the aspirate 
and dispense nodes as shown in Figure 3-3.

Figure 3-3. Single Liquid transfer before labware mapping

3. Click and drag the test tube rack to the Aspirate step of the Single Liquid 
procedure. WinPREP maps the test tube rack to the node and creates a Well 
Map Segment node under the Aspirate step node. The node title text changes 
from bold to regular weight. The test tube rack is outlined in red, indicating that 
it is mapped to an Aspirate step.

4. Click and drag the 96 well plate to the Dispense step of the Single Liquid 
procedure. WinPREP maps the 96 well plate to the node and creates a Well 
Map Segment node under the Dispense step node. The 96 well plate is 
outlined in blue, indicating that it is mapped to a Dispense step.

All the nodes in the protocol outline are mapped to labware on the deck. Note that 
none of the node names are in bold type, indicating that all nodes are mapped to 
labware. Figure 3-4 shows the current protocol and the mappings you assigned.
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Figure 3-4. Single Liquid transfer after labware mapping

Each type of step node has a default color. For example, Aspirate steps are red, 
dispense steps are blue, and wash steps are green. This provides an easy 
method to locate the labware mapped to a particular node. See Default Color 
Associations on page 149 for a complete list of default colors. When you select a 
node in the protocol outline, the labware mapped to that node is outlined with the 
node’s default color. The colored lines in Figure 3-4 further illustrate labware to 
node mappings.

The Single Liquid transfer protocol is nearly complete. The final step is to create 
well maps for the labware. Labware and nodes can have a many to many 
relationship, meaning each piece of labware can be mapped to multiple nodes or 
each node can use multiple pieces of labware. Well maps specify which wells in a 
plate or rack should be used by a node. This allows you to specify that certain 
wells in a plate or rack are used by one node while other wells in the plate or rack 
are used by a different node. Any piece of labware with wells requires you to 
identify the wells you want to use, either through a well map, worklist file, etc.

By default, WinPREP sets the well map to include all wells in the labware. 
However, you can use a subset of the total wells on the plate. For this reason, you 
should always set the appropriate well map for the labware used in the protocols.

To define the flush/wash well maps:
1. Expand the Pre-Single Liquid Flush/Wash node (Flush/Wash_1) by clicking 

the plus (+) sign next to the node, if necessary, to display the individual Flush 
and Wash steps.

2. Double-click the Well Map Segment node of the Flush node (see Figure 3-5) 
under the Flush/Wash_1 node.



 Chapter 3: Protocol Tutorials 67

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Figure 3-5. Flush Well Map Segment node

 The Well Map Segment Parameters window opens as shown in Figure 3-6.

Figure 3-6. Well Map Segment Parameters window for Flush node

The Well Map Segment Parameters window contains the well layout for the 
selected labware, in this case a Flush/Wash Station + 2 Troughs. The labels 
identify the wells in the layout. In this example, the right-most well is identified 
by a number one and a shaded color because the Flush/Wash station is 
mapped to the Flush step. The right-most well is the flush station. The wells in 
the labware were identified during the creation of the labware definition. 
WinPREP identified the flush station well and automatically mapped it to the 
step. You can toggle the flush station well on and off by clicking in the 
boundary of the well. Make sure the well is enabled before proceeding.

Troughs

Wash Station

Flush Station
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3. The second Flush node and the two Wash nodes are automatically mapped to 
the Flush/Wash station if the Flush/Wash station is in the Deck Layout when 
the procedures are added to the protocol.

4. Expand the Single Liquid_1 node by clicking the plus (+) sign next to the 
node, if necessary to display the Well Map Segments for the Aspirate node 
and the Dispense node.

5. Double-click the Well Map Segment node under the Aspirate node. The Well 
Map Segment Parameters window opens as shown in Figure 3-7.

Figure 3-7. Well Map Segment Parameters Window for Aspirate Node

By default, WinPREP selects all of the wells on the labware as shown in 
Figure 3-7. Each well is shaded in color and numbered by column, starting 
with the upper left corner. The color indicates the node that the labware is 
linked to; the mapping applies to the linked node only. You can link a single 
piece of labware to multiple steps in the outline and define independent well 
mappings for each.

6. Click the Clear All Wells button to deselect all the wells in the labware.
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7. Click in the upper corner of the well map, just above the top row and a little to 
the left of the first column, and drag a rectangle around the first ten wells in the 
well map. This selects the first ten wells in the left-most column, highlighting 
the wells in red and numbering the wells from top to bottom as shown in 
Figure 3-8.

Figure 3-8. Aspirate Well Map with Columns selected

The starting point for the drag operation determines the numbering order. 
Dragging up from the bottom of the selection numbers the wells from bottom 
to top.

8. Click OK to save the mapping and close the window.

9. Double-click the Well Map Segment node under the Dispense node to open 
the Well Map Segment Parameters window for the node.

As with the Aspirate step well map, WinPREP selects all wells in the well map, 
shades them in color, and numbers the wells. Because this well map applies 
to a Dispense step, the color is blue, the default color for Dispense steps.

10. Click the Clear All Wells button to deselect all the wells in the labware.

11. Drag a rectangle around the first column of eight wells in the well map, and 
then the top two wells in the second column to select ten wells, as shown in 
Figure 3-9.
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Figure 3-9. Dispense Well Map with Columns selected

12. Click OK to save the mapping and close the window.

13. Select File > Save to save the protocol.

The protocol setup is complete. The protocol transfers liquid from each of the first 
ten wells in the source test tube rack into the first ten wells in the destination 96 
well plate. The protocol pipets 100µL of liquid from the first well of the test tube 
rack, dispenses this volume into the corresponding well on the destination plate, 
and then flushes and washes the tips. This process repeats for each of the 
samples, in this case, nine more times.

To run the protocol, see Running Protocols on page 164.
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Varispan Mother-Daughter Transfer Protocol Tutorial
This section describes how to create a “Mother-Daughter” transfer using a Panel 
procedure for the Varispan arm.

The Panel procedure aspirates liquid from one source position and dispenses the 
liquid into two or more destination positions. The destination positions are usually 
in separate plates or racks, but in the same well position. Panel procedures are 
useful for pipetting from one source plate or set of source tubes into multiple 
destination plates or sets of destination tubes.

In the “Mother-Daughter” transfer example, you will create a protocol that uses the 
Varispan arm to transfer liquid from one plate (the mother) into three other plates 
(the daughters), creating three copies of the original plate.

This section contains the following procedures:

• Populate the Deck on page 61
• Add the Procedures to the Protocol on page 73
• Map the Labware on page 75

To create an MDT protocol, see MDT Plate Expansion Protocol Tutorial on 
page 82.

Populate the Deck

For the “Mother-Daughter” transfer, you populate the deck with the necessary 
labware. This example requires a total of four racks or plates and a Flush/Wash 
station. You can use any plates or racks that you choose, but the instructions that 
follow use 96 Well Plates.

To populate the deck:
1. Select the Varispan arm icon in the deck view. The deck view displays the 

calibration status for the deck.

2. Right-click on the Deck View and select Add Labware from the menu. The 
Add Labware window opens.

3. Select 96 Well Plate in the Category drop-down list. The Labware, Support 
Tile, Name, and Rotation fields update with information from the selected 
category.
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4. Select 96 well PICOPlate (Packard) in the Labware drop-down list, select 
Plate-Adapter Support Tile in the Support Tile drop-down list, type Mother in 
the Name field, and click the Add Labware to Deck button. The cursor 
changes to indicate that you can place the new labware on the deck.

 Note: If you do not have any physical plates that match the Labware selection, 
change the labware selection to match the physical plates that you are 
using.

5. Position the cursor over the desired location of the labware and click to place 
the labware. Place the mother plate near the back middle of the deck as 
shown in Figure 3-10. The exact position will vary depending on the JANUS 
G3 model you are using.

6. Repeat steps 2 through 5 three more times, naming the plates Daughter1, 
Daughter2, and Daughter3, respectively. Position the plates in the middle of 
the deck as shown in Figure 3-10.

 Note: The new protocol you created includes a Flush/Wash station (Washbowl + 
1 Trough) by default, so it is not necessary to add this item to the deck. 

Figure 3-10. Mother - Daughter Transfer Plate Positioning

 Note: The Flush/Wash station must be placed near the edge of the deck so that 
the drain tubing can reach the waste bottle.

When the deck contains the proper labware, see Add the Procedures to the 
Protocol on page 73.
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Add the Procedures to the Protocol

To set up the “Mother-Daughter” transfer, you add the necessary procedures to 
the protocol outline as described below. After you select and add the procedures 
to the protocol outline, you can modify the procedure parameters to perform the 
“Mother-Daughter” transfer. While you can manually create the protocol by 
including and defining individual steps, it is easier and more efficient to use the 
Panel procedure as the starting point. The Panel procedure provides the 
necessary functionality for the “Mother-Daughter” transfer.

To select and add the Panel procedure:
1. Select Protocol > Add Procedure > Panel from the menu bar. A Procedure 

Under Construction node is inserted into the protocol outline and the Panel 
Parameters window opens.

2. Select the Overview tab and type Mother-Daughter Transfer in the Name 
field.

3. Click the Add button in the Panel List frame twice to add two rows to the 
Panel List table. These three rows specify parameters for the three dispenses 
to the daughter plates. Figure 3-11 shows the Panel Parameters window.

Figure 3-11. Panel Parameters window for Mother-Daughter Transfer
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4. Change the Dispense Vol. (µL) field to 50 for each row in the Panel List 
table. This instructs WinPREP to transfer 50µL of sample from each mapped 
well in the mother plate to its corresponding mapped well in each of the 
daughter plates.

 Note: This example uses fixed tips on the Varispan arm. If you are using 
disposable tips, change the settings under Pipetting on the Panel 
Parameters window.

5. Click OK to apply and save the parameter settings. The Panel Parameters 
window closes and the Procedure Under Construction node is replaced with 
the Panel procedure in the protocol outline.

After adding the Panel procedure, it is a good idea to add a pre-Panel Flush/Wash 
procedure to the protocol outline. Adding this procedure before the Panel is 
precautionary and helps ensure the tips are clean and free from contamination 
before aspirating the first sample from the “mother” plate. Note that the Panel 
procedure includes a Flush/Wash cycle. This cycle is performed prior to each 
aspiration step and helps to prevent cross-contamination of the samples in the 
plates.

To add the pre-Panel Flush/Wash procedure:
1. Select the Panel procedure node. It is the node labeled Mother-Daughter 

Transfer in the protocol outline.

2. Select Protocol > Add Procedure > Flush/Wash from the main menu. A 
Procedure Under Construction node is inserted in the protocol outline and 
the Flush/Wash Parameters window opens.

3. Type Pre-Panel Flush/Wash in the Name field and click OK. The Flush/Wash 
Parameters window closes and the Procedure Under Construction node is 
replaced with the Flush/Wash procedure in the protocol outline.

The protocol outline is complete. The last step is to map the labware (see 
page 75). 
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Map the Labware

Mapping the labware associates the labware on the deck with the procedures in 
the protocol outline and specifies the wells that are used by each procedure. 
Mapping the labware specifies the source location of the liquid for the aspirate 
step, the destination location for the dispense step, and the wells to aspirate from 
or dispense to. 

The node name for any unmapped node displays in bold type in the protocol 
outline to identify the nodes that require labware mapping.

In a “Mother-Daughter” transfer, you aspirate liquid from the mother plate and 
dispense it into each of the daughter plates. To accomplish this action as 
efficiently as possible, WinPREP aspirates enough liquid to dispense into each of 
the daughter plates before returning to aspirate the next well in the mother plate.

For example, the Panel procedure will dispense 50µL into each of the three 
daughter plates. The Varispan arm aspirates 150µL from the first well in the 
mother plate and dispenses 50µL into the first well in the first daughter plate. It 
then moves to the second daughter plate and dispenses 50µL into the first well, 
and then moves to the third daughter plate and dispense the final 50µL. After 
completing the dispenses, the Varispan arm moves to the Flush/Wash station and 
cleans the tips. The cycle then starts over with the next well in the mother plate 
and continues until all the mapped wells in the mother plate have been 
transferred.

To map the mother and daughter plates:
1. Expand the Mother-Daughter Transfer node by clicking the plus (+) sign next 

to the node, if necessary. The node expands to display the individual aspirate 
and dispense steps in the procedure node.

2. Expand each of the aspirate and dispense nodes in the Transfer Group node 
under the Mother-Daughter Transfer node to display the End of Step 
markers for each of the aspirate and dispense nodes as shown in Figure 3-12.
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Figure 3-12. Mother-Daughter transfer before labware mapping

3. Click on the Mother plate on the deck and drag it to the Aspirate step of the 
Mother-Daughter Transfer procedure. WinPREP maps the Mother plate to 
the node and creates a Well Map Segment node under the Aspirate step 
node. The node title text changes from bold to regular weight. The Mother 
plate is outlined in red, indicating that it is mapped to an Aspirate step.

(See Figure 3-10 for the plate positions or hover the cursor over the plate on 
the deck view to display the labware information, as shown in Figure 3-13.)

Figure 3-13. Tooltip Information for Labware

4. Click on the Daughter1 plate on the deck and drag it to the first Dispense step 
(Dsp1) of the Mother-Daughter Transfer procedure. WinPREP maps the 
Daughter1 plate to the node and creates a Well Map Segment node under the 
Dsp1:Dispense step node. The Daughter1 plate is outlined in blue, indicating 
that it is mapped to a Dispense step.
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5. Click on the Daughter2 plate on the deck and drag it to the second Dispense 
step (Dsp2) of the Mother-Daughter Transfer procedure. WinPREP maps 
the Daughter2 plate to the node and creates a Well Map Segment node under 
the Dsp2:Dispense step node. The Daughter2 plate is outlined in blue, 
indicating that it is mapped to a Dispense step.

6. Click on the Daughter3 plate on the deck and drag it to the third Dispense 
step (Dsp3) of the Mother-Daughter Transfer procedure. WinPREP maps 
the Daughter3 plate to the node and creates a Well Map Segment node under 
the Dsp3:Dispense step node. The Daughter3 plate is outlined in blue, 
indicating that it is mapped to a Dispense step.

All the nodes in the protocol outline are mapped to labware on the deck. Note that 
none of the node names are in bold type, indicating that all the nodes are mapped 
to labware. Figure 3-14 shows the current protocol and the mappings you 
assigned. 

 Note: You do not need to map the Flush and Wash steps. WinPREP 
automatically maps these steps to the Flush/Wash Station, based on the 
labware definition for the Flush/Wash station. This only occurs when you 
populate the deck before adding the procedures to the protocol outline. 
Creating the protocol outline before you add labware to the deck view 
prevents the software from automatically mapping any labware.

Figure 3-14. Mother-Daughter transfer after labware mapping 
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Each type of step node has a default color. For example, aspirate steps are red, 
dispense steps are blue, and wash steps are green. This provides a way to easily 
identify the labware mapped to a particular step. See Default Color Associations 
on page 149 for a complete list of default colors. When you select a node in the 
protocol outline, the labware mapped to that node is outlined with the node’s 
default color. The colored lines in Figure 3-14 connect the selected node to the 
labware used by the node.

The “Mother-Daughter” Transfer protocol is nearly complete. The final step is to 
create well maps for the labware. Labware and nodes can have a many to many 
relationship, meaning each piece of labware can be mapped to multiple nodes or 
each node can use multiple pieces of labware. Well maps specify which wells in a 
plate or rack are used by a node. This allows you to specify that certain wells on a 
rack are used by one node while other wells on the rack are used by a different 
node. Any piece of labware with wells requires a well map.

By default, WinPREP sets the well map to include all wells in the labware. 
However, you will often only use a subset of the total wells on the plate. For this 
reason, you should always set the appropriate well map for the labware used in 
the protocols.

To define the well maps:
1. Expand the Pre-Panel Flush/Wash node by clicking the plus (+) sign next to 

the node, if necessary. The nodes expand to display the individual Flush and 
Wash steps in the procedure node.

2. Double-click the Well Map Segment node (see Figure 3-15) of the Flush 
node under the Pre-Panel Flush/Wash node.

Figure 3-15. Flush Well Map Segment node

 The Well Map Segment Parameters window opens as shown in Figure 3-16.
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Figure 3-16. Well Map Segment Parameters window for Flush node

This window contains the well layout for the selected labware, in this case a 
Flush/Wash Station + 1 Trough. The labels identify the wells in the layout. In 
this example, the right-most well is identified by a numeral one and a shaded 
color. This is because the Flush/Wash station is mapped to the Flush step in 
the procedure. As shown in the labware diagram, the right-most well is the 
flush station. The wells in the labware were identified during the creation of the 
labware definition. WinPREP identified the flush station well and automatically 
mapped it to the step. You can toggle the flush station well on and off by 
clicking in the boundary of the well. Make sure the well is enabled before 
proceeding.

3. Repeat the previous step for the other Flush node and the two Wash nodes. 
WinPREP automatically selects the appropriate well mappings for these 
nodes based on the labware definitions.

4. Expand the Mother-Daughter Transfer node by clicking the plus (+) sign next 
to the node, if necessary. Expand this node, and its child nodes to display the 
Well Map Segments for the aspirate node and the dispense nodes.

5. Double-click the Well Map Segment node under the aspirate node. The Well 
Map Segment Parameters window opens as shown in Figure 3-17.

Trough

Wash Station

Flush Station
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Figure 3-17. Well Map Segment Parameters window for Aspirate node

By default, WinPREP selects all wells on the labware, as shown in Figure 3-
17. Each well is shaded in color and numbered, by column, starting with the 
upper left corner. The color indicates the node that the labware is linked to; the 
mapping applies to the linked node only. You can link a single piece of labware 
to multiple steps in the outline and define independent well mappings for each.

6. Click the Clear All Wells button to deselect (clear) all the wells in the labware.

7. Click in the upper corner of the well map, slightly above the top row and 
slightly to the left of the first column, and drag a rectangle around the first four 
columns in the well map. The first four columns are selected and highlighted in 
red, and the wells are numbered from top to bottom and then left to right as 
shown in Figure 3-18.

The starting point for the drag operation determines the numbering order. 
Using the bottom right corner as the starting point would number the columns 
from bottom to top and right to left.
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Figure 3-18. Aspirate Well Map with Columns Selected

8. Click OK to save the mapping and close the window.

9. Double-click the Well Map Segment node under the first dispense node 
(Daughter1). The Well Map Segment Parameters window for the node opens 
with all wells selected in blue (Dispense) and numbered by column.

(Note that the steps below select the wells for dispensing into each plate. Only 
the wells required for the protocol will be used, so only the first 4 columns will 
contain liquid at the end of the protocol. If using the Stop Procedure action at 
End of Well Map or if not using the wells in the default order, the exact well 
map must be selected.)

10. Click the Clear All Wells button to deselect (clear) all the wells in the labware.

11. Drag a rectangle around the first four columns in the well map, just as you did 
for the aspirate step well map. The selected rows are highlighted and 
numbered.

12. Click OK to save the mapping and close the window.

13. Repeat steps 9 through 12 for the remaining two daughter plates.

14. Select File > Save to save the protocol.

The protocol setup is complete. The protocol duplicates the mother (source) plate 
into three daughter (destination) plates by individually pipetting 50µL of liquid from 
each well in the first four columns of the mother plate and dispensing this volume 
into the corresponding wells on the daughter plates.

To run the protocol in Evaluation mode (without moving the instrument) to check 
for errors, see Evaluating a Protocol on page 151.

To run the protocol, see Running Protocols on page 164.
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MDT Plate Expansion Protocol Tutorial
This section describes how to create a Plate Expansion protocol using an Expand 
Plate procedure for the MDT arm.

The Expand Plate procedure is used to separate the samples in a plate of higher 
well density to several destination plates with lower well density. Well density 
refers to the number of wells on a plate. For example, a 384-well plate has a 
higher well density than a 96-well plate. When complete, the Expand Plate 
procedure generates multiple plates, each containing a specific subset of the 
wells on the source plate.

In the Expand Plate procedure example, you will create a protocol that separates 
the samples in a 384-well plate into four 96-well plates.

This section contains the following procedures:

• Populate the Deck on page 82
• Add the Procedures to the Protocol on page 87
• Map the Labware on page 88

To create a Varispan protocol, see Varispan Single Liquid Transfer Tutorial on 
page 61 or Varispan Mother-Daughter Transfer Protocol Tutorial on page 71.

Populate the Deck

For the Expand Plate procedure, you populate the deck with the necessary 
labware as described below. This example requires a total of five racks or plates, 
a docking station, dispenser head, tip load carrier with tips, and Flush/Wash 
station. You can use any plates, racks, heads, and tips that you choose, but the 
instructions that follow use the following:

— 384-well source plate
— Four 96-well destination plates
— I200 - 96 Tip Head
— P235 - 96 Tip Box
— 1 Well Tipwash Tile

If you do not have the described labware, substitute the labware items you are 
using when setting up the labware. Also, remember that the dispenser head you 
use influences the types of tips you can select.

To populate the deck:
1. Select the MDT arm icon in the deck view. The deck view displays the 

calibration status for the deck.
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2. Right-click on the Deck View and select Add Labware from the menu. The 
Add Labware window opens.

3. Select 384 Well Plate in the Category drop-down list. The Labware, Support 
Tile, Name, and Rotation fields update with information from the selected 
category.

4. Select 384 round well (USA Scientific) in the Labware drop-down list, select 
Plate-Adapter Support Tile in the Support Tile drop-down list, type Source in 
the Name field. Figure 3-19 shows the completed Add Labware window.

Figure 3-19. Add Labware window for 384-well Source Plate

 Note: If you do not have any physical plates that match the labware selection, 
change the labware selection to match the physical plates that you are 
using.

5. Click the Add Labware to Deck button. The cursor changes to indicate that 
you can place the new labware on the deck.

6. Position the cursor over the desired location of the labware and click to place 
the labware. Place the Source plate near the back middle of the deck as 
shown in Figure 3-25 on page 86. The exact position will vary depending on 
the JANUS G3 model you are using.

7. Select 96 Well Plate in the Category drop-down list on the Add Labware 
window. The Labware, Support Tile, Name, and Rotation fields update with 
information from the selected category.

8. Select 96 Well (default) in the Labware drop-down list, select Plate-Adapter 
Support Tile in the Support Tile field, and type Target1 in the Name text box. 
Figure 3-20 shows the completed Add Labware window.
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Figure 3-20. Add Labware window for 96-well Target Plate

9. Click the Add Labware to Deck button.

10. Position the cursor over the desired location of the labware and click to place 
the labware. Place the Target1 plate near the front middle of the deck as 
shown in Figure 3-25 on page 86. 

11. Repeat steps 9 and 10 three more times, naming the plates Target2, Target3, 
and Target4, respectively. Place the four target plates together near the front 
middle of the deck.

12. Select Flush/Wash in the Category drop-down list on the Add Labware 
window. The Labware, Support Tile, Name, and Rotation fields update with 
information from the selected category.

13. Select 1 Well Tipwash Tile in the Labware drop-down list and type Flush/
Wash1 in the Name text box. Figure 3-21 shows the completed Add Labware 
window.

Figure 3-21. Add Labware window for 1-well Tip Wash

The Support Tile option is not available because the support tile is part of the 
labware itself.

14. Click the Add Labware to Deck button.

15. Position the cursor over the desired location of the labware and click to place 
the labware. Place the 1-well Tip Wash near the front of the deck as shown in 
Figure 3-25 on page 86.

16. Select Head in the Category drop-down list on the Add Labware window.
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17. Select I200 - 96 Tip Head in the Labware drop-down list, select Head-Adapter 
Right Side Support Tile in the Support Tile drop-down list, and type Head1 in 
the Name field. Figure 3-22 shows the completed Add Labware window.

Figure 3-22. Add Labware window for I200 - 96 Tip Head

The Head-Adapter Right Side Support Tile is designed for use against the 
right edge of the deck. When used along the right edge of the deck, this 
support tile minimizes the amount of deck space used by the labware. While 
you can use the support tile in other locations on the deck, you will not receive 
the space optimization benefits.

18. Click the Add Labware to Deck button.

19. Position the cursor near the back of the deck, on the right edge, and click to 
place the labware.

20. Select Tip Box in the Category drop-down list on the Add Labware window.

21. Select P235 - 96 Tip Box in the Labware drop-down list, select Plate-Adapter 
TipLoad Support Tile in the Support Tile drop-down list, and type Tip Box1 in 
the Name text box. Figure 3-23 shows the completed Add Labware window.

Figure 3-23. Add Labware window for P235 - 96 Tip Box

The Plate-Adapter TipLoad Support Tile is necessary so the MDT arm can 
automatically load tips during the procedure.

22. Click the Add Labware to Deck button.

23. Position the cursor over the desired location of the labware and click to place 
the labware. Place the tip box near the rear of the deck.

24. Select TipChute in the Category drop-down list on the Add Labware window.
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25. Select Waste Chute (coated) in the Labware drop-down list and type 
TipChute1 in the Name field. Figure 3-24 shows the completed Add Labware 
window.

Figure 3-24. Add Labware window for Waste Chute

The Support Tile option is not available because the reference pins used to 
position the waste chute on the deck are part of the labware itself, so this item 
does not use a support tile.

26. Click the Add Labware to Deck button.

27. Position the cursor over the desired location of the waste chute and click to 
place the labware. Place the waste chute at the front of the deck.

28. Position the labware on the deck similar to the layout in Figure 3-25.

Figure 3-25. Plate Expansion Labware Positioning

 Note: The Flush/Wash station must be placed near the edge of the deck so that 
the drain tubing can reach the waste bottle.

When the deck contains the proper labware, see Add the Procedures to the 
Protocol on page 87.
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Add the Procedures to the Protocol

To set up the Expand Plate protocol, you add the necessary procedures to the 
protocol outline as described below. While you can manually create the protocol 
by including and defining individual steps, it is easier and more efficient to use the 
Expand Plate procedure as the starting point. The Expand Plate MDT procedure 
includes several steps, specifically, Load Head MDT, Get Tips MDT, Aspirate 
MDT, Dispense MDT, Empty MDT, Wash MDT, and Drop Tip MDT. 

To select and add the Expand Plate procedure:
1. Select Protocol > Add Procedure > Expand Plate MDT from the menu bar 

or click the Expand button on the MDT toolbar. A Procedure Under 
Construction node is inserted into the protocol outline and the Expand Plate 
MDT Parameters window opens.

2. Select the Overview tab and type Plate Expansion in the Name text box.

3. Select the Load Head check box. Selecting this option also selects the Get 
Tips and Drop Tips check boxes as shown in Figure 3-26.

Figure 3-26. Expand Plate MDT Parameters

4. Change the Dispense Vol. (µL) field to 100. This transfers 100µL of sample 
from each mapped well in the source plate to the corresponding mapped well 
in each of the target plates.

5. Click the Tip Management tab and select the Enable check box under Empty 
as shown in Figure 3-27. If selected, the tips are emptied before the Wash 
step.

Figure 3-27. Expand Plate MDT Parameters Enable Empty

6. Select the Enable check box under Wash. If selected the tips are washed 
after each Dispense step.

7. Click OK to apply and save the parameter settings. The Expand Plate MDT 
Parameters window closes and the Procedure Under Construction node is 
replaced with the Plate Expansion procedure in the protocol outline.

To map the labware, see Map the Labware on page 88.
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Map the Labware

Mapping the labware involves associating the labware on the deck with the 
procedures in the protocol outline and specifying the wells that are used by each 
procedure. Mapping the labware specifies the source location of the liquid for the 
Aspirate step, the destination location for the Dispense step, and the wells to 
aspirate from or dispense to. 

The node name for any unmapped node displays in bold type in the protocol 
outline to identify the nodes that require labware mapping.

The Expand Plate procedure aspirates liquid from each quadrant of the 384-well 
source plate and dispenses it into one of the 96-well target plates. For example, 
the Plate Expansion procedure aspirates 100µL from the 96-wells in quadrant 1 of 
the source plate and dispenses the liquid into all 96 wells in the first target plate. 
The MDT arm moves to the Wash station and washes the tips. The MDT arm 
returns to the source plate, aspirates 100µL from the second quadrant of 96 wells, 
and dispenses the liquid into the second 96-well target plate. WinPREP then 
washes the tips, aspirates liquid from the third quadrant of 96 wells in the source 
plate, and dispenses into the third target plate. Finally, WinPREP washes the tips 
once more, aspirates the liquid from the remaining quadrant of 96 wells on the 
source plate, and dispenses the liquid into the fourth target plate. The 384 
samples contained on the source plate have been dispensed by quadrant into four 
different 96-well plates.

The steps below describe how to associate the labware on the deck with the 
appropriate steps in the protocol outline.

To map the Plate Expansion labware to the protocol outline nodes:
1. Expand the Plate Expansion node by clicking the plus (+) sign next to the 

node, if necessary, to display the individual steps in the procedure.

2. Select View > Expand All Outline Steps from the main menu to expand all of 
the nodes in the protocol outline. The End of Step markers display for each of 
the nodes as shown in Figure 3-28.



 Chapter 3: Protocol Tutorials 89

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Figure 3-28. Expand Plate procedure before labware mapping

3. Double-click the Plate Expansion procedure node in the protocol outline. The 
Expand Plate MDT Parameters window opens.

4. Select I200 - 96 Tip Head in the Dispense Head drop-down list and select 
P235 - 96 Tip Box in the Tip drop-down list as shown in Figure 3-29.

Figure 3-29. Dispenser Head and Tip settings for Expand Plate Procedure

5. Select MDT Water.prf in the Performance File drop-down list.

6. Click OK to save the parameter settings and close the Expand Plate MDT 
Parameters window.

The Plate Expansion procedure parameters provide the information the 
software needs to automatically map the labware for many of the steps in the 
protocol outline. Notice that all the nodes have mapped labware except the 
Aspirate and Dispense steps. The software cannot map these steps 
automatically because it cannot determine which labware to associate with the 
aspirate and dispense steps.

 Note: Automatic mapping only occurs when you populate the deck before 
constructing the protocol outline. Creating the protocol outline before you 
add labware to the deck view prevents the software from automatically 
mapping any labware. 
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7. Click on the Source plate on the deck and drag the Source plate to the 
Aspirate step of the Transfer Group MDT_1 procedure. WinPREP maps the 
Source plate to the node and creates a Well Map Segment node, shown in 
Figure 3-30, under the Aspirate step node. The node title text changes from 
bold to regular weight. The Source plate is outlined in red, indicating that it is 
mapped to an Aspirate step.

Figure 3-30. Well Map Segment Node for Aspirate step

(See Figure 3-25 for the plate positions or hover the cursor over a plate on the 
deck view to display the labware information as shown in Figure 3-31.)

Figure 3-31. Tooltip information for labware

8. Click on the Target1 plate on the deck and drag the Target1 plate to the 
Dispense step of the Transfer Group MDT_1 procedure. WinPREP maps the 
Target1 plate to the node and creates a Well Map Segment node under the 
Dispense MDT step node. The Target1 plate is outlined in blue, indicating 
that it is mapped to a Dispense step.

 Note: Dragging and dropping the labware onto the End of Step node for the 
Dispense step adds the Well Map Segment for the labware to the end of 
the Dispense node. This ensures the nodes are in the proper order.

9. Repeat step 8 for each of the other three target plates (Target2, Target3, and 
Target4). Be sure to drag these plates to the Dispense step in the proper 
order.

All the nodes in the protocol outline are mapped to labware on the deck. Note that 
none of the node names are in bold type, indicating that all of the nodes are 
mapped to labware. Figure 3-32 shows the current protocol and the mappings you 
assigned.
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Figure 3-32. Expand Plate Procedure after Labware Mapping

Each type of step has a default color. For example, aspirate steps are red, 
dispense steps are blue, and wash steps are green. Select a node to display the 
color coding for the labware mapped to the node. See Default Color Associations 
on page 149 for a complete list of default colors. When you select a node in the 
protocol outline, the labware mapped to that node is outlined with the node’s 
default color. Right-click a node and select Labware Used By to display colored 
lines to the labware used by the node.

The Expand Plate protocol is nearly complete. The final step is to create well 
maps for the labware. Labware and nodes can have a many to many relationship, 
meaning each piece of labware can be mapped to multiple nodes or each node 
can use multiple pieces of labware. Well maps specify which wells in a plate or 
rack are used by a node. Any piece of labware with wells requires a well map.

Unlike the Varispan arm, which allows you to select individual wells on a piece of 
labware, the MDT arm uses multiple wells on a piece of labware. The number of 
wells is determined by the pipetting head and tips The Varispan accesses 
individual wells, one by one or up to eight at a time. The MDT arm does not 
access wells individually. It simultaneously pipettes into or out of all the tips on the 
head at once. While this prevents access to individual wells and removes the 
ability to set the order the instrument accesses the wells, it provides high 
throughput pipetting and the ability to process entire plates or quadrants of plates 
in a single aspirate/dispense cycle.
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By default, WinPREP sets the well map to include all wells in the labware. For the 
automatically mapped items in the Expand Plate procedure, this is the correct, 
and desired, setting. However, the aspirate and dispense steps in the Plate 
Expansion procedure node are not automatically mapped. You must set the 
appropriate well maps for the labware in these nodes.

To define the Expand Plate procedure well maps:
1. Expand the Transfer Group MDT_1 node by clicking the plus (+) sign next to 

the node, if necessary, to display the Well Map Segments for the Aspirate 
node and the Dispense nodes.

2. Double-click the Well Map Segment node under the Aspirate node. The Well 
Map Segment Parameters window opens as shown in Figure 3-33.

Figure 3-33. Well Map Segment Parameters window for Aspirate node

Because this labware is mapped to an MDT procedure, WinPREP selects all 
wells on the labware, as shown in Figure 3-33. Each well is shaded in color 
and numbered. The color indicates the node in the protocol outline the 
labware is linked to; the mapping only applies to the linked node.
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The Plate Expansion procedure moves the liquid from a plate with a high well 
density (384-wells) to multiple plates with a lower well density (96-wells each). 
The procedure requires four 96-well plates and one 384-well plate (4 x 96 = 
384). The head currently loaded on the MDT arm contains 96 tips. To perform 
the expansion, the MDT arm will complete four aspirate and dispense steps, 
one for each of the target plates.

To transfer the liquid, the arm will aspirate from 96 wells on the source plate 
and dispense that liquid into the wells on the first target plate. It will then 
repeat the aspirate and dispense steps three additional times, once for each of 
the remaining target plates. Each aspirate operation will access 25% of the 
wells on the source plate.

To systematically access each of the samples on the source plate, the 
software segments the wells into “quadrants” and numbers each well from one 
to four. Each quadrant on the 384-well plate contains a total of 96 wells. Wells 
that contain the same number are in the same quadrant.

Figure 3-34 shows the quadrant numbering scheme.

Figure 3-34. Quadrant Numbering for 384-well Source plate

All the wells in quadrant 1 are aspirated at the same time. The same is true for 
all the wells in quadrants 2, 3, and 4. Figure 3-35 and Figure 3-36 shows the 
wells included in each of the quadrants.

Figure 3-35. Source plate wells in Quadrant 1 (left) and Quadrant 2 (right)
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Figure 3-36. Source plate wells in Quadrant 3 (left) and Quadrant 4 (right)

The default well map is ideal for this procedure because the quadrant 
numbers correspond to the numbers of the target plates (quadrant 1 goes into 
Target1, quadrant 2 goes into Target2, etc.) You can experiment with selecting 
and clearing wells on the well map, but make sure all four quadrants are 
selected as shown in Figure 3-34 before proceeding.

3. Click the Close button to save the well map and close the Map Room window. 
(If you modified the well map, the OK button replaces the Close button.)

4. Double-click the first Well Map Segment node under the Dispense node. The 
Well Map Segment Parameters window opens as shown in Figure 3-37.
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Figure 3-37. Well Map Segment Parameters window for Dispense node

This well map represents the wells for the Target1 plate. WinPREP selects all 
wells in the well map, shades them in color, and numbers them. Because this 
well map is for a Dispense step, the color is blue, which is the default color for 
dispense steps. All of the wells contain the same number because the tips on 
the dispenser head access all 96 wells at the same time.

5. Click OK to accept the default well map.

6. Verify all wells are selected for each of the three remaining Well Map Segment 
nodes. Each of the well maps are identical to the well map for Target1.

The protocol setup is complete. The protocol expands the source 384 well plate 
into four destination 96 well plates. The protocol individually pipets 100µL of liquid 
from the wells in one quadrant of the source plate and dispenses the entire 
volume into the wells on the destination plate with the same number as the 
quadrant (Quadrant 1 into Target1, Quadrant 2 into Target2, etc.).

To run the protocol in Evaluation mode (without moving the instrument) to check 
for errors, see Evaluating a Protocol on page 151.

To run the protocol, see Running Protocols on page 164.
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Gripper Arm Tutorial
Gripper arm procedures are typically added to a protocol that also includes 
pipetting procedures. This section describes the procedures used to move the 
plates. See Varispan Single Liquid Transfer Tutorial on page 61, Varispan Mother-
Daughter Transfer Protocol Tutorial on page 71, or MDT Plate Expansion Protocol 
Tutorial on page 82 for examples of pipetting protocols.

Follow the same three steps you use to set up a WinPREP pipetting protocol:

1. Populate the deck

2. Add the procedures to the protocol

3. Map the labware

Populate the Deck

WinPREP does not dynamically change the deck layout to represent labware 
movement in the protocol. You must lay out labware in all locations that will be 
accessed by the Gripper arm. For example, if a microplate will be located in 
position D10 at the start of the protocol but will be moved onto a shaker during the 
protocol, you must add a microplate at D10 AND on the shaker in the Deck View.

Add the Procedures to the Protocol

When adding a Move Plate Procedure to the protocol outline, you should modify 
the name of the procedure to include the plate type and location, for example: 
Move_Plate-96Plate D10 to shaker.

To add a Move Plate procedure to the protocol:

1. Select the step in the protocol above which you want to add the Move Plate 
procedure.

2. Select Protocol > Add Procedure > Move Plate on the main menu or click 
the Move Plate icon on the toolbar. The Move Plate Parameters window 
opens.

3. Type the desired name in the Name field. The name should indicate the plate 
that is being moved and the source and destination locations, for example 
Move_Plate-96Plate D10 to shaker.

4. To move a plate from one location to another, select both the Get Plate and 
Move/Put Plate check boxes on the Overview tab. Otherwise, select either 
check box to pick up a plate or to put down a gripped plate. (The Get and Put 
locations will be specified when you map the labware.)
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5. Click the OK button to save the parameters and close the Move/Put Plate 
Parameters window. The Move/Put Plate procedure is added to the protocol.

The pipetting arm(s) are automatically parked at a safe location when a Move 
Plate procedure is executed in a WinPREP protocol and when you open the 
Teach Position window. You do not have to add Park Arm procedures to the 
protocol.

Map the Labware

When mapping labware to the liquid handling procedures, you need to remember 
where the labware is located at that point in the protocol, so that the appropriate 
labware location can be mapped to the correct step in the procedure.

You must also map the labware to the Get Plate and Move/Put Plate steps in the 
procedure to specify where to pick up the plate and where to put down the plate. 
You can drag-and-drop on-deck labware or select from taught on-deck or off-deck 
positions.

To map the Get Plate and Move/Put Plate steps:

1. In the protocol outline, expand the Move Plate procedure by clicking the plus 
(+) sign next to the procedure node, if necessary. The node expands to display 
the Get Plate and Put Plate steps.

2. Double-click on the Get Plate step on the protocol outline. The Get Plate 
Parameters window opens.

3. Select the desired labware mapping in the Labware Source drop-down list. 
For this example, select the Use Deck View option. (For information about 
other options, see the JANUS Help.)

4. Click the OK button in the Get Plate Parameters window to save the 
parameters and close the window.

5. Click on the plate that you want to pick up in the deck view and drag the plate 
onto the Get Plate step.

6. Double-click on the Put Plate step to open the Put Plate Parameters window.

7. Select the desired labware mapping in the Labware Source drop-down list. 
For this example, select the Use Deck View option. (For information about 
other options, see the JANUS Help.

8. Click the OK button in the Put Plate Parameters window to save the 
parameters and close the window.

9. Click on the plate in the location in the deck view where you want to put the 
plate and drag the plate onto the Put Plate step.

The Get Plate and Put Plate steps in the Move Plate procedure are now mapped 
to the labware on the deck. 
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MDT Serial Dilution Tutorial
This tutorial explains the differences between creating an MDT protocol and 
creating a Serial Dilution Protocol using the MDT Serial Dilution Tools (SDT). You 
should understand how to create an MDT Protocol before referring to these 
instructions. See MDT Plate Expansion Protocol Tutorial on page 82 for a tutorial 
on using the MDT arm.

The following sections are included:

• Calibrating the Deck on page 98
• Selecting the Correct Support Tiles on page 98
• Selecting an Interchangeable Head and the Appropriate Tip Loading Pattern 

on page 100
• Mapping Patterns on page 101

Calibrating the Deck

You must calibrate the deck before you use the Serial Dilution Tool 
interchangeable heads. You cannot use any of the Serial Dilution Tool 
interchangeable heads to calibrate the deck. You need to use a convention MDT 
head to calibrate the deck. The Serial Dilution Tool interchangeable heads are not 
equipped with a full head of tips, which are needed to calibrate the deck.

Selecting the Correct Support Tiles

You need to select the correct tip box support and the correct docking station that 
is compatible with the selected Serial Dilution MDT interchangeable head. These 
items are selected when you populate the deck view. The deck view is populated 
from the Add Labware dialog. When you click on the drop-down arrow at the 
dialog's Support Tile selection a comprehensive list of available support tiles are 
displayed.

The SDT supports either a Right-Oriented Docking station (the pneumatic air line 
is located on the right side of the docking station) or a Left-Oriented Docking 
station (the pneumatic air line is located on the left side of the docking station). 
This tutorial includes instructions for using either docking station. Use the 
procedure that matches the hardware on the deck.

To add the SDT tip box support:
1. Right-click on a blank area of the deck view and select Add Labware from the 

menu. The Add Labware Window opens.

2. Select Head in the Category drop-down list.
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3. Select the SDT head you are using (I30RC - 384 Tip Head in this example) in 
the Labware drop-down list.

4. Select Plate-Adapter SDT TipLoad Support Tile in the Support Tile drop-
down list.

Figure 3-38. Add Labware for SDT Tip Box Support

5. Click the Add labware to deck button.

6. Use the cursor to position the Tip Load Support tile image on the deck view. 
Make sure that the deck view location corresponds to the support tile's 
physical location on the deck.

7. Click to place the Tip Load Support tile image on the deck layout.

8. Add the appropriate docking station, either left-oriented or right-oriented, to 
the deck layout as described below.

To add a right-oriented Docking station:
1. With the Add Labware window still open, select Head-Adapter Right Side 

SDT Support Tile in the Support Tile drop-down list.

Figure 3-39. Add Labware for SDT Right Docking Station

2. Click the Add labware to deck button.

3. Use the cursor to position the SDT Support Tile image on the deck view. Make 
sure that the deck view location corresponds to the support tile's physical 
location on the deck.

4. Click to place the SDT Support Tile image on the deck layout.
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To add a left-oriented Docking station:
1. With the Add Labware window still open, select Head-Adapter Left Side SDT 

Support Tile in the Support Tile drop-down list.

Figure 3-40. Add Labware for SDT Left Docking Station

2. Click the Add labware to deck button.

3. Use the cursor to position the SDT Support Tile image on the deck view. Make 
sure that the deck view location corresponds to the support tile's physical 
location on the deck.

4. Click to place the SDT Support Tile image on the deck layout.

Selecting an Interchangeable Head and the Appropriate Tip Loading 
Pattern

The type of interchangeable head that you choose determines the type of tip 
loading pattern available and the type of tips that are supported. (See Serial 
Dilution Tools on page 38 for detailed descriptions of each Serial Dilution Head.) 
Select the Dispenser Head, Disposable Tips, and Tip Loading Pattern in the 
Overview tab on the Serial Dilution (MDT) Parameters window.

Serial Dilution Tool, MDT P30, row and column: Supports left column or top 
row Tip Loading Pattern and is compatible with P30 and P10 disposable tips.

• Select I30RC - 384 Tip Head in the Dispenser Head drop-down list.
• Select either Left Column or Top Row in the Tip Loading Pattern drop-down 

list.

Serial Dilution Tool, MDT P235, row and column: Supports left column or top 
row Tip Loading Pattern and is compatible with P235 tips.

• Select I200RC - 96 Tip Head in the Dispenser Head drop-down list.
• Select either Left Column or Top Row in the Tip Loading Pattern drop-down 

list.
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Serial Dilution Tool, MDT P50, row: Supports top row Tip Loading Pattern and is 
compatible with P50 and P20 disposable tips.

• Select I50R - 96 Tip Head in the Dispenser Head drop-down list.
• Select Top Row in the Tip Loading Pattern drop-down list.

Serial Dilution Tool, MDT P50, column: Supports left column Tip Loading 
Pattern and is compatible with P50 and P20 disposable tips.

• Select I50C - 96 Tip Head in the Dispenser Head drop-down list.
• Select Left Column in the Tip Loading Pattern drop-down list.

Mapping Patterns

1. Double-click on the destination plate in the protocol outline to open the Well 
Map Segment Parameters window.

2. Click the Clear All Wells button to clear the wells in the labware.

3. Select the desired pattern in the Pattern drop-down list (Left Column or Top 
Row as described below).

4. Select the wells in the labware that you want to apply the pattern to. The wells 
are selected according to the Pattern as described below.

5. Click OK to save the mapping and close the window.

Left Column Well Map - When you select Left Column in the Tip Loading 
Pattern, the default map room displays a right-to-left dispensing pattern: the order 
by which the liquid will be dispensed into the destination plate as the serial dilution 
protocol progresses.

Figure 3-41 shows a 96-well plate with a right-to-left dispensing pattern. The head 
begins at the column on the right (numbered 1), and progresses to the column on 
the left (numbered 12). 
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Figure 3-41. Right-to-Left Dispensing Pattern

Top Row Well Map - When you select an interchangeable head that is suitable for 
top row tip pickup, the default map room displays a bottom-to-top dispensing 
pattern: the order by which the liquid will be dispensed into the destination plate 
as the serial dilution protocol progresses.

Figure 3-42 shows a 96-well plate with a bottom-to-top dispensing pattern. The 
head begins at the row at the bottom (numbered 1), and progresses to the row on 
the top (numbered 8).

Figure 3-42. Bottom-to-Top Dispensing Pattern
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Controlling the Interior Lights
The Interior Lights have a default state (On or Off) and a Brightness setting. These 
settings are used when a protocol is not running or if the protocol does not contain 
any commands to change the interior light setting.

To change the default Interior Light Settings:
1. On the main menu, select Utilities > Setup > Instrument > Settings.

2. Click the Integration Manager Tab.

3. Select the Interior Light row.

4. Click the Configure button. The Preview Interior Light window opens. 

5. Select the desired settings. The interior lights display at the selected settings.

6. Click OK to save the settings.

To control the interior lights in a protocol:
1. In the protocol, click the Interior Lights button on the Integration Toolbar. The 

Integration Parameters window opens with the Interior Lights integration 
selected in the Integration Name drop-down list.

2. Select the desired command (Turn On or Turn Off) in the Command drop-
down list.

3. If desired, select Runtime parameters or add a comment.

4. Click the OK button to add the command to the protocol. 

When the protocol is executed, the interior lights will turn on or off when the 
command is executed. When the protocol is complete, the interior lights will return 
to the default setting selected in the Preview Interior Light window (described 
above).
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Using the UV Light
The UV light requires that the Enclosure is installed on the system. The UV light 
does not turn on unless all of the enclosure doors are closed.

! WARNING Unprotected eyes and skin can be seriously damaged by exposure to UVC 
radiation. Do not open any doors or covers while the UV Light is on.

• Close all enclosure doors and install covers on any tip chutes, tip box 
chutes, or open deck locations before operating the UV Light via Direct 
Control or in a protocol. The enclosure panels block the shortwave UV 
radiation. 

To install the UV Light Option Software:
When the system is installed, the UV Light Option software is usually installed. If it 
is not already installed, refer to Installing and Registering Integration Devices on 
page 331 to install the software from the UV Light Option Software CD. After the 
UV Light software is installed, see Adding a Device to the Deck and Creating the 
Integration on page 333 to add the UV Light to the Integration Manager tab in the 
Instrument Settings window. Figure 3-43 shows the Integration Manager tab with 
the UV Light added. (The UV Light is not added to the Deck Layout tab.)

Figure 3-43. UV Light in Integration Manager Tab

To manually control the UV Light:
1. On the main menu, select Utilities > Setup > Instrument > Settings.

2. Click the Integration Manager Tab.

3. Select the UV Light row.

4. Click the Configure button. The UV Light Testing window opens as shown in 
Figure 3-44.
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Figure 3-44. UV Light Testing Window

5. Click the Turn On button or the Turn Off button to manually control the UV 
Light.

! WARNING Unprotected eyes and skin can be seriously damaged by exposure to UVC 
radiation. Do not open any doors or covers while the UV Light is switched 
on.

• Close all enclosure doors and install covers on any tip chutes, tip box 
chutes, or open deck locations before operating the UV Light via Direct 
Control or in a protocol. The enclosure panels block the shortwave UV 
radiation. 

6. Turn the UV light Off before closing the windows.

To control the UV light in a protocol:
1. In the protocol, click the UV Light button on the Integration Toolbar.

Figure 3-45. UV Light Button in Integration Toolbar

The Integration Parameters window opens with the UV Light integration 
selected in the Integration Name drop-down list.

2. Select the desired command (Turn On or Turn Off) in the Command drop-
down list.

Figure 3-46. UV Light, Turn Off Command



 Chapter 3: Protocol Tutorials 106

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

3. If desired, select Runtime parameters or add a comment. (Runtime 
Parameters are not generally used with the UV Light.)

4. Click the OK button to add the command to the protocol.

Timer commands can be added to the protocol to wait a specific time period 
before turning the UV Light off, if desired. Commands can also be added to move 
the arms to ensure the entire deck is exposed to the UV Light.

When the protocol is executed, the UV light will turn on or off when the command 
is executed. Make sure to turn the UV light Off at the end of the protocol.
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Running a Protocol
JANUS Application Assistant guides you through the process of selecting and 
running a protocol. Use the JANUS Application Assistant to:

1. Select a protocol.

2. Gather supplies you need to run the protocol.

3. Place the labware and reagents on the deck of the instrument.

4. Run the protocol and monitor its progress as the protocol executes.

5. Cleanup the instrument after the successful execution of the protocol.

To open JANUS Application Assistant, double-click the JANUS Application 
Assistant icon on the Windows desktop.

Step 1: Select a Protocol
1. Click the Select button

2. Select the protocol that you want to run in the Select Protocol section of the 
window:

3. Respond to the questions in the Answer Questions section of the window. 
You must respond to these questions before you move to the next step. The 
answers that you provide are used during the execution of the protocol:

4. Go to Step 2: Click the Next Step button or the Gather button:
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Step 2: Gather Supplies
1. Inspect the checklist (under the section Gather the Following Labware and 

Reagents) and collect the labware that you need to run the protocol. Click 
each labware item that you collect. All labware that is listed is required. For 
convenience, the location of a lab item or reagent may be listed.

! WARNING Only use consumables that are within their expiration date.

2. Go to Step 3. Click the Next Step button or the Place button:

Step 3: Place Labware on Deck
1. You need to populate the instrument deck with the labware items that you 

collected in Step 2. The collected labware and reagents are listed under the 
Place the Following Labware and Reagents section of the window. The 
Deck Position of each item is also listed. Click each labware item that you 
place on the deck:
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2. When you select an item in the top left section of the window (Place the 
Following Labware and Reagents) the item's placement instructions are 
displayed under the Instructions section of the window.

3. The bottom portion of the window displays a view of the entire populated deck.

4. Go to Step 4. Click the Next Step button or the Run button:

Step 4: Run the Protocol
1. Click the Start button.

2. Monitor the progress of the protocol if desired.

3. Go to Step 5. Click the Next Step button or the Cleanup button. (Note that if 
JANUS Application Assistant was started directly from WinPREP, JANUS 
Application Assistant will display a message and close so that you can 
continue protocol development.)
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Step 5: Cleanup
1. There are two sections to the Cleanup window (see Figure 3-47). The top half 

lists labware that must be removed from the deck. The bottom half of the 
window lists specific tasks that you need to perform. The first task is to clear 
the deck of labware that is listed in the top half of the screen. You may notice 
that some labware items require no action. Click the check box adjacent to 
each completed action item.

Figure 3-47. Cleanup Window

Protocol execution is now complete. Click the X button to exit JANUS Application 
Assistant.
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Chapter 4

Creating and Editing Protocols
A protocol is a sequence of commands that specifies the actions used to process 
samples. You create protocols by adding procedures or steps to perform the 
actions you want in the protocol. Use the Protocol Outline View to add, remove, 
modify, move, and copy procedures or steps in the protocol outline. Perform the 
procedures below in any order as needed to create the protocol you require.

This chapter contains the following general information:

• About Protocols on page 113
• About Procedures on page 114
• About Steps on page 116

This chapter contains the following procedures:

• Creating a New Protocol on page 116
• Setting the Protocol Outline Parameters on page 117
• Creating the Deck Layout on page 118

— Labware Positioning Considerations on page 119
— Adding Labware to the Deck View on page 123
— Selecting Labware on page 126
— Changing the Labware Name on page 126
— Editing Labware Parameters on page 127
— Moving Labware on page 127
— Duplicating Labware on page 128
— Deleting Labware on page 129
— Viewing Labware Labels on page 129
— Sizing the Deck View on page 131

• Adding Procedures to the Protocol on page 132
— Adding a Step to a Custom Procedure on page 133
— Adding a Transfer Group to a Custom Procedure on page 134
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• Editing Nodes in the Protocol on page 135
— Editing Procedure or Step Parameters on page 135
— Moving a Node on page 135
— Renaming a Node on page 136
— Copying a Node on page 136
— Copying a Node from Another Protocol on page 137
— Deleting a Node on page 138
— Undo and Redo Changes on page 138

• Mapping the Labware on page 139
— About Well Maps on page 139
— Mapping Labware to a Step on page 146
— Modifying Well Maps on page 146
— View Labware Associations on page 147
— Default Color Associations on page 149
— Creating Well Map Patterns on page 150

• Evaluating a Protocol on page 151
• Add the Protocol to a Protocol Category on page 153
• Arranging the Protocols in the JANUS Application Assistant on page 154
• Using Variables on page 155

— Ask User Variable on page 155
— Calculate Variable on page 157
— Select Variable on page 160

For step-by-step tutorials that explain how to create specific types of protocols for 
each of the major components of a system, see Protocol Tutorials on page 59.

 Caution: The procedures in this chapter assume you have properly calibrated the 
deck for each arm on the system. If you have not calibrated the deck, see 
Calibrating the System on page 285 before proceeding.
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About Protocols
Each protocol (*.mpt) begins with a Protocol Outline node and ends with an End 
of Protocol node. The nodes between the starting and ending nodes represent 
the procedures the protocol performs. Each procedure or step in the protocol 
displays a node in the protocol outline.

Nodes
The nodes in the protocol define the operations and functions to be performed by 
the protocol. Each node represents a procedure (group of steps) or an individual 
step in the protocol. Each procedure node contains a series of nodes, either 
embedded procedures or steps, that define the functions of the procedure. Each 
step node identifies an individual function and the labware used by that function. 

Each node in the Protocol Outline displays an icon to identify the type of node and 
a name that you can customize if desired. 

Procedure or Custom nodes that contain other nodes include a Branch Box to 
show or hide the child or component nodes. Each procedure node can be 
expanded to view or modify the steps in the procedure.

Double-click a procedure or step node to open the parameter window to define the 
specific settings for each procedure or step.

Branch Box
The Branch box collapses or expands a node to control the level of detail visible in 
the protocol outline. A branch box is located to the left of each node that contains 
additional nodes at the next level. Click the plus (+) or minus (-) to expand or 
collapse a node.

You can expand and collapse all of the nodes using the Expand All Outline 
Steps and Collapse All Outline Steps commands in the View menu.

Protocol Outline Node
When you create a new protocol, the new protocol automatically starts with a 
Protocol Outline node. The Protocol Outline node is always the highest 
possible (not indented) entry in any protocol outline. Figure 4-1 shows the starting 
protocol outline.

Figure 4-1. Protocol Outline of a New Protocol
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The Parameters window for the Protocol Outline node specifies parameters that 
affect the entire protocol, as opposed to an individual procedure or step. These 
global parameters include report generation and how to handle specific events 
that occur during a protocol. The comment field specifies a description of the 
protocol for future reference.

An End of Protocol Node is automatically included at the end of each protocol in 
the Protocol Outline. No parameters or other selections are available for an End of 
Protocol node.

Compatibility with MultiPROBE II Tests
MultiPROBE II (*.mdt) protocol (test) files are supported in WinPREP, including 
labware definitions,

About Procedures
Each procedure provides a unique set of operations to define a pipetting 
procedure, non-pipetting procedure, or integration procedure. A pipetting 
procedure (see page 184) contains a sequence of steps that perform a liquid 
transfer. A non-pipetting procedure (see page 188) contains a sequence of steps 
that perform other actions that do not involve liquid transfer, such as prompting 
the operator for input. An integration procedure (see page 115) contains the 
configuration and operation options for an integrated device on the system. A 
Custom procedure (see page 116) is used to add steps directly into a procedure.

The procedures in the protocol outline are usually the first level of indentation in 
the outline, but procedures can be included in another procedure as an embedded 
procedure (see page 115).

You configure to parameters for each procedure using the Procedure Parameters 
window. The online help provides a detailed description of the Parameters window 
for each procedure. Click the Help button at the bottom of a Parameters window to 
display the Online Help.

When you add a procedure to a protocol, the system adds a temporary 
Procedure Under Construction entry, as shown in Figure 4-2, to the Protocol 
Outline above the currently selected node or at the nearest logical position and 
opens the procedure Parameters window. You can accept the default parameters 
or configure the procedure, as desired. When you apply the parameters to the 
procedure by clicking the Apply button on the Parameters window, WinPREP 
replaces the Procedure Under Construction entry with the defined procedure.
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Figure 4-2. Procedure Under Construction

Adding one of the predefined procedures automatically includes the necessary 
steps in the procedure. You can modify the parameters for procedures and steps 
after adding the procedure to the protocol. You can also create Custom 
procedures and define the individual steps required for the protocol.

When you change the parameters of a predefined procedure, the system 
automatically propagates the changes through all the procedures and steps in the 
procedure. Common parameters that can affect the steps include the number of 
replicates, dispenses per aspirate, tip type, pre-aspirate mix cycles, and post-
dispense mix cycles.

Integration Procedures

Integration procedures provide you with configuration and control over an 
integrated hardware device directly from the WinPREP protocol. The options 
available depend on the device you are integrating and the control interface 
provided by the device’s manufacturer. For more information on integrations and 
the Integration Manager, see Integrating Devices on page 331.

Embedded Procedures

Embedded Procedures depend on another procedure and run as part of a parent 
procedure. In the protocol outline, an embedded procedure is indented under its 
parent procedure. Any procedure can be an embedded procedure. Embedded 
Procedures typically contain three additional fields on the Overview tab (Start 
After X Samples, Execution Mode, and Restart Every X Samples) and one 
additional field on the Runtime Parameters tab (Index Column Files By). 

Embedded Procedure Example: You can use embedded procedures to set up a 
repeating pattern between two sample types, such as unknowns and controls. If 
you want to pipette controls after every 50 samples, you would define an 
“Unknowns” Single Liquid procedure and embed a “Controls” Single Liquid 
procedure within it that executes after every 50 samples of the parent. For details 
about this example, see Embedded Controls Procedure on page 358.
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Custom Procedures

A Custom procedure allows you to add individual steps in any order to build a 
procedure that conforms to the needs of the particular application. You must add 
and define each transfer group and step in a Custom procedure. You must also 
keep track of all of the parameters that make up the procedure. The system does 
not automatically propagate parameter settings from the procedure tab to the 
dependent steps, nor does it check the validity of the procedure definition 
parameters. Finally, you must rigorously test the Custom procedures to ensure 
they perform correctly.

About Steps
Steps designate specific pipetting or arm movement operations that the 
instrument performs. In the protocol outline, a step is a node that exists in a 
procedure or transfer group. In predefined procedures, appropriate steps are 
automatically inserted in the procedure, according to the type of procedure and its 
definition. In Custom procedures, you are able to insert your own steps into the 
protocol outline. Types of steps include both pipetting and non-pipetting steps 
appropriate for the system configuration.

Every step is performed at a specific location on the deck, identified by a labware 
name and a well position in the labware. Each step is associated with a well map 
that specifies one or more well locations on a piece of labware. A labware node is 
indented under the step if the step is mapped to labware. The labware node name 
indicates the name of the mapped labware and the number of sample positions in 
the well map. Steps that use mapping information from a file or another step do 
not have a mapped labware node associated with them.

Creating a New Protocol
This procedure describes how to create a new blank protocol. After the protocol is 
created, you can use the Protocol Tutorials on page 59 to learn how to use the 
system components and accessories or use the procedures in this section to 
create your own protocol.

To create a new protocol:
1. Click File > New on the main menu. The Open a Protocol Template window 

opens.
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2. Select the template to use to create the new protocol:

— Click None to create a new, blank protocol. (Select this option if you are 
going to follow the tutorials to create a protocol.) The empty protocol 
opens.
OR

— Select the name of the protocol to use as a template and click Open. A 
new protocol containing the protocol outline and labware from the template 
opens.

3. Click File > Save As to save the new protocol. The Save As window opens.

4. Type a unique name in the File Name text box, specify the desired location, 
and click Save. Protocols must be saved in the C:\Packard\Janus\Bin folder or 
in a sub folder, and protocol path and name length is limited to 126 characters.

5. If you want to follow a tutorial to learn about creating protocols, see Protocol 
Tutorials on page 59. If you want to create a new protocol, see Setting the 
Protocol Outline Parameters on page 117.

Setting the Protocol Outline Parameters
The Protocol Outline Parameters specify report generation options for the 
protocol, the actions to take for specific events that can occur during the protocol, 
and a description of the protocol.

To set the Protocol Outline Parameters:
1. Double-click the Protocol Outline node to open the Protocol Outline 

Parameters window.

2. To add reports to the Overview tab, see Reports on page 240.

3. On the Advanced tab, specify actions to take if specific events occur during 
the protocol.

4. On the Comments tab, type any desired text to identify or describe the 
protocol. 

5. Click the OK button to save the settings and close the window or click the 
Apply button to save the settings and leave the window open.
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Creating the Deck Layout
Any labware that is on the deck when the protocol will run must be shown in the 
deck view, even if the labware is not used in the protocol. WinPREP uses the deck 
layout to define the locations for liquid handling operations. WinPREP also uses 
the deck view to determine the travel paths of the arms as the arms move across 
the deck. The travel path is optimized to speed up the protocol execution and 
minimize unnecessary arm movements. If labware is on the instrument deck but 
not shown in the deck view, WinPREP could calculate a travel path that causes 
the head or tips to contact the labware.

The procedures in this section explain how to create and edit the deck layout that 
displays in the Deck View.

• Labware Positioning Considerations on page 119
• Adding Labware to the Deck View on page 123
• Selecting Labware on page 126
• Changing the Labware Name on page 126
• Editing Labware Parameters on page 127
• Moving Labware on page 127
• Duplicating Labware on page 128
• Deleting Labware on page 129
• Viewing Labware Labels on page 129
• Sizing the Deck View on page 131
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Labware Positioning Considerations

This section provides guidelines for labware placement. Due to physical 
accessibility limitations of the labware, the arms, and some accessories, there 
may be restrictions on placing labware in certain locations. This section includes 
important information about arranging labware on the deck and helps you avoid 
common mistakes. Review this section when deciding on the location of labware 
on the deck.

• Accessible Deck Areas on page 119
• Docking Station Restrictions on page 120
• Tip Box Support Tile Restrictions on page 121
• Tip Loading Restrictions (Serial Dilution Tools only) on page 122
• Support Tile Restrictions on page 123
• Tipwash Bowl Restrictions on page 123
• Waste Chute Restrictions on page 123
• Labware Movement Restrictions on page 123

Accessible Deck Areas
Because each arm physically occupies space over the deck when the arm is 
parked, the deck areas accessible to each arm differ if there are multiple arms on 
the system. Much of the accessible areas for each arm overlap, however, there 
are also inaccessible areas for each arm. Figure 4-3 illustrates this principle for a 
system with two pipetting arms.

Figure 4-3. Deck Areas Accessible by each Arm

Both Arms

Va
ris

pa
n 

A
rm

 O
nl

y

M
D

T 
A

rm
 O

nl
y



 Chapter 4: Creating and Editing Protocols 120

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

The green area enclosed by the dashed line in Figure 4-3 shows the deck 
locations accessible by both pipetting arms on the system. Labware positioned in 
this area provides greater efficiency because the system can optimize arm 
movements during the protocol.

 Note: Each arm has its own accessible area. The green rectangle in Figure 4-3 
shows the area where the accessible areas overlap. The image also 
shows the areas where one arm can reach, but the other cannot.

The size of the accessible area depends on the arm configurations and deck size 
of the system. An arm cannot access the three columns on the opposite end of 
the deck if a second arm is installed. For example, in Figure 4-3, the MDT arm 
cannot reach the three columns immediately under the Varispan arm and the 
Varispan arm cannot reach the three columns immediately under the MDT arm. 
This situation becomes even more complex on a system with three arms.

Thorough planning and testing are the best ways to avoid issues associated with 
an unreachable deck area. Experiment with the protocol procedures and system 
configuration to familiarize yourself with the accessible and inaccessible areas of 
the deck.

Docking Station Restrictions
Always place the tip box support and tip box for the associated head immediately 
to the left of the head’s docking station as shown in Figure 4-4. This prevents the 
arm from accessing the tip box when the head is seated in the docking station. 
The head must be loaded before loading tips and this positioning ensures the 
head is never docked when attempting to load the associated tips.

Figure 4-4. Docking Station and Tip Box Support Positioning
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The recommended location for a Docking Station is the right-most column of the 
instrument in the back row of the deck to allow access to labware in the front deck 
positions. The right column imposes the fewest limitations on adjacent deck 
positions.

Do not place any labware (Tip Chute, Tipwash Bowl, microplates, etc.) to the left 
of a Docking Station that contains, or will contain, a docked head. The height of 
the docked head can restrict access to the labware or accessories.

When using the MDT gripper to move labware, ensure that all Docking Stations 
with seated heads do not obstruct the path of the MDT arm. Often, gripped 
labware will not vertically clear a docked head. Only standard height plates (14 
mm) or smaller in the MDT gripper will clear a Docking Station containing a 
docked head. Taller labware, tip boxes, etc., hang too low in the MDT gripper’s 
fingers to clear a docked head.

Tip Box Support Tile Restrictions
If the Docking Station is located on the right side of the deck as recommended, 
place the associated Tip Box Support to the immediate left of the Docking Station. 
A docked head can physically block access to other labware or accessories (tip 
chute, Tipwash bowl, microplates, etc.) located to the immediate left of a docking 
station.

If the Docking Station is located on the left side of the deck, the recommended 
position for the associated Tip Box Support depends on whether the Gripper 
option is installed. If the MDT gripper is not installed, position the Tip Box Support 
immediately to the right of the associated Docking Station. If the MDT gripper 
option is installed, the deck position immediately to the right of the docking station 
is restricted and you must position the Tip Box Support at another deck location.

Labware located beside a Tip Box Support must be less than 72 mm above the 
level of the deck. Labware located in front of a Tip Box Support must be less than 
108 mm above the level of the deck. Labware or accessories taller than 108 mm 
will interfere with the attachment of tips. Examples of taller labware include 
another Tip Box Support, Tip Chutes, Tall Support Tiles, docked heads, tall 
labware, Tipwash Bowls, etc.

Do not place a Tip Box Support behind a Docking Station that contains, or can 
contain, a docked head. The height of the docked head will interfere with the 
attachment of tips.
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Tip Loading Restrictions (Serial Dilution Tools only)
Due to the force required to load a single row or column of disposable tips, you 
must place the Tip Box Support Tile (shown in Figure 2-15) in the back row (A) of 
the JANUS G3 deck. This enables the MDT arm to exert the necessary downward 
force to load the tips properly. If you do not position the Tip Box Support Tile in row 
A, the tips may not load properly and could negatively affect the liquid transfer 
results.

When you load a column of tips, the Serial Dilution Tools head starts at the right-
most column of the tip box and progresses column by column from right to left 
until the tip box is empty. If you position the docking station to the right of the tip 
box support, as recommended, the docking station will not obstruct the head as it 
loads tips.

 Note: You should always use the WinPREP protocol to load tips for the Serial 
Dilution Tool head. Never attempt to load tips onto the SDT heads 
manually.

When you load a row of tips, the Serial Dilution Tools head starts at the bottom 
row of the tip box and progresses row by row from bottom to top until the tip box is 
empty. You can specify the rows and columns containing the tips you want to load 
by setting the Tips Well Map. This is identical to the way you set the well map for a 
microplate. Because the MDT head accesses the box from the front in these 
cases, you should keep the area of the deck in front of the tip box free from any 
labware. The height of any labware positioned in front of the Tip Load Support Tile 
must be less than 108mm.

Figure 4-5 illustrates these concepts.

Figure 4-5. Serial Dilution Row and Column Tip Loading Example
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Support Tile Restrictions
If you use an I30 Head with P10 or P30 Tips or an I50 Head with P20 Tips, put the 
target labware on a Tall Support Tile. The listed tip and head combinations cannot 
reach the bottoms of the wells when the target plate is on anything other than a 
Tall Support Tile. Tall labware in surrounding positions can also limit how deeply 
the tips reach into the wells on a plate.

You should only place Tip Boxes on supports that are shorter than the surrounding 
tiles if you intend to pipette into or out of the labware located in the adjacent 
positions.

Tipwash Bowl Restrictions
Place all Tipwash Bowls in either the front or back row to facilitate plumbing of 
wash and waste liquid lines.

Locating the Tipwash Bowl next to a Tip Load Carrier restricts how deeply the tips 
can reach into the wash bowl.

Waste Chute Restrictions
Place the Waste Chute in the front row so the chute is below the level of the deck 
by hanging over the edge of the instrument.

Labware Movement Restrictions
Due to the physical height of the docking station, gripped labware may not 
vertically clear a docked head. Only standard height plates in the Gripper will clear 
an MDT Head in a Docking Station on the deck. Tall labware, tip boxes, etc., hang 
too low in the MDT gripper to clear a docked head.

You cannot use the MDT gripper when the Pin Tool is attached to the MDT arm. 
The MDT gripper cannot grip Tip Boxes when disposable tips are attached to the 
dispense head. 

The Gripper and the MDT gripper cannot transport tip boxes with covers. Remove 
the Cover before moving a tip box with the gripper.

Adding Labware to the Deck View

The Labware in the Deck View is used by the software to properly position the 
instrument when accessing labware. Labware is categorized into categories to 
assist in selecting the desired labware when populating the deck. If the labware 
you are using is not defined, you can define new labware as described in Creating 
New Labware on page 252.
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To add labware to the deck view:
1. If desired, position the labware required for the protocol on the instrument 

deck. See Labware Positioning Considerations on page 119 for guidelines for 
certain types of labware.

2. Select the desired arm by clicking its icon in the deck view. This updates the 
deck view to show the calibration status for the selected arm.

3. Select Protocol > Add Labware from the WinPREP menu or right-click on a 
clear area of the deck in the deck view and select Add Labware from the 
shortcut menu. The Add Labware window opens as shown in Figure 4-6.

Figure 4-6. Add Labware window

 Note: The list of labware available on the Add Labware window reflects the 
content of the Labware Library. For more information on the Labware 
Library, see Labware Libraries on page 250.

4. Select the category that contains the labware you want to add in the Category 
drop-down list. The Labware field updates to include a list of all the labware 
for the selected category.

5. Select the desired labware from the Labware field. The Support Tile, Name, 
and Rotation fields update with default settings for the selected labware.

6. If the labware will be placed on a different support tile than the one listed, 
select the desired support tile in the Support Tile drop-down list. (If the 
correct support tile is not specified, the tips may be positioned too high to 
aspirate or dispense properly, or so low that the tips contact the bottom of the 
plate.)

7. If the labware will be placed in a rotated position on the deck, select the 
number of degrees (90, 180, or 270) to rotate the labware (clockwise) in the 
Rotation drop-down list. (Rotation must be specified when the labware is 
added to the deck. The labware cannot be rotated after it is placed in the deck 
view.)
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8. Click the Add Labware to Deck button and position the cursor over the 
desired location on the deck. A dashed outline of the labware indicates the 
size and shape of the labware so you can see where it will fit. The status bar in 
the lower-left corner of the WinPREP window, below the Protocol Outline 
View, displays the current deck location. The location should match the 
physical position of the labware on the deck. Hold the ALT key while placing 
labware to overlay one piece of labware on top of another.

 Note: WinPREP limits the placement of the labware to a valid, recognized 
position. Figure 4-7 shows an example of an invalid position. When the 
labware is positioned over a valid deck location, the cursor changes to an 
arrow, without the slashed circle, and you can click to place the labware.

Figure 4-7. Incorrect Labware Position

 Tip: When overlaying labware in the same deck locations, you can use the 
open location at the top of the deck view to temporarily hold stacked 
labware to map or access the labware underneath. You must place 
labware onto the deck before moving labware to the Temp location at the 
top of the deck view. If the overlaid labware items are the same visual size, 
you can redefine one of them to be slightly larger and choose a different 
color. Do not change the well-to-well positions when changing the labware 
properties. See Chapter 11: Labware Libraries on page 250 for more 
information. You can indicate in the JANUS Application Assistant Editor if 
the labware is not on the deck at the start of the protocol.

9. Click to place the labware on the deck view.

 Note: To overlay labware in the same deck location, press and hold the <Alt> 
key while placing the labware on top of an existing labware item. This 
positions both items at the same deck location.

10. Repeat these steps until all the necessary labware is on the deck.

After you place a piece of labware on the deck, you can select, move, duplicate, 
and delete it. Refer to the remainder of this chapter for instructions. 
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Selecting Labware

You must select labware in the deck view to move, copy, map, delete, or edit it. To 
select labware in the deck view, click on the labware item. A dashed outline 
around the labware indicates it is the active selection. To deselect the labware, 
click any other labware, or any unpopulated area of the deck.

To select a group of labware, use one of the methods below:

To select multiple labware items by dragging:
1. Click on an unpopulated area of the deck and drag a rectangle around the 

labware you want to select.

2. When you release the mouse button, all the labware items in the rectangle are 
selected. Each selected labware item displays a dashed outline.

 Note: You must completely enclose a piece of labware when selecting it with the 
click and drag option. Labware that is only partially enclosed in the 
rectangle is not included in the selection.

To select multiple labware items by clicking:
1. Click the first labware item you want to select.

2. Hold the <Shift> key and click each additional labware item you want to 
select. Click an item a second time to deselect it.

3. Release the <Shift> key when you have selected the desired items. Each of 
the selected labware items displays a dashed outline in the deck view. 

Use any combination of these methods to select multiple items. For example, drag 
around a group of items and then include or exclude labware by <Shift> clicking.

 Tip: Perform the drag selections first, as this operation always 
deselects any currently selected items.

Changing the Labware Name

To change the name of labware on the deck:
1. Double-click the labware you want to rename. The Labware Parameters 

window opens.

2. Type the new name in the Name text box.

3. Click OK to apply the new name and close the window.

When you hover the cursor over the labware, or enable labware labeling, 
WinPREP displays the new name for the labware item.
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Editing Labware Parameters

To edit the labware parameters:
1. Select the desired labware in the deck view.

2. Do one of the following:

— Double-click the desired labware in the deck view.
— Right-click the desired labware and click Properties from the menu.
— Highlight the desired labware in the deck view by clicking on the labware. 

Select Edit > Parameters on the main menu.
— Highlight the desired labware in the deck view by clicking on the labware. 

Press <Alt> + <Enter> on the keyboard.

3. Edit the parameters in the labware Parameters window as desired.

4. Click the Close button (or the OK button if modifications have not been 
applied), or click the X (Close) button in the upper right corner of the 
parameters window. WinPREP prompts you to save the changes if 
modifications were made but not applied and then closes the Parameters 
window.

Moving Labware

After placing labware in the deck view, you can easily reposition it to match the 
actual deck configuration or to make room for other labware. You can move 
pieces of labware individually or in groups. As described in Adding Labware to the 
Deck View on page 123, you cannot place labware in an unrecognized deck 
location.

When you move a group of labware, the same relative configuration is maintained 
between the labware in their new locations. There must be room for all of the 
labware in the new location or you will not be able to reposition the group.

Moving labware does not affect existing mapping for that labware.

To move labware by dragging:
1. Select one or more pieces of labware on the deck. For more information about 

selecting labware, see Selecting Labware on page 126.

2. Click and drag the labware icon, or one of the labware icons in the group to the 
new deck location.
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You can also move labware by changing its deck position parameters. The deck 
position parameters identify the location of the labware by its row (alphabetic) and 
column (numeric) values. These values identify the location of the reference pin, a 
metal post on the bottom of the labware or support tile, that inserts into the deck 
plating. The reference pin is the point of reference for labware sizes, orientation, 
and position. You can only use deck position parameters to move individual 
pieces of labware.

To move labware by modifying deck position parameters:
1. Double-click the desired labware. The Labware Parameters window opens 

as shown in Figure 4-8.

Figure 4-8. Labware Parameters window

2. Change the Deck and Position values in the Grid Position frame to the 
desired location for the labware.

3. Click OK to close the Labware Parameters window and reposition the 
labware.

The Deck and Position drop-down lists on the Labware Parameters window 
represent all possible deck locations for the deck configuration. By moving 
labware in this way, you can precisely position one piece of labware on top of a 
second piece of labware.

Duplicating Labware

You can duplicate labware in either of two ways. You can add multiple instances of 
the same labware using the Add Labware window. Each time you click the Add 
Labware to Deck button, you place a new instance of the selected labware on the 
deck. You can also duplicate an existing piece of labware as described below.
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To duplicate labware:
1. Hold down the <Ctrl> key and click and hold the left mouse button on the 

labware you want to copy. The cursor changes to include a plus (+) sign.

2. Drag the labware to a new deck location. A copy of the selected labware is 
placed in the new location.

The new labware will have the same parameters as the original labware except it 
will have a different name, since each piece of labware in the deck view must 
have a unique name. WinPREP creates unique names for the labware by 
appending a sequential number to the end of the labware name. For example, if 
you duplicate a labware item named 96 Well Plate1 the software assigns the 
name 96 Well Plate2 to the duplicated item. If the next sequential number is 
already in use on the deck, WinPREP assigns the next highest unused number.

Deleting Labware

If the protocol changes or you accidentally add labware that you do not need, you 
might want to remove it from the deck view. Having unnecessary or unused 
labware on the deck clutters the view and makes it more difficult to position the 
labware required for the protocol. In these cases, you should delete the unneeded 
labware.

To delete labware:
1. Select the labware you want to delete. This can be individual labware or 

groups of labware.

2. Press the Delete key on the keyboard or right-click the selected labware and 
choose the Remove Labware from deck option on the menu.

The labware graphic is removed from the deck view and any existing mappings to 
the protocol outline are deleted. Nodes that were mapped to this labware become 
unmapped and display in bold type.

 Caution: Use caution when deleting labware. The delete operation cannot be 
undone. If you mistakenly remove labware, you must re-add and re-
configure the items.

Viewing Labware Labels

Labware labels are descriptive, graphical elements that provide information about 
a piece of labware. When enabled, labware labels display the labware name, deck 
location, labware type and support type for each piece of labware in the Deck 
View. Labware labels are positioned on top of the labware by default. Reposition 
the label by dragging them to the desired location. Figure 4-9 shows the deck with 
labware labels.
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Figure 4-9. Labware label example

Labware labels help you identify labware on the deck. This is especially useful 
when documenting the protocols. You can activate labware labeling and capture 
the screen image for use in your own documentation.

To show or hide labware labels:
1. Right-click on any unpopulated area of the deck to open the shortcut menu.

2. Select Labware labels from the menu. When enabled, a check mark displays 
to the left of the menu item.

If you enabled Labware labels, any labware on the deck displays a label. If you 
disabled Labware labels, the labware on the deck no longer displays any labels.

 Note: Custom label positioning is reset, and any custom label positioning is lost, 
when you disable labware labeling.

To reposition a labware label:
1. Enable labware labeling as described in the previous section.

2. Click and drag the label to the desired location on the deck view.

The labware label is positioned in the new location. A line connects the label to the 
labware it describes.

To selectively disable labware labels:
1. Enable labware labels, if necessary, as described above.

2. Double-click the Labware label that you do not want to display. The label 
closes.
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To restore the Labware labels you selectively disabled, disable Labware labeling 
and then enable it again. This restores all Labware labels for all the labware on 
the deck.

 Note: Custom label positioning is reset, and any custom label positioning is lost, 
when you disable labware labeling.

Sizing the Deck View

You can resize the deck view to display varying levels of detail, as required. If you 
want to see the details of the mapping order on a particular piece of labware, 
zoom in (increase the zoom percentage) until you can read the necessary 
information. If you need to see the overall layout of the deck, zoom out (decrease 
the zoom percentage) so that the whole deck is represented in the view. The Size 
to Window option automatically resizes the deck view as the WinPREP main 
window is resized.

To zoom on the deck view:
1. Right-click on a clear area of the deck in the deck view to open the shortcut 

menu.

2. Select Zoom on the shortcut menu to display the available options.

3. Select the desired zoom factor. The options are described below:

4. Repeat these steps until you reach the desired zoom level.

You can also zoom to an area of the deck by holding <Ctrl>+<Shift> and clicking 
the area on the deck view. To zoom out from the area, hold <Ctrl>+<Shift> and 
right-click the on the deck view.

When you close a protocol, the deck view zoom level returns to the default value. 
The Size to Window command also returns the deck view to its default zoom 
level.

Option Result

Percentage Increases or decreases the deck view to the selected percentage 
of the actual size.

Size to Window Resizes the deck view to fit in the current WinPREP window (the 
default zoom value).

Increase/Decrease Increases or decreases the zoom of the deck view by a fixed 
value.
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Adding Procedures to the Protocol
To add a procedure to the protocol outline, specify the insertion point in the 
protocol outline and the type of procedure to insert as described below.

 Tip: If the selected location is not appropriate for a procedure, the procedure is 
placed in the closest logical location. If you insert a procedure in a position 
that you do not want, you can move it later.

To add a procedure to the protocol outline:
1. Select the node immediately below the location where you want to insert the 

new procedure. (You can select an End of Protocol node or End of 
Procedure node to place the procedure at the end of a protocol or procedure.)

2. Do one of the following:

— Select Protocol > Add Procedure on the main menu and select the 
desired procedure.

— Right-click on a clear area in the protocol outline, select Add Procedure, 
and select the desired procedure from the menu.

— Click the toolbar button for the desired procedure.
— Copy an existing procedure in the protocol outline and paste it in the 

desired location (see Copying a Node on page 136 for more information).
— Copy an existing procedure from another protocol outline and paste it into 

the current procedure (see Copying a Node from Another Protocol on 
page 137 for more information).

3. If you are inserting a procedure into another procedure, WinPREP displays a 
dialog to alert you that you are creating a child procedure. If this is your 
intention, click Yes, otherwise, click No. For more information, see Embedded 
Procedures on page 115.

4. The Procedure Parameters window opens. Make the desired selections on 
each tab. 

— On the Overview tab, type the desired name for the procedure in the 
Name text box. The name displays in the protocol outline and should allow 
you to determine the purpose of the procedure in the protocol.

— If using variables to prompt for values at runtime, select the desired 
parameters on the Runtime Parameters tab. To use variables to supply a 
value for a parameter at runtime, see Using Variables on page 155.

5. Click the OK button in the Parameters window to add the procedure to the 
protocol outline. 

6. Repeat this procedure to add all of the required procedures to the protocol.

7. See Mapping the Labware on page 139.
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Adding a Step to a Custom Procedure

To add a step to the protocol outline, you must include the step in a Custom 
procedure. This procedure describes how to add a Custom procedure and then 
how to add a step to the Custom procedure.

 Tip: If the selected location is not appropriate for the step, it is placed in the 
closest logical location. If you insert a step in an incorrect position, you can 
move it later.

To add a step to the protocol outline:
1. Select Tools > Add Procedure > Custom from the main menu. A Procedure 

Under Construction node is inserted in the protocol outline and the Custom 
Parameters window opens.

2. Click OK to accept the default parameters and close the window. A Custom 
Procedure node is inserted in the protocol outline.

3. Expand the Custom_1 procedure by clicking the plus (+) sign next to the 
node, if necessary, to display the steps in the procedure.

4. Select the End of Procedure node in the Custom_1 node.

5. Do one of the following:

— Select Protocol > Add Custom Step on the main menu and select the 
desired step from the menu.

— Right-click the Custom node in the protocol outline, select 
Add Custom Step, and select the desired step from the menu.

— Click the toolbar button corresponding to the desired step type.
— Copy an existing step in the protocol outline and paste it into the current 

location (see Copying a Node on page 136 for more information).
— Copy an existing step from another protocol outline and paste it into the 

current location (see Copying a Node from Another Protocol on page 137 
for more information).

 Note: The Add Custom Step menu is enabled only if the position selected in the 
protocol outline is in a Custom procedure.

6. Select the desired parameters in the Parameters window that opens when 
you insert the step. 

7. To use variables to supply a value for a parameter at runtime, see Using 
Variables on page 155.

8. Click the OK button in the Parameters window to add the procedure to the 
protocol outline. 

9. See Mapping the Labware on page 139.
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Adding a Transfer Group to a Custom Procedure

In a Custom procedure, you can add and define each Transfer Group individually 
as described below. Specify where to insert the new transfer group in the protocol 
outline by selecting the entry immediately below the desired location in a Custom 
procedure.

 Tip: If the location is not appropriate for a transfer group, it is placed in the 
closest logical location. If you insert a group in a position that you do not 
want, you can move it later.

To add a transfer group to a Custom procedure:
1. In a Custom procedure or a Custom MDT procedure, select the step or End of 

Procedure node immediately below the location where you want to add the 
Transfer Group.

2. Do one of the following:

— Select Protocol | Add Custom Step | Transfer Group on the main menu.
— Click the Transfer Group button on the toolbar.
— Copy an existing transfer group node already in the outline.
— Copy an existing transfer group node from another protocol outline.

3. Define the transfer group using the parameters window that opens when you 
insert the transfer group. Select the desired type of Transfer Group in the Type 
drop-down list. Type the desired name for the transfer group in the Name text 
box. Select the desired steps to include in the transfer group. Specify the 
volumes for Aspirate and Dispense as required. 

4. Double-click the Custom node to specify procedure options such as the 
number of samples, starting wells, number of times to repeat the procedure, 
pipetting options, and performance file.

5. To use variables to supply a value for a parameter at runtime, see Using 
Variables on page 155.

6. Click the OK button in the Parameters window to add the procedure to the 
protocol outline. 

7. Double-click the steps inside the Transfer Group node and select the desired 
parameters for any steps as necessary.

8. See Mapping the Labware on page 139.
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Editing Nodes in the Protocol
The nodes in the protocol can be moved, renamed, copied, and deleted after the 
protocol is created. Refer to the following procedures for instructions:

• Editing Procedure or Step Parameters on page 135
• Moving a Node on page 135
• Renaming a Node on page 136
• Copying a Node on page 136
• Copying a Node from Another Protocol on page 137
• Deleting a Node on page 138
• Undo and Redo Changes on page 138

Editing Procedure or Step Parameters

To edit the parameters for a procedure or step:

1. Select the desired node in the protocol outline.

2. Do one of the following:

— Double-click the desired node in the protocol outline.
— Right-click the desired node and click Edit Node from the menu.
— Highlight the desired node by clicking on the node. Select 

Edit > Parameters on the main menu.
— Highlight the desired node by clicking on the node. Press <Alt> + <Enter> 

on the keyboard.

3. Change the parameters as desired.

4. Click the Apply button. The changes are saved to the protocol.

5. Click the Close button to close the parameters window.

Moving a Node

If you need to reorder the steps or procedures in a protocol outline, you can move 
an entire procedure or step node to another position in the outline. All of the 
parameters and mapping information associated with the node are moved with the 
node.

To move a node:
1. Select the node you want to move.
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2. Click and drag the selected node to the desired location in the protocol outline.

 Tip: Move the cursor off the top or bottom of the Protocol Outline View to scroll 
the protocol in the desired direction.

 Note: While dragging the node, the cursor changes to a document page when it 
is over an acceptable location in the protocol outline. WinPREP only 
allows you to drop the node in an appropriate location.

Renaming a Node

A procedure or step node can be renamed in the protocol outline to easily identify 
the purpose of the node or to differentiate one node from another node.

To rename a node:
1. Click on the node that you want to rename.

2. Pause and then click the node a second time. The node name becomes 
editable. (If you click too quickly and double-click the node name, the node 
parameters window opens. You can change the name in the Overview tab on 
the parameters window and click the OK button.)

3. Type the desired name for the node.

4. Press the Enter key or click on another node to complete the name change.

Copying a Node

If you need to duplicate a step or procedure in a protocol outline, you can copy an 
existing node to another position in the outline. All of the parameters and mapping 
information are duplicated with the node, except that WinPREP assigns a unique 
name to the new node. You can change the assigned name in the procedure or 
step Parameters window.

To copy a node:
1. Select the node you want to copy.

2. Press and hold the <Ctrl> key.

3. Click and drag the node to the new location in the protocol outline.
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4. Release the <Ctrl> key after dropping the node in the desired location.

 Tip: Move the cursor off the top or bottom of the Protocol Outline View to scroll 
the protocol in that direction while dragging the node.

 Note: While dragging the node, the cursor changes to a document page with a 
plus sign when it is over an acceptable destination location in the protocol 
outline. WinPREP only allows you to drop the node in an appropriate 
location.

Copying a Node from Another Protocol

If you want to use a defined step or procedure in another protocol outline, you can 
copy an existing node from one protocol to another. All of the related parameters, 
including the currently mapped labware, are duplicated with the node. If a node 
with the name of the copied node already exists in the target protocol outline, a 
unique name is generated and applied to the copied node.

To copy a node from another protocol:
1. Open both the source and target protocols and adjust the windows so that you 

can view both protocol outlines simultaneously. Use Window > Tile Vertically 
to position the open protocol windows in the WinPREP window.

2. Select the node that you want to copy.

3. Click the node and drag it from the source protocol outline to the desired 
location in the destination protocol outline.

 Note: While dragging the node, the cursor changes to a document page with a 
plus sign when it is over an acceptable destination location in the target 
protocol outline. WinPREP only allows you to drop the node in an 
appropriate location.

 Tip: If you drop the node in the same outline where it originated, you will move 
the node rather than copy it.

 Tip: Move the cursor off the top or bottom of the Protocol Outline View to scroll 
the protocol in that direction while dragging a node.

4. When you drop the node, WinPREP copies the node in the source protocol to 
the location in the destination protocol. Any labware mapped to the node is 
also copied to the protocol if it can be positioned on the same deck location. If 
the deck location for mapped labware is already occupied, the labware is not 
copied to the destination protocol.
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Deleting a Node

If a node in the protocol outline is not needed or if you mistakenly added a node, 
you can delete it from the protocol outline. Deleting a node from the protocol 
outline only removes the node itself; it does not remove the associated labware 
from the deck.

To delete a node:
1. Select the node you want to delete.

2. Press the <Delete> key, or right-click the node and select Remove from the 
menu. WinPREP deletes the node, and any child nodes contained in the node.

 Note: If you add a procedure or transfer group to the protocol outline, you cannot 
individually delete the steps that make up the procedure or transfer group. 
You must delete the entire procedure or transfer group. Any steps added 
individually, and not part of a procedure or transfer group, can be deleted 
individually.

Undo and Redo Changes

Selecting Undo reverses the last change that you made to the protocol. Changes 
can include adding, removing, or changing procedures, steps, or labware. Redo is 
an undo for undo. It restores the changes to the protocol. WinPREP supports 
multiple levels of undo so you can easily undo the last several changes by 
repeatedly using undo.
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Mapping the Labware
Mapping is the process of associating a node with the labware used by the node; 
mapping consists of linking a step in the protocol outline to a labware item on the 
deck. You cannot start a protocol until each liquid handling step or gripper step in 
the protocol outline is mapped to at least one labware item. The names of 
unmapped procedures or steps display in bold in the protocol outline to signify 
their unmapped status.

This section contains the following information:

• About Well Maps on page 139
— Varispan Arm and Well Map Order on page 139
— MDT Arm and Well Map Order on page 141
— Serial Dilution Tools Option and Well Map Order on page 143

• Mapping Labware to a Step on page 146
• Modifying Well Maps on page 146
• Creating Well Map Patterns on page 150

About Well Maps

The Well Map defines the processing order of the individual sample positions in 
the labware. The well map for labware can include single or multiple groups of 
sample positions. Mapping the labware includes selecting the sample groups, and 
specifying the order in which to use the groups and the samples within each 
group.

The options available in a well map depends on the arm that is accessing the 
labware. The following sections describe the well map for each arm:

• Varispan Arm and Well Map Order
• MDT Arm and Well Map Order
• Serial Dilution Tools Option and Well Map Order

Varispan Arm and Well Map Order
The Varispan arm accesses wells on the labware one tip at a time. Depending on 
the labware definition, multiple tips may be able to access the labware 
simultaneously to decrease the processing time. The labware definition includes a 
default order for the wells, but you can define any desired order for the labware. 
Note that extremely complex or random mappings increase processing time 
(because the arm moves less efficiently) and are difficult to track and maintain.

The labware definition determines the default Well Map. Figure 4-10 shows the 
default Well Map for a 96-well plate mapped to a Dispense step.
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Figure 4-10. Well Map Segment Parameters Window

The Well Map Segment Parameters window provides a graphical interface to 
choose the wells to include in the Well Map. Active wells contain the color of the 
parent node and a number indicating the sequential order of the well in the well 
map segment.

Clicking individual wells toggles the well on or off. If the well is currently included 
in the map order (has a number assigned), clicking the well removes it from the 
segment and decreases all successive numbers to fill in the numbering gap. If the 
well is currently excluded from the map order, clicking the well toggles it on and 
assigns it a number one greater than the highest number in the map.

To toggle groups of contiguous wells, drag a rectangle around the desired group. 
The whole group is toggled on or off as appropriate. When groups are toggled on, 
the Pattern applies to the numbering order, starting in the corner you used to start 
the rectangle. Groups of wells are always ordered according to the currently 
selected Pattern, but different patterns can be applied to different groups if 
necessary. For more information about well map patterns, see Creating Well Map 
Patterns on page 150.) 

The Clear All Wells button clears all wells in the map and provides a clean 
starting point for the selections.
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Well Map Plate Row/Column Labeling
Row and column labels assist you in identifying the wells in the labware. Each row 
and column are displayed directly on the labware diagram. The title of the window 
displays the location of the well under the cursor. If the well is mapped, the 
pipetting sequence for that well also displays in the window title bar. This is 
especially useful when using high density plates such as 1536-well plates.

In Figure 4-11, well I12 is the 89th well to be pipetted in the procedure:

Figure 4-11. Well Map Plate Row/Column Labeling Example 1

MDT Arm and Well Map Order
The MDT arm simultaneously accesses as many wells on the labware as the 
currently loaded dispenser head supports. For example, if the dispenser head has 
96 tips and the plate has 96 wells, the MDT arm accesses the entire plate at once. 
If the dispenser head has 96 tips and the plate has 384 wells, the MDT arm 
accesses 96, or 25%, of the wells on the plate. Dispenser heads are available with 
96 or 384 tips. Plates are typically available with 96, 384, or 1536 wells. Note that 
these are all multiples of 96 (4 x 96 = 384; 16 x 96 = 1536 or 4 x 384 = 1536).

The labware definition for the plate includes a default order for the wells. The 
default order depends on the number of tips on the dispenser head. When the 
plate has a higher well density than the tips on the head, the MDT arm accesses 
the plate by quadrants. A quadrant defines a group, or subset, of wells on the 
plate. You cannot redefine which wells make up a quadrant, but you can 
customize the order in which the MDT arm accesses the quadrants.

By default, the labware definition determines the Well Map Order for the labware. 
Figure 4-12 and Figure 4-13 provide examples of the default Well Map Order for 
mapped labware.
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Figure 4-12. Well Map Segment Parameters window

The Well Map Segment Parameters window provides a graphical interface to 
choose the wells you want to include in the Well Map Order. Active wells contain 
the color of the parent node and a number indicating the sequential order of the 
well in the well map segment. Notice that the software numbers all wells that are 
accessed by the head at the same time with the same number. Figure 4-14 shows 
a 384-well plate that is accessed by a 96 tip MDT head using four quadrants

Figure 4-13. Well Map Segment Parameters with quadrants
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In this case, the software numbers the wells from one to four. These numbers 
indicate the quadrant for each well. For example, all wells numbered one are part 
of quadrant one. When accessing labware by quadrants, the MDT arm pipettes 
into or out of quadrant one first, quadrant two second, etc. You cannot add or 
remove wells from a quadrant, but you can redefine the order in which the 
software access the quadrants. Figure 4-14 shows the same plate with the 
quadrants renumbered.

Figure 4-14. Well Map Segment Parameters with renumbered quadrants

Clicking an individual well toggles the entire map, or the quadrant the well belongs 
to, on or off. 

In contrast to the Varispan arm, dragging a rectangle around a group of wells in 
the Map Room has no effect. Since standard heads loaded with a full box of 
disposable tips simultaneously access multiple wells on a plate with the MDT arm, 
you cannot select individual wells or groups of wells.

The Clear All Wells button deselects all wells in the map. Click any well to 
reselect all wells, or the quadrant the well belongs to, on the map.

Serial Dilution Tools Option and Well Map Order
The Serial Dilution Tools (SDT) are an option specifically for the MDT arm that you 
can use to access either a single row or a single column of wells on a plate. Row 
or column access depends on the dispenser head you use. Each head only 
supports specific disposable tips. For more information on the dispenser heads 
available for the Serial Dilution Tools, and the disposable tips supported, see MDT 
(Modular Dispense Technology) Pipetting Arm on page 31.

By default, the labware definition determines the Well Map Order for the labware. 
Figure 4-15 and Figure 4-16 provide examples of the default Well Map Order for 
mapped labware.



 Chapter 4: Creating and Editing Protocols 144

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Figure 4-15. SDT Tip Well Map Segment Parameters window - Column
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Figure 4-16. SDT Tip Well Map Segment Parameters window - Row

The Map Room provides a graphical interface to choose the rows or columns you 
want to include in the Well Map Order. Active wells contain the color of the parent 
node and a number indicating the sequential order of the rows or columns in the 
well map segment. Notice that the software numbers each well in the column or 
row the same because the Serial Dilution Tools head accesses all the wells in a 
row or column.

Clicking an individual well toggles the row or column the well belongs to on or off. 

The Clear All Wells button deselects all wells in the map. Clicking any well 
reselects all the wells in the row or column.
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Mapping Labware to a Step

To use the labware on the deck, you map the labware items to the individual steps 
in the protocol. WinPREP makes this an easy, drag and drop task in the deck 
view.

To map labware:
1. Expand the protocol outline as necessary to make the nodes you want to map 

visible. Labware maps to individual steps, not procedure nodes.

2. Select the labware that you want to map to the node. You can map individual 
pieces or groups of labware.

3. Click and drag the selected labware, or one of the pieces in the group onto the 
appropriate step in the outline.

4. When you drop the labware, WinPREP inserts a Well Map Segment node 
under the step. The Well Map Segment node identifies the mapped labware 
and its well map. By default, all wells in the labware are selected.

5. If you want to change the well map, see Modifying Well Maps on page 146.

The labware is mapped to the step. You can accept the default well map or you 
can modify it as needed. For more information about the well map for each type of 
pipetting arm, see About Well Maps on page 139.

Modifying Well Maps

Modifying the well map is optional if the default mapping and numbering meets 
your needs. Modifying the default well map is necessary if you do not want to 
process all of the wells in the labware or want to change the order in which the 
wells are used.

To change the Well Map:
1. Double-click the Well Map Segment node you want to modify. The Well Map 

Segment Parameters window opens (Figure 4-10). By default, all wells are 
selected and numbered.

2. Clear the wells you do not want to include in the well map segment. You can 
select each well position individually or select wells as a group.

 Note: Since the MDT arm accesses all wells on the labware at once, all wells are 
either selected or deselected. Clicking a well toggles the well map for the 
entire plate on or off.

3. Click OK. The Well Map Segment Parameters window closes.
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View Labware Associations

When you select a node in the Protocol Outline, WinPREP updates the deck 
view and identifies any labware mapped to that node. The labware mapped to the 
selected node is outlined with the color associated with the node or the step type. 

Selecting a step node highlights all the labware mapped to that node. If you select 
a transfer group or procedure node, the labware mapped to ALL of the steps in the 
group or procedure are indicated. (Notice the labware for both the Aspirate and 
Dispense steps of the transfer group are highlighted in Figure 4-17.)

Figure 4-17. Labware to Outline Node Association

 Note: The labware association colors display as a border around the labware 
and enable you to easily identify the purpose of the labware in the 
protocol. The labware color is completely customizable; you can modify 
color assignments on the Details tab of the Labware Definition window or 
in the properties window for the node.

Default colors are assigned for each of the step types, but you can change the 
color for each step as desired. For a description of default colors, including the 
steps to change the default color, see Default Color Associations on page 149.

The Default Colors method easily handles cases where there are few labware 
objects on the deck or when each piece of labware is related with one and only 
one step in the procedure. In reality, labware mappings are often much more 
complex. Fortunately, WinPREP allows you to view node to labware mappings 
based on a selected node or on selected labware.
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To view the labware associated with a node:
1. Right-click the desired node in the protocol outline.

2. Select Labware Used by Node from the menu.

WinPREP draws a line between the node and any labware mapped to that node. 
The line is color-coded to the color of the node. As described previously, selecting 
a step node identifies all the labware mapped to that step; selecting a transfer 
group or procedure node identifies the labware mapped to all the steps in the 
group or procedure. 

To view the nodes associated with labware:
1. Right-click the desired labware in the protocol outline.

2. Select Node(s) using Labware from the menu.

WinPREP draws a line between the labware and any nodes that use the labware. 
The line is color-coded to the color of the node as shown in Figure 4-18.

Figure 4-18. Labware Mapping to Outline Nodes

Each piece of labware can be mapped to several nodes. A labware object can 
contain multiple association lines, even if the matching node is off the screen or 
hidden in its collapsed parent node.
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The color of the lines corresponds to the color defined for the mapped step. This 
color is the same as the color identifying mapped wells on the labware. In Figure 
4-18 above, the default colors were used for the mapped aspiration and dispense 
steps. (Red and blue, respectively.) Note that a group of labware can be mapped 
to a single step in the outline and the labware will be used in order without having 
to stop and change the labware.

 Note: Remember, you can segment each labware into subgroups of sample 
positions and map each subgroup to separate steps with different 
functions. Some labware, such as the Flush/Wash station have multiple 
functions by the nature of their definition. In both of these cases, multiple 
lines, of different colors, can be drawn to this labware.

Default Color Associations

The default colors for each step type are shown in the table below.

You can change the colors for individual steps in the Well Map Settings window. 
In most cases, the default colors are sufficient. However, you might need change 
the default color for a step. The procedure below describes how to change the 
default color for an individual step.

To change the default color for a step:
1. Double-click the desired node in the protocol outline view to open the 

Parameters window.

Aspirate Step (red) Mix Step (violet)

Dispense Step (blue) Get Tip Step (cyan)

Diluent Step (gray) Drop Tip Step (dark cyan)

Flush Step (dark gray) Find Liquid Step (dark green)

Wash Step (green) Move To Target Step (yellow)
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2. Click the Location button in the Step frame on the Overview tab to open the 
Well Map Settings window.

3. Click the Color button, located to the right of the Map Type field, to open the 
Color window. Figure 4-19 shows the Color button.

Figure 4-19. Color Selection button

4. Click the desired color in the palette and click OK to close the Color window.

5. Click OK to apply the color change and close the Well Map Settings window.

6. Click OK to close the Step Parameters window.

The selected node mapping displays the new color.

Creating Well Map Patterns

A Well Map Pattern specifies a specific pattern of wells to select. Well Map 
Patterns are applied to the well map any time a selection is made in the Well Map 
Segment Parameters window. Well Map Patterns are typically used to map wells 
for the serial dilution tool heads, or to specify a numbering pattern that is different 
from the default, for example, to access every other well across a column.

To save a Well Map pattern:
1. Open the Well Map Segment Parameters window for the labware.

2. Define the desired pattern by selecting and deselecting the appropriate wells.

3. Click the Save As button in the Pattern frame when you are satisfied with the 
selections. The Save As window opens.

4. Navigate to the bin\ folder in the WinPREP installation folder, type a unique 
name in the File Name text box, and click Save.

WinPREP saves the pattern file and you can apply this pattern to any labware 
item. Applying the pattern to labware that differs significantly from the object used 
to define the pattern might yield unexpected results, so it is a good idea to indicate 
the labware type in the file name when saving the pattern file. This helps you 
match custom pattern files to the appropriate labware.

To apply a Well Map pattern:
1. Open the Well Map Segment Parameters window for the labware you want 

to configure with the pattern file.
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2. Click the Clear All Wells button or drag a selection around the entire well map 
to clear all the wells.

 Note: Applying the pattern file to a well map with all the wells selected produces 
the inverse of the pattern file; the wells that are selected in the pattern file 
are deselected in the well map.

3. Select the desired pattern from the Pattern drop-down list.

4. Click and drag to select the desired wells in the Map Room tab. WinPREP 
applies the pattern to the selected wells in the well map. If you do not select 
the entire well map, the WinPREP applies the portion of the pattern that 
applies to the selected region.

5. Click OK to save the well mapping and close the Well Map Segment 
Parameters window.

You can apply pattern files to the labware to quickly define common well 
mappings. This saves you the time and effort of selecting the wells individually.

Evaluating a Protocol
The Protocol Evaluation option is used to run the protocol without performing the 
liquid handling or moving the arms in the Z direction. You can choose whether to 
move the arms in the X and Y directions and whether to execute pre-step and 
post-step functions. WinPREP provides multiple levels of evaluation on the 
Protocol Options window.

WinPREP processes each of the steps in the protocol outline but does not actually 
perform the defined steps. The instrument does not move, or moves only in the X 
and Y directions, and no pipetting or labware move operations occur.

Protocol Evaluation provides a quick way to check the protocol for mistakes, such 
as nodes that map to the wrong labware, variable prompts and names, etc. The 
windows displayed when evaluating a protocol are identical to those displayed 
during protocol execution. 

To change the current Evaluation Level:

1. Select Protocol > Options on the main menu. The Protocol Options window 
opens.
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Figure 4-20. Protocol Options Window

2. Select the Display Summary After Evaluate Protocol check box if you want a 
summary of the protocol to display automatically after the protocol is 
evaluated. 

3. Select the desired Evaluation Level in the drop-down list:

— 1 - Non-Moving, Skip Pre/Post-Step Functions: The instrument's arms 
will not move as the protocol is evaluated. Any pre-step or post-step 
functions that have been included in the steps will NOT be run.

— 2 - Non-Moving, Run Pre/Post-Step Functions: The instrument's arms 
will not move as the protocol is evaluated. Any pre-step or post-step 
functions that have been included in the steps will be run.

— 3 - Moving, Run Pre/Post-Step Functions: The instrument's arms will 
move in the X and Y directions as the protocol is evaluated but not in the Z 
direction. No liquid handling will be performed. Any pre-step or post-step 
functions that have been included in the steps will be run.

4. Click the OK button to save the changes and close the Protocol Options 
window. 

To evaluate a protocol:

1. Open or select the desired protocol in WinPREP to make it the active protocol.

2. Select Run > Evaluate Protocol on the main menu.

3. Watch the protocol run, responding to any prompts as necessary. The protocol 
summary report will display at the end of the protocol if the option is selected 
in the Protocol Options window.

4. If you need to make changes to the protocol, edit the protocol (see page 135). 

5. To run the protocol from WinPREP, click the Run Protocol button and see 
Running Protocols on page 164).

6. To allow the protocol to be run directly from the JANUS Application Assistant, 
see Add the Protocol to a Protocol Category on page 153. Only protocols that 
are included in a protocol category are displayed in the Select tab in the 
JANUS Application Assistant.
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Add the Protocol to a Protocol Category
If the WinPREP protocol is going to be run in the JANUS Application Assistant, 
the protocol must be added to a protocol category. Only protocols that have been 
assigned to a protocol category are displayed in the Select tab in the JANUS 
Application Assistant.

To add a protocol to a protocol category:

1. On the WinPREP main window, select Utilities > Application Assistant 
Editor. The JANUS Application Assistant Editor window opens.

2. Click the Protocol Categories tab. All of the existing protocol categories 
display in the list. You can add the protocol to an existing protocol category or 
create a new protocol category.

3. To create a new protocol category, click the Add button. The Add Category 
window opens. 
If the desired category already exists, select the protocol category name, click 
the Edit button, and go to step 6.

4. Type the desired name for the protocol category in the Name text box.

5. Click the OK button. The Add Category window closes and the Protocol 
Categories tab displays the new protocol category.

6. Click the name of the category that you want to add the protocol to and click 
the Edit button. The Edit Category window opens and displays any protocols 
that are already included in the protocol category.

7. Click the Add button on the Edit Category window to open the Add Protocol 
window.

8. Click the Browse button and select the name of the protocol to add to the 
protocol category. (You can type the folder and name of the protocol in the text 
box if desired.)

9. If desired, type a description of the protocol in the Description text box. The 
description displays on the Select tab in the JANUS Application Assistant.

10. Click OK in the Add Protocol window.

11. Click OK in the Edit Category window.

12. Click OK in the JANUS Application Assistant Editor.
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Arranging the Protocols in the JANUS Application 
Assistant

The order of the categories listed in the Protocol Categories tab on the JANUS 
Application Assistant Editor determines the order of the protocols listed in the 
Select Tab in the JANUS Application Assistant. You can change the order of the 
categories to determine which applications display first in the JANUS Application 
Assistant.

These instructions only apply if you open the JANUS Application Assistant from 
the Windows desktop. If you open the JANUS Application Assistant from 
WinPREP, the active protocol is selected automatically and you cannot choose a 
different protocol.

1. Select Utilities > Application Assistant Editor on the WinPREP menu bar. 
The JANUS Application Assistant Editor Window opens.

2. Click the Protocol Categories tab. All of the existing protocol categories 
display in the list.

3. Select the protocol category that you want to move, and click the Move Up or 
Move Down buttons to change the order of the protocol categories.

4. Click OK to save the ordered list and close the JANUS Application Assistant 
Editor.
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Using Variables
Variables are a powerful and useful tool that provide a more flexible protocol 
platform. Variables enable the user to specify parameter values at run time, such 
as the number of samples to process or the volume of reagent to dispense. You 
can set many different parameters at runtime using variables. For a complete list 
of the parameters you can set with variables, see Tab Controls and Runtime 
Parameters on page 220.

There are three general types of variables available in WinPREP. Each of these 
variable types is described in detail in this section.

• Ask User Variable on page 155
• Calculate Variable on page 157 
• Select Variable on page 160

The following procedures are included describing specific uses for variables:

• Prompting for a File Name at Runtime on page 160
• Prompting for Labware IDs at Runtime on page 163

Ask User Variable

The Ask User variable prompts the user to specify a value for a defined variable at 
runtime. It is commonly used to request the number of samples to process during 
a protocol run. Any runtime parameter that includes the Var: Ask User option can 
be set in this way. When you set a runtime parameter to Var: Ask User, the Initial 
User Query includes a page to prompt for the value of the variable at the 
beginning of the protocol.

You can also use the Var: Ask User option to selectively process nodes in the 
protocol outline. You can define a single, comprehensive protocol to include all 
aspects of an assay and then selectively apply portions of the protocol on a run-
by-run basis. You set this option in the Runtime Parameters tab of a procedure 
node. In the Parameter column, locate the Use This Node entry and set the 
associated Gets Data From field to Var: Ask User; WinPREP creates and names a 
default variable to hold the value specified at runtime. When you set a procedure’s 
Use This Node option to Var: Ask User, WinPREP includes a page in the Initial 
User Query to prompt you for a decision to use or ignore the steps. During the run, 
the selected steps are performed and the unchecked steps are skipped.
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Using the Mother-Daughter Transfer protocol you created in Chapter 3: Protocol 
Tutorials on page 59 as an example, you can design the protocol to prompt you 
for the plates to include during the protocol run. You do this by setting the Use 
This Node options to Var: Ask User for each aspirate and dispense node on the 
Runtime Parameters tab. When you do this, the software creates and assigns a 
unique runtime variable to the Use This Node parameter for each of the plates. 
Once created, you can set certain options associated with the variables, such as 
the variable’s name, type, and default value. Clicking the Variables button on the 
Runtime Parameters tab opens the Runtime Variable Definitions window.

Figure 4-21 shows the Runtime Parameters and Runtime Variable Definitions 
windows for this configuration.

Figure 4-21. Runtime Variable Definitions
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Each Aspirate and Dispense step now has a variable associated with its Use This 
Node parameter. The system sets the Type option for each variable to Boolean. 
Boolean variables contain data that can take one of two values: on or off. You can 
also think of this as Yes or No. In this example, the Boolean type specifies which 
plates to process and which to exclude. Each variable has its Default Value field 
set to 1 or 0 (zero). In WinPREP, 1 represents on and 0 represents off. The 
Default Value field indicates the default variable value in the Questions at the start 
of the protocol. By setting a runtime variable’s value to 1 (Yes) in the questions at 
the start of the run, you instruct the software to include the plate associated with 
that variable by default. 

If the variables are set up as shown in Figure 4-21, the default values in the 
questions at the start of the run include the “mother” and “daughter1” plates and 
exclude the “daughter2” and “daughter3” plates. If the default values are not 
changed, the protocol will aspirate from the “mother” plate, dispense into the 
“daughter1” plate, and then the protocol will end. 

Calculate Variable

Use the Calculate variable to dynamically create a variable value based on other 
variable values. Typically, calculated values rely on values specified at the 
beginning of a run.

For example, consider a case where you must add reagent to wells prior to adding 
samples. However, the number of samples, and the number of replicates of each 
sample, vary between protocol runs. The number of wells depends on the number 
of samples, and its replicates, which are pipetted later in the protocol. In this case, 
the number of destinations must be calculated: the product of the number of 
samples and the number of replicates, as shown below.

number of samples x number of replicates = number of destinations

The steps below provide an example of calculated variables.

To configure a calculated variable:
1. Create a new protocol with a Reagent node and a Single Liquid Transfer node. 

The Reagent node should occur before the Single Liquid Transfer node in the 
protocol outline.

2. Set both the Number of Samples and the Replicates runtime parameters to 
Var: Ask User for the single liquid transfer. WinPREP creates two runtime 
variables, nNbrOfSamples_S1 and nReplicates_S1, to hold the values 
specified at runtime.

3. Set the Number of Destinations runtime parameter to Var: Calculate for the 
reagent node. WinPREP creates a runtime variable, nDestinations_S1, and 
an associated user function.
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4. Click the Variables button on the Reagent node’s Runtime Parameters tab. 
The Runtime Variable Definitions window opens.

5. Locate the row in the table where the variable name is nDestinations_S1. 
This is the default variable name WinPREP created for the calculated variable 
(Number of Destinations).

6. Click the Edit button in the User Function column associated with the 
variable name. The User Function Edit window opens.

7. Position the cursor immediately below the two lines in the function body that 
begin with double slashes (//). These lines are comments. You can include 
your own comments by beginning a line with double slashes.

8. Type the following line of code in the function body:
Rt_nDestinations_S1 = Rt_nNbrOfSamples_S1 * Rt_nReplicates_S1;

 Note: You can only type in the white area (body) of the user function. Be sure to 
include a semicolon (;) at the end of the calculation code; the semicolon 
identifies the end of the statement.

This statement multiplies the Number of Samples (Rt_nNbrOfSamples_S1) with 
the Replicates (Rt_nReplicates_S1) to produce the Number of Destinations 
(wells) for the procedure. These variable names represent the default names 
generated by WinPREP. The Number of Samples and Replicates variables hold 
the values specified at the start of the protocol.

 Note: In our calculation for the variable, nDestinations_S1, the Rt_ before each 
variable name identifies the variable as a “run time” variable. You can 
name the variables however you like, but it is a good idea to identify them 
in this way.

Figure 4-22 shows the completed User Function Edit window.
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Figure 4-22. Completed User Function Edit window

It is critical that you use the correct syntax (variable names, underscores, trailing 
semi-colon) and letter case (upper case and lower case letters.) If the User 
Function is not typed correctly, WinPREP will not recognize the MSL 
(MultiPROBE Scripting Language) commands.

9. Click OK to save the changes to the user function and close the User 
Function Edit window.

10. Click OK to close the Runtime Variable Definitions window.

11. Click OK to save the parameter changes and close the Reagent Parameters 
window.

At runtime, the protocol prompts you for the Number of Samples and the 
Replicates for each sample. WinPREP then uses these values to calculate the 
Number of Destinations (nDestinations_S1) requiring reagent.
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Select Variable

The Select variable allows you to reuse the value of a previously defined variable. 
It is useful in protocols that require the repeated use of a variable. For example, if 
a calculation for volume is defined, you can select the same calculation value in a 
different node later in the same protocol.

To use the Select variable:
1. Open the Parameters window for the desired step.

2. Set the parameter that should reuse a previous variable value to Var: Select.

3. Select the Runtime Parameters tab.

4. Select the variable name that contains the value you want to reuse in the File 
or Variable column for the parameter you selected above.

5. Click OK to save the changes and close the Parameters window.

Now, two nodes in the protocol use the value of a single calculated variable.

Prompting for a File Name at Runtime

To prompt for a file name at runtime:

Selecting a Procedure
1. Select the procedure that needs to use the file for deferred runtime parameter 

values.

2. Double click the procedure node to open the Procedure's parameters window.

Declaring a Variable
1. Click the Runtime Parameters tab.

2. Click the Variables button to open the Runtime Variable Definitions window.

3. Click the Add button to insert a new row into the table of variables.

4. Enter a name for a variable to specify the file name that you will be entering.

5. Make sure that the Variable Type is Text. Choose it from the drop-down list if 
necessary.

6. Enter a default value if you want to use one. This default will be used if you fail 
to enter a value at runtime.

7. Make sure that the Get Value From column indicates User Entry. Choose it 
from the drop-down list if necessary.

8. Click the OK button to save the variable declaration and return to the Runtime 
Parameters tab.
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Defining a File
1. Click the Files button to open the File Definitions window.

2. Click the Add button to insert a new row in the table of file definitions.

3. Choose the variable name declared above from the drop-down list in the File 
or Variable column.

4. Make sure that the File Type matches the format of the file (column or 
keyword) that you intend to use. Change it using the drop-down list if 
necessary.

5. For column type files, make sure that the Start Record is correctly indicated for 
the file.

6. For column type files, make sure that the Column Delimiter is correctly 
indicated for the file.

7. Click the OK button to save the file definition and return to the Runtime 
Parameters window.

Preparing the Pipetting Parameter
1. Find the pipetting parameter that you need to defer to a file identified at 

runtime. This parameter may be found on any appropriate tab in the procedure 
or on the Runtime Parameters tab.

2. From the drop-down list for the parameter (Gets Data From column on the 
Runtime Parameters tab), select the File format that will match the format of 
the intended file.

Defining the Runtime Parameter Requirements
1. Find the appropriate parameter to be defined in the Runtime Parameters list.

2. Make sure that the Gets Data From column correctly identifies the type of file 
that is going to be used.

3. In the File or Variable column, choose the defined variable name from the 
drop-down list. This is the same name that you used when you declared the 
variable earlier in this discussion.

4. If necessary, define any additional fields that are appropriate for the type of file 
that you are using.

5. Click the Apply button to implement the changes that you have made for the 
procedure.

Creating the Initial User Query Prompt
1. Double click on the Initial user Query node in the protocol outline to open the 

Initial User Query Parameters window.

2. In the middle section of the Overview tab, click the Add button to insert a page 
in the query.

3. Name the page as desired.
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4. In the lower section of the Overview tab, click the Add button to insert a 
prompt onto the new query page.

5. In the variable column, choose the defined variable name from the drop-down 
list. This is the same name that you used when you declared the variable 
earlier in this discussion from the drop-down list.

6. Enter the text that you want to appear when the prompt for this variable is 
displayed.

7. Enter the text that you want to appear in the help line of the query page when 
this variable is selected.

Creating the File Browser Window
1. Click on the button that appears in the Enter Via column of the table. This 

button will usually be labeled Edit Box (text) when you first enter it in the table.

2. Choose the File Browser tab in the window that appears.

3. Enter the desired Dialog Title for the custom File Browser window.

4. Determine the File Filters for the custom File Browser window.

5. Choose an Initial Directory for the custom File Browser window.

6. Ignore the Default Extension field for the particular application of the File 
Browser window.

7. Make sure that the Save As check box is NOT marked for the application of 
the File Browser window.

8. Click the OK button to complete the creation of the File Browser window.

Complete the Protocol Definition
1. Click the Apply button on the Initial User Query Parameters window to 

implement the changes that you have made.

2. Define any other necessary steps or procedures in the protocol outline. You 
can even choose this same file for other parameters if appropriate by 
indicating the same filename on the Runtime Parameters tab for the 
necessary parameters.

Running the Protocol
1. When you run the protocol, you will be prompted to enter or select a file that 

will contain the necessary information for the parameters that you have linked 
to it.

2. Select an appropriate file and the protocol should continue, receiving 
parameter values from the file where appropriate.
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Prompting for Labware IDs at Runtime

To have the system prompt you for the name of the labware at runtime:

Layout Labware
1. Add the labware in the Deck View. Be sure that AT LEAST every piece of 

labware that needs to be prompted for an ID is on the deck. Typically, you 
should lay out the entire Deck View to be sure that it is done.

2. Identify the labware that will require a specific labware ID.

Define Labware Parameters
1. Double-click the labware in the Deck View to open the Labware Parameters 

window for the corresponding labware.

2. Select the User Entry option under Source of ID in the Labware Parameters 
window.

3. Click the Apply button to apply the change to the labware.

4. Click the Close button to close the Labware Parameters window.

5. Repeat this procedure for EACH piece of labware in the Deck View that you 
want to specify the ID at runtime. Separate parameters are maintained for 
each piece of labware in the Deck View. This parameter is not applied to the 
type of labware.

Runtime Requirements
1. At runtime, a Labware Change Request window will display so that you can 

enter the labware ID for the indicated labware. Accept the default or enter your 
own ID for the labware.

2. Repeat this ID entry for each Labware Change Request window that 
displays. There will be a window for every labware item that you identified 
above as requiring a specific labware ID.

Labware Change Requirements
1. During the protocol, if a labware item that you identified above as requiring a 

specific labware ID requires changing due to the number of samples that are 
processed, you need to enter a new labware name every time that you are 
prompted to change the labware.
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Chapter 5

Running Protocols
The JANUS Application Assistant guides you through the entire process of 
selecting and running a protocol. Use the JANUS Application Assistant to:

1. Start the JANUS Application Assistant software (page 165)

2. Select a protocol (see page 166)

3. Gather supplies you need to run the protocol (see page 167)

4. Place the labware and reagents on the deck of the instrument (see page 167)

5. Run the protocol and monitor its progress as the protocol executes (see 
page 169)

— Monitoring the Protocol Execution on page 171
— Pausing a Protocol on page 172
— Stopping a Protocol on page 172
— Using the System Pause Button on page 173

6. Cleanup the instrument after the successful execution of the protocol (see 
page 174)

This section also includes the following information about messages during 
protocol execution and using the Direct Control window during error recovery:

• Execution Messages on page 175
— Status Messages on page 175
— Error Messages on page 177
— Direct Control on page 182

 Caution: The procedures in this chapter assume you have properly calibrated the 
deck for each arm on the system. If you have not calibrated the deck, 
please do so before proceeding. See Calibrating the System on page 285 
for more information.
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Starting JANUS Application Assistant
To open JANUS Application Assistant:

1. Double-click the JANUS Application Assistant icon on the Windows 
desktop, or open the protocol in WinPREP and then click the Run Protocol 
button on the WinPREP main window.

Figure 5-1. JANUS Application Assistant Icon and Run Protocol Button

The JANUS Application Assistant opens and displays the Select tab as shown 
in Figure 5-2.

Figure 5-2. JANUS Application Assistant

2. If you opened JANUS Application Assistant from the desktop, see Step 1: 
Select a Protocol.
If you opened JANUS Application Assistant from WinPREP, click the Gather 
tab and see Step 2: Gather Supplies.
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Step 1: Select a Protocol
If the JANUS Application Assistant software was opened using the desktop icon, 
you can select the protocol to run as described below. Only protocols that are in a 
protocol category display in the Select tab. See Add the Protocol to a Protocol 
Category on page 153 if the desired protocol is not displayed in the Select tab. If 
JANUS Application Assistant was opened using the Run Protocol button in 
WinPREP, the active protocol in WinPREP opens automatically and the protocol 
cannot be changed. See page 167 to gather the supplies for the open protocol.

1. Click the Select button.

2. Select the protocol that you want to run under Select Protocol.

3. Respond to the protocol questions under Answer Questions. You must 
respond to these questions before you move on to the next step. The answers 
that you provide are used during execution of the protocol.

4. Click the Next Step button or the Gather button and see Step 2: Gather 
Supplies.
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Step 2: Gather Supplies
1. Use the checklist under Gather the Following Labware and Reagents to 

collect the labware for the protocol. If desired, select the check box for each 
labware item that you collect. All labware that is listed is required. For 
convenience, the location of a lab item or reagent may be listed.

2. Click the Next Step button or the Place button and see Step 3: Place the 
Labware on the Deck.

Step 3: Place the Labware on the Deck
1. Place the labware listed under Place the Following Labware and Reagents 

on the instrument deck in the specified position. If desired, select the check 
box for each labware item that you place on the deck.

2. When you select an item under Place the Following Labware and 
Reagents, the item graphic and the item's placement instructions display 
under Instructions.
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The deck view at the bottom of the window displays the entire populated deck 
and highlights the labware selected in the Place the Following Labware and 
Reagents list.

3. Click the Next Step button or the Run button and see Step 4: Run the 
Protocol.
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Step 4: Run the Protocol
1. Verify that the front door is closed.

2. Click the Start button. The Status panel displays the Reset Tip Boxes tab and 
the Verify Labware Location tab.

3. If the protocol contains tip boxes, the tip boxes and the number of new and 
used tips in each tip box are listed in the Reset Tip Boxes tab as shown in 
Figure 5-3. 

Figure 5-3. Reset Tip Boxes Tab

4. Verify the correct number of new and used tips are listed for each tip box. If the 
numbers are not correct, or if you want to swap a used tip box for a new tip 
box, select the tip box and use the Fill or Empty button to set up the tips.

5. If you want to verify that the labware is placed in the correct locations, click the 
Verify Labware Locations tab as shown in Figure 5-4.

Figure 5-4. Verify Labware Location Tab
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6. If desired, select a labware item in the Verify Labware Locations tab and use 
the Go To button to move the desired arm over specified position in the 
labware. 

7. To start the run, click the OK button in the Status panel. The Progress Panel 
displays the procedures in the protocol and highlights the name of the 
procedure that is currently running.

Figure 5-5. Progress Panel

8. Monitor the progress of the protocol if desired. (see page 171).

9. If you need to pause the protocol, see Pausing a Protocol on page 172.

10. If you need to stop the protocol before the run is complete, see Stopping a 
Protocol on page 172.

11. To use the System pause button on the front of the instrument, see Using the 
System Pause Button on page 173.

12. If an error message displays, see Error Messages on page 177.

13. If JANUS Application Assistant was opened from the Windows desktop or 
Start menu, click the Next Step button or the Cleanup button when the 
protocol run completes and see Step 5: Cleanup on page 174. 

If JANUS Application Assistant was opened directly from WinPREP, a Protocol 
Complete message displays when the run completes. Click OK to return to 
WinPREP to continue with protocol development. To view the Cleanup tab, re-
open the protocol in JANUS Application Assistant and click the Cleanup 
button.
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Monitoring the Protocol Execution

When you start a protocol, the Progress panel opens and remains throughout the 
duration of the protocol. As the protocol runs, other panels might also open to 
prompt you to perform an action or to request information required by the protocol.

Other panels can open during the execution of the protocol, as well. Additional 
panels or user actions can result from defined User Message, User Query, or Bar 
Code Scan procedures in the protocol outline or if the protocol requires any 
Labware Changes for the mapped labware during the protocol. Labware changes 
are required when the system detects the pipetting operations on a piece of 
labware exceed the capacity of the labware itself. For example, if the system has 
more pipetting operations to perform on a plate and it determines that it has used 
all of the wells on the plate, it creates a labware change condition.

Any other message panels you receive most likely indicate an error during the 
execution of the protocol. Be sure to read these messages carefully so that you 
can determine the exact nature of any problems or failures you encounter.

Progress Panel
While the protocol is running, the current status of the protocol displays in the 
Progress panel. The Pause button temporarily pauses the protocol, if necessary 
(see page 172). Once paused, you can either resume execution of the protocol or 
abort the protocol execution.

Figure 5-6. Progress Panel
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Pausing a Protocol

If you click the Pause button in the JANUS Application Assistant, all the arm 
motors stop after the current step is completed. If the Varispan or MDT is 
aspirating or dispensing, the aspirate or dispense is completed.

You can safely perform actions such as adding liquids to the consumables by 
opening the front door while the system is paused.  Close the door when you are 
ready to resume the protocol.

Click the Resume button to continue the protocol execution.

Stopping a Protocol

After the protocol begins to execute, you can stop the protocol by clicking the 
Abort button in the JANUS Application Assistant: 

When you click the Abort button, a message displays to verify that you want to 
abort the protocol.

If you click Yes, the system disables all motors and a message displays to 
indicate that JANUS  Application Assistant will close. Click the OK button.

 Note: If there are disposable tips on the Varispan, you MUST manually remove 
the disposable tips after aborting a protocol.

If you click No, the protocol will continue execution.



 Chapter 5: Running Protocols 173

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Using the System Pause Button

Figure 5-7. System Pause Button

If you need to stop the system any time during the execution of a protocol, you 
can press the red System Pause button on the front of the instrument. If possible, 
press the software Pause button to pause the system before opening the door if 
you plan to resume the protocol execution. The system actions depend on which 
action is taking place when the System Pause button is pressed.

Pressing the System Pause button during an arm movement immediately 
disables the X, Y, and Z arm motors and displays a warning message in the 
software.

 Note: If the System Pause button is pressed while an arm is moving in the X 
direction, the arm may continue to glide, without power, in the direction it 
was moving.

• Pressing the System Pause button during a syringe pump motion will 
finish the aspirate or dispense before stopping.

 Note: Pressing the System Pause button during an aspirate when the Varispan 
is following the liquid level stops the liquid tracking motion but not the 
pump motion. You may receive a Tracking error in these cases, and the 
system may aspirate air.

• Pressing the System Pause button during an MDT Aspirate or Dispense 
step will stop the aspirate or dispense immediately.

 Note: The MDT aspirate or dispense stops immediately, even if the aspirate or 
dispense is not complete. Continuing the protocol may result in dispense 
errors or aspirating liquid into the head. Use Direct Control to empty the 
MDT in an appropriate location before restarting the protocol.

When the system has completely stopped, the Status panel displays buttons to 
Abort, Continue, or to open the Direct Control window as shown in Figure 5-8.

! WARNING Do not access the inside of the instrument until the Status panel displays 
the System Pause message as shown in Figure 5-8.

If you continue the protocol, you may receive a second message indicating a 
Horizontal Motion error or Vertical Motion error if the arm was moving when the 
system was paused.
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Figure 5-8. System Pause Button Pressed or Door Opened

Step 5: Cleanup
There are two sections to the Cleanup window (below). The top half lists labware 
that must be removed from the deck. The bottom half of the window lists specific 
tasks that you need to perform. 

1. Remove the labware that is listed in the top half of the window from the 
instrument deck. (Some labware items require no action.) If desired, select the 
check box next to each labware item as it is removed.

2. Complete each cleanup activity listed at the bottom of the window. If desired, 
select the check box as each cleanup activity is completed:

This completes the protocol execution. Click the X button to close JANUS 
Application Assistant.
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Execution Messages
This section describes messages that can display during operation. Messages are 
grouped into two general categories: Status Messages and Error Messages. The 
sections below describe each type in detail.

Status Messages

This section describes the status messages and user prompts that may display as 
you operate the instrument. Status messages provide information about the 
current run or request input necessary to complete the protocol.

• Labware Change Request Panel on page 175
• Reset Tip Boxes Tab on page 175
• Sample List Processing Results Panel on page 176
• Verify Labware Location Panel on page 176

Labware Change Request Panel
This panel displays when you need to change a piece of labware on the deck, 
such as when all of the mapped positions in the current piece of labware have 
been used, but the protocol has not yet completed. Configuring the protocol to 
stop and prompt you for a labware change displays this panel. Double-click the 
Protocol Outline node to open the Protocol Outline Parameters window, click 
the Advanced tab, and select Stop and Display Message under On Assembly 
Change.

Figure 5-9. Labware Change Request Panel

Reset Tip Boxes Tab
When you click Reset Tip Boxes you can fill the disposable tip boxes on the deck 
and then reset the system counters for each box.

The system tracks the number of tips used from each tip box on the deck and 
monitors the tip quantity based on the location of the tip in the tip box. In this way, 
you do not always have to start with a full box of tips for a protocol; a protocol can 
use the tips remaining from a previous protocol run and can even prompt you for 
an assembly change when the tip boxes are empty.
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The Reset Tip Boxes tab, shown in Figure 5-10, includes a list of the tip boxes on 
the deck. You can select a tip box from the list, replace the box with a full set of 
tips, and reset its counter to full. You can also set a box’s counter to empty if you 
are using it to dispose of used tips. You can also use this panel to move the 
pipetting arm over the selected tip box to ensure you are resetting the correct box.

Figure 5-10. Reset Tip Boxes Tab

Sample List Processing Results Panel
This panel detects and tracks problems between sample list files and scanned bar 
codes. There are two problem situations: missing tubes and excess tubes. The 
missing tubes issue occurs when the provided sample list files contain more 
sample IDs than are read during the bar code scan. The Excess tubes issue 
occurs when bar code scans read sample IDs that do not exist in the sample list 
files. In either of these situations, WinPREP displays the Sample List 
Processing Results panel.

To correct either of these conditions, make changes to the tubes in the cassettes 
and rescan all of the mapped cassettes or abort the protocol and correct the 
sample list files.

Figure 5-11. Missing Tubes or Excess Tubes

If you click the OK button, the protocol continues despite the discrepancies 
reported in the panel.

Verify Labware Location Panel
You can verify the list of labware the system needs to perform the protocol. Each 
referenced labware is shown in the list so that you can check the labware 
locations and types against the actual deck configuration.
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You can also use the Varispan pipetting tips to physically check the locations of 
the labware. By selecting labware in the list, you can use the position slider, 
immediately above the Go To button, to specify any well position defined in that 
labware. after you choose a location, you can use the GoTo button to lower one of 
the Varispan arm pipet tips over that location. By checking the alignment of the tip 
with the actual position, you can verify that the labware is properly identified and 
positioned on the deck.

Figure 5-12. Verify Labware Locations panel

Error Messages

This section describes the following error messages that can display as you 
operate the instrument.
• Clot Detect Error on page 177
• Disposable Tip Warning on page 178
• Horizontal Motion Error on page 178
• Liquid Sense Error on page 178
• Tracking Error on page 179
• Vertical Motion Error on page 179
• Stack Space Error on page 180
• Barcode Reader Scan Errors Pane on page 181

Clot Detect Error
When you enable this feature, the system registers an error when a clot is 
detected at a sample position during the execution of the protocol. You enable clot 
detection on the Liquid Sense tab of the pipetting step’s parameters window. The 
Clot Detect Error message opens so that you can choose how to proceed after the 
error.

You can choose to Abort the protocol, Ignore the error or Skip the Sample after 
receiving this error message.
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Disposable Tip Warning
This warning message occurs when you start a protocol and the system senses 
that there are disposable tips already on the tip adapters. If the system senses 
tips on the adapters, it strips off the existing tips at any tip chute available on the 
deck. If no tip chute is available, the system prompts you with the Disposable Tip 
Warning message window.

You can remove the existing tips and continue the protocol or you can abort the 
protocol. Add a Drop Tip step to the protocol outline or manually eject the tips over 
the tip chute.

! WARNING Be sure to use all standard laboratory precautions when handling used or 
contaminated disposable tips.

Horizontal Motion Error
An error can occur if there is an obstruction or physical interference with the 
motion of the arm as it is moving around the deck. When the system detects 
interference, it displays the Horizontal Motion Error message so that you can 
abort the protocol or attempt to recover from the error.

In most cases you can recover from this type of error by clearing the obstruction 
that caused the error and clicking the Retry button. This can also occur if the 
Pause button was pressed during an arm motion due to the abruptness of the 
stop; typically, you can recover from these types of motion errors.

Liquid Sense Error
The liquid sense option, which is enabled by default, causes the system to report 
errors if the Varispan arm detects no liquid or insufficient liquid in the sample 
position during the execution of the protocol. You enable and disable liquid level 
sensing on the Liquid Sense tab of the pipetting step’s parameters window. The 
Liquid Sense Error message opens so that you can choose how to proceed after 
the error.

Following this type of error, you can choose how to recover from the lack of liquid. 
You can Abort the protocol or add liquid and Retry the operation. You can also 
examine the sample position and choose to Ignore the liquid sense error or Skip 
the Sample, depending on whether or not there really is sufficient liquid present. 
The final option is to move the tip all the way to the Bottom of the current sample 
position and pipette from there. To do this, visually verify that the well contains 
liquid and click the Go To Bottom button. The system moves the tip to the bottom 
of the well, based on the labware definition for the labware, and begins the 
pipetting operation.
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! WARNING If you pipette from the bottom of the well, and the volume of available liquid 
is less than the requested pipette volume, you might aspirate air. This can 
negatively affect the results of the protocol and the performance of the 
system.

 NOTE If you use the Go To Bottom button, the tip might be submerged in the 
sample liquid farther up the tip than the wash submersion. This can 
contribute to carryover and sample contamination. Take care to avoid this 
issue by setting the wash submersion to a sufficient depth.

Tracking Error
A tracking error occurs if there is physical interference with the vertical Z motion 
while the system is trying to follow the liquid level height. The Tracking Error 
message opens so you can choose how to proceed with the rest of the protocol.

Tracking errors can occur during either aspirate or dispense steps. If you 
Continue, the sample is skipped due to the potential severity of this type of error. 
For example, when tracking is interrupted during an aspiration, it is possible the 
system aspirated air instead of the designated liquid. When tracking is interrupted 
during a dispense, the tip could have submerged in the liquid, potentially 
contaminating the sample and tip.

Vertical Motion Error
A vertical motion error occurs if there is physical interference with or an 
obstruction to the vertical motion of one or more of the pipetting tips or the MDT 
Dispense head when they are in motion. The message opens so that you can 
abort the protocol or attempt to recover from the interruption.

Usually, you can recover from this type of error by clearing the obstruction that 
caused the error and clicking the Yes or No button. The Yes button retracts the 
tips in case they have pinned the obstruction on the deck or are otherwise 
jammed. If you can clear the obstruction without moving the tips, you can click the 
No button.

A Vertical Motion Error can also occur if you press the Pause button during a 
vertical motion. This is due to the abruptness of the stop, and you should be able 
to recover from the error in this case.
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Stack Space Error
A Stack Space error occurs if the protocol is very large and runs out of stack 
space. Click the OK button in the error window and then Abort the protocol to 
increase the stack space.

Figure 5-13. Stack Space Error

To prevent the Stack Space error, double-click msl.exe in C:\Packard\Janus\Bin 
to start MSL, click Options at the top of the MSL window to open the options 
Dialog, increase the Maximum Stack Space (Bytes) setting to a larger number, 
click OK, and then close MSL.

Figure 5-14. Stack Space Setting
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Barcode Reader Scan Errors Pane
This panel displays any tubes that have missing barcodes or barcodes that cannot 
be read by the Tube Bar Code Reader-Laser or Tube Bar Code Reader-Vision. 
This panel enables you to manually type a barcode for a specific tube, to correct 
the barcode label on a tube and then rescan the tube cassette, or to skip the 
sample in a tube. See Tube Bar Code Reader Scan Errors on page 215 for 
detailed instructions.

Figure 5-15. Barcode Reader Scan Errors
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Direct Control

Some error messages include a Direct Control button to access the Direct 
Control window. Use the tabs on the Direct Control window to recover from errors 
or to move arms or arm components while the system is in an error state. Only the 
tabs for arms that are installed on the system display. Figure 5-16 shows the 
Varispan tab on the Direct Control window. See the WinPREP online Help file for 
detailed descriptions of the Varispan, MDT Head, and GIP Gripper Arm tabs.

Figure 5-16. Direct Control Window - Varispan tab

Use the controls on the tabs to move the arms, eject tips, raise or lower tips on the 
Varispan (individually or all at once), dispense or aspirate with the Varispan, raise 
or lower the MDT head, or open or close gripper fingers to recover from an error. 

If you want to retry the step that generated the error, the arms must be in their 
original positions. If any arm is not in the original position, you are prompted to 
allow the system to move the arms back to their original positions as shown in 
Figure 5-17. Click the Yes button to move the arms back or the No button to go 
back to the JANUS Application Assistant to abort the protocol.
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Figure 5-17. Retry Recovery Option Notice Window
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Chapter 6

Procedures and Steps
The procedures and steps in a protocol determine the movements of the 
instrument during a run. This section lists the Procedures and Steps that are 
available for each component. Only the procedures and steps valid for installed 
components are displayed.

Procedures
Procedures are high-level nodes in the protocol outline that usually contain 
individual steps to perform a specific function. The Procedure Parameters window 
contains the options available for the procedure. The steps that are included in a 
procedure are often determined by the options selected in the Procedure 
Parameters window. Selections in the Procedure Parameters window are 
automatically updated in the Step Parameters windows.

• Varispan Procedures on page 184
• MDT Procedures on page 186
• Non-Pipetting Procedures on page 188
• Procedure Parameters Window on page 191

Varispan Procedures

Varispan procedures move liquid from one location to another using the tips on 
the Varispan arm or move the Varispan arm to a specific location. For information 
on MDT procedures, see MDT Procedures on page 186. For information on non-
pipetting procedures, see Non-Pipetting Procedures on page 188.

Single Liquid (Varispan)
The Varispan Single Liquid procedure transfers a single liquid (one or more 
replicates) at a time from one source position to one or more destination positions 
(depending on the number of replicates defined). The default configuration of the 
procedure includes one Transfer Group (one aspirate and one dispense step per 
Transfer Group) for each replicate of each sample, a flush step, and a wash step. 
Mixing is allowed before the aspirate step and after the dispense step.
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Reagent (Varispan)
The Varispan Reagent procedure aspirates liquid from one source position and 
dispenses liquid at two or more destination positions, such as adding reagent to 
all wells of a plate. The default configuration of the procedure includes one 
aspirate step and one dispense step. Replicates are not applicable, and multi-
pipetting is allowed. Mixing is allowed before each aspirate step and after each 
dispense step unless multi-pipetting is defined.

Panel (Varispan)
The Varispan Panel procedure aspirates liquid from one source position and 
dispenses liquid to two or more destination positions, which generally are not 
contiguous wells in labware. Panel procedures are useful for pipetting liquid into 
multiple plates from the same set of source tubes or plates. You can also use 
Panel procedures for “mother-daughter” plate-to-plate transfers.

Dilution (Varispan)
The Varispan Dilution procedure has three varieties: direct, serial, and custom. 
The Direct dilution produces consistently accurate dilutions as each dilution is 
independent of any other dilution steps. The Serial dilution produces progressively 
increasing dilutions as the source for each subsequent dilution is the diluted 
sample of the current well. The Custom dilution is completely flexible, allowing you 
to define any sequence of dilution steps that you desire.

Multiple Liquid (Varispan)
The Varispan Multiple Liquid procedure aspirates liquid from two or more source 
positions and dispenses all of the liquid at one destination position. The default 
configuration of the procedure typically includes multiple aspirate steps for each 
dispense step. A Multiple Liquid procedure with only one aspirate step is the same 
as a Single Liquid procedure. The default configuration of the procedure includes 
one Transfer Group (multiple aspirates and one dispense step per transfer group) 
that executes once for each replicate of the procedure, a flush step, and a wash 
step. Mixing is allowed in the Transfer Group before the first aspirate step and 
after the dispense step.

Flush/Wash (Varispan)
In a Varispan Flush step, the system dispenses liquid through the pipetting tips to 
clean the inside of the tips and ensure a constant flow of system liquid through the 
system. Any sample or reagent material left in the tips is dispensed at the waste 
position when the tips are flushed. You must ensure that a waste container is 
mapped to each Flush step.

In a Varispan Wash Step, the system dispenses liquid through the pipetting tips to 
wash both the inner and outer walls of the tips. You must ensure that labware in 
the deck view is mapped to each wash step.
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Park Arm (Varispan)
The Park Arm procedure positions the Varispan arm so that it is out of the way 
when you are performing deck or labware maintenance. This position should have 
a waste container to catch any liquids dispensed or leaked during the 
maintenance of the pumps, tips, or tubing.

The Park Arm procedure includes a single Move To Target step.

MDT Procedures

MDT procedures move liquid from one location to another using the MDT head, 
move the MDT arm to a specific location, or use the MDT gripper to move labware 
to defined locations. For information on Varispan procedures, see Varispan 
Procedures on page 184. For information on non-pipetting procedures, see Non-
Pipetting Procedures on page 188.

Replicate Plate MDT
The MDT Replicate Plate procedure transfers liquid from a source plate to one or 
more destination plates. Dispense volumes can differ from plate to plate. Source 
and destination plates must have the same number of wells. The MDT head 
aspirates from the next location in the aspirate step list and dispenses to the next 
location in the dispense list of each dispense step. 

Reagent MDT
The MDT Reagent procedure is a special version of the Single Liquid procedure. 
The Reagent procedure aspirates liquid from one source position and dispenses 
liquid at two or more destination positions. Use this procedure to quickly and 
efficiently add a reagent liquid to all wells in a plate. 

The default configuration of the procedure includes one Transfer Group (one 
aspirate and one dispense step per transfer group). Replicates are not supported, 
but you can define multiple dispenses per aspirate to optimize the speed of the 
reagent transfer. Use the well map to specify the order in which the instrument fills 
the wells or you can allow the software to determine the most efficient dispense 
order.

By default, the system tries to aspirate enough reagent to perform as many 
dispenses as possible. If necessary (due to tip volume restrictions), the aspiration 
step repeats to fulfill the dispense step requests. If desired, you can limit the 
number of dispenses per aspirate. Mixing is always allowed before aspiration, but 
mixing after dispense requires you to set one dispense per aspirate.

Expand Plate MDT
The MDT Expand Plate procedure transfers the same volume of liquid from a 
source plate to one or more destination plates; each destination plate contains a 
unique subset of the wells in the source plate. The total number of wells on the 
destination plates must equal the number of wells on the source plate.
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The labware mapping order in the protocol outline defines the order of pipetting 
operations. The MDT head aspirates from the next location in the aspirate step 
and dispenses to the next location in the dispense step. In the simplest case, this 
includes one aspirate followed by a sufficient number of dispenses to plates 
mapped in the dispense step. When complete, each well in the source plate is 
transferred to a well in one of the dispense plates. Using this method, a 384-well 
plate can be expanded to four 96-well plates. 

The expansion procedure supports Replicates. However, replicates are dispensed 
into replicate plates, rather than adjacent wells in the same plate.

Compress Plate MDT
The MDT Compress Plate procedure transfers the same volume of liquid from one 
or more source plates (up to four) to one destination plate. The contents of each 
source plate are in a unique subset of the wells in the destination plate. The total 
number of wells on the source plates must equal the number of wells on the 
destination plate.

The labware mapping order in the protocol outline defines the order of pipetting 
operations. The MDT head aspirates from the next location in the aspirate step list 
and dispenses to the next location in the dispense step. In the simplest case, this 
is one aspirate followed by a dispense to a quadrant in a plate mapped in the 
dispense step. When complete, each well in the source plates is transferred to a 
well in a dispense plate. Using this method, four 96-well plates can be 
compressed into a single 384-well plate.

The compression procedure supports replicates. However, replicates are 
dispensed into adjacent quadrants in the same plate, rather than replicate plates. 

Dilution MDT
There are two types of MDT Dilution procedures: Direct and Serial.

Direct dilutions use a single reagent source for all dilution steps. Each dilution in 
the set is aspirated from the original source location and diluted into a new well. 
This produces extremely accurate dilutions because each operation is 
independent.

Serial dilutions are step-wise operations that use the product of the previous 
dilution step as the aspirate source for the current dilution. This produces 
increasingly lower concentrations of the original sample. This procedure creates 
low concentration dilutions that would otherwise be difficult to prepare.

Multi-Liquid MDT
The MDT Multiple Liquids procedure aspirates two or more source liquids and 
dispenses them into one destination plate. This procedure is useful for preparing 
test kits that require multiple liquid components or where sample material from two 
or more sources is required.
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Tip washing between aspirates is not available because the MPD head is emptied 
as part of the tip wash step. Replicates are supported but multiple dispenses per 
aspirate are not. Rather, the aspirate sequence is repeated and dispensed into 
the adjacent quadrant or next plate.

Custom Pipetting MDT
The MDT Custom Pipetting procedure builds a user-defined sequence of steps. 
The MDT custom procedure allows you to add individual steps in any order to 
build a procedure that conforms to the needs of the particular application. You 
must add and define each transfer group and step in a custom procedure. 

The system does not propagate parameter settings from the procedure tab to the 
dependent steps automatically, nor does it validate the procedure definition 
parameters. You must ensure the custom procedures you create run correctly.

Empty/Wash MDT
The MDT Empty/Wash procedure empties the liquid remaining in the MDT head 
and washes the interior and exterior of the attached disposable tips. The system 
washes the tips by aspirating and dispensing liquid from a wash trough for a 
specified number of cycles.

Move Plate MDT
The Move Plate MDT procedure enables you to move plates using the MDT 
Gripper. You can use this procedure to move labware from one deck location to 
another. 

A Move Plate MDT procedure must contain either a Get Plate step, a Move/Put 
Plate step, or both.

Park MDT
The Park MDT procedure moves the MDT arm to a safe location so that it is out of 
the way of other instrument arms.

The Park MDT procedure includes a single Move To Target step.

Non-Pipetting Procedures

Non-pipetting procedures do everything except perform liquid handling 
operations. For information on Varispan procedures, see Varispan Procedures on 
page 184. For information on MDT procedures, see MDT Procedures on 
page 186.

Loop
The Loop procedure allows you to repeat execution of one or more procedures in 
the protocol outline. Add the procedures to repeat as child procedures inside the 
loop.
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Timer
The Timer procedure can perform any of the following time-related tasks:

• immediately pause the protocol for a defined length of time; for example, you 
can delay the start of a protocol or wait during an incubation period

• pause the protocol until a defined date and time; for example, you can delay 
the start of a protocol overnight

• pause the protocol for a defined length of time, calculated from a specific Time 
Marker; for example, to provide the same time spacing between sample 
transfers or reagent additions

Time Marker
The Time Marker procedure inserts a time reference point in the protocol outline. 
This marker is then available as a reference point to one or more Timer 
Procedures. Each time marker is unique and has a corresponding parameters 
window.

User Program
The User Program procedure runs an external program or function to perform 
specific actions. These actions might be to communicate with another device such 
as a robot or other instrumentation, to perform data transfer functions with another 
computer, or to execute unique functions for a specific application. 

User Message
The User Message procedure defines and displays custom messages at runtime. 
You can use this procedure to display reminders or information in the protocol. 
The protocol pauses until you respond to the message. User messages may also 
ask Yes/No questions; a negative response stops the protocol and a positive 
response continues with the next node in the protocol outline. For example, you 
can embed a User Message procedure inside another procedure to periodically 
ask whether you want to continue running the protocol or are ready to quit. 

User Query
The User Query procedure prompts the user for information at runtime. The 
protocol pauses until the user responds to the message. You can place User 
Query procedures anywhere in the protocol outline; this makes it easy to provide 
up to the minute values, as needed. The information entered by the user is stored 
in variables that were defined during protocol setup and populates the procedure 
parameters associated with the variables.

Variables can be defined for requesting information such as text, numerical data, 
or date and time data. Variable creation and query definitions determine the type 
of values expected, including checking entry limits and providing a list of possible 
responses, if necessary.
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Initial User Query
The Initial User Query procedure creates multiple query pages that open at the 
beginning of the protocol. By default, the Initial User Query includes all 
parameters deferred to runtime entry from the entire protocol. It is a good idea to 
modify the Initial User Query procedure after completely setting up the procedures 
and steps in the protocol outline.

Initial User Query pages provide the interface to assign parameter values deferred 
to runtime. You can organize the individual queries onto separate pages as 
necessary, giving each page a unique name.

Use the User Query procedure to create query pages that come up during other 
stages of the protocol. The User Query procedure is described in detail on 
page 189.

Move Plate (Gripper)
Only displays if a Gripper arm is installed. The Move Plate procedure adds a Get 
Plate step and a Put Plate step to move a plate using the Gripper arm. You can 
define the source and destination deck locations of the labware that you want to 
move. You can also select from previously taught positions, or if necessary, you 
can teach new positions.

Bar Code Scan
Only displays if a Tube Bar Code Scanner is installed. The Barcode Scan 
procedure reads the sample ID barcode information from a set of sample tubes. If 
you supply a Sample List file, the scanned IDs are checked against the IDs in the 
sample list file and related information for the samples can be read from the 
corresponding record in the file.

This procedure is only available on systems configured with a Tube Bar Code 
Scanner.
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Procedure Parameters Window

Each procedure Parameters window contains several tabs that organize the 
parameters into logical groups. Each window contains one or more of the tabs 
shown in Figure 6-1, which in turn contain parameters appropriate to the specific 
type of procedure. After making changes to any of the parameters, accept the 
changes by clicking the Apply button, or cancel the changes by clicking the Undo 
or Cancel button. The Apply button updates all parameters on all tabs of the 
procedure.

Figure 6-1. Procedure Parameters Tabs

Click the desired tab at the top of the window to display the parameters on the tab. 
Refer to the online help for a complete description of procedure parameters, 
controls, and settings.

 Note: The title bar displays the procedure type, regardless of which tab is active.

Open the Procedure Parameters Window
There are several ways to open a parameters window for a node in the protocol 
outline or for labware in the deck view. The results are identical, whichever action 
you choose to use.

To open a procedure parameters window:
1. Select the desired node in the protocol outline.

2. Do one of the following:

— Double-click the desired node in the protocol outline.
— Right-click the desired node and click Edit Node from the menu.
— Highlight the desired node in the protocol outline by clicking on it. Select 

Edit > Parameters on the main menu.
— Highlight the desired node in the protocol outline by clicking on it. Press 

<Alt> + <Enter> on the keyboard.

WinPREP opens the Parameters window for the selected node. You can modify 
and configure the parameters for the node as desired.

Close the Procedure Parameters Window
When you finish modifying the procedure parameters, you can apply the changes 
and close the window.
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To close the procedure parameters window:
1. Click the Close button (or the OK button if modifications have not been 

applied), or click the X (Close) button in the upper right corner of the 
parameters window. WinPREP prompts you to save the changes if 
modifications were made but not applied and then closes the Parameters 
window.

Steps
Each step in the protocol outline has a step parameters window associated with it. 
Types of steps include both the pipetting and the non-pipetting steps listed below:

Step Parameters Window

Each step Parameters window contains several tabs that organize the 
parameters into logical groups. Each window contains one or more of the tabs 
shown in Figure 6-2, which in turn contain parameter fields appropriate to the 
specific type of step. After making changes to any of the parameters, accept the 
changes by clicking the Apply button or cancel the changes by clicking the Undo 
button. Clicking Apply updates all parameters on all tabs of the step.

Figure 6-2. Step Tabs

• Transfer Group • Transfer Group MDT

• Aspirate Air • Aspirate Air MDT

• Aspirate • Aspirate MDT

• Dispense • Dispense MDT

• Drop Tip • Empty MDT

• Find Liquid • Mix MDT

• Flush • Move to Target MDT

• Get Tip • Wash MDT

• Mix • Move/Put Plate

• Move to Target

• Wash

• Find Liquid

• Pre-Aspirate Mix
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Click the desired tab at the top of the window to display the parameters associated 
with that tab. Refer to the online help for a complete description of procedure 
parameters, controls, and settings.

 Note: The step type always displays in the window title bar regardless of which 
tab is active (currently displayed).

Open the Step Parameters Window
There are several ways that you can open a parameters window for the currently 
selected node. The results are identical, whatever action you choose to use.

To open the step parameters window:
1. Select the desired step node in the protocol outline.

2. Do one of the following:

— Double-click the selected node in the protocol outline.
— Right-click the selected node and click Edit Node from the menu.
— Select Edit > Parameters from the main menu.
— Press <Alt> + <Enter> on the keyboard.

WinPREP opens the Parameters window for the selected step node. You can 
modify and configure the parameters for the node or labware as desired.

Close the Step Parameters Window
When you finish modifying the step parameters, save or discard the changes and 
close the window.

To close the step parameters window:
• Click the Cancel button to close the window without saving any changes to 

the parameters.
• Click the Close button if changes have already been applied or if no changes 

have been made.
• Click the OK button to save the changes and close the window.

WinPREP closes the Parameters window.

Customizing the Toolbars
The toolbars in WinPREP can be customized to suit your needs. The 
customizations are saved for each user so that each user can have the look that 
best suits them.
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The following procedures are included in this section:

• Hiding Toolbars (page 194)
• Removing or Moving Buttons (page 194)
• Adding Buttons to a Toolbar (page 194)
• Renaming Buttons (page 195)
• Adding a Custom Image to a Toolbar Button (page 196)
• Resetting the Toolbar to Factory Settings (page 197)

Hiding Toolbars

To hide a toolbar, right-click on a blank area of the toolbar. On the popup menu, 
uncheck the toolbars you want to hide. Standard shows or hides the Main toolbar.

Figure 6-3. Toolbar Shortcut Menu

Toolbars can also be shown or hidden from the View menu. Select the toolbar 
name on the View menu to show or hide the toolbar. View > Procedure Toolbar 
toggles the view of any arm toolbars (MDT and Varispan).

Removing or Moving Buttons

To change the content of the toolbars, use the Customize window. Right click on a 
blank area of the toolbar and select Customize. 

While the Customize window is open you can click and drag buttons on the 
toolbar.

• Drag a button to the left or right to change the order.
• Drag a button off the toolbar to remove it.
• Drag a button a little bit to the right or left to create a vertical separator.

Adding Buttons to a Toolbar

To add a menu command as a button on a toolbar:

1. Right click on a blank area of the toolbar and select Customize. 

2. Click the Commands tab in the Customize window.
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Figure 6-4. Commands Tab in the Customize Window

To add the Access database as a toolbar button:
1. Select Utilities as the category. 

2. Drag Database from the command list to the toolbar. As you move the cursor 
over the buttons, an indicator shows where the button will be added.

3. Release the mouse button when the button is in the desired location. A text 
button is created. 

Figure 6-5. Database Button

4. You can stop here or you can further customize the button by changing the 
name and image.

Renaming Buttons

Rename a button by right-clicking on the button and typing a new name in the 
Name field.
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Figure 6-6. Changing a Button Name

Adding a Custom Image to a Toolbar Button

To add a custom image to a button:

1. Right-click on the button and select Edit Button Image. The Button Editor 
window opens.

Figure 6-7. Button Editor Window

2. Click the Import from File button on the Tools palette.

3. Navigate up one level and look for the “Images” folder. This contains a 
selection of button images. 

4. Select the image you want to use for the button and click Open.



 Chapter 6: Procedures and Steps 197

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Figure 6-8. Select the Button Icon

5. Click OK in the Button Editor to add the icon to the button.

Resetting the Toolbar to Factory Settings

To reset the toolbars back to the factory settings:

1. Right click on a blank area of the toolbar and select Customize.

2. Click the Toolbars tab in the Customize window.

3. Click the Reset button.

Figure 6-9. Reset the Toolbars
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Chapter 7

Bar Code Readers
The JANUS workstation offers two types of Bar Code Readers: The Plate ID Bar 
Code Reader to read individual bar codes from labware, or the Tube Bar Code 
Reader to read bar codes from test tubes in tube cassettes on the deck.

This section describes the two options and explains the commands required to 
use the bar code readers in WinPREP protocols.

This chapter contains the following information and procedures:

• Bar Code Scan Files on page 199
• Sample List Files on page 201
• Use a Scan File as a Sample List on page 202
• Plate ID Bar Code Reader Protocols on page 203
• Tube Bar Code Reader Protocols on page 207

For step-by-step tutorials that explain how to create specific types of protocols for 
each of the major components of a system, see Protocol Tutorials on page 59.

 Caution: The procedures in this chapter assume you have properly calibrated the 
deck for each arm on the system. If you have not calibrated the deck, see 
Calibrating the System on page 285 before proceeding.
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Bar Code Scan Files
A Scan File contains all of the Sample IDs read during the Bar Code Scan 
Procedure or Tube Rack Scan Procedure. The name of the Scan file is specified 
in the Scan procedure. The Scan File makes scanned IDs and position 
information available to other programs or functions. By default, the file is named 
using the procedure name followed by a “.csv” file extension and is saved in the 
“\Janus\Bin” folder.

Note: Scan Files are NOT automatically deleted at the end of the protocol. You 
should manually remove them when they are no longer needed.

The Scan File for a Tube Rack Scan procedure contains the following fields for 
each tube, in the order below:

• Column 1 - Lane: The cassette position, numbered from left (lane 1) to right 
(lane 12 or lane 6).

• Column 2 - Name: The name of the cassette specified when the labware was 
added to the deck.

• Column 3 - Position: The sample position in the cassette, numbered from the 
back of the instrument (position 1) to the front of the instrument (position 16).

• Column 4 - Scan Code: The Sample ID scanned from the barcode label on 
the sample.

Figure 7-1 shows a scan file generated during a protocol. Record 1 in the Scan 
File is the heading row. The data starts at Record 2 if using the Scan File as a 
Sample List. 

NOTE: If you want to keep a copy of the scan file, you should change the file 
name each time the Bar Code Scan procedure is used. WinPREP writes a new 
scan file.csv to the \bin folder and overwrites the existing file of the same name 
during each run.
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Figure 7-1. Scan File in Excel

Use the Runtime File Definitions window to change the name or location of the 
scan file. Click the Files button on the Runtime Parameters tab to open the 
Runtime File Definitions window (see Figure 7-2). Click the file name to change 
the name.

Figure 7-2. Scan File Name in Runtime File Definitions Window
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Sample List Files
Sample List files are CSV files that contain a list of bar codes (Sample IDs). The 
Sample list files can be used to track samples during a run or to specify 
parameters for each sample based on the scanned bar code. The bar codes that 
are scanned during a run can be compared to the bar codes in the Sample List 
and actions can be taken depending on whether the scanned bar codes are found 
in the Sample List. The Sample List can also be used to verify that all of the bar 
codes in the Sample List have been scanned by the bar code reader.

The Sample List files for a Bar Code Scan procedure or a Tube Rack Scan 
procedure are specified on the Sample Lists tab as shown in Figure 7-3. To use 
the scan file as a sample list, see page 202.

Figure 7-3. Sample Lists Tab

If more than one Sample List file is specified, each Sample List file is read starting 
with the file in Row 1 and continuing down.
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Use a Scan File as a Sample List
A scan file can be used as a Sample List file by selecting the Yes, and Use as a 
Sample File option in the Bar Code Scan Procedure or Tube Rack Scan 
Procedure.

The Scan File is then used as the Sample List for the procedure and is 
automatically added to the table on the Sample List tab. The column number of 
the ID and the file name are automatically entered in the table, since the format of 
the file is already defined. Choosing to use the file in Scan Order or List Order has 
no effect, because for this file they are exactly the same.
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Plate ID Bar Code Reader Protocols
The Plate ID Bar Code Reader is a JANUS G3 option that works with the Gripper 
arm or MDT Gripper to read bar code labels on labware during a protocol. The 
Gripper arm or MDT Gripper moves a labware item to a defined position in front of 
the Plate ID Bar Code Reader so the bar code reader can read the bar code on 
the labware. WinPREP saves the bar codes in a CSV file that you can use to 
specify how the sample is processed or to produce reports. The Plate ID Bar 
Code Reader is also called the Secondary Bar Code Reader, or SBCR.

Before operating the Plate ID Bar Code Reader, teach the Plate ID Bar Code 
Reader position to the Gripper arm or MDT Gripper using the instructions in 
Teaching Off-Deck (or Special On-Deck) Locations on page 319.

Creating a Protocol for the Plate ID Bar Code Reader

When you create a protocol for the Plate ID Bar Code Reader, the protocol outline 
displays procedures and steps that make up the protocol. The Deck View displays 
the deck positions used during the protocol. The Plate ID Bar Code Reader, 
during the “Get Plate” portion of each Gripper “Move” procedure, scans labware 
items occupying positions on the deck marked for bar code identification. During 
the plate bar code reader protocol, the system expects a bar code on any labware 
item that occupies that deck position. The barcode on labware is indicated by the 
deck position and not the labware item. 

Several predefined sample protocols are supplied with the Plate ID Bar Code 
Reader. You can use one of these predefined protocols and modify it as 
necessary or you can create your own custom protocol. If you create a custom 
protocol, you must include a Setup Bar Code Parameters node in the protocol 
(see Selecting the Plate ID Bar Code Reader (SBCR) Parameters on page 206). 
You must also create user functions for the Plate ID Bar Code Reader (see 
Creating Plate ID Bar Code Reader User Functions on page 204).

To access the predefined sample protocols, select File > Open on the main 
menu, browse to the sample protocols in C:\Packard\JANUS\bin\Samples\, and 
choose the appropriate protocol. The names of Plate ID Bar Code Reader 
protocols start with “SBCR...”.

To use the Plate ID bar code reader:
1. Open one of the predefined bar code reader sample protocols supplied with 

the system or create a custom protocol. 

2. Customize the sample protocol, if necessary.

3. Save the file with a new, unique name. Do not overwrite the original sample 
protocols.
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4. Specify the deck positions that contain labware items you want to scan with 
the plate bar code reader. Use the Labware Parameters window for labware 
in the Labware Library. Use the Teach Position and Teach Manifold 
Components windows for custom labware positions. See Calibrating the 
Gripper Arm on page 312 for more information.

5. Verify that the plate ID bar code reader setup parameters are appropriate for 
the protocol. See Selecting the Plate ID Bar Code Reader (SBCR) Parameters 
on page 206 for more information.

 Note: The protocol must contain a Setup Barcode Parameters procedure. 
Create your own or copy one from one of the sample protocols provided 
with the system.

6. If creating a custom protocol, create User Functions for the plate bar code 
reader or copy the required functions from other protocols (see Creating Plate 
ID Bar Code Reader User Functions on page 204).

7. Execute the protocol.

The system moves and scans each of the plates specified in the protocol.

Creating Plate ID Bar Code Reader User Functions

If you are creating a custom Plate ID bar code reader protocol, you must create 
user functions to initialize the barcode reader and to abort the Plate ID bar code 
reader protocol as described below. If you use one of the predefined sample 
protocols, these user functions are already included in the protocol. Create the 
Plate ID bar code reader User Functions for a custom protocol as described 
below:

To create a Plate ID Reader Initialize function
1. Double-click on the Protocol Outline node of the protocol. The Protocol 

Outline Parameters window opens.

2. Click the Advanced tab.

3. Select Run User Function in the Action To Take field of the On Protocol 
Startup frame.

4. Click the List button in the On Protocol Startup frame. The User Function 
List window opens.

5. Click the Add button.

6. Type an appropriate name for the new user function, for example: Initialize 
Plate ID Reader, in the Function Name column.

7. Click the Edit button. The User Function Edit window opens.

8. Type: SBCR_Initialize( );



 Chapter 7: Bar Code Readers 205

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

9. Click the OK button in the User Function Edit window.

10. Click the OK button in the User Function List window.

11. Select the initialize function in the User Function field of the On Protocol 
Startup frame.

12. Click the OK button in the Protocol Outline Parameters window.

Create a Plate ID Reader Abort Function
1. Double-click the Protocol Outline node of the protocol. The Protocol Outline 

Parameters window opens.

2. Click the Advanced tab.

3. Select Run User Function in the Action To Take field of the On Protocol 
Abort frame.

4. Click the List button in the On Protocol Abort frame. The User Function 
List window opens.

5. Click the Add button.

6. Type an appropriate name for the new user function, for example: Abort Plate 
ID, in the Function Name column.

7. Click the Edit button. The User Function Edit window opens.

8. Type: SBCR_Abort( );
9. Click the OK button in the User Function Edit window.

10. Click the OK button in the User Function List window.

11. Select the abort function in the User Function field of the On Protocol Abort 
frame.

12. Click the OK button in the Protocol Outline Parameters window.
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Selecting the Plate ID Bar Code Reader (SBCR) Parameters

If you are creating a custom Plate ID Bar Code Reader protocol, you must include 
a Setup Barcode Parameters node after the Initial User Query node in the 
protocol. If you use one of the predefined sample protocols, this node, named 
SBCR Setup, is included by default.

To set up the Plate ID Barcode Reader Parameters in a protocol:
1. Right-click on the Protocol Outline node and select Add Procedure > User 

Procedure > User Program, or double-click on the Setup Barcode 
Parameters node if it is already created. The User Program Parameters 
window opens.

Figure 7-4.  User-Program Parameters Window for Plate ID Barcode Reader

2. Select External DLL Function in the User Program-Type drop-down list.

3. Select SBCR_Setup in the Select Function drop-down list.

4. Click the Edit Parameters button. The Plate Bar Code Reader Setup 
window opens.
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5. Verify that the Plate ID barcode reader setup parameters are appropriate for 
the protocol. The parameters are described in the Plate Barcode Reader 
Setup Window topic in the online Help. The settings on the Reader tab specify 
the name of the read position for the gripper, the location of the bar code, the 
orientation of the barcode reader, the actions on errors or duplicate bar codes, 
and whether to read the barcodes on the labware and generate a scan file. 
Specify any Worklist settings or report settings on the corresponding tabs.

6. Change the Name as desired, typically either Setup Barcode Parameters or 
SBCR Setup.

7. Click the Close button.

Tube Bar Code Reader Protocols
The Tube Barcode Reader option is used to read bar code labels on test tubes 
during a protocol. The JANUS supports two 12-Lane Tube Bar Code Readers, the 
Tube Bar Code Reader - Laser and the Tube Bar Code Reader - Vision. The Tube 
Bar Code Reader - Laser uses a laser bar code reader to read the tube bar codes. 
The Tube Bar Code Reader - Vision uses a camera bar code reader to read the 
tube bar codes. The appropriate option is selected when the WinPREP software is 
installed on the system controller. 

Use The Bar Code Scan procedure to scan the tubes in the 12 Lane barcode 
rack with the installed bar code reader. During the Bar Code Scan procedure, the 
Tube Bar Code Reader arm moves a cassette of test tubes into position in front of 
the Tube Bar Code Reader. The Tube Bar Code Reader reads the bar code label 
on each tube and stores the decoded barcode information in a CSV file that you 
can use to specify protocol steps or produce reports.

See Calibrating the Tube Barcode Reader on page 323 for instructions on 
calibrating the Tube Bar Code Reader deck, teaching the Engage Position, and 
teaching the cassettes.
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Create a Protocol for the Tube Barcode Reader

The Bar Code Scan procedure reads the sample ID bar code information from a 
cassette of test tubes. If you supply a sample list file, the scanned IDs are 
checked against the IDs in the sample list file so that related information can be 
read from the appropriate record in the file.

Figure 7-5. Example Bar Code Scan Node in Protocol Outline

In the Deck View, the Tube Barcode Reader option occupies the left side of the 
deck, as shown in Figure 7-6.

Figure 7-6. Example Tube Barcode Reader in Deck View

If you are creating a new Tube Bar Code Reader protocol, you must include a Bar 
Code Scan procedure in the protocol. If you use one of the predefined sample 
protocols, such as Bar Code Scan Demo.MPT, this procedure is already included.

 Note: The sample protocols provided with WinPREP are located in the 
\bin\Samples\ folder in the WinPREP installation folder.

To create a protocol using the tube barcode reader:
1. Select File > New to open the New window.

2. Select Protocol and click New to open the Open a Protocol Template 
window.

3. Click None to create a new protocol.

Tube Barcode Reader
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4. Click File > Save As to save the file. The Save As window opens.

5. Type a unique name in the File Name field and click Save. WinPREP creates 
a new protocol, saves it, and opens it in the Protocol Outline View.

6. Select the End of Protocol node in the protocol outline and click the Bar 
Code Scan button on the toolbar.

WinPREP creates a temporary Procedure Under Construction node in the 
protocol outline and opens the Bar Code Scan Parameters window, as 
shown in Figure 7-7.

Figure 7-7.  Bar Code Scan Parameters Window

7. Click OK on the Bar Code Scan Parameters window.

The software closes the Bar Code Scan Parameters window and converts 
the Under Procedure node into a Bar Code Scan node.

8. Click File > Save As to open the Save As window.

9. Type a unique file name and click Save to save the protocol.

10. Set the Bar Code Scan parameters. See Setting the Bar Code Scan 
Parameters on page 210.
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Setting the Bar Code Scan Parameters

The Bar Code Scan Parameters window specifies the functions for the tube 
barcode reader. 

To set the Bar Code Scan parameters:
1. Double-click the Bar Code Scan procedure in the protocol.

2. On the Overview tab in the Bar Code Scan Parameters window, specify the 
following Bar Code Scan parameters:

— Scan From: Specifies the source of the locations to scan.
— Terminate Scan Code: Specifies a bar code to use to end tube bar code 

scanning. Type the value or specify a variable or file name. If thee 
specified bar code is read, the Bar Code Scan procedure terminates. The 
scan file /sample list stops at the termination bar code and no additional 
bar codes are processed.

— Generate a Scan File: Specifies whether to generate a Scan File (see 
page 199) of the bar codes that are read during the Bar Code Scan 
procedure. The Scan File can be used as a Sample List File (see 
page 202) for the protocol if desired.

3. Click the OK button to save the settings and close the Bar Code Scan window.

 Note: The Tube Barcode Reader can read many common bar code formats, as 
long as the labels meet defined minimum quality standards. For more 
information on the supported bar code formats, see Tube Barcode Reader 
Supported Formats on page 210.

Tube Barcode Reader Supported Formats

The JANUS Tube Barcode Reader has been tested to reliably read bar code 
labels generated using the following formats:

• Interleaved 2 of 5 (uses a modulus 10 check digit)
• Code 39 High Density
• Codabar High Density
• 128 Auto High Density
• UPC-A Medium Density

Note: The UPC-A Medium Density format was tested during development but did 
not produce reliable or acceptable read results. PerkinElmer recommends you 
use one of the more reliable formats to generate the bar code labels.



 Chapter 7: Bar Code Readers 211

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Tube Bar Code Label Quality

By following minimum quality guidelines when producing bar code labels, you 
ensure accurate and reliable bar code read results. This section describes 
important guidelines to follow when producing bar code labels. Print Quality 
Labels must meet the print quality specifications outlined in the “ANSI X#.182-
1990 Bar Code Print Quality-Guideline.”

Regardless of the bar code format used to encode label information, certain 
minimum quality specifications for the printing of the labels is required. The better 
the label generation, the more reliable the scanning can be. PerkinElmer 
recommends the following minimum specifications when printing bar code labels:

• Minimum Print Contrast Signal (PCS): 80%
• Minimum Reflectance Difference (MRD): 45%
• Decodability: 100%
• Length: 10 mm – 100 mm
• Height: 8 mm – 30 mm
• Label Coatings: Resin-coated paper labels, Retroreflective labels, Laminated 

Labels
• Character Limit: 64 alphanumeric characters (including the start character, 

stop character, and check digits).
• Barwidth/Density: 0.19 mm to 0.51 mm (including narrow bar width and 

wide-to-narrow ratios). The bar code density (narrow bar width) for each bar 
code format is defined as:

Bar Code Format Density

Interleaved 2 of 5 0.007 inches (0.178 mm)

Code 39 High Density 0.007 inches (0.178 mm)

Codabar High Density 0.007 inches (0.178 mm)

128 Auto High Density 0.008 inches (0.203 mm)

UPC-A Medium Density 0.011 inches (0.279 mm)
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Loading the Test Tubes in the Cassettes

The test tubes must be placed in the cassettes with the barcodes displayed on the 
right side of the cassette, toward the bar code reader on the arm. The Barcodes 
should be fully visible in the cutout in the cassette. Make sure the labels are not 
stained, peeling, or folded.

The Tube Bar Code Reader-Laser option uses tube cassettes without bar code 
labels below each tube location as shown in Figure 7-8.

Figure 7-8. Tube Bar Code Reader-Laser Cassette

The Tube Bar Code Reader-Vision uses tube cassettes with bar code labels 
below each tube location and inside the back of each tube location as shown in 
Figure 7-9. The bar code label at the back of each tube position is only visible if 
there is no tube in the location. This allows the Tube Bar Code Reader-Vision to 
determine when there is no tube present. The Tube Bar Code Reader-Laser does 
not sense when a tube location is empty. Make sure you are using the proper 
cassettes.

Figure 7-9. Tube Bar Code Reader-Vision Cassette
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Tube Bar Code Reader Example Protocol

The example protocol shown in Figure 7-10 scans the barcode cassettes and 
creates a sample list. The sample list is then used to aspirate from the test tubes 
and dispense into the 96 well microplate. The samples from the test tubes can be 
tracked to the wells in the plate.

Figure 7-10. Tube Bar Code Reader Protocol

For the protocol above to use the newly created sample list, the Single Liquid 
parameters must be set to Aspirate From: SmpList: ScanMap. The Number of 
Samples needs to be set to SmpList: Records as shown in Figure 7-11.

Figure 7-11. Single Liquid Parameters
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The Aspirate location could also be set to Map Type: SmpList: Column as shown 
in Figure 7-12.

Figure 7-12. Aspirate Well Map Settings

If using SmpList: Column as the Aspirate Well Map, the Rack Name Column # 
and Position Name Column # must be specified in the Runtime Parameters tab, 
Type: Well Maps. The example in Figure 7-13 uses Column 2 for the Rack Name 
and Column 3 for the Position.

Figure 7-13. Single Liquid Parameters, Runtime Parameters Tab
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Tube Bar Code Reader Scan Errors

When running a protocol that reads tube bar codes, if an error occurs while 
reading a bar code, the Barcode Reader Scan Errors pane displays as shown in 
Figure 7-14.

Figure 7-14. JANUS Application Assistant Barcode Reader Scan Errors

To correct an error, click the tube in the Barcode Reader Scan Errors pane to 
select the row. Each tube is identified in the table by the Lane number and 
Position number in the first column.

• To manually type the barcode, type the barcode in the Edit Barcode ID text 
box and click the Update button.

• To skip processing the tube for the rest of the run, click the Skip Sample 
check box.

• To move the tube cassette in front of the barcode reader, click the Go To 
button.

• To try scanning the tube again, click the Rescan button.
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Chapter 8

Worklists
From the perspective of sample preparation, a worklist file contains specific 
information about each sample you want to process. The information in the file 
can vary, depending on the laboratory and protocol requirements. Typically, 
worklist files include a sample ID and the position of the sample at a minimum.

Worklist files can contain significantly more information about each of the 
samples, if desired. They can include dilution values, well mapping locations, 
sample volumes, replicate information, protocol selections, etc. WinPREP can 
read any runtime parameter from a worklist file. If necessary, you can include 
multiple worklist files in the protocol, assigning and using them as needed in the 
procedures.

You can use any program to create or edit worklists for JANUS G3, as long as it is 
capable of generating a delimited ASCII file. Most spreadsheet, word processor, 
and database programs can produce this kind of output. Delimited ASCII files are 
column-based and each row, or record, in the file contains information about a 
single sample. Each column represents a specific piece of information and a 
delimiter character separates columns in the record. The delimiter character can 
vary, but a comma is one of the most widely used. In fact, commas are so popular 
that comma-delimited text files have a specific name: Comma Separated Values 
or CSV. CSV file names typically include the “.csv” extension. While this is not a 
requirement, it helps identify the structure of the file. Figure 8-1 shows a typical 
worklist file.

Figure 8-1. Worklist File Example
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In this example, each row in the file is a single record and each record contains 
four pieces of information: sample ID, labware ID, position, and number of 
replicates. The first row in the file is the header, or title, record and identifies the 
data contained in each column.

Notice that the example worklist file is open in Microsoft Excel. WinPREP uses 
Microsoft Excel as its worklist and data file editor and includes a copy of Excel for 
this purpose. You can use any text-editing program to create and edit worklist 
files, but PerkinElmer recommends Microsoft Excel. The examples in this chapter 
all use Excel to manipulate worklist files.

Create and Edit a Worklist
When you create a worklist in Excel, or any other external program, you must 
specify and use one of the three WinPREP delimiter characters: a comma, a tab, 
or a space. Make sure the data does not contain any instances of the selected 
delimiter character. If the data contains the delimiter characters, or if the file uses 
a delimiter character other than a comma, tab, or space, WinPREP may not be 
able to process the data correctly.

For example, if you select a comma as the delimiter character for the worklist file, 
the worklist data should not include a comma but it can, and often will, contain 
spaces or tabs.

Using Excel to Edit a Worklist

Microsoft Excel provides all the functionality required to create, import, export, 
edit, and save worklist files. The sections below describe how to import and export 
CSV files using Microsoft Excel.

Exporting CSV files from Excel
To export CSV files from Excel, save the file using the CSV file type as described 
below.

To export a CSV file from Excel:
1. Use File > Save to save the Excel file.

 Caution: Make sure the data in the Excel file does not contain any commas. If the 
data contains commas, Excel encloses the cell data in double quote (“) 
characters. This may cause problems, or undesirable output.

2. Select File > Save As from the menu bar. The Save As window opens.

3. Use the File Browser on the Save As window to select the desired export 
location for the CSV file.
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4. Type a name for the file in the File Name field.

5. Select CSV (Comma Delimited) (*.csv) in the Files of Type list.

6. Click Save. Excel displays a message stating the selected file type does not 
support workbooks that contain multiple sheets.

7. Click OK to save the currently active sheet and close the warning window. 
Excel displays a second warning message stating the file may contain 
features that are not compatible with CSV files.

8. Click Yes to retain the file in CSV format and close the window.

9. Close the file and Microsoft Excel.

Importing CSV files into Excel
Importing a CSV file into Excel displays the values in each record in one row, with 
each data value in a single cell.

To import a CSV file into Excel:
1. Start Microsoft Excel.

2. Select File > Open from the menu bar.

3. Select Text Files (*.prn; *.txt; *.csv) in the Files of Type list.

4. Use the File Browser on the Open window to locate the desired CSV file.

5. Select the file and click Open. Excel opens and displays the contents of the 
file in a new window.

 Note: If the data in the CSV file is not imported properly, it may be due to 
commas in the data. This is generally the case if some records import 
properly but other records do not.
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Using Worklists
Worklists are a powerful feature of the JANUS G3 system. You can configure a 
protocol generically, without having to specify sample information, and supply this 
information at runtime using a worklist. You do not need to specify the number of 
samples you want to process, since WinPREP reads this information from the 
worklist file. In fact, you can specify many different types of runtime parameters in 
a worklist file. Table 8-1 on page 220 provides a complete list of these parameters. 
Refer to the online help for a complete description of each control and parameter.

The ability to dynamically configure the protocols at runtime, from one or more 
worklist files, provides a flexible and efficient way to configure and reuse 
protocols.

Worklists also make it possible to store sample data in a location other than the 
protocol. You can enter, edit, maintain, and manipulate sample data in a custom 
database or Laboratory Information Management System (LIMS), and export the 
necessary data to a worklist for processing.

To use a worklist, you must associate it with one or more procedure nodes in a 
protocol. You can associate worklists with a procedure node in two different ways: 
statically, by linking the file to the node during protocol creation, or dynamically, by 
querying the operator for a worklist at runtime. 

This section contains the following procedures:

• Statically Link a Worklist on page 221
• Dynamically Link a Worklist on page 224
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Tab Controls Runtime Parameters

Tab Control Name Type Parameter Name

O
ve

rv
ie

w
Number of Samples Parameters Number of Samples

Start with Sample Parameters Start with Sample

Start with Destination Parameters Start with Destination

Aspirate From Well Maps Asp. Well Map

Dispense To Well Maps Dsp. Well Map

Dispense Volume Parameters Dispense Volume

Replicates Parameters Replicates

ID Parameters Asp. Sample Id

D
et

ai
ls

Waste Volume Parameters Waste Volume

LLS Parameter LLS Verification

Pre-Aspirate Mix Volume Parameters Pre-Aspirate Mix Volume

Pre-Aspirate Mix Cycles Parameters Pre-Aspirate Mix Cycles

Post-Dispense Mix Volume Parameters Post-Dispense Mix Volume

Post-Dispense Mix Cycles Parameters Post-Dispense Mix Cycles

Air Gap(s): System Parameters System Air Volume

Air Gap(s): Transport Parameters Transport Air Volume

Tip Adapters Parameters Tip Adapter List

Fl
us

h/
W

as
h

Flush Location Well Maps Flush Well Map

Flush System Liquid Volume Parameters Flush Volume

Flush Cycles Parameters Flush Cycles

Wash Fixed Tips Location Well Maps Wash Well Map

Wash Fixed Tips System Liquid 
Volume

Parameters Wash Volume

Wash Fixed Tips Cycles Parameters Wash Cycles

M
is

c. N/A Parameters Use This Node

Table 8-1. Tab Controls and Runtime Parameters
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Statically Link a Worklist

When you statically link a worklist to a protocol, it is included in the protocol from 
that time forward. When you run the protocol, WinPREP looks for the file in the 
location you specified when you linked the file, and reads the file data. If it cannot 
find the specified file, the software displays a file not found error. 

See Dynamically Link a Worklist on page 224 for instructions on how to 
dynamically query for a worklist file at runtime.

To use a worklist in a protocol:

 Note: The steps below assume you are setting up a Single Liquid Transfer 
procedure to use a worklist and that the worklist you want to use already 
exists. The data included in the worklist includes source labware name, 
source labware sample position, transfer volume, and destination labware 
name. Figure 8-2 shows the worklist (SLTInputData.csv) used in these 
examples.

Figure 8-2. Worklist Example (SLTInputData.csv)

1. Open the desired protocol in WinPREP.

2. Make sure you have a source labware named Source and a destination 
labware named Destination on the deck. You also need a Flush/Wash station 
on the deck.

3. Double-click the Single Liquid_1 procedure node. The Single Liquid 
Parameters window opens.

4. Click the Runtime Parameters tab and click the Files button to open the 
Runtime File Definitions window.

5. Click the Add button to insert a new row in the Defined Files frame. This is 
where you associate the worklist file with the procedure.
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6. Click in the File or Variable field in the newly-created row and click the 
Browse button to open the Select File window.

7. Use the file browser to select the desired worklist file and click Open. (This 
example uses a worklist file named SLTInputData.csv.)

The software loads the file name, including path, into the File or Variable 
column in the Defined Files table and updates the Preview of pane with a 
preview of the first few records in the file. You can adjust the number of 
preview records by increasing or decreasing the View Records value.

 Note: The starting location in the Select File window defaults to the bin\ folder in 
the WinPREP installation folder.

8. Set the File Type, Start Record, and Column Delimiter to Column, 1, and “,” 
(the comma character, without the double quotes), respectively and click OK. 
Figure 8-3 shows this window. The In Use option is not checked because the 
worklist file is not yet associated with any runtime parameters.

 Note: If the worklist file includes a header record, set the Start Record value to 
2. This instructs WinPREP to ignore the first record in the file, as it does 
not contain sample data.

Figure 8-3. Runtime File Definitions window

9. Select Well Map from the Type drop-down list on the Runtime Parameters 
tab. The window displays the well map settings for the procedure.

10. Set the Gets Data From values to File: Column for both the Asp. Well Map 
and Dsp. Well Map parameters. The File values for both parameters update 
to the name of the worklist file. The Rack Name Column #, and Position 
Column # fields update to 1 and 2, respectively. This is correct, except the 
Rack Name Column # for the Dsp. Well Map parameter should be the fourth 
column. Change this value to 4 and click Apply. Figure 8-4 shows this window 
in its completed state.
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Figure 8-4. Runtime Parameters Well Map Settings window

This instructs WinPREP to transfer liquid from well one in the source plate to 
well one in the destination plate, well two in the source plate to well two in the 
destination plate, etc.

11. Select Parameters in the Type drop-down list. The window displays the 
runtime parameters for the procedure.

12. Set the Gets Data From value of the Number of Samples parameter to 
File: Records. This allows WinPREP to determine the number of samples to 
process from the number of records in the worklist file. The File or Variable 
column updates to include the name of the worklist file and the Preview of 
pane displays a preview of the records in the worklist.

 Note: Because you associated the worklist file with a runtime parameter 
(Number of Samples), the In Use option on the Runtime File Definitions 
window is marked with a red check mark.

13. Set the Gets Data From values for Asp. Sample Id and Dispense Volume 
parameters to File: Column. The File or Variable value updates to the name 
of the worklist file and the Column # or Keyword value updates to the 
numerical value one. Since the aspirate sample ID and dispense volume for 
the samples is in column two and three of the worklist, set the Column # or 
Keyword for Asp. Sample Id to 2 and Dispense Volume to 3.

14. Click Apply. The worklist is statically linked to the protocol procedure.

15. Click Close to close the Single Liquid Parameters window.

When you run this protocol, WinPREP reads and processes the data in the file. As 
long as the file name and location stay the same, you can process new samples 
by updating the data in the file.

 Note: When you set up the protocol, you specified the column numbers for input 
controls. For this reason, the order of the columns in the worklist file is 
important; you can change the data in the worklist but the arrangement of 
columns must be the same as the original worklist file.
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Dynamically Link a Worklist

In the previous example, you statically linked a worklist to the protocol outline. 
This method saves you the trouble of having to create a new protocol for the 
specified data and separates the protocol procedure from the data. You only need 
to update the worklist file when you want to process new data. This works fine for 
single protocols or protocols you run infrequently. However, instead of statically 
linking the worklist to the protocol, you can design the protocol so it queries for the 
worklist at runtime. This provides a whole new level of flexibility to your processing 
flow. You can set up and configure a protocol once and then dynamically select 
the sample data you want to process. Even though the data in the worklist 
changes, the protocol can process it, as long as the structure of the worklist 
remains the same.

To use the worklist, you must set up the protocol to prompt for a worklist file at 
runtime as described below.

To query for a worklist in a protocol:

 Note: The steps below assume you are setting up a Single Liquid Transfer 
procedure to use a worklist and that the worklist you want to use already 
exists. The data included in the worklist includes source labware name, 
source labware sample position, transfer volume, and destination labware 
name. Figure 8-5 shows the worklist (SLTInputData.csv) used in these 
examples.

Figure 8-5. Worklist Example (SLTInputData.csv)

1. Open the desired protocol in WinPREP.
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2. Make sure you have two liquid containers such as test tube racks, 
microplates, etc., on the deck: one named Source and one named 
Destination. The Single Liquid procedure also requires a Flush/Wash station.

 Note: To name labware, place the labware on the deck, double-click the item, 
type the name in the Name field on the labware Parameters window, and 
click OK. When you hover the cursor over the labware, the Tooltip displays 
the new name, along with other information about the labware.

It is important to note the names of the source and destination labware on the 
deck must match the names in the worklist file exactly. If they do not match, 
WinPREP cannot perform the requested pipetting steps.

3. Double-click the Single Liquid_1 procedure node you want to link with the 
worklist. The procedure parameters window opens.

4. On the Overview tab, set the Gets Data From fields for Number of Samples 
parameter to File: Records, the Asp. Sample Id parameter to File: Column, 
and the Dispense Volume (µL) parameter to File: Column and click Apply. 
Figure 8-6 shows a completed example of this window.

Figure 8-6. Single Liquid Parameters Settings

By setting the Number of Samples field to File: Records, WinPREP 
determines the number of samples to process by counting the number of 
records in the worklist file. This provides a way to dynamically determine the 
number of samples to process with each run of the protocol.

5. Select the Runtime Parameters tab and click the Variables button to open 
the Runtime Variables Definitions window.

6. Click the Add button to insert a new row in the Defined Variables table.



 Chapter 8: Worklists 226

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

7. Type Select_Worklist in the Variable Name field and click OK to create the 
variable and return to the Runtime Parameters tab.

 Note: Variable names cannot contain spaces. Use the underscore (_) to denote 
spaces in variable names.

Figure 8-7 shows the complete Runtime Variables Definitions window.

Figure 8-7. Runtime Variables Definitions

8. Click the Files button to open the Runtime File Definitions window.

Because you set the parameters on the Overview tab to File: Column, the 
software created a “placeholder” entry in the Defined Files table.

9. Set the File or Variable field to Var: Select_Worklist for the row you inserted 
and click OK to return to the Runtime Parameters tab.

10. For the Number of Samples parameter, set the File or Variable column to 
Select_Worklist. The Get Data From field for this parameter is already set to 
File: Records, because you selected this option on the Overview tab.

11. For both the Asp. Sample Id and Dispense Volume parameters, set the Gets 
Data From column to File: Column and the File or Variable column to 
Select_Worklist.

12. For the Asp. Sample Id and Dispense Volume parameters, set the Column 
# or Keyword column to 2 and 3, respectively. Figure 8-8 shows a completed 
example of this window.

Figure 8-8. Runtime Parameters

13. Select Well Maps in the Type drop-down list.
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14. For the Asp. Well Map and Dsp. Well Map parameters, set the Gets Data 
From columns to File: Column. The File column updates to contain the 
Select_Worklist runtime variable name, as shown in Figure 8-9.

Figure 8-9. Runtime Well Map Parameters

15. For the Asp. Well Map parameter, set the Rack Name Column # and 
Position Column # columns to 1 and 2, respectively. This tells the software 
where in the worklist to find the well map information for the aspirate step of 
the procedure.

16. For the Dsp. Well Map parameter, set the Rack Name Column # and 
Position Column # columns to 4 and 2, respectively. This tells the software 
where in the worklist to find the well map information for the dispense step of 
the procedure.

17. Click OK to save the changes and close the properties window.

18. Double-click the Initial User Query node in the protocol outline. The Initial 
User Query Parameters window opens as shown in Figure 8-10.
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Figure 8-10. Initial User Query Parameters

19. Click the Add button under Pages in User Query Dialog to add a new query 
page. The query page is used to prompt for the worklist at runtime.

20. Type Select Worklist in the Page Label column and click the Add button in the 
Prompts for Page 1: “Select Worklist” frame.

21. Set the Variable Name field to Select_Worklist and click the button in the 
Enter Via column to open the Enter Via window shown in Figure 8-10.

Figure 8-11. Enter Via window
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22. Select the File Browser tab, type Open Worklist in the Dialog Title field, and 
click the Edit button to the right of the File Filters field. The File Selection 
Filter(s) window opens as shown in Figure 8-12.

The file browser allows you to prompt with a standard Windows file browser to 
locate and select the worklist file. File filters limit the files that display in the file 
browser to one or more file extensions.

23. Click the Add button to insert a new filter row, type Comma Separated Values 
(CSV) (*.csv) in the Description field and *.csv in the Value field, and click the 
Move Row Up button to move the row to the top of the list. Figure 8-12 shows 
the File Selection Filter(s) window in its completed state. Click OK to save 
the changes and return to the Enter Via window.

Figure 8-12. File Selection Filter(s) window

24. Type the path to the folder where you want the file browser to start in the Init. 
Directory field. This specifies the folder that opens in the file browser when it 
starts.

 Note: If you do not enter a value in the Init. Directory field, the initial folder 
defaults to the \Bin\ folder in the WinPREP installation folder.

Figure 8-13 shows the Enter Via window in its completed state.

Figure 8-13. Enter Via window

25. Click the Test button to preview how the file browser looks and works. When 
you are done previewing the file browser, click Cancel to return to the Enter 
Via window.
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26. Click OK to save the changes and return to the Initial User Query 
Parameters window.

27. Click OK to save the changes and close the Initial User Query Parameters 
window.

28. Select Run > Evaluate Protocol to view the window in the protocol. This 
operation executes the steps in the protocol without actually moving the 
equipment or pipetting liquids. Figure 8-14 shows a worklist query window at 
runtime.

 Note: If you prompt for a worklist in the protocol, each of the potential worklist 
files must follow a consistent format. For instance, in this example, sample 
ID and volume of liquid to transfer occupy columns one and two in the file, 
respectively. Any future files must follow the same convention; they must 
contain the sample ID in column one and the volume of liquid to transfer in 
column two.

Figure 8-14. Query for Worklist windows

Each time the protocol runs, the user is prompted for the input worklist.
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Chapter 9

JANUS Security
System security for the JANUS G3 Automated Workstation, the WinPREP 
software, and the JANUS Application Assistant software is handled through the 
standard Windows User Account security. Security and privilege access is 
controlled through password protected user log in. Three levels of security access 
for user accounts are created when WinPREP is installed:

• Packard User
• Packard Administrator
• Packard TSE

Each security level allows increased accessibility to the system over the previous 
level, with Packard TSE having the greatest control. You can create as many 
users as necessary to maintain security and usability of the system. System 
administrators can create or modify User Accounts with the User Manager 
program, one of the standard Administrative Tools provided with the Windows 
operating system.

In addition to the standard Windows User Account security, PerkinElmer offers the 
JANUS Enhanced Security Option, which provides 21 CFR Part 11 compatibility. 
For more information, see the documentation that is included with the JANUS 
Enhanced Security Option integration kit.

This section contains the following information:

• Security Levels on page 232
• Assigning Local Users to JANUS Security Groups on page 234
• Assigning Domain Users to JANUS Security Groups on page 238
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Security Levels
The sections below describe each of the three levels of security access in detail. 
The JANUS Security levels only affect access to WinPREP and JANUS 
Application Assistant. Other programs are not affected by the JANUS security.

Packard User
Packard User level has the most restricted accessibility to the system. These 
users can open and run protocols that are already defined. They cannot modify 
the protocols or change any parameters except for those that require a runtime 
response. This group can also access system setup and diagnostic tests.

Packard Administrator
Packard Administrator level has permission to create, open and run protocols as 
necessary for the administration of the system. This group also has access to 
calibration, setup and performance file utilities that are required to ensure proper 
operation of the system.

 Note: Packard Administrator level does not include system administrator 
permissions. If this is desired, make the user account a member of both 
the Packard Administrator and the Administrators groups.

Packard TSE
Packard TSE level is intended only for use by the PerkinElmer Technical Service 
Engineer. An account for this purpose is automatically created on installation to 
allow password access by appropriate personnel for setup and maintenance 
purposes. This user has all of the Packard Administrator privileges plus access to 
additional service utilities for system calibration, configuration, and 
troubleshooting.

When the Technical Service Engineer logs into Windows with Packard TSE level, 
they have unrestricted access to all functions of the WinPREP software and the 
service utilities. 

 Note: Packard TSE group does not include system administrator permissions. If 
this is desired, make the user account a member of both the Packard TSE 
and the Administrators groups.
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The table below summarizes the functionality available for each security level:

Creating or Modifying User Accounts
To add a new user for the JANUS G3 Automated Workstation, you must have 
Windows System Administrator privileges on the computer. Only System 
Administrators can create or modify User Accounts.

When the WinPREP software is originally installed, three new Local Groups are 
created. By making a user account a member of one of these three groups, the 
user’s access to features in the WinPREP software and the JANUS Application 
Assistant software is defined. Each level of security builds on the previous level, 
so you do not need to add more than one of the defined security groups to a User 
Account.

Task Packard
User

Packard
Admin

Packard
TSE

Open existing protocols in WinPREP or 
JANUS Application Assistant Yes Yes Yes

Respond to User Query prompts for 
runtime parameters Yes Yes Yes

Execute protocols Yes Yes Yes

Save protocols in WinPREP No Yes Yes

Modify existing protocol outlines No Yes Yes

Add labware to the deck view No Yes Yes

Modify existing deck layouts No Yes Yes

Evaluate protocols Yes Yes Yes

Edit the Labware Library No Yes Yes

Edit the Performance Set Library No Yes Yes

Perform Utilities-Setup functions Yes Yes Yes

Perform Utilities-Diagnostic Tests 
functions Yes Yes Yes

Perform Utilities-Database maintenance 
functions Yes Yes Yes

Run service utilities for configuration, 
calibration and troubleshooting No No Yes
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Users can be local users that are only defined by a Local user account on the 
computer, or domain users that have a user account on the domain that is used to 
log into the local computer. See the appropriate section below for details on 
assigning a user account to a JANUS security group:

• Assigning Local Users to JANUS Security Groups on page 234
• Assigning Domain Users to JANUS Security Groups on page 238

Assigning Local Users to JANUS Security Groups
This section explains how to change the Security Group for a Local User. This 
procedure can only be performed by a user with Packard Admin or Packard TSE 
permissions.

1. Click the Windows Start button.

2. Right-click on Computer and then click Manage in the shortcut menu. The 
Computer Management window opens.

Figure 9-1. Computer > Manage

3. Navigate to Local Users and Groups > Users.
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Figure 9-2. Users Folder

4. Double-click the Name of the User to change the security group. The 
Properties window for the selected user opens as shown in Figure 9-3.

Figure 9-3. User Properties Window

5. Click the Member Of tab.
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Figure 9-4. Member Of Tab

6. Click the Add button. The Select Groups window opens.

7. Click the Advanced button (see Figure 9-5) to search for the desired group.

Figure 9-5. Select Groups Window - Advanced Button

8. Click the Find Now button. All Groups defined on the computer display at the 
bottom of the window as shown in Figure 9-6.
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Figure 9-6. Find Now-Search Results

9. Double-click the Security group to add the group to the selected user, or 
highlight multiple groups and click the OK button. (See Security Levels on 
page 232 for details about the permissions for each security group.) The 
Select Groups window displays the selected security groups.

10. Click the OK button to display all groups assigned to the user in the Member 
Of list as shown in Figure 9-7.
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Figure 9-7. New security Groups Added

11. Click the OK button to save the changes.

 Note: To remove a security group from the user, highlight the group in the 
Member Of list and click the Remove button.

 Note: The security group changes will take affect the next time the user logs in.

Assigning Domain Users to JANUS Security Groups
This section explains how to assign a Domain User to a JANUS Security Group. 
This procedure can only be performed by a user with Packard Admin or Packard 
TSE permissions.

1. Click the Windows Start button.

2. Right-click on Computer and then click Manage in the shortcut menu. The 
Computer Management window opens.

3. Navigate to Local Users and Groups > Groups.

4. Double-click the Name of the Local Group that you want to assign the user to 
(Packard Admin, Packard User, or Packard TSE). The Properties window for 
the selected group opens.

5. Click the Add button. The Select Users, Computers, Service Accounts, or 
Groups window opens.
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6. Click the Advanced button.

7. Verify the domain for the user account is listed in the From this location text 
box. If necessary, click the Locations button and select the correct location.

8. Click the Find Now button. All users defined on the specified domain display 
at the bottom of the window. If desired, use the Name and Description filters to 
locate the desired user.

9. Double-click the user name to add the user to the selected group, or highlight 
multiple users and click the OK button. (See Security Levels on page 232 for 
details about the permissions for each security group.) The Select Users, 
Computers, Service Accounts, or Groups window displays the users selected 
to add to the group.

10. Click the OK button to display all of the users in the group in the Properties 
window for the group.

11. Click the OK button to save the changes.

 Note: To remove a user from the security group, highlight the user in the 
Members list and click the Remove button.

 Note: The security group changes will take affect the next time the user logs in.



PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Chapter 10

Reports
WinPREP tracks and maintains data about the protocols you run on the 
instrument. The software installation included a full version of Microsoft Access, 
which WinPREP uses as its database and reporting engine. Several reports, 
useful for auditing and tracking, are included with WinPREP. The tools built into 
Microsoft Access can be used to create custom reports.

This section contains:

• Protocol Activity Reports on page 240
• Adding Reports on page 242
• Viewing Reports on page 243
• Purge Protocol Reporting Data on page 245
• Custom Reports on page 246
• Writing Custom Queries on page 249

Protocol Activity Reports
When you run a protocol, WinPREP logs information about the equipment and 
protocol in its database. This data is the basis for a variety of protocol activity 
reports. These reports, which summarize information about the protocol runs, 
provide a historical record of the instrument’s operation and usage.

The reports provided with the instrument are grouped into the following general 
categories:

• Protocol Summary Report
There are multiple versions of this report; each contains the same information 
but uses different sort criteria to display the data. The report can be sorted by 
Source Rack ID, Destination Rack ID, or Comma Delimited. You can output 
these reports to screen, printer, or file.

• Labware Movements Report
There are two versions of this report; each contains the same information but 
uses different sort criteria to display the data. The report can be sorted by 
Labware ID or Chronologically. You can output these reports to screen, printer, 
or file.
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• Labware Movements and Pipetting Chronological Report
This report comes in a single version, sorted chronologically by Labware 
Movements and Pipetting. You can output this report to screen, printer, or file.

• Error Report
There are multiple versions of this report; each contains the same information 
but uses different sort criteria to display the data. The report can be sorted by 
Well Position, Sample ID, Component, Showing Preceding Operation, or All 
Operation Errors. You can output these reports to screen, printer, or file.

• Dispense Volume Report
There are multiple versions of this report; each contains the same information 
but uses different sort criteria to display the data. The report can be sorted by 
Sample Rack Well, Rack Well Sample, or Chronological by Tip. You can 
output these reports to screen, printer, or file.

• Aspirate Dispense Volume Report
There are two versions of this report; each contains the same information but 
uses different sort criteria to display the data. The report can be sorted by 
Sample Rack Well or Chronological by Tip. You can output these reports to 
screen, printer, or file.

In addition to the reports, two queries are provided with the software:

• _DispenseVolumeQueryForTestId
This query extracts the dispense volume data for a specific protocol ID. You 
can output the results of this query to screen, file, or Excel. If you choose to 
output the files in Excel, the query opens Excel and displays its results in a 
new spreadsheet window.

• _AspirateDispenseVolumeQueryForTestId
This query extracts the aspirate and dispense volume data for a specific 
protocol ID. You can output the results of this query to screen, file, or Excel. If 
you choose to output the files in Excel, the query opens Excel and displays its 
results in a new spreadsheet window.

The sections below describe how to add reports to the protocol outline, view 
reports, purge protocol reporting data, and create custom reports.
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Adding Reports
You can configure the protocols to create one or more reports automatically. This 
configuration allows you to send the automatically generated reports to the 
screen, to a file, or to the default printer. You assign automated report generation 
on a protocol-by-protocol basis, so you can automatically generate reports for 
some protocols and not others. To automate report generation, you must 
associate one or more reports with the protocol outline by adding them to the 
Protocol Outline node as described below.

To add a report to a protocol:
1. Double-click the Protocol Outline node in the protocol outline to open the 

Protocol Outline Parameters window shown in Figure 10-1.

Figure 10-1. Protocol Outline Parameters Window

2. Select either Yes or Yes, but purge the protocol after reports are generated in 
the Log Activity drop-down list. Selecting Yes records the protocol data in the 
database for later reporting. You can generate reports from this data until you 
purge it from the database. Selecting Yes, but purge the protocol after reports 
are generated records the protocol data, immediately generates the selected 
reports, and deletes the data from the database. With this option, the 
generated reports are the only record of the protocol. If you choose No for the 
Log Activity option, WinPREP will not record the protocol data.

3. Click Add in the Protocol Database Reports frame to add a report option to 
the table.
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4. Set the Generate Reports option to the name of the desired report. If you are 
not sure which report you want to include, click Preview to open the database 
and to generate an example of one or more reports using data from previous 
protocols.

5. Select the desired output format in the Send To drop-down list. You can 
choose to send the report to the screen, save it to a file, or print it to the default 
printer. selecting File as the Send To value enables the File Name and 
Append Id columns in the table. Type a file name, including path, in the File 
Name field, or use the Browse button to select the desired output file. When 
selected, the Append Id option adds the protocol identification number from 
the database to the file name you supply.

6. Repeat step 3 through step 5 until the table includes all the desired reports.

7. Click OK to save the settings and close the window or click Apply to save the 
settings without closing the window.

Viewing Reports
By default, WinPREP logs information about each protocol in a database; viewing 
reports is a manual process. You must open the database, select the desired 
protocol, and generate one or more reports. However, you can configure 
WinPREP so it generates and saves reports to a file or displays them on the 
screen as the protocol runs. Since you configure and apply these settings in the 
protocol outline, you can customize the reporting setup for each protocol. This 
provides a great deal of flexibility.

Manually Viewing Reports

You can manually generate, view, print, and save reports based on the recorded 
information. These reports are installed with the software and display data 
recorded by WinPREP during a protocol run.

To manually view reports:
1. Click the Microsoft Access icon on the WinPREP toolbar to open the reporting 

database.

2. Select the name of the protocol you want to view in the Protocol Selection 
frame.

3. Select the desired report or query from the Report/Query/Action Selection 
drop-down list.
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4. Select the format for the report in the Output Selection drop-down list.

 Note: If you selected File in the Output Selection list, WinPREP opens a Save 
As window. Browse to the desired location, type a file name, and click 
Save to close the window. The Output File field on the database window 
updates to display the path and filename for the file you entered.

5. Click Apply to generate the report. Note that:

— If you selected Screen as the Output Selection type, Microsoft Access 
displays the formatted report in a new window where you can print or view 
the report.

— If you selected File as the Output Selection type, Microsoft Access saves 
a plain text file to the specified location.

— If you selected Print as the Output Selection type, Microsoft Access 
sends a copy of the formatted report to the default printer.

— If you selected Excel as the Output Selection type, Microsoft Access 
opens Microsoft Excel and displays a tabular list of the report data. Excel 
is only available when you select one of the query types in the Report/
Query/Action Selection list.

6. Repeat steps 2 through 5 to generate each of the reports you want.

7. Click Exit to close Microsoft Access when you are finished generating and 
viewing reports.

Viewing Reports after each Run

As described in the previous section, you can manually generate and save reports 
for any protocol, as long as the protocol data is in the database. However, you 
might want a report of the protocol execution without storing the data in the 
database. In this case, you can configure WinPREP to generate a set of reports, 
and purge the data recorded during the protocol run, when the protocol 
completes.

To automatically create reports at protocol completion:
1. Double-click the Protocol Outline node in the protocol outline to open the 

Protocol Outline Parameters window.

2. Make sure the Log Activity option is set to the Yes, but purge the protocol 
after reports are generated or the Yes option. 

3. Use the Add and Remove buttons to select the desired reports in the 
Protocol Database Reports frame. See Adding Reports on page 242 for 
more information.



 Chapter 10: Reports 245

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

4. Set the Send To, File Name, and Append Id options, as required.

 Note: If the file specified in the File Name field already exists, the new file will 
overwrite the contents of the existing file.

5. Click OK to save the settings and close the window or click Apply to save the 
settings without closing the window.

6. Save and run the protocol. The software executes the protocol and generates, 
saves, and displays the reports and queries you configured for the protocol.

Purge Protocol Reporting Data
Because WinPREP tracks and logs information about each protocol you run, the 
database can become very large over time or after many protocol operations. This 
size increase can negatively affect database performance. It is a good idea to 
periodically clear the database of unnecessary protocol data. You should also 
regularly compress the database to keep its overall size manageable, or you can 
configure WinPREP to purge protocol data from the database automatically. For 
more information, see Viewing Reports after each Run on page 244.

To manually purge protocol data from the database:
1. Click the Microsoft Access icon on the WinPREP toolbar or select 

Utilities > Database from the main menu to open the reporting database.

2. Select the name of the protocol you want to purge in the Protocol Selection 
frame.

3. Click the Purge button. WinPREP deletes the information for the selected 
protocol from the database.

 Caution: Take care when using the purge operation. There is no way to recover 
protocol reporting data after you purge it from the database.

4. Repeat step 2 and step 3 to delete the remaining unnecessary report data. 
You can select multiple items by holding down the <Shift> key while clicking.

5. Click Exit to close the database.

To compress the database:
1. In WinPREP, hold down the <Shift> key and click the Microsoft Access icon or 

use Windows Explorer to navigate to the location where the database is 
located (in the database/ folder of the WinPREP installation folder). Hold down 
the <Shift> key and double-click the Microsoft Access icon.

This bypasses the reporting interface and opens the Microsoft Access object 
browser window.
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2. Select Tools > Database Utilities > Compact and Repair Database from 
the menu bar. Access may display a Security Warning window, advising you 
that the file may not be safe. Click Open to close this window.

Microsoft Access reads through the file and attempts to compact the data and 
structures in the database. It is possible to get a significant amount of 
compression of the data using this method.

 Caution: The time required to compress the database can vary considerably based 
on factors such as the size of the database at the time you perform the 
compression.

Custom Reports
Because WinPREP uses Microsoft Access as its data store and reporting engine, 
there are a wide range of reporting options available. The software comes with 
several pre-built report templates and you can create custom or specialized 
reports to suit your needs.

Microsoft Access provides two ways to create custom reports: the report wizard 
and the report designer. The report wizard automates the process of designing a 
report by presenting a series of options, such as the tables or queries containing 
the data and the fields you want to include on the report. The selections to these 
options provide the information the wizard needs to build the report. Once 
created, you can further customize the report using the report designer. The 
wizard is the quickest and easiest way to create a customized report; however, it 
does not provide the same level of fine control as using the designer.

The report designer provides the tools you need to build the report manually. 
Using a point-and-click interface, you can configure nearly every aspect of the 
report including page layout, header and footer content, data content, and text 
formatting. While it requires more work than the wizard, it grants you complete 
control over the look and content of the report.

Often, some combination of the report wizard and the report designer is the 
easiest way to create a customized report. You can use the report wizard to 
quickly generate the report and then use the report designer to organize and 
rearrange the page layout or data content to meet your needs.

Detailed explanations of the report wizard and the report designer are beyond the 
scope of this document. If you have questions about the report designer or report 
wizard when completing the procedures below, refer to the online help provided 
with Microsoft Access.
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To create a custom report using the report wizard:
1. <Shift> + click the Microsoft Access icon on the WinPREP toolbar to open the 

reporting database. This bypasses the reporting interface and opens the 
Microsoft Access object browser window shown in Figure 10-2.

Figure 10-2. Microsoft Access Object Browser window

2. Select Reports from the Object column on the left side of the window. The 
browser portion of the window updates and displays a list of all the available 
report layouts.

3. Double-click Create report by using wizard in the object browser list box.

4. Select the source of the data (table or query) from the Tables/Queries drop 
down list, move the fields you want to include on the report from the Available 
Fields list box to the Selected Fields list box, and click Next.

5. Select the grouping levels for the report, as desired, and click Next.
6. Select the sort order for the detail lines on the report, as desired, and click 

Next.
7. Select the Layout and Orientation options for the report and click Next. As 

you select layout options, the preview pane updates and displays a simplified 
view of the selected report.

8. Select a style for the report and click Next. The style controls the colors, 
images, and backgrounds used on the report. As you select style options, the 
preview pane updates and displays a simplified view of the selected style.

9. Type a title for the report, click the Preview the Report option, and click 
Finish. WinPREP saves the custom report and opens it for preview in a new 
window.

 Caution: Be sure to select a unique name for the custom report. If you do not, the 
custom report will overwrite any existing report with the same name.
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10. The report is available in the Generate Reports list on the Protocol Outline 
Parameters window.

To create a custom report using the report designer:
1. <Shift>-click the Microsoft Access icon on the WinPREP toolbar to open the 

reporting database. This operation bypasses the reporting interface and 
opens the Microsoft Access object browser window. (See Figure 10-2 for an 
example.)

2. Select Reports from the Object column on the left side of the window. The 
browser portion of the window updates and displays a list of all the available 
report layouts.

3. Double-click Create report in design view in the object browser list box. 
Access opens a new, blank report design window.

4. Design the report as desired using the tools in the report designer tool box. 
For information about using the report designer, including tools, consult the 
Microsoft Access online help.

5. Select File > Save As to save the file.

6. Type a name for the custom report and click OK.

 Caution: Be sure to select a unique name for the custom report. If you do not, the 
custom report will overwrite any existing report with the same name.

7. Continue designing the report until you are satisfied with the way it looks, save 
the changes, and close the report designer window.

8. Double-click the report in the object browser list box to open and populate the 
report with the data you specified.

9. The report is available in the Generate Reports list on the Protocol Outline 
Parameters window.
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Writing Custom Queries
Queries are typically used to output columnar data without any special formatting. 
This data can then be viewed on screen, exported to a file or exported directly to 
Excel for further analysis. The following steps describe how to write your own 
query in Access:

1. Name the query. The name must begin with an underscore (_) character. Only 
queries beginning with the underscore character will display in the Report/
Query/Action Selection frame of the Database Operations window.

2. Filter the query. To filter the query to include only the selected protocolId, you 
must:

• Include “protocolId” as one of the columns returned by the query.
• Create a form with a name that is the same as the query, with the name 

preceded by the word “Form”. For example, if the query name is 
“_UserQuery”, the form name must be “Form_UserQuery”.

• Include “protocolTbl.protocolId” as one of the columns returned by the 
query, if the query output is directed to a file.

3. Open the Microsoft Access form named “registers”. This action “registers” the 
query so that it is available in the WinPREP Protocol Outline Parameters 
window Generate Reports list.
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Chapter 11

Labware Libraries
The Labware Library is used to create and edit labware used in the WinPREP 
software This section describes how to use the labware library.

WinPREP labware is an electronic representation of the physical laboratory 
equipment used on the instrument deck during a protocol. Labware includes test 
tubes, test tube racks, microplates, support tiles, flush/wash stations, and many 
other types of common laboratory equipment. WinPREP groups similar types of 
labware into categories. Labware is assigned to a category when the labware is 
created. The labware categories make it easier to locate the desired labware.

WinPREP provides an extensive library of predefined labware items. Although the 
predefined labware will meet many of your needs, you may require labware that is 
not defined in the library. Before you can use new labware with the JANUS G3, 
you must define the physical dimensions of the labware so that the JANUS G3 
can accurately access the labware.

This section contains the following procedures:

• Viewing the Labware in the Labware Library on page 251
• Creating New Labware on page 252

— Copy an Existing Labware Definition on page 252
— Create a New Labware Definition on page 253
— Open the Labware Properties Window on page 259
— Set the Labware Properties in the Details Tab on page 261
— Evaluate the Labware on page 262

• Editing Labware on page 264
• Creating Custom Labware Images on page 264
• Importing Labware Definitions on page 267
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Viewing the Labware in the Labware Library
The Labware Library window enables you to view the labware assigned to each 
labware category, to add new labware, or to edit existing labware.

To view labware in the Labware Library window:

1. Select Utilities > Labware Library on the main menu. The Labware Library 
window opens as shown in Figure 11-1. The Labware Library window lists all 
of the defined labware categories on the left side of the window.

Figure 11-1. Labware Library window

2. Select a category in the Category list. The Available list displays all of the 
labware in the selected category. (Labware can only be included in one 
category.)

3. If you want to edit a labware item or view the labware parameters, select the 
labware name and click the Edit button. See Editing Labware on page 264.

4. If you want to create a new labware item, click the New button. You do not 
have to select a category or labware name. The New Labware Wizard opens. 
See Creating New Labware on page 252.

5. If you want to import labware definitions from another JANUS G3 system or a 
MultiPROBE II system, click the Import button. See Importing Labware 
Definitions on page 267.
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Creating New Labware
The New Labware Wizard provides a step-by-step process to define new 
labware for the system. You can create a new labware definition either by basing 
the new labware on an existing labware item or by manually selecting the options 
for the new labware. 

The New Labware Wizard asks you a series of questions about the general layout 
of the labware. As you respond to these questions and click the Next button, you 
proceed through a series of pages with questions appropriate to the selections 
you made on previous pages. The next page in the wizard depends on the 
responses to previous pages. To change the selection on a previous page, click 
the Back button one or more times to return to previous pages. On the final 
window, click the Finish button to save the labware with the selections.

After completing the New Labware Wizard, use the Labware Properties window 
to define the critical dimensions of the labware. You can use the Evaluate tab to 
actually move a tip or arm to the desired position or you can use the Details tab to 
enter physical measurements. In either case, you need to provide data for all the 
critical parameters listed on the left side of the Details tab.

Overview of creating new labware:
1. Follow the instructions in Viewing the Labware in the Labware Library on 

page 251 to open the New Labware Wizard.

2. Choose whether to base the new labware on existing labware:

• See Copy an Existing Labware Definition on page 252 to base the new 
labware on an existing labware definition.

• See Create a New Labware Definition on page 253 to create a new 
labware item.

3. When the New Labware Wizard is complete, see Set the Labware Properties 
in the Details Tab on page 261 and Evaluate the Labware on page 262 to set 
additional labware parameters.

4. If a Gripper arm is installed, see Editing Labware on page 264 to verify and 
adjust the labware parameters for the gripper.

Copy an Existing Labware Definition

You can copy an existing labware definition and use it as a starting point for a new 
labware definition. The overall layout of the new labware will be the same as the 
one that you copy. The specific details of the labware, wells, and well spacing can 
be modified as necessary to describe the new labware.
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To create new labware by copying an existing definition:
1. Select Utilities > Labware Library from the main menu to open the Labware 

Library window.

2. Click the New button to start the New Labware Wizard.

3. Select the Yes option to indicate that you want to copy the new definition from 
an existing definition and click Next.

4. In the Copy Definition From text box, type the name of the definition file (.lab) 
you want to copy or use the browse button to choose the file name of existing 
labware.

5. In the Save Labware with Name text box, type the name for the new file, or 
use the browse button to select the location and filename for the new file, and 
click Next. All labware definition files should be located in 
C:\Packard\JANUS\Labware Files.

 Caution: Be sure to provide a unique file name for the new file. If you use the name 
of an existing labware definition file, the new file will overwrite the existing 
file. The specified name is the filename for the saved definition file and 
also identifies the labware in the selection drop-down lists on the Add 
Labware and Labware Library windows. Use a name that is descriptive 
enough for future reference and identification.

6. Click Finish to complete the wizard. The new labware is an exact copy of the 
existing labware and is added to the same category as the definition you 
copied. To change or verify the labware parameters, see Set the Labware 
Properties in the Details Tab on page 261 and Evaluate the Labware on 
page 262.

Create a New Labware Definition

If you want to define new labware that is not based on existing labware, you must 
specify all aspects of the labware layout before you can define the specific details 
of the labware, wells, and well spacing.

To create new labware:
1. Select Utilities > Labware Library to open the Labware Library window.

2. Click the New button to start the New Labware Wizard.

3. Select the No option to indicate that you do not want to copy the new definition 
from an existing definition and click Next.
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4. Select the desired Labware Type:

• Plate/Rack - Use for labware that contains multiple, definable sample 
positions. This can be a regular repeating pattern of sample positions or a 
random positioning with various sized wells. This labware type includes 
microplates of various configurations, test tube racks, vial racks, and 
similar devices.

• Support - Use for deck supports that position the actual labware on the 
deck. Supports have locating pins to ensure accurate positioning on the 
deck and labware guides to ensure that the labware is always positioned 
consistently in the support.

• Multi-Function - Use for labware with a standard frame to simultaneously 
hold multiple kinds of labware with different functions. The functions 
available for placement in these frames are Wash Bowls, Reagent 
Troughs, and Tip Chutes. You must define the combination of functions for 
the new labware. Most functions are predefined for each layout, but you 
can make any required changes while defining the labware.

• Bar Code Cassette - Use for the specific rack that moves labeled tubes in 
front of the bar code scanner. These predefined racks can only be used in 
the bar code lanes on the deck.

5. Select the category for the new labware in the Category drop-down list or type 
a new category name to create a new category.

6. Type the desired name for the new labware in the Name text box. The name 
cannot include special characters such as commas, colons, slashes, etc. To 
change the location of the new labware file, click the Browse button and 
specify the location and file name. The default location for labware files is 
C:\Packard\JANUS\Bin.

 Caution: Be sure to provide a unique file name for the new file. If you use the name 
of an existing labware definition file, the new file will overwrite the existing 
file. The specified name is the filename for the saved definition file and 
also identifies the labware in the selection drop-down lists on the Add 
Labware and Labware Library windows. Use a name that is descriptive 
enough for future reference and identification.

7. Click Next. If you are defining Support or Bar Code Cassette labware, the 
definition is complete. The Last Page of the New Labware Wizard opens and 
displays a reminder that the labware dimensions and well locations need to be 
evaluated. Click the Finish button and see Set the Labware Properties in the 
Details Tab on page 261 and Evaluate the Labware on page 262.

If you are defining Plate/Rack or Multi-Function labware, see Defining New 
Plate/Rack Labware on page 255 or Defining New Multi-Function Labware on 
page 257.
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Defining New Plate/Rack Labware
This section assumes you selected Plate/Rack as the Labware Type on the 
previous wizard screen. If not, go back to Create a New Labware Definition and 
locate the section for the selected labware type.

To define new Plate/Rack labware, the wizard guides you through the process of 
configuring the support requirements, well configurations, and well details.

Continuing from the steps in Create a New Labware Definition:

1. Select the Support Requirements for the new labware:

• Does Not Require Support - Choose this setting if the labware is self 
positioning and does not require the use of any support labware. A typical 
example of labware that does not require a support is a test tube rack or 
the standard wash bowl.

• Labware Requires Support - Choose this setting if the labware requires a 
support to be placed on the deck. The support labware generally ensures 
the deck position of the labware, and can hold the labware at specific 
heights for the protocols. Typical examples of labware that require a 
support are microplates or disposable tip boxes.

2. Click Next.
3. Select the Well Configuration of the new labware:

• Row/Column - Choose this setting if the labware uses a regular repeating 
pattern of sample positions in rows and columns. All sample positions 
must be the same size and shape with consistent spacing throughout the 
rack. Staggered columns are allowed if the offset is uniform.

• Circular - Choose this setting if the sample positions are oriented in a 
circular pattern. All sample positions must be the same size and shape 
with consistent spacing in the circle. This layout only supports single 
circles; concentric circles are not supported.

• Custom - Choose this setting if the layout of the labware is not regular or if 
the well sizes are not uniform. You must define the size, shape, and 
location of each well individually.

4. Click Next.
As described in Create a New Labware Definition, the selections on each 
window determine the path the wizard takes. When you click Next after 
selecting the Well Configuration, you must complete additional setup steps. 
These additional steps are similar for each configuration, and any differences 
in the wizard path are noted.
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5. For Row/Column well configurations, specify the well options:

• Number of Columns - Specifies the number of columns on the new 
labware. Set the value to the number of columns on the new labware.

• Number of Rows - Specifies the number of rows on the new labware. Set 
the value to the number of rows on the new labware.

• Staggered Wells - Specifies that the columns in the new labware are 
staggered. Enable this option if the columns on the new labware are 
staggered.

• Label Wells - Specifies how to identify the sample positions in the new 
labware. You can choose sequential numbering throughout the labware 
(for labware such as test tube racks) or use the row/column labeling 
scheme (commonly used for microplates). Select the option that best 
matches the layout of the labware.

6. For Circular well configurations, specify the well options:

• Number of Wells in the Circle - Specifies the number of wells that make 
up the perimeter of the circle on the new labware. Set the value to the 
number of wells on the labware.

7. For Custom well configurations, use the Add button to insert a row into the 
Custom Well Details table for each well in the labware. Set the following 
options for each well:

• Circular - Specifies the shape of the sample position (well) in the labware. 
Select this check box if the well is round. Clear this check box if the well is 
rectangular.

• Width - Specifies the width of the well in millimeters (mm). If Circular is 
selected for this well, specifies the diameter of the well in millimeters (mm).

• Length - Specifies the length of the well in millimeters (mm). If Circular is 
selected for this well, specifies the diameter of the well in millimeters (mm).

• Tips Per Well - Specifies the number of tips that can access one well at 
the same time. For labware that typically contains sample material, this is 
often a single tip. In this case, enter a numerical value of one. For labware 
intended to hold reagents, the well may be large enough to accommodate 
multiple tips simultaneously. In this case, enter the maximum number of 
tips that can fit into the well at the same time.

8. Click Next. If you are defining Custom well configuration labware, the 
definition is complete. The Last Page of the New Labware Wizard opens and 
displays a reminder that the labware dimensions and well locations need to be 
evaluated. Click the Finish button and see Set the Labware Properties in the 
Details Tab on page 261 and Evaluate the Labware on page 262.

For Circular and Row/Column types, continue with the next step.
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9. Select the well parameters for the labware:

• Circular Wells - Specifies the shape of the sample positions (wells) in the 
labware. Select this check box if the well is round. Clear this check box if 
the well is rectangular. This selection changes the well dimension options 
on the page. You must define the diameter of circular wells or the length 
and width of rectangular wells. All well dimensions are in millimeters (mm).

• Tips per Well - Specifies the number of tips that can access a single well 
at the same time. For labware that typically contains sample material, this 
is often a single tip. In this case, enter a numerical value of one. For 
labware intended to hold reagents, the wells may be large enough to 
accommodate multiple tips simultaneously. In this case, enter the 
maximum number of tips that can fit into a well at the same time.

• Well Diameter - Specifies the diameter of wells on the labware in 
millimeters (mm). Each well must be the same size. This setting is only 
available for circular wells.

• Well Length - Specifies the length of the wells on the labware in 
millimeters (mm). Each well must be the same size. This setting is only 
available for rectangular wells.

• Well Width - Specifies the width of the wells on the labware in millimeters 
(mm). Each well must be the same size. This setting is only available for 
rectangular wells.

10. Click Next. If you are defining Circular or Row/Column well configuration 
labware, the definition is complete. The Last Page of the New Labware Wizard 
opens and displays a reminder that the labware dimensions and well locations 
need to be evaluated. Click the Finish button and see Set the Labware 
Properties in the Details Tab on page 261 and Evaluate the Labware on 
page 262.

Defining New Multi-Function Labware
This section assumes you selected Multi-Function as the Labware Type on the 
previous wizard screen. If not, go back to Create a New Labware Definition and 
locate the section for the selected labware type.

To define new Multi-Function labware, the wizard guides you through the process 
of configuring labware combinations, trough details, and support requirements.
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Continuing from the steps in Create a New Labware Definition:

1. Select the frame/wash bowl/trough configuration that matches the labware 
you are configuring:

• Trough Frame + Wash Bowl - Select this option if one side of the frame 
contains a Wash Bowl and the other side accepts some configuration of 
Reagent Troughs.

• Wash Bowl + Tip Chute - Select this option if one side of the frame 
contains a Wash Bowl and the other side contains a Tip Chute for ejecting 
used disposable tips as waste.

• Trough Frame + Trough Frame - Select this option if both sides of the 
frame accept some configuration of Reagent Troughs.

• Trough Frame + Tip Chute - Select this option if one side of the frame 
accepts some configuration of Reagent Troughs and the other side 
contains a Tip Chute for ejecting used disposable tips as waste.

2. Click Next. If you are defining Wash Bowl + Tip Chute labware, the definition 
is complete. The Last Page of the New Labware Wizard opens and displays a 
reminder that the labware dimensions and well locations need to be 
evaluated. Click the Finish button and see Set the Labware Properties in the 
Details Tab on page 261 and Evaluate the Labware on page 262.

If you are defining Trough Frame + Wash Bowl, Trough Frame + Tip Chute, or 
Trough Frame + Trough Frame labware, continue with the next step. The 
following steps are similar for all types, and any differences in the wizard path 
are noted.

3. Select the number of troughs the trough frame holds and click Next.

 Note: If you selected Trough Frame + Trough Frame in the Multi-Function 
frame, you must specify the number of troughs in both the left and right 
openings of the trough frame.

If you are defining Trough Frame + Wash Bowl or Trough Frame + Tip Chute 
labware, the definition is complete. The Last Page of the New Labware Wizard 
opens and displays a reminder that the labware dimensions and well locations 
need to be evaluated. Click the Finish button and see Set the Labware 
Properties in the Details Tab on page 261 and Evaluate the Labware on 
page 262.

If you are defining Trough Frame + Trough Frame labware, continue with the 
next step.
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4. Select whether or not the labware uses a support under Support 
Requirements:

• Does Not Require Support - Select if the labware is self positioning and 
does not require the use of any support labware.

• Labware Requires Support - Select if the labware requires a support to 
be placed on the deck.

5. Click Next. The definition for Trough Frame + Trough Frame labware is 
complete. The Last Page of the New Labware Wizard opens and displays a 
reminder that the labware dimensions and well locations need to be 
evaluated. Click the Finish button and see Set the Labware Properties in the 
Details Tab on page 261 and Evaluate the Labware on page 262.

Open the Labware Properties Window

The Labware Properties window specifies the name, dimensions, and graphics for 
the selected labware. Use the tabs on the Labware Properties window to verify the 
current settings, edit the labware properties, or evaluate the labware (use the 
instrument to measure the labware dimensions).

To open the Labware Properties window:
1. If you will be evaluating labware, select a location on the instrument deck and 

place the labware (and the support if applicable) at the desired location. 
Choose a calibrated position on the deck with good visibility of the labware.

2. If you will be evaluating the labware, select the arm icon that will be used to 
evaluate the labware at the top of the Deck View on the WinPREP main 
window. If you are changing the settings on the Details tab, only the 
parameters for the selected arm are displayed on the Details tab.

 Note: Evaluating the labware requires that the instrument is calibrated and that 
the tips are properly aligned. If necessary, run the Calibration and Tip 
Alignment diagnostics before continuing (see Diagnostic Tests on 
page 408 for more information).

3. Select Utilities > Labware Library on the main menu, select the category 
that contains the labware, select the labware name, and click the Edit button.

OR

If the labware is already on the Deck View in the correct location, double-click 
a labware item of the same type that you want to edit. The Labware 
Parameters window opens. Click the Edit button. 

The Prepare for Labware Evaluation window opens as shown in Figure 11-2
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Figure 11-2. Prepare for Labware Evaluation window

4. Select the Plate Adapter Support Tile that will be used on the deck during 
the labware evaluation. (If you are not going to evaluate the labware, leave the 
default settings and skip to step 7.)

5. Select the Deck that the labware is placed on for evaluation.

6. Select the Position of the labware you want to evaluate. (Rotation is not 
supported during labware evaluation.)

7. Click OK.

8. If tips are attached to the Varispan arm, you are prompted to remove the tips. 
Manually remove the tips and click OK.

9. The Labware Properties window opens and displays the properties for the 
selected labware.

10. See Set the Labware Properties in the Details Tab on page 261 or Evaluate 
the Labware on page 262.
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Set the Labware Properties in the Details Tab

After new labware is created or if changes to existing labware are necessary, 
labware properties such as the name, color, and image of the labware can be 
changed on the Details tab of the Labware Properties window. Labware 
dimensions and gripper offsets can also be changed on the Details tab, although it 
is usually easier to use the instrument to define the dimensions rather than 
manually measuring and entering the values. See Evaluate the Labware on 
page 262 for instructions on using the instrument arms to define the labware 
dimensions.

To change Labware Properties on the Details tab:
1. Open the Labware Properties Window (see page 259 for details).

2. Click the Details tab.

3. To change the color of the labware in the Deck Layout View, click the Color 
field, select the desired color from the Color window, and click the OK button.

4. To specify the location where the labware is located in the lab, type the desired 
text in the Lab Location field. (This text displays on the Gather tab in the 
JANUS Application Assistant.)

5. To specify the images to use to display the labware in the software, type the 
image names in the Image File and Deck Image File fields. (See Creating 
Custom Labware Images on page 264 for information on creating and naming 
the graphic files.)

6. Click OK to save the settings.
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Evaluate the Labware

The WinPREP software uses the dimensions of the labware to calculate the 
correct position of the arm when accessing labware. When new labware is 
defined, you can use the Evaluate tab for a selected arm on the Labware 
Properties window to measure the dimensions of the labware. Evaluating 
labware uses the motors and the actual arms to accurately define the dimensions 
of the labware. You must identify the locations of the front right corner of the 
labware, the center of sample positions, and specific critical heights for the 
labware.

When you evaluate a labware item, the system uses the selected arm to perform 
the measurements. Make sure the desired arm is selected before beginning the 
evaluation. You can choose whichever pipetting arm you prefer but the windows 
for each arm are slightly different. If a Gripper arm or MDT Gripper is installed and 
the labware will be moved with the gripper, you should also evaluate the labware 
with the gripper to define gripper-specific parameters. 

You can use the Evaluate Labware feature to use the Varispan or MDT pipetting 
arm to measure and record the dimensions for the labware. This is the easiest 
and most efficient way to optimize labware and creates the most accurate labware 
definitions because the hardware used to define the labware is the same 
hardware that will access the labware.

 Note: To use an instrument arm to evaluate labware dimensions, the labware 
must be on a calibrated deck position. If the labware location on the deck 
does not display in green, you will not be able to evaluate the labware at 
that deck position.

To evaluate the labware:
1. At the top of the deck view in the WinPREP main window, select the icon for 

the arm you want to use to evaluate the labware.

2. Open the Labware Properties Window (see page 259 for details). (The 
labware and support, if required, should be placed on the deck and the proper 
location specified in the Prepare for Labware Evaluation window.)

3. Click the MDT Evaluate tab or the Var Evaluate tab, depending on which arm 
you want to use to evaluate the labware or which arm is installed on the 
instrument.

4. If using the Varispan arm, select the tip to use for alignment in the Tip drop-
down list. It is usually easiest to use the tip closest to you, either tip number 4 
on a 4-Tip system, or tip number 8 on an 8-Tip system.

5. Click on a dimension parameter in the table to select the row. 
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6. Click the Go To button. The instrument moves to the X and Y position shown 
in the table.

7. Check the alignment of the specified tip with the location indicated on the 
labware diagram. If the tip is not aligned with the location indicated, you must 
move the tip until it is properly aligned. You can align the tip manually or you 
can use the software.

• To manually align the tip, click the Off option under Motor Power, 
manually move the tip and arm as required to align the tip with the 
indicated location, and then click the On option under Motor Power.

• To use the software, use the Z Motor buttons to move the tip down close 
to the desired position, and then use the X/Y Motor buttons to move the 
arm as required to align the tip with the indicated location. Adjust the Step 
Size as needed to increase or decrease the distance moved for each step.

8. Adjust the height parameters by positioning the tip or head at the desired 
height. See the text at the bottom of the Details tab or in the JANUS Help file 
for a description of each parameter.

Tip: If all of the wells in the labware are the same height and depth, you can 
select the Update Z for All Wells check box when measuring a height to 
define the current vertical position for ALL of the troughs or wells at once.

9. When the tip is aligned with the location shown on the labware diagram, click 
the Update button to display the current location in the table.

10. Repeat steps 5 through 9 until dimensions for ALL of the parameters have 
been defined.

11. If necessary, click the Details tab to access parameters for customized trough 
shape, size, and position. Default trough definitions describe standard reagent 
troughs.

12. If desired, see Creating Custom Labware Images on page 264 to use a 
custom graphic file to display the labware in the WinPREP and JANUS 
Application Assistant software.

13. If an MDT Gripper or Gripper Arm is installed on the system and the labware 
will be moved by the gripper, see Editing Labware on page 264.

14. Click the OK button to save the labware definition.
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Editing Labware
Labware Parameters specify settings for a specific labware item on the deck in a 
specific protocol. Labware Properties specify settings common to all labware of 
the specified type used in any protocols.

To edit parameters for existing labware:
1. If the labware is already on the deck view, right-click the labware graphic and 

select Properties. The Labware Parameters window opens.

2. Change the labware Name, Deck, Position, Source of ID, Barcode Position, 
and Barcode Gripper as desired.

3. Click the OK button. The Labware parameters for the labware item on the 
deck are updated.

To edit properties for a specific labware type:
1. Open the Labware Properties Window (see page 259 for details). (If you are 

going to evaluate labware, the labware and support, if required, should be 
placed on the deck and the location specified in the Prepare for Labware 
Evaluation window.)

2. To change the labware dimensions by evaluating the labware, see Evaluate 
the Labware on page 262 to measure the dimensions, and then click the OK 
button on the Labware Properties window to save the changes to the labware 
file.

3. To change the Labware Properties in the Details tab, see Set the Labware 
Properties in the Details Tab on page 261 to type the dimensions directly in the 
window and then click the OK button on the Labware Properties window to 
save the changes to the labware file.

Creating Custom Labware Images 
JANUS Application Assistant uses two images for each piece of labware:

• The “Hero” image provides a close up picture of the labware so you can easily 
identify the item. The Hero image displays in the Instructions panel on the 
Place tab in the JANUS Application Assistant.

• The “Deck” image is used to show how the labware is positioned on the deck 
next to other labware. The Deck image displays on the deck view in the Place 
tab and Run tab in the JANUS Application Assistant.

WinPREP uses the “Deck” image to display the labware on the Deck View.
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WinPREP and JANUS Application Assistant come with both “Hero” images and 
“Deck” images for common labware installed with the system. In some cases, you 
may want to create custom labware. It is highly recommended that you also create 
images for each new piece of custom labware. If you don't create a custom image, 
a default generic image is displayed. This may cause confusion if you create 
several new pieces of custom labware that all use the same images. Using 
custom images will eliminate confusion when viewing the images in WinPREP or 
JANUS Application Assistant.

The images that you create must adhere to several rules so that they display 
correctly in the software. If these rules are not followed, the images may not 
display, may appear in the wrong place, or may be the wrong size.

Hero Image Rules
• The file must be an image file of type PNG. Transparency should be used 

where the physical labware has no material.
• The image dimensions should be large enough to clearly identify the labware. 

Typical hero images are approximately 1500X1000 pixels. The image is 
scaled to the appropriate size when displayed in the software.

• Hero images are recommended to be viewed from the right and above. This 
gives perspective on the height, width, and depth of the item. You can refer to 
existing hero images for examples.

• The filename for the hero image should adhere to the following naming 
convention. The base part of the filename should match the labware name. 
The label “_Hero” should then be appended. For example, if the custom 
labware has the labware name of “MyCustomLabware.LAB” then the hero 
image name should be “MyCustomLabware_Hero.PNG”.

• Edit the custom labware in the Labware Properties window and add the hero 
image filename to the “Image File” field. In the example above, enter 
“MyCustomLabware_Hero.PNG”.



 Chapter 11: Labware Libraries 266

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Deck Image Rules
• The file must be an image file of type PNG. Transparency should be used 

where the physical labware has no material.
• The deck images are displayed at a Y angle of 50 degrees where 0 degrees is 

an overhead view.
• The width (x) of the image must be Labware Width (mm) * 3.285. The depth 

(y) of the image must be Labware Depth (mm) * 2.5165.
•  If the labware can be rotated (to 90, 180 or 270 degrees) then rotated deck 

images must be created for the labware to display properly on the deck.
• The filename for the deck images must use the following naming convention. 

The base part of the filename should match the labware name. The label 
“_Deck” is then appended. Finally the rotation angle should be appended as 
“_0” for 0 degrees, “_90” for 90 degrees, etc. For example, if the custom 
labware is named “MyCustomLabware.LAB” and can have rotations of 0 and 
180 degrees, then the deck image filenames should be 
“MyCustomLabware_Deck_0.PNG” for 0 degrees of rotation and 
“MyCustomLabware_Deck_180.PNG” for 180 degrees of rotation.

• Edit the new labware in the Labware Properties window and add the deck 
image filename to the “Deck Image File” field. In the example above, enter 
“MyCustomLabware.PNG”. The software automatically inserts “_Deck” and 
the appropriate angle when displaying the images in WinPREP or JANUS 
Application Assistant.

Both hero and deck image files must be placed in the \Labware Files folder.
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Importing Labware Definitions
WinPREP provides an easy way to convert MultiPROBE II labware rack files (.rak) 
to the labware definitions (.lab) used by WinPREP. To convert the files, use the 
Import function in the Labware Library.

To import an older (.rak) labware definition:
1. Select Utilities > Labware Library from the main menu. The Labware 

Library window opens.

2. Click the Import button. The Import Labware Window opens as shown in 
Figure 11-3.

Figure 11-3. Import Labware Window

3. Click the Browse button, at the top of the window. Use the Browse for Folder 
window to locate and select the location where the desired rack (.rak) files are 
stored. The Import Labware Window updates to display a list of rack files in 
the left column.

4. Select one or more rack files you want to convert. To select multiple files, hold 
down the <Ctrl> key and click the file names in the Rak File Names list.
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5. Click the Import Labware(s) button at the bottom of the Import Labware 
Window. WinPREP converts the files and saves them with a WinPREP 
labware (.lab) extension, as shown in Figure 11-4. WinPREP saves the 
converted file in the same location as the rack file.

Figure 11-4. Import Labware Window with Converted Rack file

6. Move the converted labware file into the \Labware Files folder in the WinPREP 
installation folder. If you do not move the files, they may not be available for 
use in protocols.

 Note: WinPREP saves the converted file in the same location as the rack file.

The conversion is complete. You can use the converted file in any WinPREP 
protocols. You can also convert older, MultiPROBE II protocols for use with the 
JANUS G3 system. If you do this, be sure to convert any rack files used by the 
older protocol to the newer labware format.
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Chapter 12

Performance Files
Liquid delivery calibration of JANUS G3 is based on the use of performance files. 
Performance files ensure accurate pipetting by adjusting system parameters to 
optimize for several factors including tip type, mode of operation, aspirate and 
dispense volume, and fluid properties.

PerkinElmer includes several performance files with WinPREP. Varispan 
performance files are categorized according to tip type (fixed or disposable) and 
pipetting mode (blowout or waste). MDT performance files are categorized 
according to the dispenser head type: Standard, NanoHead, and Pin Tool. 
Performance files can help you address most common performance 
recommendations. The performance files are located in the Performance Files\ 
folder in the WinPREP installation folder.

The Performance Set Library is a catalog of the performance files on the system. 
Use the Performance Set Library to select, edit, and create new performance files. 
The performance files for the system depend on the types of tip adapters and 
disposable tip types available for the instrument.

This chapter contains information on performance files, including:

• Using Performance Files (page 269)
— Performance File Parameters (page 272)
— Choosing a Performance File (page 276)

• Creating Performance Files (page 277)
• Editing Performance Files (page 280)

— Missing Performance Files (page 281)
— Volume Compensation (page 282)
— General Performance Guidelines (page 284)

Using Performance Files
The desired performance file is specified on the Overview tab of each procedure. 
The type of tip you select for a procedure and the mode of operation control which 
performance files you can select in the procedure.
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Performance files contain two general types of parameters: performance set and 
selection criteria. Varispan performance files also contain a third type of 
information known as Global Parameters. You can configure each type of 
information through an individual tab on the Performance File properties window.

Selection Criteria parameters define the compatibility of the performance file with 
respect to tip types, pipetting mode, and syringe sizes. By enabling one or more 
tip types for the Adapter Tips parameter (Varispan) or the MDT Tip Type 
parameter, you specify the tips that can use the performance file. Figure 12-1 and 
Figure 12-2 provide examples of the Selection Criteria tabs for the Varispan and 
MDT arms.

Figure 12-1. Performance File Properties - Varispan Selection Criteria

Figure 12-2. Performance File Properties - MDT Selection Criteria

The selection criteria options for the MDT arm are minimal and only contain 
settings for the tip type. Varispan selection criteria also includes Pipetting Mode 
and Syringe Sizes. When you set the Pipetting Mode parameter, you specify the 
operation mode (blowout or waste) for the performance file. Finally, setting the 
Syringe Sizes option identifies the syringes that can use the performance file. 
You can set adapter tips, pipetting modes, and syringe sizes by modifying these 
values on the Selection Criteria tab of the performance file properties window.

Performance Set parameters address the performance characteristics of liquids. 
The volume of the liquid you are pipetting influences these characteristics. You 
can review, modify, and delete records in the performance file on the 
Performance Set tab of the performance file properties window. You can also use 
this window to modify the parameters for existing records in the performance file. 
The MDT Tip Type parameter specifies the tips that can use the performance file. 
Figure 12-3 and Figure 12-4 provide examples of the Performance Set tabs for 
the Varispan and MDT arms.
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Figure 12-3. Performance File Properties - Varispan Performance Set

Figure 12-4. Performance File Properties - MDT Performance Set

To optimize the performance of the system for a specific liquid volume, the 
performance set parameters include pump speeds, pump delays, mode (waste 
and blowout) volumes, and air gap volumes for a range of liquid volumes. Several 
of the parameters are common between pipetting arms. However, each arm 
requires certain unique settings and this causes the performance set data to differ 
between Varispan and MDT arms.
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Global Parameters are Varispan performance factors that are not dependent on 
the volume or type of liquid you are handling. These settings control various 
factors such as moving into and out of a sample liquid, liquid level sense 
parameters, syringe pump accelerations, and volume compensation. You can 
modify these parameters on the Global Parameters tab of the performance file 
properties window. Figure 12-5 shows the Varispan Global Parameters tab.

Figure 12-5. Performance File Properties - Varispan Global Parameters

The sections below describe performance files in more detail.

Performance File Parameters

The previous section gave you a brief introduction to performance file parameters. 
This section provides details about each type of performance file parameter 
individually.

Selection Criteria
Specifies the conditions under which a specific performance file can be selected, 
including which arms, tips, dispenser heads, modes, etc. are valid.

Performance Set
Performance Set parameters differ slightly between pipetting arms. The table 
below describes each of the Performance Set options and identifies the arms 
affected by each.
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Arm Parameter Description

Va
ris
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Volume Specifies the liquid volume in microliters (µL) for which the parameter values 
of the row will apply. These parameters in this row are applicable for liquid 
volumes from this value up to the volume indicated for the next row. 

Aspirate Speed Specifies the speed of the syringe pumps or dispenser head when aspirating 
liquid.
Specifies the pump speed in microliters per second (µL/s) to use when 
aspirating with the syringe pumps. The viscosity and volume of liquid being 
moved determine the optimum pump speeds.

Aspirate Delay Specifies the time in milliseconds (mSec) to pause after an aspiration using 
the syringe pump and before any other operation or function. Due to the 
elasticity of the liquid column, particularly the air gaps, there is a delay 
between the time that the syringe stops and the time that liquid movement is 
complete.

Dispense Speed Specifies the pump speed in microliters per second (µL/s) to use when 
dispensing with the syringe pumps. The viscosity and volume of liquid being 
moved determine the optimum pump speeds.

Dispense Delay Specifies the time in milliseconds (mSec) to pause after a dispense using the 
syringe pump and before any other operation or function. Due to the elasticity 
of the liquid column, particularly the air gaps, there is a delay between the time 
that the syringe stops and the time that liquid movement is complete.

Waste Vol. (µL) Specifies the waste volume in microliters (µL) to be used when µL is selected 
as the measurement units for waste volume. The value in this column 
determines the waste volume directly.

Blowout Mode Specifies the volume of air in microliters (µL) to be used to blowout the tip 
when the blowout mode is selected for a procedure. The value in this column 
determines the blowout volume directly.

Blowout Delay Specifies the time in milliseconds (mSec) to delay after sample liquids are 
dispensed and before the blowout is performed. By defining an appropriate 
delay time, any liquids remaining in the tip due to viscosity or surface tension 
have an opportunity to drain down to the bottom of the tip and get blown out 
when the air is dispensed.

Va
ris

pa
n 

on
ly

Waste Vol.
(% of Asp.)

When % of Aspirate is selected as the measurement units for waste volume, 
specifies the waste volume to use, as a percentage of the aspiration volume 
for the step. Enter values for this column in percentages (for example, enter 15 
for 15%).

Transport Air Gap Specifies the volume in microliters (µL) for the air gap aspirated between liquid 
aspirates to prevent dilution or contamination. 

System Air Gap Specifies the volume in microliters (µL) for the air gap aspirated before any 
liquid aspirates to prevent liquid contact with the system liquid.
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Global Parameters
Global Parameters are various options to control the way the Varispan arm 
aspirates and dispenses liquids. The following table describes each of these 
options in detail.

M
D

T 
on

ly

Dsp. Back Volume Specifies the volume in microliters (µL) of aspirated liquid to dispense back 
into the well after an aspirate operation. This setting is useful for reducing the 
First Shot Effect and depends on the viscosity of the liquid you are pipetting.

Liq. Entry Speed Specifies how fast in millimeters per second (mm/s) the MDT tips move down 
when entering liquid in the well.

Retract Distance Specifies the distance in millimeters (mm) that the MDT tips retract from the 
liquid using the Retract Speed.

Retract Speed Specifies the speed in millimeters per second (mm/s) that the MDT tips are 
moving when leaving the liquid. This speed depends on the viscosity and 
surface tension characteristics of the liquid for which the performance file is 
defined. Typically, this speed is slower than other travel speeds to ensure any 
liquid on the outside of the tips has a chance to wick off into the well.

Tip Wash Delay Specifies the time in milliseconds (ms) that the MDT tips pause between 
aspirate and dispense operations when washing tips.

Tip Wash Speed Specifies the speed in microliters per second (µL/s) that the MDT tips aspirate 
and dispense liquid in the wash bowl.

Group Parameter Description
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Scan in speed (mm/s) Specifies the speed in millimeters per second (mm/s) that the Varispan 
tips move down when searching for liquid with the liquid level sense 
option. This speed depends on the electrical characteristics of the liquid 
for which the performance file is defined.

Scan out speed (mm/s) Specifies the speed in millimeters per second (mm/s) that the Varispan 
tips move up when searching for the top of the liquid with the liquid level 
sense option. This speed depends on the electrical characteristics of 
the liquid for which the performance file is defined.

Retract from liquid speed 
(mm/s)

Specifies the speed in millimeters per second (mm/s) that the Varispan 
tips are moving when leaving the liquid. This speed depends on the 
viscosity and surface tension characteristics of the liquid for which the 
performance file is defined. Typically, this speed is slower than other 
travel speeds to ensure any liquid on the outside of the tips has a 
chance to wick off into the well.

Retract from liquid height 
(mm)

Specifies the distance in millimeters (mm) that the Varispan tips retract 
from the liquid using the Retract from Liquid Speed. 
Note, this height is also used in the clot detection routine, when 
enabled.

Arm Parameter Description
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Submerge before aspirate 
(mm)

Specifies how far in millimeters (mm) into the sample liquid the 
Varispan tips submerge before beginning to aspirate liquid when using 
Liquid Level Sensing. Both positive and negative values are allowed for 
this parameter, with positive numbers submerging the tip into the liquid 
and negative values retracting the tip above the sensed level of the 
liquid. This distance positions the tip into or above the liquid when 
aspirating.

Submerge before 
dispense (mm)

Specifies how far in millimeters (mm) into the liquid the Varispan tips 
submerge before beginning to dispense liquid. Both positive and 
negative values are allowed for this parameter, with positive numbers 
submerging the tip into the liquid and negative values retracting the tip 
above the sensed level of the liquid. This distance positions the tip into 
or above the liquid when dispensing.

Retract after clot detect 
(mm)

Specifies distance in millimeters (mm) to retract for the second 
retraction step if a clot is detect ed. This routine uses the liquid level 
sense option to detect when clots form at the ends of the tips.
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Aspirate ramp (µL/s/s) Specifies how quickly the Varispan syringe pump motors reach the 
Aspiration Speeds specified on the Performance Set tab. In the 
performance files provided with the instrument, this value is optimized 
for the fluid dynamics of the associated system liquid. If you create your 
own performance files, be sure to determine the appropriate values for 
this parameter. Enter values for this parameter in microliters per second 
per second (µL/s2).

Dispense ramp (µL/s/s) Specifies how quickly the Varispan syringe pump motors start and stop 
a dispense stroke. In the performance files provided with the 
instrument, this value is optimized for the fluid dynamics of the 
associated system liquid. If you create your own performance files, be 
sure to determine the appropriate values for this parameter. Enter 
values for this parameter in microliters per second per second (µL/s2).
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Slope (µL/µL) Specifies the slope of the linear response curve determined for the 
associated system liquid. 
The relationship between the Varispan syringe stroke movements and 
actual liquid delivered, while reasonably linear, is not necessarily one-
to-one. To compensate for this physical inequality, the system 
calculates the actual syringe stroke required to deliver the requested 
volume. The compensation is based on the Slope and Offset 
parameters. See Volume Compensation on page 282 for more 
information about how to calculate this parameter.

Offset (µL) Specifies the actual Y-offset (or Y-intercept) of the linear response 
curve determined for the associated system liquid. 
The relationship between the Varispan syringe stroke movements and 
actual liquid delivered, while reasonably linear, is not necessarily one-
to-one. To compensate for this physical inequality, the system 
calculates the actual syringe stroke required to deliver the requested 
volume. The compensation is based on the Slope and Offset 
parameters. See Volume Compensation on page 282 for more 
information about how to calculate this parameter.

Group Parameter Description
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Choosing a Performance File

The performance files available in a protocol depend on the tip type and mode 
selected. You can only select performance files that apply to the tips and mode 
identified in the procedure. For example, you cannot select a performance file for 
blowout mode if the procedure uses waste mode, and you cannot use a 
performance file for disposable tips if the procedure uses fixed tips.

To select a performance file:
1. Double-click the desired procedure node in the protocol outline.

2. Select the desired Tip and Mode values in the Pipetting frame of the 
Overview tab. WinPREP scans the Performance Set Library and displays a 
list of compatible performance files in the Performance File drop-down list. 
Figure 12-6 shows these controls.

 Note: Fixed tips are the only available tip type until you add some form of 
disposable tip labware to the deck.

Figure 12-6. Overview Tab: Pipetting Frame

3. Select the desired performance file from the Performance File drop-down list, 
as shown in Figure 12-7.

 Note: Click the Performance File button to open the performance file properties 
window for the selected performance file. Be careful when viewing 
performance files in this way because any changes you make will 
overwrite the original file. See Editing Performance Files on page 280 for 
more information.

Figure 12-7. Performance File drop-down list

4. Click Apply on the procedures parameters window to save the changes.

5. Click OK to close the procedure parameters window.
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Creating Performance Files
The Performance Set Library window displays a catalog of all the performance 
files currently defined for the system. You can edit existing files or add new files to 
the library as necessary. The performance file drop-down list on a procedure’s 
Overview tab displays the compatible performance files from the Performance 
Set Library.

Figure 12-8 shows the Performance Set Library window.

Figure 12-8. Performance Set Library window

In most cases, the performance files supplied with the JANUS G3 system are all 
you need. However, in certain instances you might want to create a new, or modify 
an existing, performance file. If an existing performance file contains most of the 
information you need, you can use it as a template for the new file to save time. 
For more information, see Editing Performance Files on page 280.

To create a new performance file:
1. Select Utilities > Performance Set Library from the WinPREP menu bar to 

open the Performance Set Library window.

2. Set the Arm Type value to the desired arm.

3. Select the tip type in the Categories list. When you select a tip type, the 
Available Performance Files list displays all the performance files available 
for the selected tip type.

4. Click the New button on the Performance Set Library window to open the 
new performance file properties window, shown in Figure 12-9.
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Figure 12-9. New Performance File Properties window - Performance Set tab

5. Click Save As.

6. Provide a unique File name for the new performance file and click Save. The 
“.prf” extension is automatically added to the file name.

 Note: Save all performance files in the Performance Files\ folder in the WinPREP 
installation folder. If you do not save the custom performance files in the 
correct location, you may not be able to access them from WinPREP.

7. Modify the values on the Performance Set tab as necessary for the 
application. The Performance Set tab contains the majority of the data for the 
performance file. It allows you to set the volume, aspirate speed, aspirate 
delay, dispense speed, dispense delay, waste volume, blowout volume, etc.

8. Once you modify the first value, WinPREP displays a warning window, shown 
in Figure 12-10. Since this is a new performance file and is not associated with 
any protocols, click OK to close the warning window and continue modifying 
the file as needed.

Figure 12-10.Edit Performance File Warning window

9. Click the Selection Criteria tab and modify the values as needed. An 
example of the Selection Criteria tab is shown in Figure 12-11.
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Figure 12-11. New Performance File Properties window - Selection Criteria tab

The Selection Criteria tab identifies the associated tip type, pipetting mode, 
and tip size for the performance file.

10. For Varispan performance files, click the Global Parameters tab and modify 
the values as necessary for the application. Figure 12-11 shows the Global 
Parameters tab.

Figure 12-12.New Performance File Properties window - Global Parameters tab

The Global Parameters tab contains options that specify tip movement into 
and out of liquid, syringe pump acceleration, Liquid Level Sensing (LLS), and 
volume compensation. 

11. Click OK when you are finished modifying the file.
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Editing Performance Files
In certain situations, the performance files provided with the equipment may not 
meet your needs. You might need to modify certain parameters or optimize the 
performance file for the protocol. While you can create a new performance file and 
type in the values, editing an existing performance file is often the easiest and 
fastest way to create a customized performance file.

To edit an existing performance file:
1. Select Utilities > Performance Set Library from the WinPREP menu bar to 

open the Performance Set Library window.

2. Select the tip type from the Adapter Tip Categories list. When you select an 
adapter tip category, the Available list updates to display all the performance 
files available for the tip selection.

3. Select the Performance file (*.prf) that most closely meets the needs of the 
application from the performance files listed.

4. Click Edit. The Performance File Properties window opens as shown in Figure 
12-13.

Figure 12-13.Performance File Properties window

The Performance File Properties window displays the parameters 
associated with the performance file. The title bar of the window contains the 
path and name of the performance file you are editing. You can edit any of the 
Performance Set, Global Parameters, or Selection Criteria values for the 
file.

5. Click Save As.
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6. Provide a unique File name for the custom performance file and click Save. 
The “.prf” extension is automatically added to the file name.

 Caution: Do not save the file using a name that matches one of the supplied 
performance files as these files can be overwritten during a system 
software update. Saving the custom performance files with unique names 
helps protect from this type of data loss.

 Note: Save all performance files in the Performance Files\ folder in the WinPREP 
installation folder. If you do not save the custom performance files in the 
correct location, you may not be able to access them from WinPREP.

7. Modify the values on the Performance Set, Global Parameters, and 
Selection Criteria tabs, as necessary for the application. When you modify 
the first value, WinPREP displays a warning window as shown in Figure 12-10 
on page 278. Since you saved this file with a new name, and it is not 
associated with any protocols, click OK to close the warning window.

8. Continue modifying the file as needed.

9. Click OK when you are finished modifying the file.

 Note: Changes can be made to the new performance file without compromising 
the original Performance File.

The new performance file is available in the Performance File list on the 
Overview tab of the protocol procedures.

Missing Performance Files

If the performance file drop-down list is blank after you select a tip for the Tip 
parameter, there is no performance file that exactly matches the dispensing 
conditions. Either the Mode parameter is incorrect or the system’s syringe size is 
invalid for the tip or dispenser head type.

The syringe size and mode for an existing performance file can be modified to 
create the required performance file.

To modify a performance file:
1. Select Utilities > Performance Set Library from the main menu to open the 

Performance Set Library window.

2. Select the Arm Type associated with the performance file you want to modify.

3. Select the tip type and the performance file and click Edit.
4. Select the Selection Criteria tab. This tab lists all the conditions that apply to 

the performance file.



 Chapter 12: Performance Files 282

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

5. Change the desired parameters by enabling or disabling the check boxes 
associated with the parameters. More than one box can be selected for a 
parameter.

 Note: Changing the Selection Criteria for a performance file may change the 
precision and accuracy of the instrument.

6. Click Save As to open the Save As window.

7. Provide a unique name for the new performance file and click Save to save 
the file and close the window.

 Caution: Do not save the file using a name that matches one of the supplied 
performance files as these files can be overwritten during a system 
software update. Saving the custom performance files with unique names 
helps protect from this type of data loss.

8. Click OK to close the performance file Properties window and return to the 
Performance File Library.

The custom performance file is available from any step that matches the defined 
criteria.

Volume Compensation

WinPREP uses slope and offset values to compensate for differences between 
requested and actual volumes in a pipetting operation. You can view and edit 
these values on the Global Parameters tab of the performance file properties 
window.

To calculate the slope and offset (y-intercept) values, consider the slope-intercept 
equation, shown in Eq. 12.1.

(Eq. 12.1)

The component parts of the slope-intercept equation apply to WinPREP in the 
following way:

• y is the actual volume delivered by JANUS G3
• m is the slope value WinPREP reads from the performance file
• x is the requested volume entered by the user
• b is the offset value WinPREP reads from the performance file

y mx b+=
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When applied to the slope-intercept equation, the slope and offset values help 
WinPREP compensate for differences between the requested volume and the 
actual volume. Using the slope, offset, and slope-intercept equation, WinPREP 
can adjust the actual volume so that it represents the requested volume.

The slope and offset values are determined by gravimetrically measuring 
expected versus actual dispense volumes over a range of volumes and then 
determining the linear regression line that fits those points. The slope and offset 
(y-intercept) values for the linear regression line are the values you enter in the 
fields on the Global Parameters tab in the performance file properties window. 
Prior to gravimetrically measuring and calculating the slope and offset, the values 
should be set to 1 and 0, respectively.

 Caution: You should clean the liquid path (tips, tubing, syringes, etc.) before 
attempting to determine the slope and offset values. See 
Appendix B: Caring for the System on page 398 for more information on 
cleaning the system.

 Caution: Wear gloves when performing the gravimetric analysis as oils and 
contaminants from your fingers can add weight to the test tubes.

To determine the slope and offset values:
1. Select and open a performance file displayed in the Performance Set Library 

window.

2. Click Save As. Provide a unique File name for the custom performance file 
and click Save. This file is strictly for testing purposes, so name it accordingly.

3. Select the Global Parameters tab and type “1” and “0”, without the quotes, in 
the slope and offset fields, respectively. Click OK to save the file.

4. Set up a protocol using the newly-created performance file and run ten 
replicate/tip protocols for each tip using four different volumes (for example, 
for 20 µL tips, test 2 µL, 5 µL, 10 µL, and 14 µL).

5. Plot the mean value for the results of each tip at each of the tested volumes. 
The x-axis represents the requested volume (the volume desired by the user) 
while the y-axis represents the dispensed volume (the actual volume 
dispensed, calculated from the data set). Fit the linear regression line through 
the points. Note the linear regression should yield a correlation coefficient of 
0.999 or better to be statistically valid. Obtain the slope and y-intercept of the 
regression line, as well. The ideal results for this regression line would be a 
slope of one and y-intercept of zero as this would mean the protocol data 
correlated perfectly with the requested volumes.

6. Return to the Global Parameters tab for the protocol performance file, enter 
the linear regression derived values for the slope and intercept, and save the 
file.
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7. Rerun the replicate/tip protocols you used to verify the slope and intercept. 
Use the same method to determine the actual versus requested volume 
delivery for the instrument.

 Note: If one tip dispenses differently than the other tips, it may be due to a leak, 
loose fitting, or some type of debris in the liquid path for that tip. Clean the 
liquid path and thoroughly check it for leaks, loose fittings, or other 
problems.

General Performance Guidelines

The sections below describe performance recommendations that you set in 
WinPREP, rather than in a performance file. 

Liquid Level Sense Verification
Liquid Level Sense (LLS) verification may be enabled for samples that have a 
propensity to foam. This feature enables WINPREP to verify the liquid level 
multiple times per transfer. Parameters refining the LLS verification feature are 
defined in the Arm Settings window (select 
Utilities > Setup > n Tip Arm > Arm Settings (where n is the number of tips on 
the pipetting arm) from the menu bar to open this window). You can enable LLS 
Verify on a per procedure basis on the Procedure Details tab in WinPREP.

Tracking
As liquid is aspirated out of a well, the JANUS Script Language (MSL) calculates 
the rate at which the liquid level drops. This allows the JANUS G3 instrument to 
“follow” the liquid level down. The opposite tracking occurs for dispensing. You 
may need to adjust the tracking speed if the well is not defined correctly or has a 
non-definable characteristic such as a conical bottom. The default value is 100%, 
which moves the tip at the same speed as the speed calculated by MSL based on 
the geometry of the well and the viscosity of water. You can adjust the Tracking 
value to make the system track faster or slower. The Tracking speed is specified 
on the Overview tab of an aspirate or dispense step. Adjusting the Aspirate 
Tracking to 130% helps ensure the tip is in pure liquid and does not aspirate air.

Large Syringe Volumes
Syringe volumes greater than 1 ml (2.5 and 5 mL) may not require any volume 
compensation. If you experience precision and accuracy problems with large 
volume syringes, set the Slope and Offset values in the performance file to 1 and 
0, respectively. These values are specified on the Global Parameters tab of the 
performance file.
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Chapter 13

Calibrating the System
This chapter describes how to calibrate the instrument to ensure accurate 
positioning of the arms and tips. This chapter contains the following calibration 
procedures:

• Deck Calibration on page 285
• Calibration Types on page 287

— Uncalibrated Points on page 287
— Initial/Reset on page 288
— 3 Point Calibration on page 289
— Individual Point on page 291

• Deck Calibration Coordinate System
• Calibration Procedures

— Selecting an Arm on page 293
— Calibrating the Varispan Pipetting Arm on page 294
— Calibrating the MDT Pipetting Arm on page 297
— Calibrating the MDT Arm for 1536-Well Microplates on page 307
— Calibrating the NanoHead on page 311
— Calibrating the MDT Gripper on page 311
— Calibrating the Gripper Arm on page 312
— Calibrating the Tube Barcode Reader on page 323

Deck Calibration
Deck calibration is an important consideration and directly influences the accuracy 
and precision of the instrument. By calibrating the deck, you manually identify the 
physical location of deck locations for the system. This calibration, along with 
reliable labware definitions, allows the system to accurately locate and pipette 
from precise locations on the deck.

By design, the instrument must conform to very rigorous engineering tolerances. 
However, small material and mechanical variances can and do occur. Calibrating 
the deck allows you to correct for these variances and greatly improves the ability 
of the instrument to access precise labware locations, such as the wells in a 1536 
well plate.
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WinPREP uses colors to identify calibrated versus uncalibrated points on the 
deck. The color-coding identifies the points that are calibrated for the selected 
arm. The color-coding also identifies the calibration method used to calibrate each 
point on the deck.

You should recalibrate the deck (and realign the tips) if any system component 
crashes into another component or deck item and the positioning of the system 
component is affected. Prepare the instrument by running the Random Move 
Test prior to calibrating the arms.

To calibrate an arm, you use the Calibration window to physically locate specific 
points on the deck. This process defines the exact location of specific points so 
the system can accurately locate any position on the deck, compensating for 
skewed or sloping decks.

For the initial calibration, you must complete the Initial/Reset Calibration to 
determine a coarse positioning for the deck. After you perform the Initial/Reset 
calibration, you can choose any of the Calibration Types to more precisely 
calibrate the deck. WinPREP provides three calibration types. See Calibration 
Types on page 287 for more information.

• Initial/Reset Calibration - Calibrates the entire deck based on a single 
measured point.

• 3 Point Calculated Calibration - Calibrates the area enclosed by three 
measured points. If the measured points make up a right triangle, the software 
calibrates the points enclosed by the rectangle bounded by the three points.

• Individual Point Calibration - Calibrates the deck by teaching one location at 
a time.

 Note: Performing an Initial/Reset Calibration on the system clears all previous 
calibration information for all decks.

All calibration methods involve moving to and saving the locations of one or more 
points on the deck. The number of points you save and the location of the 
calculated positions vary depending on the selected calibration type.

You calibrate the instrument using a combination of the three calibration types. 
This provides you with a great deal of flexibility and makes it easy to tailor the 
calibration of the instrument to your specific needs. It also allows you to set up 
areas of the deck that are calibrated with a high degree of precision.

See Calibration Types on page 287 for descriptions of each of the calibration 
types and how to determine the calibration status for a specific arm.



 Chapter 13: Calibrating the System 287

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Calibration Types
The following types of calibration are specified in WinPREP:
• Uncalibrated Points on page 287
• Initial/Reset on page 288
• 3 Point Calibration on page 289
• Individual Point on page 291

Uncalibrated Points

Points on the deck that are uncalibrated display as red points. You perform deck 
calibration independently for each arm. For example, on a two arm system, the 
Varispan arm can be calibrated while the MDT arm is uncalibrated. An arm can be 
completely or partially calibrated to the deck. Figure 13-1 shows an uncalibrated 
deck with a Varispan arm (selected) and an MDT arm.

Figure 13-1. Example of Uncalibrated Deck View

Figure 13-1 shows that the Varispan arm is not calibrated to the deck because all 
points on the decks are red when the Varispan arm is selected. This calibration 
status is only for the Varispan arm. To view the calibration status of another arm, 
click the arm icon (the MDT icon is in the upper right corner in Figure 13-1).
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Initial/Reset

WinPREP uses Initial/Reset calibration type to calibrate the entire JANUS deck 
based on a single measured point. When you use this method to calibrate an arm 
to the deck, you locate and save a single deck position. WinPREP uses the 
measured point to calculate the approximate locations of all other deck positions.

The Initial/Reset calibration provides a quick and easy way to calibrate the deck in 
a single step, but it is the least accurate method of calibration. The calculated 
locations may be adequate for operating the system when using labware with 
relatively large sample positions, such as Big Well or some 96-well plates. 
However, it does not provide the precision necessary to access small wells, such 
as wells in 1536-well plates. The Initial/Reset calibration does not compensate for 
any skewing, sloping, warping or other physical abnormalities that may affect deck 
positions. Deck abnormalities may present problems when attempting to use high 
density labware.

The single point measured during Initial/Reset calibration displays as a green 
Measured position. The rest of the positions on the deck are calculated from the 
single measured point and display as white 1-point calculated points, as shown in 
Figure 13-2. 

Figure 13-2. Example of Initial/Reset Calibration
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In Figure 13-2, all deck positions except the upper left corner and the right three 
columns of the right-most deck plate display as white points, indicating the points 
were calculated from the Initial/Reset calibration. The upper left position (A1 as 
denoted by the arrow) displays as a green point, indicating the position was 
physically measured with the Varispan arm. WinPREP uses the measured 
position to calculate the rest of the positions on the deck. The right three columns 
(7, 8, and 9) on the right deck plate display as red points because the Varispan 
arm is unable to physically access these positions. The MDT arm is above this 
deck area and prevents the Varispan arm from reaching these positions. 
WinPREP does not calibrate these positions because they are inaccessible to the 
arm.

3 Point Calibration

The 3 Point calibration provides a quick and easy way to calibrate the deck. It is 
more accurate than the Initial/Reset calibration but less accurate than measuring 
each point with an Individual Point calibration. This method is usually adequate for 
larger labware targets, such as Big Well, 96-well plates, or 384-well plates. 
However, it may not provide the precision necessary to access very small targets, 
such as wells in 1536-well plates.

WinPREP uses a 3 Point calibration to calibrate portions of the deck based on 
three measured points. When you use this method to calibrate an arm to the deck, 
you measure and verify the locations of three positions on the same deck. The 
software then calculates all other positions included in the triangle or rectangle 
bounded by the three measured points. The positions that are calculated by 
WinPREP (3 Point Calculated) depend on the orientation of the three measured 
points.

The measured points (positions A1, G1, and G9, as denoted by the arrows in 
Figure 13-3) display in green. The 3 Point Calculated points display in yellow. 
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Figure 13-3. Example of 3 Point Calculated Calibration

Unlike the Initial/Reset calibration, which calculates all positions on the current 
deck, the positions calculated by the 3 Point calibration are limited to the triangle 
or rectangle bounded by the three measured points. All other deck positions 
remain unchanged and display in white. The orientation of the measured points 
determines the points that are calculated, as shown in Figure 13-4.

 Tip: When calibrating the deck with the 3 Point calibration, all three points must 
be on the same deck.

Figure 13-4. Calibration Areas for 3 Point Calculated Calibration
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The 3 Point Calculated area on the left uses C1, G1, and G9 as the measured 
points. The 3 Point Calculated area on the center deck uses A3, D3, and G3 as 
the measured points. The 3 Point Calculated area on the right deck uses D4, F9, 
and G2 as the measured points. The dashed lines illustrate the triangles formed 
by the three measured points for each calibration. The shaded regions 
demonstrate the areas included when calculating the positions. The triangle on 
the left has a solid, black box in the lower vertex of the triangle, indicating a right 
angle (90º).

When the measured points for a 3 Point Calculated includes a right angle, such as 
the example on the left deck in Figure 13-4, the software determines the rectangle 
that bounds the points in the triangle and calculates the positions for all points 
inside the rectangle. It does this by rotating the triangle 180º around the center of 
the longest edge, (the hypotenuse). The hypotenuse is the side opposite the right 
angle of the triangle.

When the measured points for the calibration do not include a right angle, such as 
the example on the right deck in Figure 13-4, the software calibrates all the points 
enclosed in the triangle. Only the points completely enclosed in the triangle are 
calibrated; if a portion of the point extends beyond or lies on the bounding triangle, 
the software excludes that point from the calibration.

The example on the center deck in Figure 13-4 is a special case of three point 
calibration. It demonstrates the calibration behavior when all three measured 
points are in a line. In this example, the measured points are A3, D3, and G3, 
thereby including the whole column. While this provides an easy way to calibrate a 
single column or row on the deck, it does not have to include the entire column or 
row. You can include only the portions that you require. 

Individual Point

The Individual Point calibration type allows you to access any individual deck 
location on the deck. By calibrating individual points, you measure the locations of 
single points for precise positioning. Only the points you choose to calibrate in this 
calibration type are modified. The calculated points from any previous calibrations 
are not affected.

While it is the most time consuming, the Individual Point calibration method 
provides the highest level of precision and may be required for labware with very 
small wells, such as 1536-well plates. This method can also be used to more 
accurately calibrate the arms for any other labware or positions as necessary.
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Deck Calibration Coordinate System
The coordinate system used for calibrating the deck is measured from the deck 
origin, which is determined by the physical edges of the left-most deck plate. The 
deck origin is located in the back-left corner of the instrument deck. 

All measurement values are in millimeters (mm) and specify the distance from the 
deck origin. The X coordinate values increase (become larger) as the arm moves 
to the right of the deck and decrease (become smaller) as the arm moves toward 
the left. The Y coordinate values increase as the arm moves toward the front of 
the deck and decrease as the arm moves closer to the back. The Z coordinate 
values decrease as the tip or head moves closer to the deck and increase as the 
tip or head moves away from the deck.

Figure 13-5. Deck Calibration Coordinate System

Calibration Procedures
This section describes calibration of the Varispan pipetting arm, MDT pipetting 
arm, Gripper arm, and Tube Bar Code Reader. In most respects, the calibration of 
the Varispan and MDT pipetting arms is very similar. Separate calibration 
procedures are provided for each arm because there are important differences.

Origin
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This section includes:

• Selecting an Arm on page 293
• Calibrating the Varispan Pipetting Arm on page 294
• Calibrating the MDT Pipetting Arm on page 297
• Calibrating the MDT Arm for 1536-Well Microplates on page 307
• Calibrating the NanoHead on page 311
• Calibrating the MDT Gripper on page 311
• Calibrating the Gripper Arm on page 312
• Calibrating the Tube Barcode Reader on page 323

Selecting an Arm

Selecting an arm displays the calibration status for the arm in the Deck View. To 
select an arm, click the arm icon at the top of the Deck View. The icon for the 
selected arm becomes active and the deck view updates to display the calibration 
status for the selected arm. The icon for the active arm displays in color with a 
blue outline; the icon for an inactive arm displays in gray. Figure 13-6 shows the 
Varispan arm selected as the active arm.

Figure 13-6. Example of Varispan Arm Selected
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Calibrating the Varispan Pipetting Arm

To calibrate the Varispan arm using the WinPREP software, you measure 
individual or multiple points on the deck. WinPREP can then calculate other 
positions on the deck based on the measured points.

To setup the Calibration:
1. Prepare for calibration by removing any disposable tips from the Varispan.

2. Select Utilities > Setup > Varispan-<x>tip > Calibrate on the main menu, 
where <x>tip identifies the number of tips on the Varispan arm. The Deck 
Calibration: Varispan window opens as shown in Figure 13-7.

Figure 13-7. Varispan Deck Calibration Window

3. Select the deck to calibrate in the Deck drop-down list below the deck view.

4. Choose a Calibration Type in the drop down list. The default calibration 
point(s) is/are selected on the specified deck.

If you are calibrating the deck for the first time, the Calibration Type must be 
Initial/Reset. If you choose Initial/Reset calibration, all previous calibration 
points on the entire deck are cleared. After the Initial/Reset calibration, you 
can choose 3 Point or Individual Point.
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5. Select the tip to use to calibrate the deck in the Calibration Using drop-down 
list. (Use Tip 2 unless Tip 2 does not reach the position you are teaching.)

6. Place the calibration cone, shown in Figure 13-8, in the selected deck position. 
The calibration cone is provided with the instrument.

Figure 13-8. Varispan Calibration Cone

7. Measure and record the calibration points as described below.

To define the calibration points:
1. Select the first row in the Point Name table. The first calibration point is 

selected in the deck view and outlined in dark blue as shown in Figure 13-9. 
For Initial/Reset calibration, only one point is listed. For 3 Point calibration, the 
two remaining points are outlined in light blue.

Figure 13-9. Example of Selected Calibration Point (Initial/Reset)

The Point Name column displays the name and location of the calibration 
points. Each row in the table represents a calibration point on the deck, as 
shown in Figure 13-10. For 3 Point calibration, there are three points listed.

2. If you want to change the points that will be measured, click the row in the 
table, and then click a point on the deck view. The row updates to the selected 
point.

Figure 13-10.Point Name Table (Varispan Arm, Middle Deck)

3. Select the type of calibration cone in the Cone Type drop-down list.
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4. Click the Go To button for the associated calibration point. The arm moves to 
the specified location and lowers the reference tip so you can align it with the 
calibration cone.

If the tip is very far from the selected point, you can select the Move XY 
Manually option and manually move the arm close to the point.

 Tip: Use the Up and Down controls to make sure the tip is above the 
calibration cone. You do not want the tip to touch the calibration cone 
during horizontal adjustment, but the closer the tip is to the calibration 
cone, the easier to it is to check the alignment.

5. Use the Forward, Back, Right, and Left controls under Arm Position to 
make fine adjustments until the tip is aligned with the point of the calibration 
cone. Aligning the tip with the calibration plate or calibration cone is a visual 
determination. (The Move XY Manually option is automatically cleared when 
you click one of the motor control buttons.)

Select the desired Step Size to specify the distance the arm moves each time 
you click the Arm Position controls.

6. Use the Up and Down controls to make fine vertical adjustments until the end 
of the tip touches the tip of the calibration cone. The tip should be close 
enough to the calibration cone to prevent the cone from being lifted up, but 
you should be able to easily rotate the calibration cone around the vertical 
axis.

! WARNING When performing this step, be very careful that you do not bend or break 
the tip or crash the tip into the deck or calibration cone. Doing so could 
severely damage the Varispan tips and arm.

7. Click Update next to the point in the Point Name table when the tip is aligned. 
WinPREP saves the current location for the point and updates the row in the 
Point Name table. The measured point displays in green in the deck view, 
indicating its calibration status is Measured.

8. Click the Home Z button to raise the tip to a safe travel height above the deck.

9. For 3 Point or Individual Point calibration, click another row in the table and 
repeat the procedure until all of the calibration points are measured.

10. Click the Calculate Positions button to process the measured points and 
calculate the locations of all other deck positions in the affected region as 
determined by the selected calibration mode.

 Note: The Calculate Positions button is not available in Individual Point 
calibration. Individual Point calibration only measures one point, so there 
is no calculation or interpolation of other points on the deck.
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11. If performing an Initial/Reset calibration, a message box opens to remind you 
that all calibration points on the deck will be reset. Click Yes to reset the 
calibration points or No to revert to the last saved calibration.

Figure 13-11. Reset Calibration Window

12. After the points are calibrated, the deck view updates the color of the deck 
positions depending on the calibration method used (white for Initial/Reset or 
yellow for 3 Point).

13. Click OK to save the results and close the calibration window.

14. After performing an Initial/Reset Calibration, perform a 3 Point calibration for 
each deck to ensure accurate positioning of the tips.

Varispan deck calibration is complete. Individual areas of a deck, such as the 
Tube barcode reader lanes (see Calibrating the Tube Barcode Reader on 
page 323) or a recessed deck, are calibrated separately from the rest of the deck.

Calibrating the MDT Pipetting Arm

To calibrate the MDT pipetting arm, you measure individual or multiple points on 
the deck. WinPREP calculates other positions on the deck based on the 
measured points.

Unlike the Varispan pipetting arm, the MDT arm requires additional preparation 
steps before beginning the calibration. You must load a dispense head and 
disposable tips before you can calibrate the system. If the system has not been 
calibrated, you must load and unload the head and tips manually. This step is very 
important as it sets the necessary Z height parameters in the software. Failure to 
complete this mandatory step could severely impair the precision and accuracy of 
the instrument. After calibration, the head and tips can be loaded either manually 
or automatically.

This section describes how to load and unload the tips and head manually and 
automatically. You can use whichever approach you prefer after the system is 
calibrated.
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Loading Dispense Heads and Tips
This section explains the two methods for loading a dispense head and tips: 
manually (see page 298) and automatically (see page 299). Automatically loading 
a head and tips requires less manual work but also requires that the system is 
calibrated. Manually loading a head and tips requires more manual interaction, but 
can be used if the system is not yet calibrated.

To manually attach an MDT head and tips:
1. Place a Dispense Head in the Docking Station on the deck. Orient the head so 

that the Head ID Pickup on the head is on the right, as shown in Figure 13-12.

Figure 13-12.Dispense Head Orientation for Manual Load

2. Choose Utilities > Setup > MDT > Calibrate from the main menu. The Deck 
Calibration: MDT window opens.

3. Use the Forward, Back, Right, and Left buttons to align the head over the 
docking station.

4. Use the Up and Down buttons to make fine vertical adjustments until the arm 
is near the docked head.

! WARNING When performing this step, be very careful that you do not crash the MDT 
arm into the deck, docking station, or docked head.

5. Use the Forward, Back, Right, and Left buttons once more to visually align 
the quick release latches with the couplings in the four corners of the docked 
head.

6. When the quick release latches are aligned with the couplings in the four 
corners of the head, click the Manual Head Load button.

7. The MDT arm moves down and engages the latching mechanisms for the 
head. Once latched, the arm moves up and lifts the head out of the docking 
station.

Head ID Pickup

Front Latch Couplings

Back Latch Couplings
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8. A prompt opens asking you to accept the Z Height recorded with the head 
pickup. If the head loaded properly (all latches engaged completely), accept 
the new Z Height setting. Reject the Z Height and retry the manual head load if 
errors occur.

9. Click the Manual Tip Load button. A dialog box asks if you are ready to 
proceed.

10. Click the OK button. You are prompted to load the Tip Box Carrier onto the 
MDT head.

11. Place a full Tip Box in the Tip Load Carrier.

12. Manually hook the Tip Load Carrier onto the bottom of the head. The hook 
openings must be toward the front of the instrument. Once fully connected, the 
Tip Load Carrier will hang suspended from the MDT head.

 Caution: Make sure all four hooks on top of the Tip Load Carrier are secured before 
proceeding.

13. Click the OK button. The system moves the Tip Load Carrier up to press the 
tips onto the head’s tip adapters and then lowers the Tip Load Carrier. You are 
prompted to remove the Tip Load Carrier from the MDT Head.

14. Remove the Tip Load Carrier and then click the OK button.

15. Set up the MDT calibration (see page 300).

To automatically attach an MDT head and tips:

 NOTE If you are calibrating the instrument for the first time, you cannot 
automatically load the dispense head and tips. You must manually load the 
head and tips. See page 298 for complete details.

1. Place a Dispense Head in the Docking Station on the deck. Orient the head so 
that the Head ID Pickup on the head is on the right, as shown in Figure 13-12.

2. Choose Utilities > Setup > MDT > Calibrate from the main menu. The Deck 
Calibration: MDT window opens.

3. Click Head Change. The Head Change window opens.

Figure 13-13.Head Change Window
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4. Select the appropriate Dispenser Head, Deck, Position, and Support values in 
the drop-down lists.

5. Click Load Head. The Head Change window closes. The MDT arm moves to 
the specified deck location and loads the head in the docking station.

6. Place a full Tip Box in the Tip Load Carrier on the deck. The hook openings 
should face the front of the instrument.

7. Click Tip Change. The Tip Change window opens.

Figure 13-14.Tip Change Window

8. Choose the appropriate Tip type, Deck, Position and Support values in the 
drop-down lists.

9. Click Get Tips. The Tip Change window closes. The MDT arm moves to the 
specified deck location and loads the tips in the tip carrier. The automatic head 
and tip load is complete.

10. Set up the MDT calibration (see page 300).

To set up the MDT calibration:
1. If not already done, attach the desired head and load the tips.

 Note: If this is the first time you are calibrating the instrument, you must manually 
load the head and tips. Otherwise, you can automatically load the head 
and tips. For instructions on loading tips manually and automatically, see 
Loading Dispense Heads and Tips on page 298.

2. Select Utilities > Setup > MDT > Calibrate on the main menu. The Deck 
Calibration MDT window opens as shown in Figure 13-15.
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Figure 13-15.MDT Calibration Window

3. Select the deck to calibrate in the Deck drop-down list below the deck view.

4. Choose a Calibration Type in the drop down list. The default calibration 
point(s) is/are selected on the specified deck.

If you are calibrating the deck for the first time, the Calibration Type must be 
Initial/Reset. If you choose Initial/Reset calibration, all previous calibration 
points on the entire deck are cleared. After the Initial/Reset calibration, you 
can choose 3 Point or Individual Point.

5. Place the calibration plate, shown in Figure 13-16, in the first calibration 
position. The calibration plate is provided with the instrument.

 Note: Place the calibration plate in a medium, solid support tile before placing it 
on the deck. The support tile provides the reference pins necessary to 
position the calibration plate to the deck.
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Figure 13-16.MDT Calibration Plate (on Medium Support Tile)

6. Define and record the calibration points (see page 302).

To define the calibration points:
1. Select the first row in the Point Name table. The selected points are outlined 

in dark blue as shown in Figure 13-17. For Initial/Reset calibration, only one 
set of points is listed. For 3 Point calibration, the two remaining sets of points 
are outlined in light blue.

Figure 13-17.Example of Selected Calibration Point (MDT)

The MDT arm accesses all wells of a labware plate simultaneously due to the 
physical structure of the head and arm. The MDT calibration requires you to 
calibrate the three deck points that correspond to the width of the head and 
selects the points accordingly, as shown in Figure 13-17.

WinPREP measures three points at the same time for the MDT arm. 
WinPREP always selects three points in a row when calibrating the MDT arm. 
Clicking either A7, A8, or A9 selects three points (A7, A8, and A9) for the 
calibration points as shown in Figure 13-17.

The Point Name column displays the calibration point names as “DeckName 
[Range of Three Points]”. Each row in this table represents three measured 
points on the deck, as shown in Figure 13-18. The X, Y, and Z values are the 
point on the left side of the range.

Figure 13-18.Calibration Points Table - MDT
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2. Click the XY Go To button for the associated calibration point. The arm moves 
over the specified location.

3. Click the Z Go To button to lower the head so that you can align the 
disposable tips with the calibration plate.

 NOTE Use the Up and Down controls to make sure the disposable tips are above 
the calibration plate. You do not want the disposable tips to touch the 
calibration plate during horizontal adjustments, but the closer the 
disposable tips are to the calibration plate, the easier it is to check the 
alignment.

4. Use the Forward, Back, Right, and Left buttons to align the disposable tips 
with the row and column grooves in the calibration plate. Aligning the tips with 
the calibration plate is a visual determination.

Select the desired Step Size to specify the distance the arm moves each time 
you click the Arm Position controls.

5. Use the Up and Down buttons to move the arm until the disposable tips 
almost touch the bottom of the grooves in the calibration plate.

! WARNING When performing this step, be very careful that you do not bend or break 
the tips or crash the tips or head into the deck or calibration plate.

6. Click Update in the Point Name table when the disposable tip is aligned with 
the calibration plate. WinPREP saves the current location for the three points 
and updates the row in the Point Name table. The three points display in 
green in the deck view, indicating the calibration status is Measured.

7. Click the Home Z button to raise the head and tips to a safe travel height 
above the deck.

8. For 3 Point or Individual Point calibration, choose another alignment point and 
repeat the procedure until all of the calibration points are measured. For 3 
Point Calibration, three default alignment points are selected. Click a row in 
the table and click a different deck location to change the calibration points.

9. Click the Calculate Positions button to process the measured points and 
calculate the locations of all other positions in the affected region as 
determined by the selected calibration mode.

 NOTE The Calculate Positions button is not available in Individual Point 
calibration. Individual Point Calibration only measures one point, so there 
is no calculation or interpolation of other points on the deck.

10. If performing an Initial/Reset calibration, a message box opens to remind you 
that all calibration points on the deck will be reset. Click Yes to reset the 
calibration points or No to revert to the last saved calibration.
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Figure 13-19.Reset Calibration Window

11. After the points are calibrated, the deck view updates the color of the deck 
positions depending on the calibration method used (white for Initial/Reset, 
yellow for 3 Point, green for Measured).

12. Click OK to save the results and close the calibration window.

13. After performing Initial/Reset calibration, perform a 3 Point calibration for each 
deck to ensure accurate positioning of the head.

 NOTE If this is the first time you are calibrating the instrument, you must manually 
unload the head and tips. Otherwise, you can automatically unload the 
head and tips. For instructions on unloading heads and tips manually and 
automatically, see Unloading Dispense Heads and Tips.

Unloading Dispense Heads and Tips
Similar to loading tips, the MDT dispense head and tips can be unloaded manually 
(see page 304) or automatically (see page 305). Automatically unloading the head 
and tips requires less manual work but also requires that the system is calibrated. 
Manually unloading the head and tips requires more manual interaction but can 
be used if the system is not yet calibrated.

To manually unload an MDT head and tips:
1. Place an empty Tip Box in the Tip Load Carrier.

2. Manually hook the Tip Load Carrier onto the bottom of the head. The hook 
openings must be toward the front of the instrument. Once fully connected, the 
Tip Load Carrier will hang suspended from the MDT head.

 NOTE Make sure all four hooks on top of the Tip Load Carrier are secured before 
proceeding.

If not using a Tip Load Carrier, place a container under the head to catch the 
dropped tips or use the X, Y, and Z directional controls to move the arm over a 
tip chute.

3. Select Utilities > Setup > MDT > Calibrate on the main menu. The Deck 
Calibration: MDT window opens.
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4. Click the Manual Tip Unload button. The system ejects the disposable tips 
from the tip adapters into the empty tip box, container, or tip chute.

5. Remove the Tip Load Carrier from the bottom of the head, if necessary.

6. Use the Forward, Back, Right, and Left buttons to align the head over the 
docking station.

! WARNING Make sure the docking station you plan to unload the head into does not 
already contain a dispense head.

7. Use the Up and Down buttons to move the head down near the docking 
station.

 NOTE When performing this step, be very careful that you do not crash the head 
into the docking station or deck.

8. As the head gets close to the docking station, use the Forward, Back, Right, 
and Left buttons to visually align the two head with the docking station.

9. When the head is aligned with the docking station, click the Manual Head 
Unload button.

The MDT arm moves down and releases the latching mechanisms for the 
head. After releasing the head, the arm moves up, leaving the head in the 
docking station.

The manual head and tip unload is complete and the MDT calibration is complete. 
You can reload the head and tips to perform additional calibrations or start using 
the instrument to run protocols.

To automatically unload the MDT head and tips:

 NOTE If you are calibrating the instrument for the first time, you must manually 
unload the head and tips (see page 304).

1. Select Utilities > Setup > MDT > Calibrate on the main menu. The Deck 
Calibration: MDT window opens.

2. Place an empty Tip Box in the Tip Load Carrier on the deck. The hook 
openings must be toward the front of the instrument. If not ejecting the tips into 
an empty tip box, the tips can be ejected into a tip chute on the deck.

3. Click Tip Change. The Tip Change window opens (see Figure 13-14 on page 
page 300).

4. Choose the appropriate Tip type, Deck, Position, and Support values in the 
drop-down lists. The deck and position fields specify the location where the 
system will unload the tips.

5. Click Drop Tips. The Tip Change window closes and the MDT arm moves to 
the specified deck location and unloads the tips from the tip adapters.
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6. Click Head Change. The Head Change window opens (see Figure 13-13 on 
page page 299).

7. Choose the appropriate Dispenser Head, Deck, Position, and Support 
using the drop-down lists and click Unload Head.

The Head Change window closes. The MDT arm moves to the specified deck 
location and unloads the head into the docking station.

The automatic head and tip unload is complete. The MDT calibration is also 
complete. You can reload the head and tips to perform additional calibrations or 
start using the instrument to run protocols.
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Calibrating the MDT Arm for 1536-Well Microplates

Accessing the wells on a 1536-well microplate requires precise and accurate 
positioning. You must perform additional calibration tasks to ensure the high level 
of precision and accuracy.

The following items outline the conditions necessary to reliably aspirate from and 
dispense into 1536-well microplates using the MDT pipetting arm.

• Perform the deck calibration with the dispense head and disposable tips (if 
applicable) you will use to access the 1536-well microplate.

• Perform an Individual Point calibration at each deck location that will support a 
1536-well plate. See 1536-Well Calibration Method on page 308 for 
instructions.

• The I30 dispenser head and P30 or P10 disposable tips are the optimal 
choices for accessing 1536-well microplates. The I50 dispenser head, with 
P20 disposable tips, is also acceptable for accessing 1536-well microplates. 

• If using both I30 and I50 heads on the same system, you must use the 
Individual Point calibration method to re-calibrate any common deck positions 
before switching from one head to the other. If the heads access1536-well 
plates on different deck positions, recalibration is not necessary. 

• If both NanoHead and MDT dispense heads access the same 1536-well Plate, 
perform the Individual Point calibration with the disposable tip dispense head 
first and verify the calibration with the NanoHead Calibration Tool.

• Use the Individual Point calibration method to recalibrate all 1536-well plate 
positions on the deck if the MDT pipetting arm encounters any obstruction 
during motion.

Calibrating the JANUS G3 Deck for 1536-Well Microplates
This section describes how to calibrate deck locations for improved positional 
accuracy when using 1536-well microplates. 

Using this method, you can verify the calibration by observing how all the tips 
align with the wells in a 1536-well plate. You can ensure the tips do not touch the 
tops or sides of the wells. You can also check the alignment of all tips and see how 
the tip locations vary from well to well. This allows you to estimate any necessary 
adjustments based on all the tips rather than a few distributed tips.

Although this method uses the Labware Evaluation screen, it does not change 
any labware definitions. This method changes the calibrated deck positions to 
improve access to 1536-well microplates.
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1536-Well Calibration Method
Perform the following calibration method for all deck locations where you want to 
use the MDT pipetting arm to access 1536-well microplates. 

Prior to beginning any calibrations, fully level the instrument and adjust for head-
to-deck level and squareness to ensure optimal positional accuracy.

To perform a 1536-well calibration:
1. Calibrate each deck plate using a 3 Point calibration. Perform the calibration 

procedure using the disposable tips you will use when accessing the 1536-
well microplate. See Calibrating the MDT Pipetting Arm on page 297 for more 
information on performing a 3 Point calibration.

2. Perform an Individual Point calibration for the 1536-well microplate deck 
position using the procedure described in Calibrating the MDT Pipetting Arm 
on page 297. 

When using disposable tips to access the 1536-well microplate, use the actual 
dispense head that will access the plate wells. Load the head with a new box 
of disposable tips. When using the NanoHead to access the 1536-well 
microplate, use the NanoHead calibration tool. 

 Note: If the disposable tip head and the NanoHead will access the same 1536-
well microplate, calibrate the deck with the disposable tip head first 
followed by verification with the NanoHead calibration tool. 

3. Remove the MDT calibration plate from the deck support tile and replace it 
with a 1536-well microplate. The microplate must be identical to the plate type 
used in the actual protocol. 

 Note: The labware file for the microplate used in the calibration must be accurate 
according to the microplate manufacturer’s specifications. Unless an 
accurate labware file is available, this method of adjusting the calibration 
should not be used. 

 Note: Position the microplate in the medium solid support tiles so the plate is 
pushed to the left/back corner of the support. 

4. Open a new WinPREP protocol and populate the deck view with a 1536-well 
microplate and support. Be sure to place these items in the same deck 
location you calibrated in Step 2 above.

5. Double-click the microplate in the deck view to open the Labware 
Parameters window, shown in Figure 13-20.



 Chapter 13: Calibrating the System 309

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Figure 13-20.Labware Parameters Window

6. Click Edit in the lower-left corner of the Labware Parameters window and 
click OK on the Prepare for Labware Evaluation window. The Properties 
window opens as shown in Figure 13-21.

Figure 13-21.Labware Properties Window
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7. Select the first well, first column field in the table on the left side of the 
window, as shown in Figure 13-22.

Figure 13-22.Labware Properties Window

8. Click the Go to button to move the A1 tip of the MDT head to the center of well 
A1.

9. Before making any adjustments to the position of the MDT arm or tips, record 
the X and Y coordinates shown in the X/Y Motors frame. These are the 
starting X and Y values.

10. Set the Step size option to 1 mm and use the Z Motor Up and Down buttons 
to move the tips into and out of the wells. 

11. While moving the tips in and out of the wells, listen for any tip contact with the 
well walls and look to make sure the tips are centered in the wells. Inspect as 
many tips as possible and visually average the tip positions in the wells. 

12. If you need to adjust the calibrated position, make fine X- and Y-axis 
adjustments using the controls in the X/Y Motors frame until, on average, all 
of the tips are centered in the wells.

13. Write down the current X and Y positions. These are the ending X and Y 
values.

14. Subtract the starting X and Y values from the ending X and Y values. The 
change in positioning is referred to as delta-X (X) and delta-Y (Y). 
NOTE: Do not update the labware properties for the 1536 well microplate.

15. Record the delta-X and delta-Y (X and Y) values and close the Labware 
Definition window without updating. 

16. Remove the 1536 well microplate from the deck. 

17. Select Utilities > Setup > MDT > Calibrate on the main menu to open the 
Deck Calibration: MDT window. Click Go To to move the MDT arm to the 
calibrated deck position. 

18. Using the Arm Position control, adjust the X and Y position by the X and Y 
values recorded in Step 15 above. 

19. Click Update to record the changes to the calibrated position and click OK to 
close the Deck Calibration MDT window. 

20. Verify the first well position for the same 1536-well microplate at this deck 
location by repeating Steps 5 through 8 above. 

The calibration is complete. Note: you must repeat these calibration steps each 
time you load a different MDT head.
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Calibrating the NanoHead

To calibrate the NanoHead, follow the instructions for Calibrating the MDT 
Pipetting Arm on page 297, but use the NanoHead Calibration Tool to align the 
head with the calibration plate.

Calibrating the MDT Gripper

If the MDT arm includes an MDT gripper, the X and Y position of the head is set 
when calibrating the MDT arm, but you must also calibrate the MDT gripper by 
setting the gripper height.

To calibrate the MDT gripper:
1. Load the MDT head with disposable tips.

2. Select Utilities > Setup > MDT > Calibrate on the main menu to open the 
Deck Calibration: MDT window (see Figure 13-15 on page 301).

3. Click the Set Gripper Height button. The Set Gripper Height window opens 
as shown in Figure 13-23.

Figure 13-23.Set Gripper Height Window

4. Use the Z Height controls to lower the MDT gripper fingers until the bottom of 
the fingers are flush with the bottom of the disposable tips on the head.

 Tip: Hold an item with a flat surface, such as the MDT Calibration Plate or a 
rigid piece of cardboard, against the bottom of the tips and move the 
gripper down to contact the same surface.

5. When the gripper is positioned properly, click OK to save the vertical height 
and close the Set Gripper Height window.

6. Click OK to close the Deck Calibration: MDT window.

The MDT gripper calibration is complete. You can proceed with additional 
calibration tasks or begin using the instrument.
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Calibrating the Gripper Arm

In order for the system to reliably manipulate labware using the Gripper, it must be 
able to accurately locate the labware with the Gripper fingers. When you calibrate 
the Gripper arm, you identify and measure points on the instrument’s deck. Each 
Gripper calibration point consists of three deck positions. Once calibrated, you 
can associate grippable labware on the deck with Get Plate and Move/Put Plate 
steps in the protocol outline. You can specify that an item is grippable by providing 
the necessary information in its labware definition.

• For standard On-Deck positions, see Calibrate the Deck for the Gripper Arm 
below.

• For labware positions that are located off the deck but within range of the 
Gripper arm, or special locations on the deck such as in front of a barcode 
reader, see Teaching Off-Deck (or Special On-Deck) Locations on page 319. 
Use this procedure to teach positions on incubators, shakers, readers, or plate 
sealers, or to position labware in front of barcode readers for plate 
identification, etc.

• For manifold components that are located at a single location, see Teaching 
Manifold Component Locations on page 321. Manifold components that can 
be assembled or disassembled during a protocol are typically located at a 
single location, but with different heights and/or finger positions to grip each 
manifold component.

Calibrate the Deck for the Gripper Arm
To setup the Gripper calibration:
1. Select Utilities > Setup > GripperArm (or ExtendedGripper) > Calibrate on 

the WinPREP menu. The Deck Calibration: Gripper window opens as 
shown in Figure 13-24. Default calibration points are selected based on the 
selected deck and calibration type.
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Figure 13-24.Gripper Calibration Window

2. Click the deck position where you want the gripper arm to move to load the 
Gripper Calibration Tool. The point should enable you to reach the keyboard 
and calibration tool at the same time. The position is highlighted in the deck 
layout but the gripper does not move. Note that the calibration position in the 
Calibration Point Table updates to the selected position.

3. Click the Load Calibration Tool button on the Deck Calibration: Gripper 
window. The gripper moves to the point selected on the deck layout. The 
Gripper Get Calibration Tool window opens as shown in Figure 13-25.

Figure 13-25.Get Calibration Tool Window

4. Place the calibration tool, shown in Figure 13-26, onto the Gripper fingers and 
hold it up on the Gripper fingers.

The Gripper fingers fit through the four oval holes in the Gripper calibration 
tool, as shown in Figure 13-27. Make sure that the metal pins in the Gripper 
calibration tool point downward.
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Figure 13-26.Gripper Calibration Tool

5. Click OK. The Gripper fingers open to grip the calibration tool and the Get 
Calibration Tool window closes. Carefully move the gripper tool down on the 
fingers until the bottom of the plate rests on the horizontal finger pins, as 
shown in Figure 13-27.

Figure 13-27.Gripper Calibration Tool on Gripper Fingers

6. In the Deck Calibration: Gripper window (see Figure 13-24), select the deck to 
calibrate in the Deck drop-down list below the deck view.

7. Choose a Calibration Type in the drop down list. The default calibration 
point(s) is/are selected on the specified deck.

8. If you are calibrating the deck for the first time, the Calibration Type must be 
Initial/Reset. If you choose Initial/Reset calibration, all previous calibration 
points on the entire deck are cleared. After the Initial/Reset calibration, you 
can choose 3 Point or Individual Point.

9. Set the Orientation option to the orientation of the gripper for calibration, 
normally Landscape. Figure 13-28 shows a 96-well plate in landscape and 
portrait orientations.

Metal Pins
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Figure 13-28.Labware Orientation Example (Landscape and Portrait)

10. Select and record the calibration points as described below.

To select the calibration points:
1. Select the deck to calibrate in the Deck drop-down list below the deck view. 

The default calibration point(s) for the deck are selected.

2. Click the first row in the Point Name table. The selected point is outlined in 
dark blue as shown in Figure 13-29. Any other default points are outlined in 
light blue.

Figure 13-29.Example of Selected Gripper Calibration Point

The software selects deck positions in groups of three because there are three 
pins on the Gripper calibration tool. The software automatically selects three 
deck locations when you click one Gripper calibration point. For example, 
when you click position G1, the software selects positions G1, G2, and G3.

The Point Name column shows the selected calibration points (one for Initial/
Reset or Individual Point calibration, three for 3 Point calibration). Each row 
represents a Gripper calibration point on the deck, as shown in Figure 13-30.

Figure 13-30.Point Name Table

3. Place three calibration cones, shown in Figure 13-31, in the three deck 
positions associated with the calibration point you want to measure. The three 
deck positions are indicated on the deck view and in the Point Name table. 
The calibration cones are provided with the instrument.
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Figure 13-31.Gripper Calibration Cone

You use three deck positions because the Gripper calibration tool contains 
three alignment pins. During calibration, align the three metal pins in the 
Gripper calibration tool with the three deck positions. The Point Name Table 
displays the coordinates of the middle of the three deck positions. For 
example, in landscape orientation, to measure position G2, select positions 
G1, G2, and G3. In portrait orientation, to measure position B2, select 
positions A2, B2, and C2.

4. Click the XY Go To button for the associated calibration point. The arm moves 
above the specified location.

Alternately, if the Gripper arm is far from the selected point, select the Move 
XY Manually check box and physically move the arm until the pins are close 
to the calibration cones. Deselect the Move XY Manually check box before 
proceeding.

5. Click the Z Go To button for the associated calibration point. The Gripper arm 
moves down to the specified height.

 Tip: Use the Up and Down controls to make sure the pins on the calibration 
plate are above the calibration cones. You do not want the pins to touch 
the calibration cones during horizontal adjustments, but the closer the pins 
are to the calibration cones, the easier it is to check the alignment.

6. Use the Front, Back, Right, and Left position slider controls in the Arm 
Position frame of the window to make fine adjustments until the pins on the 
calibration plate are aligned with the points of the calibration cones. Aligning 
the pins with the calibration cones is a visual determination.

Select the desired Step Size to specify the distance the arm moves each time 
you click the Arm Position controls.
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7. Use the Up, Down, Clockwise, and Counterclockwise position slider 
controls to make fine vertical and rotational adjustments until the pins on the 
bottom of the calibration plate touch the tips of the calibration cones. Align the 
pins with the tips of the calibration cones; the pins on the calibration plate 
should not touch or exert any pressure on the tips of the calibration cones. 
See Figure 13-32 for an example of calibration pin to cone alignment.

! WARNING:When performing this step, be very careful that you do not bend or break 
the calibration pins or calibration cones or crash the calibration pins into 
the deck or calibration cones. Doing so could damage the Gripper arm or 
calibration plate.

Figure 13-32.Gripper Calibration Tool Alignment with Calibration Cones

8. Click Update in the Point Name table when the Gripper Calibration Tool is 
aligned. WinPREP records the measured location for the point and updates 
the selected row in the Point Name table. The measured point displays in 
green, indicating its calibration status is Measured.

9. Click the Home Z button to raise the Gripper to a safe travel height above the 
deck.

10. For 3 Point or Individual Point calibration, click another row in the table and 
repeat the procedure until all of the calibration points are measured.

11. If you want to unload the gripper calibration tool, click the deck location where 
you want to unload the calibration tool and then click the Unload Calibration 
Tool button. The Gripper moves to the selected location and then moves 
down to approximately 10mm above the deck. The Unload Gripper Calibration 
Tool window opens as shown in Figure 13-33.
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Figure 13-33.Unload Gripper Calibration Tool Window

12. Hold your hand under the calibration tool to prevent the tool from dropping 
onto the deck and click the OK button to release the Gripper calibration tool.

13. Click the Calculate Positions button to process the measured reference 
points and calculate the locations of all other deck positions in the affected 
region as determined by the selected calibration mode.

 Note: The Calculate Positions button is not available in Individual Point 
Calibration mode. This mode calibrates individual points, so there is no 
calculation or interpolation of other points on the deck.

14. If performing an Initial/Reset calibration, a message box opens to remind you 
that all calibration points on the deck will be reset. Click Yes to reset the 
calibration points or No to revert to the last saved calibration.

Figure 13-34.Reset Calibration Window

15. After the points are calibrated, the deck view updates the color of the deck 
positions depending on the calibration method used (white for Initial/Reset or 
yellow for 3 Point).

16. Click OK to save the results and close the calibration window.

17. After performing Initial/Reset calibration, perform a 3 Point calibration for each 
deck to ensure accurate positioning of the gripper.
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Teaching Off-Deck (or Special On-Deck) Locations
The Teach Position window allows you to teach custom positions for the Gripper 
arm.

To teach Gripper positions for Off-Deck or special On-Deck locations:
1. Select Utilities > Setup > Gripper > Teach Positions on the main menu. 

The Select Taught Position window opens as shown in Figure 13-35.

Figure 13-35.Select Taught Position Window

2. If the position already exists, select the Existing Positions option, select the 
name of the position to teach, and go to step 8.

3. To create a new position, select the New Position option.

4. Select whether to create an On-Deck or Off-Deck position. On-Deck positions 
are relative to a location on the deck. Off-Deck locations are relative to the 
Deck Origin (see Deck Calibration Coordinate System on page 292).

5. If creating an On-Deck position, select the Deck and the Position that the 
taught position will be relative to.

6. Type a Category name for the position in the Category text box. The Category 
name groups the taught positions so they are easier to identify.

7. Type a name for the position in the Labware text box. 

8. Click the OK button. The Teach Position window opens as shown in Figure 13-
36.
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Figure 13-36.Teach Position Window for Gripper Arm

9. Position the labware in the position it will be located in when the gripper will be 
moving the labware.

10. If the labware item must be gripped by the fingers from the inside of the lip of 
the labware, select the Open to grip check box. 

11. Change the step size, as necessary to facilitate precise positioning.

12. Move the fingers to the precise location of the labware (rotate the fingers if 
necessary) and position the four fingers equidistant from the labware.

13. Click the Update button to display the current position of the gripper and 
fingers in the Learned Position row of the table.

14. Click the Save button to save the position.

15. If desired, click the Select button to open the Select Taught Position window 
and repeat steps 2-14 until all the necessary positions are taught.

16. Click the Close button to close the Teach Position Window.

17. Click the OK button to close the Select Taught Position window.
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Teaching Manifold Component Locations
The Teach Manifold Components window allows you to teach the gripper 
positions for manifold components. This allows the gripper to adjust for the 
variable height and size of different manifold components as components are 
added or removed from the manifold during the protocol. Manifold Component 
Locations are relative to the deck position of the labware.

1. Select Utilities > Setup > Gripper > Teach Manifold Components on the 
main menu. The Select Manifold Components window opens as shown in 
Figure 13-37.

Figure 13-37.Select Manifold Component Window

2. If the component already exists, select the Existing Manifold Component 
option, select the name of the manifold component to teach, and go to step 7.

3. To create a new manifold component, select the New Manifold Component 
option.

4. Type the desired name for the type of manifold in the Type drop-down list, or 
select an existing type if the manifold has already been created.

5. Type the desired name for the component to teach in the Component drop-
down list.

6. Select the Deck and Position where the labware is located on the deck.
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7. Click the OK button. The Teach Manifold Components window opens as 
shown in Figure 13-38.

Figure 13-38.Teach Manifold Components Window

8. If the labware will be gripped from the inside of the labware, select the Open 
to Grip check box.

9. Change the Step Size as necessary to precisely position the gripper.

10. Use the Motor buttons to position the gripper in the proper location to grip the 
labware. 

11. Verify the gripper fingers are equidistant from the labware by opening or 
closing the fingers until they almost touch the labware and verifying that the 
gripper is centered.

12. Open or close the gripper fingers all the way, so the fingers are as far as 
possible from the labware.

13. Click the Update button to display the current position of the Gripper arm in 
the table.

14. Click the Save button to save the position. 

15. If desired, click the Select New Position button to open the Select Manifold 
Components window and repeat steps 2-14 until all the necessary 
components are taught.

16. Click the Close button to close the Teach Manifold Components window.

17. Click the OK button to close the Select Manifold Components window.
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Calibrating the Tube Barcode Reader

This procedure calibrates the Varispan arm to the Varispan Tube Barcode Reader 
deck (Var-Left-BCR). The Tube Barcode Reader has 12 lanes of tube cassettes 
numbered 1 to 12 from left to right. Each cassette holds 16 tubes numbered from 
1 to 16 (from back to front). The barcode scanner (laser or optical) reads the 
barcodes on the tubes in the tube cassettes as the cassette is moved in front of 
the barcode scanner.

This section contains the following procedures for calibrating the Tube Barcode 
Reader:

• Calibrating the Tube Barcode Reader Deck on page 323
• Teaching the Tube Barcode Reader Engage Position on page 326
• Teaching Labware for the Tube Barcode Reader Cassettes on page 327

Calibrating the Tube Barcode Reader Deck
Teach the Varispan Tube Barcode Reader deck using a 3 Point calibration as 
described below.

To calibrate the Varispan Tube Barcode Reader Deck:
1. Select Utilities > Setup > Varispan 8-Tip or 4-Tip > Calibrate. The Deck 

Calibration:Varispan window opens as shown in Figure 13-39.
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Figure 13-39.Calibrate Tube Barcode Reader, Initial/Reset Calibration

2. Select Var-Left-BCR in the Deck drop-down list.

3. Select 3 point in the Calibration Type drop-down list. 

4. Click position AL on the tube rack on the deck layout. Three default points 
(GL-Left Front, AL-Left Rear, and AR-Right Rear) are circled on the Var-Left-
BCR Deck.

 NOTE: The Var-Left-BCR Deck positions must be taught in the following order: 
GL, AL, and then AR. Teaching in any other order will not calculate the 
positions properly. The positions must form a right angle when teaching.

5. In the Cone Type drop-down list, select Standard 14mm.

6. Remove the black plastic 12-lane rack from the deck.

7. Place the calibration cone (P/N 5077293) in position GL.

8. Click the Go To button in the XY column for position AR. The Varispan arm 
moves to the taught position in the X and Y directions, but the tip does not 
move down.
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9. Click the Go To button in the Z column for position AR. The selected Varispan 
tip moves down and should lightly contact the top of the cone. When the arm 
and tip are positioned correctly, you should be able to rotate the cone, but not 
remove the cone from under the tip.

10. If the position needs to be adjusted, use the Step Size setting and the 
Position buttons to move the arm left/right or forward /back and to move the 
tip up/down. Click the Update button when the arm and tip are in the correct 
positions.

11. Click the Update button to teach each position.

12. Repeat to teach positions AL and then AR.

13. Click the Calculate Positions button. The Tube Imaging Module positions on 
the Var-Left-BCR deck are calculated based on the new taught positions. (The 
calculated positions on the Var-Left-BCR Deck display in yellow to indicate the 
3 Point calibration is complete.)

14. Replace the black plastic 12-lane rack on the deck.

15. Calibrate the right side of the Var-Left-BCR deck by performing a 3 point 
calibration using three points that form a right angle to enclose the deck. The 
default is A1, G1, and then G3.
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Teaching the Tube Barcode Reader Engage Position
When reading barcodes, the engagement finger on the arm interlocks with a notch 
on the end of the cassette and pulls the tube cassette past the tube barcode 
reader. To ensure the finger properly engages with the cassette, you must 
calibrate the tube barcode reader. This calibration defines the exact location of the 
initial finger engagement for the first cassette (Lane 1). The system determines 
the engagement positions of the remaining cassettes based on the first cassette.

To calibrate the tube barcode reader:
1. Position a cassette in Lane 1 with the metal tab toward the back of the deck 

and move the cassette to the front of the instrument.

2. Select Utilities > Setup > Bar Code Scanner > Setup. The Setup Lane 1 
Engage Position window opens as shown in Figure 13-40 to define the 
engagement position for the first cassette on the deck.

Figure 13-40.Setup Lane Engage Position window

3.  Use the Left, Right, Back, and Front directional control buttons to position 
the engagement finger in the center of the notch on the end of the cassette in 
Lane 1. Verify the Engage Sensor check box displays a check mark, 
indicating that the sensor detects the cassette.

Alternately, set the Motor Power option to Off and manually move the 
barcode finger into proper alignment. (Motor power is automatically restored 
when you use any of the directional buttons. You do not have to explicitly turn 
the motor power back on.)

4. Verify that the finger engages with the cassette and click Update to save the 
new position.

5. Click OK to close the window.

6. Adjust the Y Offset if necessary. If the cassette is not positioned all the way at 
the front of the rail when moving the rack to the Home position, increase the Y 
Offset. If the cassette bumps against the front of the rail and the back of the 
cassette lifts, decrease the Y Offset.
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Teaching Labware for the Tube Barcode Reader Cassettes
Teaching the tube cassettes enables the Varispan tips to accurately access the 
tubes in the cassettes. Two positions, Tube 1 and Tube 16, are taught. The 
remaining positions in the cassette are calculated relative to the two taught 
positions.

To teach the tube cassettes:

1. Open any protocol that includes the Tube Barcode Reader.

2. Add the Tube Bar Code Cassette labware to Lane 1 of the tube rack, 
specifying the tubes you are using.

3. Place a tube in Position 1 of the tube cassette, place the tube cassette in Lane 
1, and move the tube cassette all the way to the front of the rail.

4. Right-click on the cassette in lane 1 and click Properties. The Tube Bar Code 
Cassette1 Parameters window opens.

5. Click the Edit button. The Prepare For Labware Evaluation window opens.

6. Click the OK button. The Properties window for the specific tube opens 
(Figure 13-41).

Figure 13-41.Streck Properties Window

7. Click the Var Evaluate tab.

8. Click the First Well, First Column entry in the table. 

9. Click the GoTo button to move the tip to the XY location in the table.
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10. Use the Left/Right and Back/Front buttons to align Tip 2 with the center of 
the tube in Lane 1, Position 1 (the back position on the far left cassette).

11. Use the Up/Down buttons to align the end of the tip with the top of the tube as 
shown in Figure 13-42.

Figure 13-42.Tube Cassette in Lane 1

12. Click the Update button.

13. Click the Last Well, Last Column entry in the table. 

14. Click the GoTo button to move the tip to the XY location in the table.

15. Use the Left/Right and Back/Front buttons to align Tip 2 with the center of 
the tube in Lane 1, Position 16 (the front position on the far left cassette).

16. Use the Up/Down buttons to align the end of the tip with the top of the tube as 
shown in Figure 13-42.

17. Click the Update button.

18. Click the OK button. The tip moves up to the Z Home position.

19. If you are using multiple tube types, repeat to teach the other tubes in the 
cassette.

20. Close the protocol.
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Chapter 14

System Configuration
This chapter describes how to configure the instrument and its various 
subsystems so that it functions correctly. Specifically, this chapter describes how 
to configure the following:

• JANUS G3 Instrument on page 329
• Varispan Pipetting Arm on page 340
• MDT Pipetting Arm on page 340
• Gripper Arm on page 340

It also describes how to calibrate the deck. You should recalibrate (and realign the 
tips) if the sampling tips or arms crash into anything. You should also recalibrate 
the deck regularly. While weekly calibration is not critical (the instrument should 
stay in calibration if operating smoothly for longer than a week) it is import to have 
scheduled times for calibration and quarterly is too infrequent.

JANUS G3 Instrument
This section describes how to change the JANUS G3 deck configuration, add and 
enable integrated instruments, initialize the system, and park the arms.

• Changing the Deck Configuration on page 330
• Configuring the Status Lights on page 330
• Integrating Devices on page 331
• Initializing the System on page 339
• Parking the Arms on page 339
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Changing the Deck Configuration

If you change the deck plates on the instrument, you must change the deck 
configuration in the Instrument Setup window to match the actual system 
hardware.

To change the instrument deck configuration:

1. Select Utilities > Setup > Instrument > Settings on the WinPREP main 
menu. The Instrument Setup window opens.

2. Select the installed deck plates from the Deck Configuration Controls (see 
Figure 14-1) below the instrument Layout.

Figure 14-1. Deck Configuration Controls

3. Click the OK button to save the settings and close the Instrument Setup 
window.

4. After changing deck plates, you must calibrate the arms and reteach any 
gripper positions. 

Configuring the Status Lights

You can customize the status lights on the front of the instrument. The colors, 
brightness, and the time elapsed until the status lights dim can be changed as 
desired.

To configure the status lights:

1. Select Utilities > Setup > Instrument > Settings on the WinPREP main 
menu. The Instrument Setup window opens.

2. Click the Light Settings tab.

3. Select the desired options for the status lights. (See the description of the 
Instrument Setup Window - Light Settings tab in the online help for details.)

4. Click the OK button to save the settings.
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Integrating Devices

You must enable the deck and subsystem options so that the software can use the 
hardware that is installed. You enable these options in the Instrument Options 
window. To open the Instrument Options window, select: 
Utilities > Setup > Instrument > Settings.

Using the Integration Manager requires two general steps:

• Installing and Registering Integration Devices
• Adding a Device to the Deck and Creating the Integration

The following sections describe each of these steps in greater detail.

Installing and Registering Integration Devices
The first step to creating an integration on the JANUS G3 system is to install and 
register the DLL or OCX files for the integration devices.

In many cases, the hardware device’s manufacturer provides an installation disk 
with the hardware. The installation disk usually includes an automated process for 
installing and registering the integration device. If this is the case for the hardware, 
you can skip to Adding a Device to the Deck and Creating the Integration on 
page 333. If the hardware does not include an automated installation, you must 
install and register the integration device manually. This section describe how to 
perform the manual installation and registration.

To install and register an integration device:
1. Make sure WinPREP is not active. Close WinPREP if necessary.

2. Obtain the DLL/OCX file for the hardware device. This file should be among 
the support files provided by the hardware manufacturer.

3. Place the DLL/OCX file in the Integrations\ folder in the WinPREP installation 
folder. The WinPREP installation folder defaults to C:\Packard\JANUS\ and this is 
the most common location. If this is not the location for the particular 
installation, locate the actual installation folder or contact your system 
administrator.

4. Open a Command Prompt window: 
Click the Windows Start button, type cmd in the Search text box, and then 
click the cmd.exe program.

5. Type the following command at the command prompt and press Enter:
X:

Where “X” is the drive letter identifying the location of the WinPREP 
installation. The default installation drive for WinPREP is “C”.
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6. Type the following command at the command prompt and press Enter:
cd \Packard\JANUS\Integrations\

This uses the cd (change directory) DOS command to change to the 
Integrations folder.

 Note: If the WinPREP installation is in a location other than the default 
(C:\Packard\JANUS\), substitute the actual location for the default 
location shown in the previous command.

7. Type the following command at the command prompt and press Enter:
regsvr32 IntegrationDevice.DLL

where IntegrationDevice.DLL is the name of the DLL or OCX file you want to 
register. Figure 14-2 shows an example.

Figure 14-2. Registering a DLL or OCX file

8. When the command completes, the command prompt returns and Windows 
displays a confirmation message, as shown in Figure 14-3.

Figure 14-3. DLL/OCX registration confirmation window

 Note: If you receive an error message, make sure you typed the command and 
file name correctly. Also make sure you copied the DLL/OCX file into the 
Integrations folder and executed the cd command successfully.

9. Click OK to close the registration confirmation window.
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10. Type the following command at the command prompt and press Enter:
exit

The Command Prompt window closes.

When you complete the previous steps, the integration DLL/OCX is ready to use 
in WinPREP. See Adding a Device to the Deck and Creating the Integration to add 
an instance of the integration device to the deck and create the integration.

Adding a Device to the Deck and Creating the Integration
After adding the integration interface for the internal device, you must integrate 
the device into the liquid handling work flow using the Integration manager.

To add the device and create the integration:
1. Select Utilities > Setup > Instrument > Settings from the main menu. The 

Instrument Setup window opens as shown in Figure 14-4.

Figure 14-4. Instrument Setup window

 Note: If the device you want to integrate already exists in the table on the Deck 
Layout tab, you can skip Steps 2 through 4 and start with Step 5.

2. Select the Deck Layout tab on the Instrument Setup window, if it is not 
already the active tab.

3. Click Add to insert a new row in the Deck Layout table, as shown in Figure 
14-5.
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Figure 14-5. New Deck Layout Table Entry

4. Use the Accessory drop-down list to select the hardware you want to 
integrate. For the purposes of this example, the selection is PlateStak-URight. 
The table updates with the position data (X, Y, and Z distances) for the 
selected device, as shown in Figure 14-6.

Figure 14-6. Accessory Selection in Deck Layout Table

By setting this option, you are selecting the device and its placement with 
respect to the JANUS G3 deck. The optional hardware devices installed on 
the system and the configuration of the JANUS G3 instrument determine the 
options available in the Accessory list. In this example, and as the Accessory 
setting implies, the PlateStak is located in the upper right corner of the deck.

 Note: Make sure the position on the physical deck matches the virtual deck 
layout before running the protocols. Exact positioning is not required 
because you determine this information during deck calibration.

5. Select the Integration Manager tab.

6. Click Add to insert a new row in the Integration Manager table, as shown in 
Figure 14-7.

Figure 14-7. New Integration Manager Table Entry

7. Set the Type option to the device you want to integrate. This example uses the 
PlateStak option. When you set the Type option, the Icon, Name, and 
Connection fields populate with default values, as shown in Figure 14-8.
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Figure 14-8. PlateStak Integration type

 Note: If the device you are integrating is not connected to the assigned 
Connection port, set it to the appropriate value.

8. Set the Deck option to the device you want to integrate. This example uses 
the PlateStak device you placed on the deck in Step 4 above. The Deck drop-
down contains a list of all the integration devices available.

 Note: The Configure button opens a window containing configuration options for 
the device selected in the Type option. These options vary depending on 
the selected device and the control options supplied in hardware’s DLL/
OCX.

9. Click OK to save the changes and close the Instrument Settings window. 
WinPREP now displays a toolbar with a button for the integrated hardware, in 
this example, the PlateStak. Figure 14-9 shows the toolbar icon.

Figure 14-9. PlateStak Integration Toolbar Button

The integration is complete. You can include the PlateStak device in a protocol 
outline by clicking the icon on the integration toolbar, selecting Protocol > Add 
Procedure > Integrations > PlateStak_1 from the main menu, or right-clicking in 
the protocol outline and selecting Add Procedure > Integrations > PlateStak_1 
from the menu. WinPREP inserts a procedure node into the protocol outline and 
opens an Integration Parameters window where you can configure the device’s 
parameters.

Parameters differ for each integration device. Consult the device’s specific 
documentation for more information on parameter settings.
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Using the Integration Toolbar Buttons
The buttons on the Integration toolbar provide access to individual instances of 
integrations configured on the instrument. The Integration toolbar only displays if 
at least one integration has been added to the system using the Integration 
Manager. The icons on the toolbar vary depending on the number and types of 
integrations that are configured. Figure 14-9 shows the Integration toolbar after 
adding a PlateStak integration.

When you add multiple integration instances of the same device type, the 
Integration toolbar displays a button for each integration. For example, if you 
added two PlateStak integrations, the Integration toolbar would contain two 
PlateStak buttons, as shown in Figure 14-10.

Figure 14-10. Integration Toolbar (with multiple PlateStak integrations)

Although the icons are the same, the buttons represent individual integration 
instances. Hover the cursor over a button on the Integration toolbar to display the 
name of the integration instance. This helps you determine which icon on the 
toolbar relates to an associated integration instance. Figure 14-11 shows this 
functionality.

Figure 14-11. Tooltip display for Integration Toolbar

Clicking a button on the Integration toolbar inserts an Integration node for the 
specific integration into the protocol outline. For example, Figure 14-12 shows an 
Integration toolbar containing both a PlateStak and an IKA Shaker integration. It 
also shows the corresponding Integration nodes for these instances in the 
protocol outline.
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Figure 14-12. Integration toolbar and corresponding integration nodes

You use the Integration node to configure and control the integration device 
directly from the WinPREP protocols. Figure 14-13 shows an example of the 
Integration Parameters window.

Figure 14-13. Integration Parameters window

This example shows the Integration Parameters window for an IKA Shaker 
integration. The procedure frame of the window contains common integration 
settings such as Integration Name, Name, and a Command drop-down list. The 
bottom portion of the window updates with control parameters based on the 
selected integration instance and the selected Command parameter.
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The Integration Name defines the integration instance associated with the 
integration node. In this example, it is the IKA shaker. However, if you change the 
Integration Name, WinPREP dynamically updates the node to reflect the 
selected integration instance. The Name field is a unique identifier for the 
integration node in the protocol outline. You can change the name by typing the 
desired text in the field or you can accept the default value. The commands 
available in the Command drop-down list is determined by the integration 
instance. For example, commands for the IKA Shaker include Turn Shaker On 
and Turn Shaker Off, while commands for the PlateStak are more extensive and 
include DownStack, MoveCarrier, ReStack, SetUpMagazines, UpStack, and 
WaitForCompletion. Selecting a command in the Command list displays the 
configuration and options associated with the command on the lower part of the 
window. Figure 14-14 shows an example of the Integration Parameters window 
for the IKA Shaker integration with Turn Shaker On selected in the Command 
drop-down list.

Figure 14-14. IKA Shaker Integration Parameters window

As shown above, the Turn Shaker On Command has one parameter to control 
the speed of the shaker.

You can also add a generic integration node to the protocol. A generic integration 
node is an integration node in the protocol outline not associated with a specific 
integration instance. You can insert a generic integration node by clicking the 
Integration icon on the Time and Dialog Functions toolbar. The icon used to 
represent a generic integration node and the generic integration node’s toolbar 
button are shown in Figure 14-15.

Figure 14-15.Generic Integration Node

Figure 14-16 shows the Integration Parameters window for a generic integration 
procedure.
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Figure 14-16.Generic Integration Parameters window

Because no specific integration instance is associated with the generic 
integration, the Integration Name field is blank and the Name field identifies the 
node as an integration. If you change the Integration Name option to one of the 
recognized integration instances, WinPREP converts the generic integration node 
into an integration node for the selected integration.

Initializing the System

To initialize the system, select Utilities > Setup > Instrument > Initialize from 
the main menu.

When you execute the Initialize command, the system goes through a series of 
motions as it finds Home positions for each of the motions. A status box opens to 
display the progress and the current axis being initialized. The arms, tips, and 
syringe pumps all move at various times during the initialization as the home 
positions are verified and reestablished.

 NOTE: Do not click or right-click in the WinPREP software until initialization is 
complete. Interfering with the Initialization could cause WinPREP to crash.

This initialization is similar to the initial startup routine that occurs when you apply 
power to the instrument.

Parking the Arms

To park all the arms on the system, select Utilities > Setup > Instrument > Park 
All Arms from the main menu.

When you execute the Park All Arms command, the system goes through a series 
of motions as it attempts to find the home positions for each of the installed arms. 
The system components (arms, tips, heads, etc.) all move at various times during 
the initialization as the home positions are verified and reestablished. 
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Varispan Pipetting Arm
The Varispan arm accesses labware on a well-by-well basis. Each well is treated 
as a separate entity and the operations for each well, including aspiration and 
dispense volumes, can be tailored accordingly. This provides an unprecedented 
level of flexibility with your assays, allowing you to tailor protocols to suit your 
needs. You can use a single well, multiple wells, or all the wells on a particular 
piece of labware.

Varispan Arm Configuration

The Arm Settings window provides access to important parameters stored in the 
instrument’s configuration file. These parameters provide values that are system 
dependent. Some of these values represent system options such as syringe size, 
tip adapters and liquid level sense verification, while others represent global 
values for syringe pump speeds during the aspirate, dispense, flush and wash 
steps.

The Varispan arm must be calibrated before use. See Calibrating the Varispan 
Pipetting Arm on page 294 for instructions.

MDT Pipetting Arm
The MDT arm accesses labware on a plate-by-plate basis. Each well on the 
labware is treated the same and the operations for each well are identical. This 
provides an easy way to duplicate entire plates, compress and expand plates, add 
reagent to an entire plate, and perform multi-liquid procedures.

MDT Arm Configuration

Unlike the Varispan arm, the MDT arm does not provide any options for you to 
configure directly. The head type controls the number of pipetting tips and 
volumes available in the protocols.

The MDT arm must be calibrated before use. See Calibrating the MDT Pipetting 
Arm on page 297 for instructions.

Gripper Arm
The Gripper arm operates in the same X, Y, and Z-directions as the primary liquid 
handling arm, but is also capable of gripping and rotational (theta) motions.
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The Gripper arm moves in the following directions: 

• X Horizontal movement is along the front of the instrument and parallel to the 
X-axis of the primary arm.

• Y Horizontal movement is perpendicular to the front of the instrument and 
parallel to the Y-axis of the primary arm.

• Z Vertical movement is parallel to the Z-axis of the primary arm.
• Rotational movement is the rotation in the horizontal plane about the Z-axis.
• Gripping movement is the opening and closing of the Gripper fingers in the 

horizontal plane.

The Gripper arm must be calibrated before use (see Calibrating the Gripper Arm 
on page 312).

 Caution: After upgrading or reinstalling the WinPREP software, you must 
completely recalibrate the deck and then verify all taught positions and 
reteach any incorrect or inaccurate locations.

The Gripper arm does not require configuration before use, but speed profiles are 
provided to specify the speeds at which the Gripper arm travels. 

Speed Profiles
You can create unique “speed profiles” for the Gripper Arm. Each profile includes 
rates of acceleration and velocity for the Gripper Arm’s X motor, Y motor, Z motor, 
and theta motor. You can create a speed profile in the Gripper Arm Motion 
Preference Editor. After a profile is created, it can be saved and later used in other 
protocols with similar gripper speed requirements.
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Chapter 15

Example Protocols
WinPREP includes several example protocols to demonstrate the features and 
techniques you can use when creating protocols. These protocols provide 
examples of many common liquid handling procedures. The example protocols 
are located in the \bin\samples\ folder in the WinPREP installation folder. Each 
example protocol includes a short description on the Comment tab of the 
Protocol Outline node. To view the description, open the example protocol, 
double-click the Protocol Outline node, and select the Comment tab.

This chapter includes a detailed description of several of the example protocols, 
and explains the protocol definition and setup in detail. This information is also 
available in the online help. To access the online help, select Help > Help Topics 
from the menu bar. The Help window opens and remains on top of all other 
windows. You can resize the WinPREP window to fit beside the help window so 
you can use the WinPREP window and the Help window at the same time as 
shown in Figure 15-1. 

Figure 15-1. Example Protocol Description Tiled with WinPREP

Each protocol description includes the name of the protocol and a general 
description of its purpose. Before reading the protocol description, you can open 
the indicated protocol so you can examine the nodes, parameters, and deck 
setup. Open the node and labware parameter windows as you read about them. 
This is an excellent way to familiarize yourself with the details of protocol setup.
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If one or more of the example protocols are similar to the protocol you need to 
create, you can save a copy of the protocol and use it as a starting point for the 
new protocol. Pay particular attention to the reasons and special considerations in 
the description, as you may need to modify values or mappings to make the 
protocol work with your modifications. Do not make changes to the original 
example protocols because this will make the protocol descriptions difficult to use 
as a reference in the future. 

See Basic Varispan Example Protocols on page 343, Basic MDT Example 
Protocols on page 361, and Advanced Varispan Example Protocols on page 366.

Basic Varispan Example Protocols
These protocols provide examples for using the Varispan to perform basic 
protocol operations such as multiple liquid handling, using disposable tips, and 
dilutions. For examples using advanced Varispan functionality, see Advanced 
Varispan Example Protocols on page 366. 

This section includes:
• Multiple Liquid on page 343
• Disposable Tips on page 346
• Serial Dilution on page 349
• Reagent Before Samples Protocol on page 354
• Reagent After Samples Protocol on page 356
• Embedded Controls Procedure on page 358

Multiple Liquid

Load File: Reagent with Samples.MPT
Purpose: Transfers two reagent liquids and one sample liquid in a single 

procedure.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 Prompts for the Number of Samples to prepare in this protocol.

 nNbrOfSamples_S1 is automatically inserted due to the Var:AskUser 
definition on the Overview tab of the “Multiple Liquids” procedure.

Multiple Liquids procedure
 This Multiple Liquids procedure aspirates two reagents and a sample and 

dispenses them together into the destination location.
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 On the Overview tab, the “Initial User Query” prompts you to identify how 
many samples to process (Number of Samples= Var:AskUser). The number 
entered is stored in the variable nNbrOfSamples_S1.

 On the Overview tab, the Multi-Liquid List table contains three rows. Each 
row contains information about aspirating a single liquid in the procedure.

 The first row identifies the first aspiration (Reagent 1) and aspirates 
300 µL of the specified liquid (Aspirate Volume=300). This row also 
indicates the protocol uses the row (Use=Yes) and the aspirated liquid 
does not have an associated sample ID (ID=None). Mapping for this 
aspiration is specified in the appropriate aspiration step below (Aspirate 
From=Use Deck View).

 The second row identifies the second aspiration (Reagent 2) and aspirates 
100 µL of the specified liquid (Aspirate Volume=100). This row also 
indicates the protocol uses the row (Use=Yes) and the aspirated liquid 
does not have an associated sample ID (ID=None). Mapping for this 
aspiration is specified in the appropriate aspiration step below (Aspirate 
From=Use Deck View).

 The third row names the last aspiration “Sample” and aspirates 100 µL of 
sample liquid (Aspirate Volume=100). This row also indicates the protocol 
uses the row (Use=Yes) and the sample ID takes the form SRCxxxx 
(ID=SRC%0000). Mapping for this aspiration is specified in the 
appropriate aspiration step below (Aspirate From=Use Deck View).

Transfer Group node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Reagent 1:Aspirate step
 The Sample ID field inherits its value from the first row of the Multi-Liquid 

List table on the Overview tab of the procedure.

 The Sample Volume field inherits its value from the first row of the Multi-
Liquid List table on the Overview tab of the procedure.

 The “Reagent 1:Aspirate” step for the procedure is mapped to one of the 
troughs in the Reagent Trough rack.

 In the Map Room window for the labware mapped to this node, the Reagent 
Trough rack is segmented so that only the first trough position is used for this 
reagent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the Reagent Trough is defined to Wrap Around to keep using the same 
reagent liquid for all the samples.

Reagent 2:Aspirate step
 The Sample ID field inherits its value from the second row of the Multi-Liquid 

List table on the Overview tab of the procedure.
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 The Sample Volume field inherits its value from the second row of the Multi-
Liquid List table on the Overview tab of the procedure.

 The “Reagent 2:Aspirate” step for the procedure is mapped to one of the 
troughs in the Reagent Trough rack.

 In the Map Room window for the labware mapped to this node, the Reagent 
Trough rack is segmented so that only the second trough position is used for 
this reagent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the Reagent Trough is defined to Wrap Around to keep using the same 
reagent liquid for all the samples.

Sample:Aspirate step
 The Sample ID field inherits its value from the third row of the Multi-Liquid 

List table on the Overview tab of the procedure.

 The Sample Volume field inherits its value from the third row of the Multi-
Liquid List table on the Overview tab of the procedure.

 The “Sample:Aspirate” step for the procedure is mapped to labware on the 
deck.

 In the Well Map Settings window, the Action at End of Well Map value for 
the labware is set to Assembly Change to prompt for more samples if 
necessary.

Dispense step
 The “Dispense” step for the procedure is mapped to a second set of labware 

on the deck.

 In the Well Map Settings window, the Action at End of Well Map value for 
the labware is set to Assembly Change to prompt for more labware if 
necessary.

Looping
 The “Multiple Liquid” procedure is repeated until nNbrOfSamples_S1 samples 

have been processed.

Multiple Liquid Flush step
 This step is mapped to the Flush/Wash station on the deck.

Multiple Liquid Wash step
 This step is mapped to the Flush/Wash station on the deck.
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Disposable Tips

Load File: 200 ul Transfer with 200 ul DT (via Panel).MPT
Purpose: Transfers 200 µL of sample using disposable tips with a maximum 

capacity of 150 µL. Transfer the liquid in two steps using a Panel 
procedure.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 Prompts for the Number of Samples to prepare in this protocol.

 nNbrOfSamples_S1 is automatically inserted due to the Var:AskUser 
definition on the Overview tab of the “200µL Dispense w/DT” procedure.

Flush/Wash procedure
 This initial Flush/Wash procedure ensures the tips are clean and free of any 

contamination before starting the protocol.

 Both the Flush and Wash steps map to the Flush/Wash station on the deck.

200µL Dispense w/DT procedure
 This Panel procedure aspirates liquid from one location and dispenses it in 

another in two separate locations.

 On the Overview tab, the user is prompted in the “Initial User Query” to 
identify how many samples to process (Number of Samples= Var:AskUser). 
The number entered is stored in the variable nNbrOfSamples_S1.

 Mapping for the sample location is specified in the Aspiration step below 
(Aspirate From=Use Deck View).

 Notice that the Use Multi-panel across dispense steps check box is not 
selected, so two transfer groups are created to transfer sample liquid in two 
steps. Each Transfer Group has independent Aspirate and Dispense steps.
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 On the Overview tab, two rows are added to the Panel List table. Each row 
contains the information for one of the Dispense steps to be performed.

 The first row names the first dispense operation Disp1 and defines the 
volume to be dispensed as 100 µL (Dispense Volume=100; total volume of 
200 µL  2). The information also indicates that there will not be any 
replicates (Replicates=1) and that the row should be used (Use=Yes). 
Mapping for this dispense is specified in the appropriate dispense step 
below (Dispense To=Use Deck View).

 The second row names the second dispense operation Disp2 and defines 
the volume to be dispensed as 100 µL (Dispense Volume=100; total 
volume of 200 µL  2). The information also indicates that there will not be 
any replicates (Replicates=1) and that the row should be used (Use=Yes). 
Mapping for this dispense is specified in the appropriate dispense step 
below (Dispense To=Use Deck View).

 The “200µL Dispense w/DT” procedure is defined on the Overview tab to use 
disposable tips (Tip=200µL Conductive RoboRack Tips).

Get Tip step
 The Get Tip step is mapped to a set of two disposable tip boxes on the deck. 

Transfer Group_1 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Aspirate step
 The Aspirate step for the procedure is mapped to source labware on the deck.

 In the Well Map Settings window, the Action at End of Well Map value for 
the source labware is set to Assembly Change to prompt for more samples if 
necessary.

Disp1:Dispense step
 On the Overview tab, the Sample Volume field for the step inherits its value 

from the first row in the Panel List table on the Overview tab of the 
procedure.

 The “Disp1” Dispense step for the procedure is mapped to another set of 
labware on the deck. 

 In the Well Map Settings window, the Action at End of Well Map value for 
the destination labware is set to Assembly Change to prompt for more labware 
if necessary.

Transfer Group_2 node
 All parameters in the Transfer Group are determined through the procedure 

definition.
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Aspirate step
 The Aspirate step for the procedure is a duplication of the first Aspirate step. 

This step cannot be edited or mapped individually.

 In the Well Map Settings window, the Action at End of Well Map value for 
the labware is set to Assembly Change to prompt for more labware if 
necessary.

Disp2:Dispense step
 On the Overview tab, the Sample Volume field for the step inherits its value 

from the second row in the Panel List table on the Overview tab of the 
procedure.

 The “Disp2” Dispense step for the procedure is mapped to the destination 
labware on the deck. This is the same location as the first Dispense step. 
Each Dispense step maintains its own mapping into this labware, so the 
second Dispense uses exactly the same location as the first Dispense step for 
each sample. 

 In the Well Map Settings window, the Action at End of Well Map value for 
the labware is set to Assembly Change to prompt for more labware if 
necessary.

Flush step
 This Flush step is mapped to the Flush Wash station on the deck.

 This Flush step disposes of the Waste Volume aspirated for the sample.

Drop Tip step
 This step is mapped to the Tip Chute on the deck for disposal of the used 

disposable tips.

 Excess sample aspirated in the last step is dispensed as waste with the tip 
during this step.

Looping
 The “200µL Dispense w/ DT” procedure repeats for the number of samples 

identified during the Initial User Query.

Flush/Wash procedure
 This procedure is included to provide final cleanup of the tip adapters before 

finishing the protocol.

 Both the Flush and Wash steps are mapped to the Flush/Wash station on the 
deck.
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Serial Dilution

Load File: Serial Dilution.MPT
Purpose: Creates serial dilutions from original samples.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 Prompts for the Number of Samples to prepare in this protocol.

 nNbrOfSamples_S1 is automatically inserted due to the Var:AskUser 
definition on the Overview tab of the “Dilution - Serial” procedure.

Dilution - Serial procedure
 This Serial Dilution procedure aspirates a sample and a diluent and then 

dispenses them together into the destination location.

 The location of the diluent material is specified in the first diluent aspiration 
step below (Diluent From=Use Deck View). All subsequent Aspirate Diluent 
steps are mapped to this same location.

 The first sample aspiration step below identifies the location of the original 
samples (Aspirate From=Use Deck View). Subsequent dilution aspirations in 
a Serial Dilution procedure always map to the destination of the previous step.

 The Auto Fade check box is selected so that the series of dilutions in the 
microplates will be evident in the Deck View. By selecting the procedure in the 
outline, all four of the defined dilutions appear mapped into the chosen 
columns of the destination plates, as shown by the different intensities of blue 
color in the columns. You may find it necessary to zoom in on the deck view to 
see this distinction in microplates.
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 On the Overview tab, four rows are added to the Dilution List table. Each 
row contains the information for one step of the serial dilution.

 The first row names the first dilution step “Dil1” and aspirates 50 µL of 
sample (Aspirate Volume=50) and 250 µL of diluent (Diluent Volume=250). 
Mapping for the dispensing of this dilution step is specified in the 
appropriate dispense step below (Dispense To=Use Deck View).

 The second row names the second dilution step “Dil2” and aspirates 
100 µL of sample (Aspirate Volume=100) and 200 µL of diluent (Diluent 
Volume=200). Mapping for the dispensing of this dilution step is specified 
in the appropriate dispense step below (Dispense To=Use Deck View).

 The third row names the next dilution step “Dil3” and aspirates 50 µL of 
sample (Aspirate Volume=50) and 250 µL of diluent (Diluent Volume=250). 
Mapping for the dispensing of this dilution step is specified in the 
appropriate dispense step below (Dispense To=Use Deck View).

 The last row names the fourth dilution step “Dil4” and aspirates 100 µL of 
sample (Aspirate Volume=100) and 200 µL of diluent (Diluent 
Volume=200). Mapping for the dispensing of this dilution step is specified 
in the appropriate dispense step below (Dispense To=Use Deck View).

Transfer Group_1 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil1:Asp. Diluent step
 The Sample Volume field on the Overview tab inherits its value from the first 

row in the Dilution List table of the “Dilution - Serial” procedure.

 The “Dil1:Aspirate Diluent” step for the procedure is mapped to one of the 
troughs in the Reagent Trough rack.

 In the Map Room window for the labware mapped to this node, the Reagent 
Trough rack is segmented so that only the first trough position is used for 
diluent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the Reagent Trough is defined to Wrap Around to keep using the same diluent 
location for all the samples.

Dil1:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the first 

row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil1:Aspirate” step for the procedure is mapped to the 96 well Deep Well 
Plate on the deck.



 Chapter 15: Example Protocols 351

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

 In the Well Map Settings window, the Action at End of Well Map value for 
the Deep Well Plate is set to Assembly Change to prompt for more plates if 
necessary.

Dil1:Dispense step
 The “Dil1:Dispense” step for the procedure is mapped to a set of three 96 well 

microplates on the deck.

 When mapping the Dispense steps for any Dilution procedure, WinPREP asks 
if you would like to redistribute the wells by column among all the dilution 
steps. If you answer Yes, one or more columns of wells in the labware (based 
on the number of dilution steps) will be mapped to each dispense step in the 
dilution.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates is set to Assembly Change to prompt for more microplates if 
necessary.

Transfer Group_2 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil2:Asp. Diluent step
 The Sample Volume field on the Overview tab inherits its value from the 

second row in the Dilution List table of the “Dilution - Serial” procedure.

 The “Dil2:Aspirate Diluent” step for the procedure maps to the same trough as 
the first step in the series, by default.

 In the Map Room window for the labware mapped to this node, the Reagent 
Trough rack is segmented so that only the first trough position is used for 
diluent.

 This node does not have an associated Map Room node because it inherits 
the Reagent Trough rack assigned to the first aspirate diluent step in the 
series.

 In the Well Map Settings window, the Map Type value for the Reagent 
Trough defaults to Org. Sample to keep using the same diluent location for all 
the samples.

Dil2:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the 

second row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil2:Aspirate” step for the procedure is mapped to the Dispense location 
of the previous dilution (Location=Prev. Dilution). In this case, the previous 
dispense location is “Dil1:Dispense”.
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Dil2:Dispense step
 This Dispense step inherits its destination well mapping from the distribution of 

the Dil1:Dispense step mapping above.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates are set to Wrap Around so that only one prompt for Assembly 
Change (“Dil1:Dispense”) occurs.

Transfer Group_3 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil3:Asp. Diluent step
 The Sample Volume field on the Overview tab inherits its value from the third 

row in the Dilution List table of the “Dilution - Serial” procedure.

 The “Dil3:Asp. Diluent” step for the procedure maps to the same trough as the 
first step in the series, by default.

 This node does not have an associated Map Room node because it inherits 
the Reagent Trough rack assigned to the first aspirate diluent step in the 
series.

 In the Well Map Settings window, the Map Type value for the Reagent 
Trough defaults to Org. Sample to keep using the same diluent location for all 
the samples.

Dil3:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the third 

row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil3:Aspirate” step for the procedure is mapped to the Dispense location 
of the previous dilution (“Dil2:Dispense”).

Dil3:Dispense step
 This Dispense step inherits its destination well mapping from the distribution of 

the Dil2:Dispense step mapping above.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates is set to Wrap Around so that only one prompt for Assembly 
Change (“Dil1:Dispense”) occurs.

Transfer Group_4 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil4:Asp. Diluent step
 The Sample Volume field on the Overview tab inherits its value from the 

fourth row in the Dilution List table of the “Dilution - Serial” procedure.
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 The “Dil4:Aspirate Diluent” step for the procedure maps to the same trough as 
the first step in the series, by default.

 This node does not have an associated Map Room node because it inherits 
the Reagent Trough rack assigned to the first aspirate diluent step in the 
series.

 In the Well Map Settings window, the Map Type value for the Reagent 
Trough defaults to Org. Sample to keep using the same diluent location for all 
the samples.

Dil4:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the 

fourth row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil4:Aspirate” step for the procedure is mapped to the Dispense location 
of the previous dilution (“Dil3:Dispense”).

Dil4:Dispense step
 This Dispense step inherits its destination well mapping from the distribution of 

the Dil3:Dispense step mapping above.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates is set to Wrap Around so that only one prompt for Assembly 
Change (“Dil1:Dispense”) occurs.

Aspirate Excess Sample step
 This step evens out the volume in the last well of the series. By design, the 

system aspirates sample from the previous dilution step to create the next 
dilution. Therefore, the last dilution has a greater volume than the rest in the 
series, because it is not the basis for the next dilution. This step aspirates the 
volume specified for the last dilution and disposes of it as waste.

 The Sample Volume field inherits its value from the volume specified for the 
last dilution in the series, in this case the fourth row of the Dilution List table 
(Aspirate Volume=100).

Serial Dilution Flush step
 This step is mapped to the Flush/Wash station on the deck.

 This step disposes of the excess sample aspirated in the “Aspirate Excess 
Sample” step.

Serial Dilution Wash step
 This step is mapped to the Flush/Wash station on the deck.

Looping
 The “Dilution - Serial” procedure repeats until nNbrOfSamples_S1 samples 

are processed.
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Reagent Before Samples Protocol

Load File: Reagent Addition before Sample Addition.MPT
Purpose: Transfers reagent material to the destination wells before 

transferring the sample material to the wells.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 Prompts for the value of nNbrOfSamples_S1, which is automatically included 

as a prompt due to the Var:AskUser definition for Number of Samples field 
on the Overview tab of the “Single Liquid” procedure.

 Prompts for the value of nReplicates_S1, which is automatically included as a 
prompt due to the Var:AskUser definition for Replicates on the Overview tab 
of the “Single Liquid” procedure.

Reagent procedure
 This Reagent procedure transfers the reagent liquid to the destination wells.

 The number of wells to fill with reagent is a calculated value (Number of 
Destinations=Var:Calculate). The calculation is based on the two variable 
values entered at runtime and is defined on the Runtime Parameters tab 
described next.

 From the Runtime Parameters tab, click the Variables button and Edit the 
calculation for the variable nDestinations_S1. The Number of Destinations is 
calculated by multiplying the Number of Samples value and the Number of 
Replicates value from the “Single Liquid” procedure below.

 The Volume of reagent to transfer to each well is 100 µL (Dispense 
Volume=100).

 Enough reagent is taken in a single aspirate to dispense for six samples 
(Dispenses Per Aspirate=6) as determined by the maximum volume of the 
syringe pumps.

(Reagent) Transfer Group node
 The “Reagent” procedure definition determines all the parameters in the 

Transfer Group.

Reagent Aspirate step
 The “Aspirate” step for the “Reagent” procedure is mapped to one of the 

troughs in the Reagent Trough rack.

 In the Map Room window for the labware mapped to this node, the Reagent 
Trough rack is mapped so that only the first trough position is used for 
reagent.
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 In the Well Map Settings window, the Action at End of Well Map value for 
the Reagent Trough is defined to Wrap Around to keep using the same 
reagent liquid for all the samples.

Reagent Dispense step
 The “Dispense” step for the “Reagent” procedure is mapped to a set of three 

96 well microplates on the deck.

 The Dispense Volume field on the Overview tab inherits its value from the 
“Reagent” procedure definition.

Reagent Flush step
 This step is mapped to the Flush/Wash station on the deck.

Reagent Wash step
 This step is mapped to the Flush/Wash station on the deck.

Looping the Reagent procedure
 The “Reagent” procedure repeats until nNbrOfSamples_S1 * nReplicates_S1 

sample positions are filled with reagent material.

Single Liquid procedure
 This Single Liquid procedure contains the “sample transfer” part of the 

protocol.

 On the Overview tab, the “Initial User Query” prompts to identify the number 
of samples to process (Number of Samples= Var:AskUser). The number 
entered is stored in the variable nNbrOfSamples_S1.

 On the Overview tab, the “Initial User Query” prompts to identify the replicates 
per sample for the procedure (Replicates= Var:AskUser). The number 
entered is stored in the variable nReplicates_S1.

 The volume of each sample dispensed is set to 50 µL (Dispense Volume=50).

 For efficient pipetting in situations where multiple replicates are requested, the 
number of dispenses specified for a single aspirate is set arbitrarily high 
(Dispenses per Aspirate=8) on the Overview tab. Replicate requests (up to 
eight) are dispensed from a single aspiration.

(Single Liquid) Transfer Group node
 The “Single Liquid” procedure definition determines all parameters in the 

Transfer Group.

Single Liquid Aspirate step
 The Aspirate step for the Single Liquid procedure is mapped to a set of three 

96 well microplates on the deck.
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Single Liquid Dispense step
 Mapping for this step is set to Match to Step(s)…. In this case, the mapping 

points to the “Reagent Dispense” step so that the sample material is added to 
those wells that already contain the reagent material from the previous 
procedure.

 The Dispense Volume field inherits its value from the Overview tab of the 
“Single Liquid” procedure.

Single Liquid Flush step
 This step is mapped to the Flush/Wash station on the deck.

Single Liquid Wash step
 This step is mapped to the Flush/Wash station on the deck.

Looping the Single Liquid procedure
 The Single Liquid procedure repeats until nNbrOfSamples_S1 samples (with 

nReplicates_S1 replicates) are processed.

Reagent After Samples Protocol

Load File: Reagent Addition after Sample Addition.MPT
Purpose: Transfers reagent to the destination wells after all the sample 

material is transferred.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 Prompts for the value of nNbrOfSamples_S1, which is automatically included 

as a prompt due to the Var:AskUser definition for Number of Samples field 
on the Overview tab of the “Single Liquid” procedure.

 Prompts for the value of nReplicates_S1, which is automatically included as a 
prompt due to the Var:AskUser definition for Replicates on the Overview tab 
of the “Single Liquid” procedure.

Single Liquid procedure
 This Single Liquid procedure contains the “sample transfer” part of the 

protocol.

 On the Overview tab, the user is prompted in the “Initial User Query” to 
identify how many samples to process (Number of Samples= Var:AskUser). 
The value entered is stored in the variable nNbrOfSamples_S1.

 On the Overview tab, the user is prompted in the “Initial User Query” to 
identify the replicates per sample for the procedure (Replicates= 
Var:AskUser). The value entered is stored in the variable nReplicates_S1.

 The dispense volume of each sample is set to 50 µL on the Overview tab 
(Dispense Volume=50).
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 On the Overview tab, the number of dispenses per single aspirate (Dispenses 
per Aspirate=2) is defined to limit the aspiration volume by the capacity of the 
disposable tips (150 µL). This value is derived from (50 µL dispense volume * 
2 dispenses per aspirate) + 5 µL waste volume <= 150 µL.

 The “Single Liquid” procedure is defined on the Overview tab to use 
disposable tips (Tip=200µL Conductive RoboRack Tips).

Get Tip step
 The Get Tip step is mapped to a set of two disposable tip boxes on the deck. 

(Single Liquid) Transfer Group node
 All parameters in the Transfer Group are determined through the “Single 

Liquid” procedure definition.

Single Liquid Aspirate step
 This Aspirate step for the “Single Liquid” procedure is mapped to the source 

labware on the deck.

Single Liquid Dispense step
 This Dispense step for the “Single Liquid” procedure is mapped to a set of four 

96 well microplates on the deck.

 The Dispense Volume inherits its value from the Overview tab of the Single 
Liquid procedure.

Drop Tip step
 This step is mapped to the Tip Chute on the deck for disposing of the used 

disposable tips.

Looping the Single Liquid procedure
 The Single Liquid procedure repeats until nNbrOfSamples_S1 samples (with 

nReplicates_S1 replicates) have been processed.

Reagent procedure
 This Reagent procedure transfers the reagent material to the destination wells 

that contain sample material.

 The Volume of reagent to transfer to each well is 100 µL (Dispense 
Volume=100).

 Enough reagent is aspirated in a single aspirate to dispense six samples 
(Dispenses per Aspirate=6) for efficient processing.

 The “Reagent” procedure is defined on the Overview tab to use the tip 
adapters as fixed tips (Tip=Fixed).

(Reagent) Transfer Group node
 All parameters in the Transfer Group are determined through the “Reagent” 

procedure definition.



 Chapter 15: Example Protocols 358

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Reagent Aspirate step
 The “Aspirate” step for the “Reagent” procedure is mapped to one of the 

troughs in the Reagent Trough rack on the deck.

 In the Map Room window for the labware mapped to this node, the Reagent 
Trough rack is segmented so that only the first trough position is used for 
reagent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the Reagent Trough is set to Wrap Around to keep using the same reagent 
liquid for all the samples.

Reagent Dispense step
 The “Dispense” step for the “Reagent” procedure is mapped to a set of four 96 

well microplates on the deck. This is because the Location field on the 
Overview tab is set to Match To Steps. This binds the reagent dispense to 
the same locations at the dispenses from the transfer group.

 The Dispense Volume field on the Overview tab inherits its value from the 
“Reagent” procedure definition.

Reagent Flush step
 This step is mapped to the Flush/Wash station on the deck.

Reagent Wash step
 This step is mapped to the Flush/Wash station on the deck.

Looping the Reagent procedure
 The “Reagent” procedure repeats until reagent material is added to all sample 

positions processed in the “Single Liquid” procedure.

Embedded Controls Procedure

Load File: Unknowns and Controls.MPT
Purpose: Inserts a set of three Controls, in duplicate, at the beginning of 

every 96 well plate where the unknowns are also prepared in 
duplicate.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 Prompts for the value of nNbrOfSamples_S1, which is automatically included 

as a prompt due to the Var:AskUser definition for Number of Samples field 
on the Overview tab of the “Unknowns” procedure.

Initial Flush/Wash procedure
 This initial Flush/Wash procedure ensures that the tips are clean and free of 

any contamination before starting the protocol.

 Both the Flush and Wash steps map to the Flush/Wash station on the deck.
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Unknowns procedure
 This Single Liquid procedure includes an embedded “Controls” procedure to 

process the control samples and the processing instructions for the 
Unknowns.

 On the Overview tab, the user is prompted in the “Initial User Query” to 
identify how many samples to process (Number of Samples= Var:AskUser). 
The number entered is stored in the variable nNbrOfSamples_S1 and 
specifies the number of Unknown samples processed by this procedure.

 On the Overview tab, the Sample ID for the Unknowns is an auto-
incrementing value of the form UNK_#### (ID=UNK_%0000).

 On the Overview tab, the Unknown samples are prepared in duplicate 
(Replicates=2).

 On the Overview tab, the Unknown samples are prepared with volumes of 50 
microliters (Dispense Volume=50) per sample.

 On the Overview tab, enough sample is taken in one aspiration to dispense 
duplicate samples (Dispenses per Aspirate=2).

 On the Overview tab, the Aspirate From location reflects the mapping 
selection made for the “Aspirate Unknowns” step below.

 On the Overview tab, the Dispense To location reflects the mapping selection 
that is made for the “Dispense Unknowns” step below.

Controls procedure
 This embedded Single Liquid procedure prepares three Control samples, in 

duplicate.

 On the Overview tab, three Control samples are prepared (Number of 
Samples=3), in duplicate (Replicates=2).

 On the Overview tab, the Controls are prepared and dispensed as the very 
first samples of the protocol, before any Unknown samples (Start After=0).

 On the Overview tab, controls are prepared at the beginning of every 
microplate (Restart Every=45). This value is derived from (96 wells - (3 
controls * 2 control replicates)  2 unknown replicates = 45).

 On the Overview tab, the embedded procedure is set to optimize the tip 
usage between the two procedures by simultaneously pipetting both 
procedures if possible (Execution mode=Parallel with other Procedures).

 On the Overview tab, the Sample ID for the Controls is an auto-incrementing 
value of the form CTRL_#### (ID=CTRL_%0000).

 On the Overview tab, the Control samples are prepared with volumes of fifty 
microliters (Dispense Volume=50) per sample.

 On the Overview tab, enough sample is aspirated to dispense the duplicates 
for a single Control sample (Dispenses per Aspirate=2).
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 On the Overview tab, the Aspirate From location reflects the mapping 
selection made for the “Aspirate Controls” step below.

 On the Overview tab, the Dispense To location reflects the mapping selection 
made for the “Dispense Controls” step below.

(Controls) Transfer Group node
 All parameters in the Transfer Group are determined through the “Controls” 

procedure definition.

Aspirate Controls step
 The Big Well Plate on the deck is mapped to this “Aspirate Controls” step.

 In the Map Room window for the labware mapped to this node, the Big Well 
Plate is segmented so that only the first three well positions are used for 
Controls.

 In the Well Map Settings window, the color for the “Aspirate Controls” step 
changes to distinguish it from the “Aspirate Unknowns” step in the protocol.

 In the Well Map Settings window, the Action at End of Well Map value for 
the Big Well Plate is set to Wrap Around to keep using the same three wells 
for the Controls.

 On the Overview tab, the ID inherits its value from the “Controls” procedure 
definition.

Dispense Controls step
 In the Well Map Settings window, this step is defined to Continue From the 

“Dispense Unknowns” step mapping. When the Controls are processed, they 
should be dispensed to the next available positions in the labware mapped to 
the “Unknowns” procedure. According to the calculations for the Restart After 
Every parameter in the “Controls” procedure, this will be the first six wells in 
every microplate.

 The Dispense Volume field on the Overview tab inherits its value from the 
“Controls” procedure definition.

Controls Flush step
 This step is mapped to the Flush/Wash station on the deck.

Controls Wash step
 This step is mapped to the Flush/Wash station on the deck.

(Unknowns) Transfer Group node
 All parameters in the Transfer Group are defined through the “Unknowns” 

procedure definition.

Aspirate Unknowns step
 The Test Tube Rack is mapped to this “Aspirate Unknowns” step.

 The ID on the Overview tab inherits its value from the “Unknowns” procedure 
definition.
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Dispense Unknowns step
 This step is mapped to the set of 96 Well Plates on the deck. The plates are 

used in the order mapped.

 The Dispense Volume field on the Overview tab inherits its value from the 
“Unknowns” procedure definition.

Unknowns Flush step
 This step is mapped to the Flush/Wash station on the deck.

Unknowns Wash step
 This step is mapped to the Flush/Wash station on the deck.

Looping
 The Unknowns procedure repeats until nNbrOfSamples_S1 Unknown 

samples are processed. If more sample positions are required than are 
available, WinPREP prompts for an Assembly Change.

Basic MDT Example Protocols
This section includes an examples for using the MDT with the Serial Dilution Head 
to perform a serial dilution by rows.

This section includes:
• Serial Dilution Tools Serial Dilution - Row on page 361

Serial Dilution Tools Serial Dilution - Row

Load File: Example Script SDT_Row.MPT
Purpose: Creates a row-based serial dilution using the MDT Serial Dilution 

Tools.
Requires: Modular Dispense Technology Serial Dilution Tools option and 

labware.
The protocol uses PerkinElmer half-area plates for the assay. If you use different 
labware, be sure to adjust the plate heights/volumes as necessary in the 
WinPREP protocol.

When preparing this protocol, you must add the desired reagent into the first row 
of the microplate prior to running the protocol. This reagent is the basis for the 
dilution and the protocol is designed to pick up the initial dilution volume from the 
first row of the plate.

A second Serial Dilution Tools example protocol (Example Script SDT_Column.MPT) is 
included. It is almost identical to the protocol described here except it uses a 
column-wise, rather than a row-wise, approach.
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Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 No special use in this protocol.

Example Row Serial Dilution Procedure
 This step loads the MDT Serial Dilution Tools head and transfers buffer into 

each of the mapped wells in the microplate.

Load Head MDT
 Loads the Serial Dilution Tools head onto the MDT arm. In this case, the 

protocol uses the I50R - 96 Tip head.

Transfer Group MDT_1
 This group loads a row of tips from the disposable tip box, aspirates reagent 

(reagent trough) and diluent liquid (first row of plate), dispenses the liquids into 
the second row of the plate, mixes the dilution, and disposes of the used tips.

Get Tip MDT_1
 Moves the MDT arm to the disposable tip box and picks up a row of tips from 

the tip box. For this step, the tip box is completely full and the procedure picks 
up the bottom row of tips out of the box.

Dil1:Asp. Diluent MDT
 Aspirates 25µl of diluent liquid from the diluent trough.

Dil1:Aspirate MDT
 Aspirates 25µL of reagent liquid from the first row of wells on the plate.

Dil1:Dispense MDT
 Dispenses the contents of the tips into the second row of the microplate. The 

first row contains undiluted reagent liquid and acts as the initial dilution source 
and a control for the assay.

Post-dispense Mix
 Mixes the reagent and diluent in the wells. This step performs four total mix 

cycles.

Drop Tip MDT_1
 Moves the arm to the tip chute and disposes of the used tips.

Transfer Group MDT_2
 This group loads a row of tips from the disposable tip box, aspirates reagent 

(reagent trough) and diluent liquid (second row of plate), dispenses the liquids 
into the third row of the plate, mixes the dilution, and disposes of the used tips.

Get Tip MDT_2
 Moves the MDT arm to the disposable tip box and picks up a row of tips from 

the tip box. Note that the previous step used the bottom row of tips so this step 
picks up the next available row of tips.
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Dil2:Asp. Diluent MDT
 Aspirates 25µl of diluent liquid from the diluent trough.

Dil2:Aspirate MDT
 Aspirates 25µL of reagent liquid from the second row of wells on the plate.

Dil2:Dispense MDT
 Dispenses the contents of the tips into the third row of the microplate. The 

second row contains the first step of the dilution sequence and acts as the 
dilution source for the current step.

Post-dispense Mix
 Mixes the reagent and diluent in the wells of the third row. This step performs 

four total mix cycles.

Drop Tip MDT_2
Moves the arm to the tip chute and disposes of the used tips.

Transfer Group MDT_3
 This group loads a row of tips from the disposable tip box, aspirates reagent 

(reagent trough) and diluent liquid (third row of the plate), dispenses the 
liquids into the fourth row of the plate, mixes the dilution, and disposes of the 
used tips.

Get Tip MDT_3
 Moves the MDT arm to the disposable tip box and picks up a row of tips from 

the tip box. Note that the previous steps used the two bottom rows of tips so 
this step picks up the next available row.

Dil3:Asp. Diluent MDT
 Aspirates 25µl of diluent liquid from the diluent trough.

Dil3:Aspirate MDT
 Aspirates 25µL of reagent liquid from the third row of wells on the plate.

Dil3:Dispense MDT
 Dispenses the contents of the tips into the fourth row of the microplate. The 

third row contains the second step of the dilution sequence and acts as the 
dilution source for the current step.

Post-dispense Mix
 Mixes the reagent and diluent in the wells of the fourth row. This step performs 

four total mix cycles.

Drop Tip MDT_3
Moves the arm to the tip chute and disposes of the used tips.
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Transfer Group MDT_4
 This group loads a row of tips from the disposable tip box, aspirates reagent 

(reagent trough) and diluent liquid (fourth row of the plate), dispenses the 
liquids into the fifth row of the plate, mixes the dilution, and disposes of the 
used tips.

Get Tip MDT_4
 Moves the MDT arm to the disposable tip box and picks up a row of tips from 

the tip box. Note that the previous steps used the three bottom rows of tips so 
this step picks up the next available row.

Dil4:Asp. Diluent MDT
 Aspirates 25µl of diluent liquid from the diluent trough.

Dil4:Aspirate MDT
 Aspirates 25µL of reagent liquid from the fourth row of wells on the plate.

Dil4:Dispense MDT
 Dispenses the contents of the tips into the fifth row of the microplate. The 

fourth row contains the third step of the dilution sequence and acts as the 
dilution source for the current step.

Post-dispense Mix
 Mixes the reagent and diluent in the wells of the fifth row. This step performs 

four total mix cycles.

Drop Tip MDT_4
Moves the arm to the tip chute and disposes of the used tips.

Transfer Group MDT_5
 This group loads a row of tips from the disposable tip box, aspirates reagent 

(reagent trough) and diluent liquid (fifth row of the plate), dispenses the liquids 
into the sixth row of the plate, mixes the dilution, and disposes of the used tips.

Get Tip MDT_5
 Moves the MDT arm to the disposable tip box and picks up a row of tips from 

the tip box. Note that the previous steps used the four bottom rows of tips so 
this step picks up the next available row.

Dil5:Asp. Diluent MDT
 Aspirates 25µl of diluent liquid from the diluent trough.

Dil5:Aspirate MDT
 Aspirates 25µL of reagent liquid from the fifth row of wells on the plate.

Dil5:Dispense MDT
 Dispenses the contents of the tips into the sixth row of the microplate. The fifth 

row contains the fourth step of the dilution sequence and acts as the dilution 
source for the current step.
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Post-dispense Mix
 Mixes the reagent and diluent in the wells of the sixth row. This step performs 

four total mix cycles.

Drop Tip MDT_5
Moves the arm to the tip chute and disposes of the used tips.

Transfer Group MDT_6
 This group loads a row of tips from the disposable tip box, aspirates reagent 

(reagent trough) and diluent liquid (sixth row of the plate), dispenses the 
liquids into the seventh row of the plate, mixes the dilution, and disposes of 
the used tips.

Get Tip MDT_6
 Moves the MDT arm to the disposable tip box and picks up a row of tips from 

the tip box. Note that the previous steps used the five bottom rows of tips so 
this step picks up the next available row.

Dil6:Asp. Diluent MDT
 Aspirates 25µl of diluent liquid from the diluent trough.

Dil6:Aspirate MDT
 Aspirates 25µL of reagent liquid from the sixth row of wells on the plate.

Dil6:Dispense MDT
 Dispenses the contents of the tips into the seventh row of the microplate. The 

sixth row contains the fifth step of the dilution sequence and acts as the 
dilution source for the current step.

Post-dispense Mix
 Mixes the reagent and diluent in the wells of the seventh row. This step 

performs four total mix cycles.

Drop Tip MDT_6
 Moves the arm to the tip chute and disposes of the used tips.

Reagent MDT_1
 This group loads a row of tips from the disposable tip box, aspirates reagent 

(reagent trough), dispenses the reagent into the eighth row of the plate, and 
disposes of the used tips.

Get Tip MDT_1
 Moves the MDT arm to the disposable tip box and picks up a row of tips from 

the tip box. Note that the previous steps used the six bottom rows of tips so 
this step picks up the next available row.

Transfer Group MDT_1
 This group loads a row of tips from the disposable tip box, aspirates reagent 

(reagent trough) and diluent liquid (sixth row of the plate), dispenses the 
liquids into the seventh row of the plate, mixes the dilution, and disposes of 
the used tips.
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Aspirate MDT
 Aspirates 25µl of diluent liquid from the diluent trough.

Dispense MDT
 Dispenses the contents of the tips into the eighth row of the microplate. The 

eighth row is not a part of the actual dilution sequence and contains only 
diluent liquid. In this way, it acts as a secondary control along with the reagent 
control in the first row.

Drop Tip MDT_1
 Moves the arm to the tip chute and disposes of the used tips.

Unload Head
 Moves the MDT arm to the docking station and releases the Serial Dilution 

Tools head.

Advanced Varispan Example Protocols
The advanced example protocols address more advanced WinPREP functionality, 
such as using input files to select samples and create dilutions. The following 
sections describe each advanced example protocol in detail. 
• Select Samples Using File on page 366
• Dilutions Using a File on page 369
• Top Off Wells on page 376

For more information on Basic Example Protocols see Basic Varispan Example 
Protocols on page 343 or Basic MDT Example Protocols on page 361.

Select Samples Using File

Load File: Hits Reformatting.MPT 
Purpose: Processes selected samples from a set of labware based on a 

“hits” list from a file.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 No special use in this protocol.

Flush/Wash procedure
 This procedure ensures the tip adapters are clean and free from 

contamination before starting the protocol.

Single Liquid procedure
 This Single Liquid procedure aspirates selected samples from a set of labware 

and dispense them into a set of destination labware.
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 On the Overview tab, the number of samples to process is based on the 
number of records in a supplied data file (Number of Samples=File:Records). 
The number of samples is determined by counting the number of records 
(lines) in an ASCII data file. Specify the name of the data file on the Runtime 
Parameters tab as described below.

 The selected samples (“hits”) to transfer, and their locations in the labware, 
must be identified in an ASCII data file. This file, therefore, contains the 
sample map for the samples (Aspirate From=File:Column). Specify the name 
of the data file on the Runtime Parameters tab as described below.

 The supplied data file also specifies the Sample ID field value 
(ID=File:Column). The Runtime Parameters tab specifies the name of the 
data file, as described below.

 The Sample Volume field is defined to be 10 µL for this protocol (Dispense 
Volume=10).

 The Single Liquid procedure is defined on the Overview tab to use disposable 
tips (Tip=200ul Conductive RoboRack Tips).

 On the Runtime Parameters tab, the Number of Samples parameter reflects 
the File:Records entry from the Overview tab. The desired file is specified in 
the next column (File or Variable=Hits Reformatting.csv). When this row is 
selected in the table, a portion of the file displays in the preview frame at the 
bottom of the tab.

 On the Runtime Parameters tab, the Aspirate Sample ID parameter reflects 
the File:Column entry from the Overview tab. The desired file is specified in 
the next column (File or Variable=Hits Reformatting.csv). The next column in 
the row indicates that the Sample ID value is in the first column of the file 
(Column # or Keyword=1).

 On the Runtime Parameters tab, change the Type to Well Maps using the 
drop-down list. The Parameters List displays the different Well Maps required 
during the protocol.

 On the Runtime Parameters tab, the Aspirate Well Map parameter reflects 
the File Based Map entry from the Overview tab (Gets Data 
From=File:Column). The third column identifies the desired data file 
(File=Hits Reformatting.csv). The next column in the row indicates that the 
name of the labware is located in the second column of the file (Rack Name 
Column #=2) and the sample position in the labware is located in the third 
column of the file (Position Column #=3). File based well maps require these 
two parameters to uniquely identify each sample location on the deck.
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 On the Runtime Parameters tab, click the Files button to display the Runtime 
File Definitions window. Notice the data file (Hits Reformatting.csv) is 
defined in the table as a comma delimited, column based file with data 
starting in record 2. In the file itself, the first line (record) in the file contains 
column headers, identifying the data in the columns of the file. The In Use flag 
indicates this file is already identified for use in at least one part of the protocol 
(Number of Samples, Sample ID, and Aspirate Well Map).

 The Deck View contains three 96 well microplates that may or may not contain 
the samples indicated in the data file. In fact, if you examine the example Well 
Mappings in the data file, you can see that 24 of the “hits” are on the first plate 
(column 2=96 Well Plate1), 14 “hits” are on the second plate (column 2=96 
Well Plate2) and 63 “hits” are on the third plate (column 2=96 Well Plate3) for 
a total of 101 “hits” out of a possible 288 samples.

 Three functions in the protocol use the indicated data file (Hits 
Reformatting.csv). The number of records in the file (minus the header 
record) specifies the number of samples to process. The first column contains 
a Sample ID that uniquely identifies each sample record. The second and third 
columns identify the location of the sample by Rack Name and Sample 
Position in the labware, respectively.

Get Tip step
 The Get Tip step is mapped to a set of two disposable tip boxes on the deck. 

Transfer Group node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Aspirate step
 The Location field on the Overview tab inherits its value from the procedure 

definition (Location=File Based Map).

 The Sample ID field on the Overview tab inherits its value from the procedure 
definition.

 On the Runtime Parameters tab, the Asp. Sample Id parameter in the table 
inherits its value from the Runtime Parameters tab for the “Single Liquid” 
procedure.

 On the Runtime Parameters tab, the Aspirate Well Map definition in the table 
(Parameter Type=Well Map) inherits its value from the Runtime Parameters 
tab for the procedure.

Dispense step
 The Dispense Volume field value on the Overview tab inherits its value from 

the procedure definition (Dispense Volume=10).

 The Dispense step maps to a set of three 96 well microplates on the deck.



 Chapter 15: Example Protocols 369

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates are set to Assembly Change to prompt for more labware if 
necessary.

Flush step
 This step disposes of any waste volume and flushes the tips with system 

liquid.

 The Flush step maps to the Flush/Wash station on the deck.

Drop Tip step
 This step is mapped to the Tip Chute on the deck for disposal of the used 

disposable tips.

Looping
 The “Single Liquid” procedure repeats for every record in the data file.

Flush/Wash procedure
 This procedure is included to provide final cleanup of the tip adapters before 

completing the protocol.

 Both the Flush and Wash steps are mapped to the Flush/Wash station on the 
deck.

Dilutions Using a File

Load File: Serial Dilution (Importing Dilutions).MPT
Purpose: Processes samples in a serial dilution, picking up dilution factors 

from a file that vary from sample to sample.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 No special use in this protocol.

Flush/Wash procedure
 This initial Flush/Wash procedure ensures the tips are clean and free of any 

contamination before preparing the dilutions.

 Both the Flush and Wash steps are mapped to the Flush/Wash station on the 
deck.

Dilution - Serial procedure
 This Serial Dilution procedure aspirates a sample and a diluent and dispenses 

them together into the destination location.
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 On the Overview tab, the number of records in the supplied file identifies the 
number of samples to process (Number of Samples=File:Records). The 
number of samples is determined by counting the number of records (lines) in 
an ASCII data file. Specify the name of the data file on the Runtime 
Parameters tab as described below.

 The first sample aspiration step below identifies the location of the original 
samples (Aspirate From=Use Deck View). Subsequent dilution aspirations in 
Serial Dilution procedures always map to the destination of the previous step.

 The first diluent aspiration step below identifies the location of the diluent 
material (Diluent From=Use Deck View). All subsequent diluent aspiration 
steps map to this same location.

 The Auto Fade check box makes it easy to identify the series of dilutions in 
the microplates. By selecting the “Dilution - Serial” procedure in the protocol 
outline, all six of the defined dilutions map into the chosen columns of the 
destination plates, as shown by the different intensities of blue color in the well 
columns. You may find it necessary to zoom in on the deck view to see this 
distinction in microplates.

 On the Overview tab, six rows make up the Dilution List table. Each row 
contains the information for one step of the serial dilution.

 Each row names the dilution step “Dil#”, where “#” is a number. The volumes 
of sample and diluent are read from the columns in a comma delimited ASCII 
data file (Aspirate Vol.=File:Column and Diluent Vol.=File:Column). Specify 
the file name and column positions for these parameters on the Runtime 
Parameters tab. Mapping for the dispensing of each dilution step is done in 
the appropriate dispense step below (Dispense To=Use Deck View).

 The “Dilution - Serial” procedure is defined on the Overview tab to use 
disposable tips (Tip=200ul Conductive RoboRack Tips).

 On the Runtime Parameters tab, the Number of Samples parameter reflects 
the File:Records entry from the Overview tab. The File or Variable column 
specifies the input file (File or Variable=Serial Dilution.csv). When this row is 
selected in the table, a preview of the file displays in the Preview frame at the 
bottom of the tab.

 On the Runtime Parameters tab, each of the Dil#:Sample Vol. parameters 
reflects the File:Column entry from the Overview tab. The next column 
specifies the input data file (File or Variable=Serial Dilution.csv). The next 
column in the row indicates that the Sample Volume value is located in the 
first column of the file (Column # or Keyword=1).

 On the Runtime Parameters tab, each of the Dil#:Diluent Vol. parameters 
should reflect the File:Column entry from the Overview tab. The desired file 
is specified in the next column (File or Variable=Serial Dilution.csv). The next 
column in the row indicates that the Diluent Volume value is located in the 
second column of the file (Column # or Keyword=2).
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 From the Runtime Parameters tab, click the Files button to access the 
Runtime File Definitions window. Notice that the data file (Serial 
Dilution.csv) is defined as a comma delimited, column based file with data 
starting in record 2. In the file itself, the first line (record) in the file contains 
column headers for the data in the columns. The In Use flag indicates that this 
file is already identified for use in at least one part of the protocol (Number of 
Samples, all six Dil#:Sample Volume parameters and all six Dil#:Diluent 
volume parameters).

 The indicated data file (Serial Dilution.csv) is used for three functions in this 
protocol. The number of records in the file (minus the header record) indicates 
the number of samples to process. The first column contains the Sample 
Volume and the second column contains the Diluent Volume for each sample 
record. The protocol uses the same Sample and Diluent Volumes for each of 
the dilution steps in the series.

Get Tip step
 The Get Tip step is mapped to a set of two disposable tip boxes on the deck. 

Transfer Group_1 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil1:Asp. Diluent step
 The Sample Volume field on the Overview tab inherits its value from the first 

row in the Dilution List table of the “Dilution - Serial_1” procedure.

 The “Dil1:Aspirate Diluent” step for the procedure maps to one of the troughs 
in the Flush/Wash station.

 In the Map Room window for the labware mapped to this node, the Flush/
Wash station is segmented so that only the first trough position is used for 
diluent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the reagent trough is set to Wrap Around to keep using the same diluent 
location for all the samples.

Dil1:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the first 

row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil1:Aspirate” step for the procedure is mapped to the labware on the 
deck.

 In the Well Map Settings window, the Action at End of Well Map value for 
the labware is set to Assembly Change to prompt for more samples if 
necessary.
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Dil1:Dispense step
 The “Dil1:Dispense” step for the procedure maps to a set of four 96 well 

microplates on the deck.

 When mapping the Dispense steps for any Dilution procedure, WinPREP asks 
if you would like to redistribute the wells by column among all the dilution 
steps. If you answer Yes, one or more columns of wells in the labware (based 
on the number of dilution steps) are mapped to each dispense step in the 
dilution.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates is set to Assembly Change to prompt for more microplates if 
necessary.

Transfer Group_2 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil2:Asp. Diluent step
 The Sample Volume field on the Overview tab inherits its value from the 

second row in the Dilution List table of the “Dilution - Serial” procedure.

 The “Dil2:Aspirate Diluent” step for the procedure maps to one of the troughs 
in the Flush/Wash station.

 In the Map Room window for the labware mapped to this node, the Flush/
Wash station is segmented so that only the first trough position is used for 
diluent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the reagent trough his set to Wrap Around to keep using the same diluent 
location for all the samples.

Dil2:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the 

second row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil2:Aspirate” step for the procedure maps to the Dispense location of 
the previous dilution (“Dil1:Dispense”).

Dil2:Dispense step
 This Dispense step inherits the well mapping of the destination labware from 

the distribution of the Dil1:Dispense step mapping above.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates is set to Wrap Around so that only one prompt for Assembly 
Change (“Dil1:Dispense”) occurs.
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Transfer Group_3 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil3:Asp. Diluent step
 The Sample Volume field on the Overview tab inherits its value from the third 

row in the Dilution List table of the “Dilution - Serial” procedure.

 The “Dil3:Aspirate Diluent” step for the procedure maps to one of the troughs 
in the Flush/Wash station.

 In the Map Room window for the labware mapped to this node, the Flush/
Wash station is segmented so that only the first trough position is used for 
diluent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the reagent trough is set to Wrap Around to keep using the same diluent 
location for all the samples.

Dil3:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the third 

row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil3:Aspirate” step for the procedure maps to the Dispense location of 
the previous dilution (“Dil2:Dispense”).

Dil3:Dispense step
 This Dispense step inherits the well mapping of the destination labware from 

the distribution of the Dil1:Dispense step mapping above.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates is set to Wrap Around so that only one prompt for Assembly 
Change (“Dil1:Dispense”) occurs.

Transfer Group_4 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil4:Aspirate Diluent step
 The Sample Volume field on the Overview tab inherits its value from the 

fourth row in the Dilution List table of the “Dilution - Serial” procedure.

 The “Dil4:Aspirate Diluent” step for the procedure maps to one of the troughs 
in the Flush/Wash station.

 In the Map Room window for the labware mapped to this node, the Flush/
Wash station is segmented so that only the first trough position is used for 
diluent.
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 In the Well Map Settings window, the Action at End of Well Map value for 
the reagent trough is set to Wrap Around to keep using the same diluent 
location for all the samples.

Dil4:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the 

fourth row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil4:Aspirate” step for the procedure maps to the Dispense location of 
the previous dilution (“Dil3:Dispense”).

Dil4:Dispense step
 This Dispense step inherits the well mapping of the destination labware from 

the distribution of the Dil1:Dispense step mapping above.

 In the Well Map Settings window, the Action at End of WMap value for the 
microplates is set to Wrap Around so that only one prompt for Assembly 
Change (“Dil1:Dispense”) occurs.

Transfer Group_5 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil5:Aspirate Diluent step
 The Sample Volume field on the Overview tab inherits its value from the fifth 

row in the Dilution List table of the “Dilution - Serial” procedure.

 The “Dil5:Aspirate Diluent” step for the procedure maps to one of the troughs 
in the Flush/Wash station.

 In the Map Room window for the labware mapped to this node, the Flush/
Wash station is segmented so that only the first trough position is used for 
diluent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the reagent trough is set to Wrap Around to keep using the same diluent 
location for all the samples.

Dil5:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the fifth 

row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil5:Aspirate” step for the procedure maps to the Dispense location of 
the previous dilution (“Dil4:Dispense”).
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Dil5:Dispense step
 This Dispense step inherits the well mapping of the destination labware from 

the distribution of the Dil1:Dispense step mapping above.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates is set to Wrap Around so that only one prompt for Assembly 
Change (“Dil1:Dispense”) occurs.

Transfer Group_6 node
 All parameters in the Transfer Group are determined through the procedure 

definition.

Dil6:Aspirate Diluent step
 The Sample Volume field on the Overview tab inherits its value from the sixth 

row in the Dilution List table of the “Dilution - Serial” procedure.

 The “Dil6:Aspirate Diluent” step for the procedure maps to one of the troughs 
in the Flush/Wash station.

 In the Map Room window for the labware mapped to this node, the Flush/
Wash station is segmented so that only the first trough position is used for 
diluent.

 In the Well Map Settings window, the Action at End of Well Map value for 
the reagent trough is set to Wrap Around to keep using the same diluent 
location for all the samples.

Dil6:Aspirate step
 The Sample Volume field on the Overview tab inherits its value from the sixth 

row in the Dilution List table of the “Dilution - Serial” procedure.

 On the Overview tab, the Sample ID field inherits its value from the procedure 
definition.

 The “Dil6:Aspirate” step for the procedure maps to the Dispense location of 
the previous dilution (“Dil5:Dispense”).

Dil6:Dispense step
 This Dispense step inherits the well mapping of the destination labware from 

the distribution of the Dil1:Dispense step mapping above.

 In the Well Map Settings window, the Action at End of Well Map value for 
the microplates is set to Wrap Around so that only one prompt for Assembly 
Change (“Dil1:Dispense”) occurs.

Aspirate Excess Sample step
 This step evens out the volume in the last well of the series. By design, the 

system aspirates sample from the previous dilution step to create the next 
dilution. Therefore, the last dilution has a greater volume than the rest in the 
series, because it is not the basis for the next dilution. This step aspirates the 
volume specified for the last dilution and disposes of it as waste.
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 The Sample Volume field inherits its value from the volume specified for the 
last dilution in the series, in this case the sixth row of the Dilution List table 
(Aspirate Volume=File:Column).

Drop Tip step
 This step maps to the Tip Chute on the deck for disposal of used disposable 

tips.

 The tip, along with any Excess Sample aspirated in the last step, is disposed 
of as waste during this step.

Looping
 The “Dilution - Serial” procedure repeats until a sample is processed for every 

record in the data file.

Flush/Wash procedure
 This procedure provides final cleanup of the tip adapters before finishing the 

protocol.

 Both the Flush and Wash steps are mapped to the Flush/Wash station on the 
deck.

Top Off Wells

Load File: TopOffWells - Simple.mpt
Purpose: To top-off wells with a reagent so that each sample position will 

have the same amount of liquid in it.

Protocol Outline node
 No special use in this protocol.

Initial User Query procedure
 Prompts for the value of two parameters. Variables for these parameters are 

defined and used elsewhere in the protocol.

 nNbrOfSamples_S1 is automatically inserted due to the Var:AskUser 
definition on the Overview tab of the “Top-Off Wells” procedure.

 dAspVolume_S1 is automatically added to the query page due to the 
Var:AskUser definition on the Overview tab of the “Aspirate (if not enough liq. 
In well)” step.

Flush/Wash procedure
 This initial Flush/Wash procedure is included to ensure that the tips are clean 

and free of any contamination before touching the liquid of your samples.

 Both the Flush and Wash steps are mapped to the Flush/Wash station on the 
deck.
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Top-Off Wells procedure
 This “Custom” procedure contains the actual steps that perform the top-off 

process. The procedure controls the number of samples to process which is 
identified as Var:AskUser to prompt for a value in the “Initial User Query”. The 
number of samples entered by the user is stored in the variable 
nNbrOfSamples_S1 for use in this procedure.

 Waste mode is selected as the pipetting mode on the Overview tab of the 
procedure.

Find Liquid Level step
 This Find Liquid step lowers the tip until it touches the liquid in the well as 

determined by the liquid level sense. The height at which liquid is found 
determines the volume of liquid in the well.

 On the Overview tab, the Increment Location Every Replicate ensures that 
the well maps for steps that follow can be matched to this step.

 Mapping for this step is set on the Overview tab to Use Deck View.

 A 96 well plate in the deck view is dragged onto the step. The protocol will 
prompt you for an assembly change as necessary when the number of 
samples is greater than 96.

Aspirate (if not enough liq. In well) step
 This Aspirate step is used to determine the volume of liquid, if any, that is 

required to top off the well. That volume will be aspirated in preparation for 
dispensing in the next step.

 On the Overview tab, the Sample Volume is identified as Var:AskUser to 
prompt for a value in the “Initial User Query”. It is convenient to use the 
Sample Volume parameter to prompt for the target volume, as the actual 
aspirate volume will be calculated in the user function as defined next.

 A Pre-Step function is defined on the Advanced tab to get information from 
the “Find Liquid Level” step (previous node in the protocol outline) and 
determine the values needed for this step to aspirate the appropriate volume 
of liquid.

 Information stored for a step can be accessed by functions in subsequent 
steps of the same procedure. This can include the volume of liquid found in a 
well based on the height of the liquid. In this function, the volume will be 
subtracted from the target volume (dAspVolume_1) entered in the “Initial User 
Query”.

 If the current volume in the well is within 5 uL of the target volume, the entire 
sample is skipped and the protocol continues with the next sample. Notice that 
this will cause the following “Dispense” and “Flush” steps to be skipped for this 
sample as well.
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 If there is not enough liquid in the well, the volume difference is calculated 
(target - actual). This volume, along with the associated pump speed (as 
determined from the performance file) are set at this time in the function. This 
calculated value replaces the original Sample volume value (dAspVolume_1) 
that was actually used for another purpose (target volume).

 Mapping for this step is set on the Overview tab to Use Deck View.

 The reagent trough that is part of the Flush/Wash station in the deck view is 
dragged onto the step. The trough is defined to Wrap Around as the Action 
At End of Well Map so that the same trough position is used for the entire 
protocol.

Dispense step
 This Dispense step uses a Pre-Step function defined on the Advanced tab to 

determine how much system liquid was aspirated in the previous Aspirate 
step.

 If no liquid was aspirated (no additional volume was required), this step is not 
executed for the sample.

 If there was liquid aspirated (sample did not meet minimum volume) the step 
is set to dispense that volume. Both the volume and pump speed (as 
determined from the performance file) are set at this time in the function. The 
volume determined in the function replaces the default Volume defined on the 
Overview tab for this Dispense step.

 Mapping for this step is set on the Overview tab to Match the “Find Liquid 
Level” step so that additional liquid is dispensed into the same well that was 
tested.

Flush step
 This Flush step ensures that any liquid remaining in the tip is ejected before 

checking the next sample. This is necessary because the procedure is defined 
to use the Waste Mode.

 The Flush step is mapped to the Flush/Wash station on the deck.

Looping
 The Top-Off Wells procedure is repeated until nNbrOfSamples_S1 samples 

have been topped off or skipped.

Flush/Wash procedure
 This final Flush/Wash procedure is included to ensure that the tips are clean 

and free of any contamination before finishing the protocol.

 Both the Flush and Wash steps are mapped to the Flush/Wash station on the 
deck.
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Appendix A

Liquid Handling
The JANUS G3 Automated Workstation uses an “aspirate and dispense” method 
of sampling. System liquid (usually distilled water) is used as hydraulic fluid in the 
instrument. Before the sampling tips can aspirate liquid, the system must be 
primed with the system liquid. For some applications the system can be primed 
with reagent or diluent (see Prime the System with Reagent on page 380 for more 
information).

The system liquid, once primed through the tubing and sampling tips, acts like 
non-compressible hydraulic fluid in a braking system. The syringe pump moves 
the syringe plunger up and down in the syringe barrel like a piston. The movement 
of the syringe plunger moves the system liquid. The motion of the system liquid 
pulls and pushes sample liquids and other fluids into and out of the sampling tip.

 Caution: Never run the instrument without fluid. Running a system dry (without fluid) 
can accelerate seal, syringe, and valve wear.

This chapter contains information on the concepts of Liquid Handling:

• Movement of the Sampling Tip on page 380
• Accuracy and Precision on page 386
• Determining Aspirate and Dispense Rates on page 392
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Movement of the Sampling Tip
After the lines have been primed, the sampling tip moves to the source tubes or 
vials to aspirate liquid. The downward motion of the syringe plunger causes the 
system liquid to draw, or aspirate, fluid into the sampling tip at the source position. 
This fluid can include samples, controls, standards, reagent, or diluent.

After aspirating fluid, the sampling tip moves to the destination position. The 
upward motion of the syringe plunger causes the system liquid to push, or 
dispense, fluid out of the sampling tip into the destination position.

Thus, one cycle of the syringe equals one downward motion and one upward 
motion of the plunger. The motion of the syringe plunger coupled with the system 
liquid causes fluid to move throughout the tubing and the sampling tip.

Prime the System with Reagent

Certain assays require time-dependent dispensing of reagent. In these situations, 
using the conventional aspirate and dispense method is undesirable because too 
much time transpires between the first and last dispense operations. If the 
elapsed time is too great, protocol results may be negatively affected.

Priming the system with reagent can be used to dispense reagent into multiple 
destinations without the sampling tips returning to the reagent trough multiple 
times. This method reduces the amount of time it takes to dispense reagent.

To prime the system with reagent, replace the system liquid with a sufficient 
amount of reagent liquid and run the Flush and Wash Tips utility. This displaces 
the system liquid in the system tubing with reagent. You should only use this 
option for protocols where the timely dispensing of reagent is critical. For more 
information about the Flush and Wash Tips utility, see Flush and Wash Tips on 
page 415.

 Note: When using the Flush and Wash Tips utility to prime the system with 
reagent, be sure to specify an adequate volume and enough Flush/Wash 
cycles to replace all the system liquid in the liquid path with reagent.

To return the system to its normal operating state, replace the reagent liquid with 
system liquid and run the Flush and Wash Tips utility at least three more times. 
This restores the instrument to its “normal” condition; it backprimes the reagent in 
the lines and replaces it with system liquid.

 Note: When using the Flush and Wash Tips utility to prime the system with 
system liquid, be sure to specify an adequate volume and enough flush/
wash cycles to replace all the reagent in the liquid path with system liquid.
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The Syringe Valve

A syringe pump connects to each sampling tip on the pipetting arm of the JANUS 
G3 device. The syringe pump controls the aspiration and dispensation of liquid 
through the sampling tip. Each syringe pump is composed of three major 
components: a pump, a syringe, and a valve. The pump moves the syringe 
plunger up and down in the barrel of the syringe. The syringe measures and 
stores the liquid aspirated or dispensed. The syringe valve directs the flow of 
liquids in the system.

The syringe valve is mounted on top of each syringe (Figure A-1). The internal 
mechanism of the valve contains a connection pathway that rotates clockwise and 
counter-clockwise to properly direct the flow of fluid in the instrument, including:

• The flow of system liquid from the system liquid container to the syringe. This 
process is the first step in priming the system.

• The flow of system liquid into the syringe pump outlet tubing and the sampling 
tip. This process represents the final step in priming the system.

• The aspiration and dispensing of fluid. This process is the aspirate/dispense 
cycle, where the sampling tip picks up one or more liquids from source 
locations and dispenses them into one or more destination locations.

• The flow of system liquid from the peristaltic pump through the syringe pump 
outlet tubing and the sampling tip. This process represents the flush of the 
system after completion of sample processing.

Figure A-1. Syringe Valve
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The syringe valve has three positions. Each position corresponds to a specific 
flow requirement of the system:

• Position A directs system liquid from the system liquid container into the 
syringe, as shown in Figure A-2.

• Position B directs liquid from the syringe to the sampling tip, shown in Figure 
A-3. This position is used to aspirate and dispense liquids after the syringe 
pump outlet tubing and the sampling tip have been primed with system liquid.

• Position C directs system liquid from the peristaltic pump to the sampling tip as 
shown in Figure A-4. This position is used to clean (flush) the syringe pump 
outlet tubing and the sampling tip.

Figure A-2. Syringe Valve Positions: Position A
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Figure A-3. Syringe Valve Positions: Position B

Figure A-4. Syringe Valve Positions: Position C
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Aspirate and Dispense Example

The example below demonstrates syringe valve tube movement, sampling tip 
movement, the use of air gaps, and the two-step wash process at the wash 
station. In the example, the protocol aspirates 50 µL of sample and dispenses the 
sample to duplicate destination tubes in a multi-pipetting mode. Ten microliters of 
sample waste are dispensed into the waste position of the wash station.

 Note: The liquid volumes here are just examples; they can vary with the 
requirements of real protocols.

Refer to Figures A-2 through A-5 as you read through these steps.

1. The syringe valve tube rotates to position A (Figure A-2) and the syringe pump 
moves the syringe plunger down. This action pulls system liquid into the 
syringe. When the system liquid fills the syringe, the syringe valve rotates to 
position B (Figure A-3). It remains in this position through step 7. The syringe 
pump moves the syringe plunger up and forces system liquid through the 
syringe pump outlet tubing and sampling tip. The system is now primed. This 
step also represents the initial system flush.

2. The syringe pump moves the syringe plunger down and aspirates 10 µL of air 
into the bottom of the sampling tip. This volume of air separates the system 
liquid from the sample and is known as the “System Air Gap” (see Air Gaps on 
page 389 for more information.)

3. The syringe pump moves the syringe plunger down and aspirates 110 µL of 
sample into the sampling tip. This volume represents two individual 
dispensations of 50 µL each and 10 µL of sample waste. The waste volume 
represents the sample at the top of the liquid column in the sampling tip, just 
beneath the system air gap. This fluid can become diluted by the system liquid 
and is dispensed at the wash station at the end of the cycle.

4. The syringe pump moves the syringe plunger down and aspirates three micro-
liters of air into the sampling tip. This volume of air, known as the “Transport 
Air Gap,” provides a barrier between the sample liquid and the end of the 
sampling tip. The transport air gap helps prevent the sample from dripping off 
the tip during high speed movements (see Air Gaps on page 389 for more 
information.)

5. The sampling tip moves to the first dispense location and dispenses the 
transport air gap and 50 µL of sample.

6. The sampling tip aspirates a transport air gap (three microliters of air) and 
moves to the second dispense location where it dispenses the transport air 
gap and 50 µL of sample.
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7. The sampling tip moves to the wash station and dispenses 10 µL of sample 
waste and 10 µL of air (the system air gap) into the waste position of the wash 
station. The syringe valve rotates to position C (Figure A-4). The peristaltic 
pump flushes the syringe pump outlet tubing and sampling tip by pushing 
system liquid through the tubing.

8. The sampling tip moves from the waste position to the wash position 
(chimneys) of the wash station where the peristaltic pump flushes the tubing 
and sampling tip a second time.

Figure A-5. Basic Liquid Handling
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Basic Liquid Handling Process (in brief)
• Start with system liquid in sampling tip and tubing.
• Aspirate 10 µL of air.
• Aspirate 110 µL of sample.
• Aspirate 3 µL of air.
• Dispense 3 µL of air and 50 µL of sample in tube 1.
• Dispense 50 µL of sample in tube 2.
• Dispense 10 µL of sample waste volume and 10 µL air gap.
• Wash sampling tip.

Accuracy and Precision
Accuracy is the ability of a measurement to match the actual value of the quantity 
being measured. In liquid handling, this involves accurately dispensing a 
predetermined amount of fluid. In other words, when a protocol procedure 
requires 10 µL of fluid, the system dispenses 10 µL of fluid.

Precision is the reproducibility of a measurement. In liquid handling, this is the 
reproducibility of a dispensed volume. The system should precisely dispense a 
specific volume each and every time that volume is requested.

You can determine the Accuracy and Precision of the JANUS G3 using the 
Syringe Test utility in the WinPREP software. To run the Syringe Test, select 
Utilities > Syringe Test from the WinPREP drop-down menu (see Caring for the 
System on page 398 for more information.)

Many factors can influence the accuracy and precision of the automated liquid 
handling protocol results. The sections below provide insight into these factors 
and suggest ways to reduce, minimize, or overcome the impact these issues have 
on your results.

Delays

A delay is a short pause of the pipetting arm, programmed to occur just before or 
after aspirating or dispensing fluid. The delay allows the fluids in the liquid column 
to equilibrate before performing the next step. Delays tend to enhance accuracy 
and precision. The standard delay time (aspiration and dispense) is 200 ms.
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Blowout Mode

Blowout mode refers to the process of using the system air gap, and sometimes 
additional air, to force any remaining sample from the sampling tip into the sample 
container. Blowout mode can be used with serial dilutions, predilutions, when 
dispensing reagent with sample, and any other application that requires pipetting 
very small fluid volumes.

Typically, blowout mode is used when dispensing sample volumes smaller than 
10 µL. You cannot use blowout mode when you aspirate a waste volume or for 
multiple dispense/aspirates (see Sample Waste Volume on page 390 for more 
information about waste volume.)

 Note: Blowout Mode is not recommended for viscous solvents or samples.

Multiple Dispenses

Multi-dispensing is when enough liquid is drawn up into the sampling tip to 
dispense into more than one destination position without having to aspirate more 
sample. Multi-dispensing is useful when making replicate dispenses.

Before the liquid is dispensed at each destination position, a portion of the liquid is 
dispensed as waste; this portion is referred to as the dispense back/prime volume. 
A dispense back/prime volume must be used to minimize the first shot effect (see 
First Shot Effect on page 387 for more information.)

The maximum number of multiple dispenses is eight, however, accuracy and 
precision decrease after four to five replicate dispenses. In addition, multiple 
dispenses are especially prone to the dilution effect (see The Dilution Effect on 
page 388 for more information.) 

First Shot Effect

The first shot effect occurs when a small amount of the sample volume adheres to 
the inside of the sampling tip. As a result, the first amount dispensed is less than 
subsequent dispenses. Typically, the first shot effect occurs when using multiple 
dispenses. 

The best way to reduce the first shot effect is to make use of a dispense back/
prime volume when performing multiple dispenses (see Multiple Dispenses on 
page 387 for more information.)
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The Dilution Effect

The dilution effect describes situations where other liquids in the system dilute 
aspirated samples. The dilution effect occurs in at least two ways. During 
aspiration, the system liquid leaves tiny droplets behind inside the tip and Teflon® 
tubing. The leading portion of the aspirated sample picks up these droplets, 
thereby becoming diluted.

Dilution also occurs at the interface between the system liquid and the sample. 
When the system aspirates a sample, the sample liquid and the system liquid 
come into direct contact. When this happens, the system liquid dilutes the upper 
portion of the sample. Any reagents or samples aspirated into the tubing can 
become diluted due to contact with the system liquid. 

Figure A-6 shows how fluids mix to create the dilution effect.

Figure A-6. Dilution Effect

There are several measures you can take to reduce the frequency and level of 
dilution effect you experience when running your assays. These measures are 
described in detail in the sections below.
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Air Gaps
Air gaps are specific volumes of air aspirated into the tips and tubing to separate 
the fluids in the liquid column. There are three types of air gaps:

• System
The system air gap separates the sample volume from the system liquid. The 
default is 10 µL. This helps to prevent your sample from becoming diluted by 
mixing with the system liquid.

• Separation
The separation air gap is similar to the system air gap except it separates 
multiple samples rather than a single sample and the system liquid. Using 
separation air gaps between the various aspirated liquids helps maintain 
precision and minimizes any cross reaction between the liquids during 
transfer. An example would be to aspirate buffer, patient serum, and tracer at 
then dispense all three at one time. In this scenario, there are two separation 
air gaps: one between the buffer and patient serum and one between the 
patient serum and tracer.

• Transport
The transport air gap prevents the aspirated sample from dripping out of the 
sampling tip. Dripping is unlikely with most non-volatile liquids. However, non-
volatile liquids may drip from the sampling tip when there is a leak in the 
system or air is trapped in the tubing between the syringe and the tip. In this 
situation, a transport air gap is a temporary fix for the underlying problem. 
Volatile solvents, such as methanol (MeOH), routinely require transport air 
gaps to prevent dripping.

Each movement of a liquid column introduces error. The movement 
associated with a transport air gap has the potential to introduce error and 
should be avoided when possible.

Figure A-7. Air Gaps
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The volume of the sample helps determine the size of the air gap. Specifically, the 
larger the aspirated volume, the larger the air gap. Table A-1 lists the 
recommended air gaps for a range of sample volumes.

Very small air gaps, 5 µL or less, can dislodge from the Teflon tubing and move 
into the liquid. A more reasonable system air gap value for most standard 
dispensing is 10 µL. There is also danger in having a system air gap that is too 
large. Unlike various liquids in the system, the system air gap is compressible and 
expandable, giving it properties much like a spring. If the system air gap is too 
large, its “spring action” can influence liquid column motion and dispense 
precision (see The Elasticity Effect on page 391 for more information.)

While air gaps minimize the dilution effect, they do not entirely eliminate it. A 
minute amount of dilution can occur around the edges of the air gap resulting from 
the surface tension of the liquids as they move up and down in the small diameter 
tubing. Minute quantities of system liquid can also cling to the sides of the tubing 
and dilute the sample. Including a sample waste volume helps to reduce this 
problem even further (see Sample Waste Volume on page 390 for more 
information.)

In general, minimize the size and number of air gaps used, since too much air can 
compromise the hydraulic effect of the liquid system. Air gaps can also contribute 
to an “Elasticity Effect” (see The Elasticity Effect on page 391 for more 
information.)

Sample Waste Volume
Incorporating a sample waste volume can help overcome the dilution effect. The 
waste volume represents extra sample fluid at the top of the liquid column in the 
sampling tip, just beneath the air gap. This fluid can become diluted by system 
liquid or sample. By aspirating more sample than needed, the waste volume 
collects any remaining liquid droplets in the tip and tubing. The waste volume is 
not used in the dispense and is dispensed as waste in the wash station at the 
conclusion of the cycle.

The waste volume used should increase as the aspirated volume increases, with 
waste volumes of 30–35% or more often being necessary to effectively stop 
dilution. In some extreme cases, a waste volume of 50–100% may be necessary.

Volume of Liquid Recommended air gap

< 100 µL 5 µL

100–200 µL 8 µL

> 200 µL 10 µL

Table A-1. Recommended air gaps
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For example, when aspirating and dispensing sample fluid you can define the 
following sample volume and waste volume:

• Sample Volume 100 µL
• Waste Volume 10 µL

Aspirate 110 µL of sample fluid at the source tube or vial. Next, dispense 100 µL 
of sample fluid into the destination tube or vial. Dispense the remaining 10 µL of 
sample into the waste position of the wash station. The sample waste volume 
occupies the area immediately beneath the air gap in the sampling tip; it is the 
portion of sample that is most likely to be diluted by system liquid.

Multiple dispenses are especially prone to the dilution effect and may show a 
concentration gradient from the first dispense to the last if the waste volume is too 
small. The order in which you aspirate fluids may also contribute to, or protect 
against, the dilution effect. For example, when adding buffer and sample to a well, 
aspirate the buffer first, then the sample, and dispense the two together. When 
aspirated in this way, any dilution to the sample is by the buffer rather than the 
system liquid.

The Elasticity Effect

The elasticity effect describes the tendency of gases, in this case air gaps, to 
compress or expand in the fluid column.

Large air gaps are easily compressed when fluids are dispensed during high 
speed pump motions. When the pump motion ceases, the air gap “bounces” and 
causes the fluids in the tubing to move. The movement of fluids in the tubing can 
have a negative effect on accuracy and precision.

Large air gaps can also be stretched and break down when fluids are aspirated 
during high speed pump motions. When the air gap disintegrates, the sample 
liquid is diluted by the system liquid, having a negative affect on accuracy and 
precision (see Aspirate Rates on page 393 for more information.)

The volume of each air gap should be kept as small as possible to minimize the 
elasticity effect. Air gap volumes depend on the volume of the aspirated fluid 
samples but should follow the recommendations in Table A-1. Anything larger 
than 10 µL can increase the potential for the elasticity effect.



 Appendix A: Liquid Handling 392

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

Overloading the Varispan Syringe Volume

Varispan syringe volume overloading occurs when the aspirated sample volume is 
larger than the internal volume of the syringe. The valve on the pump rotates 
when the syringe is at its lowest position. The piston inside the syringe is then 
raised up to its highest position. The valve is then rotated back to aspirate 
additional sample as the plunger inside the syringe is drawn down. This series of 
valve rotation and plunger movement continues until the volume of sample 
aspirated equals the desired volume.

Note that because the volume aspirated in this case exceeds the maximum 
volume of the tip, the aspirated liquids are held in the system tubing. This allows 
the JANUS G3 to aspirate a volume of liquid that is higher than the volume of the 
tips or the volume of the syringes.

Performance Files

Performance files provide a basic foundation for correcting for proper liquid 
volume delivery. Performance files optimize pipetting accuracy by adjusting 
parameters based on tip type, mode, fluid volume, and fluid properties. Select the 
performance file designed for the specific system liquid or create a custom 
performance file that meets your needs (see Performance Files on page 269 for 
more information.)

Determining Aspirate and Dispense Rates
Fluid aspiration and dispensation rates can greatly affect accuracy and precision. 
The volume of fluid in the aspiration or dispense step influences the rate at which 
the fluid is moved. For aspirations, smaller sample volumes require lower rates 
while larger sample volumes require higher rates. For dispenses, the opposite is 
true: smaller sample volumes require higher rates while larger volumes require 
lower rates.

You can specify these rates when you set up a protocol or specify the values in 
micro-liters per second (µL/s).
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Table A-2 lists the recommended aspirate and dispense rates for a range of 
sample volumes.

The recommended rates in Table A-2 assume a fluid viscosity similar to that of 
water. Fluids having a higher viscosity require slower aspiration and dispense 
rates.

 Note: By default, the WinPREP software sets the sample aspiration and 
dispense rates to the recommended values. You can accept the default 
values when you set up a protocol or you can enter the rates as desired.

Aspirate Rates

Aspiration rates that exceed those suggested for a specified volume can increase 
throughput of sample processing. However, the vigorous movement of fluid in the 
sampling tip tends to destroy air gaps and makes fluids subject to dilution and 
elasticity.

For example, 50 µL of sample that is aspirated at 100 µL/s instead of the 
recommended rate of 50 µL/s, can break down the air gap that separates the 
sample from the system liquid (Figure A-8). The breakdown of the air gap can 
cause sample dilution, and thus the quality of the dispensed liquid.

Volume of Liquid Recommended
Aspiration Rate

Recommended
Dispense Rate

< 5 µL 10 µL per second 400 µL per second

5–29 µL 25 µL per second 400 µL per second

30–49 µL 50 µL per second 400 µL per second

50–99 µL 75 µL per second 400 µL per second

100–max µL 125 µL per second 400 µL per second

Table A-2. Recommended Aspiration and Dispense Rates
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Figure A-8. Breakdown of air gap

Lower aspirate rates produce less force on the air gap in the sampling tip. 
Reduced force greatly lessens the risk that the air gap will break down and 
compromise the accuracy and precision of the pipetted volumes.

The effects of increased and decreased aspirate rates on accuracy and precision 
are shown in Figure A-9.
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Figure A-9. Effects of Aspirate Rate

 Note: Data shown in Figure A-9 was obtained gravimetrically under optimum 
laboratory conditions. Trends may differ for other volumes or conditions.

Dispense Rates

Dispense rates that exceed those recommended for a specified volume can also 
increase throughput of sample processing. However, high dispense rates tend to 
increase the mixing of fluids in the reaction tube.

For example, dispensing 100 µL of sample and 100 µL of reagent at a rate of 
600 µL per second, instead of the recommended rate of 400 µL per second, will 
effectively mix the reagent and sample in the reaction tube. Be careful of 
splashing when dispensing fluid into shallow vessels such as microplates. Very 
high dispense rates increase the potential for splashing.

Conversely, slower dispense rates result in less vigorous movement of fluid in the 
reaction tube. This means much less mixing of fluids.

When dispensed too slowly, small quantities of fluid adhere to the sampling tip 
instead of being dispensed into the destination container. These drops reduce the 
precision of the dispensed volume and can contaminate or dilute other samples.
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The effects of increased and decreased dispense rates on accuracy and precision 
are shown in Figure A-10.

Figure A-10. Effects of Dispense Rates

 Note: Data shown in Figure A-10 was obtained gravimetrically under optimum 
laboratory conditions. Trends may differ for other volumes or conditions.

Liquid Viscosity

Finding the optimum aspirate and dispense rates requires some experimentation. 
The recommended rates in Table A-2 assume a liquid viscosity similar to water. 
You must consider this factor as you set the optimum aspirate and dispense rates.

When using viscous fluids, it is recommended that you decrease aspirate and 
dispense rates. Thicker fluids create different hydrodynamics and can increase 
the elasticity effect on air gaps.

For example, to aspirate 45 µL of polyethyleneglycol (PEG), you might want to set 
the aspirate rate at 30 µL/s and set the dispense rate at 400 µL/s (see Table A-2). 
In both instances, the rates are slower than if the solution were of a normal 
viscosity.
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For very viscous fluids, it can be helpful to increase the delay (see Delays on 
page 386 for more information.) The standard delay time (aspiration and 
dispense) is 200 ms. Increase the delay to over 200 ms for viscous fluids; the 
thicker the fluid, the longer the delay.

Meeting Your Requirements
Aspirate and dispense rates should be set to effectively transport samples in the 
tubing. Consult your PerkinElmer liquid handling specialist for the rates best 
suited to handle your pipetting requirements.
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Appendix B

Caring for the System
This chapter describes the diagnostic testing and regular preventive maintenance 
you should perform to maintain the JANUS G3 system.

This section contains:
• Preventative Maintenance Procedures on page 398
• Preventative Maintenance Checklist on page 402
• As-Needed Maintenance on page 403
• Diagnostic Tests on page 408
• Removal of Equipment from Use for Repair or Disposal on page 426

! WARNING Do not perform any maintenance procedures other than those included in 
this manual.

Preventative Maintenance Procedures
Preventive maintenance consists of Daily, Weekly, Quarterly, and As Needed 
procedures that help to ensure proper operation of the system. Refer to each 
section for the appropriate maintenance procedures.

• Daily Preventative Maintenance on page 398
• Weekly Preventative Maintenance on page 400
• Monthly Preventative Maintenance on page 401
• Quarterly Preventative Maintenance on page 401

Daily Preventative Maintenance

Daily maintenance includes tasks that should be performed on a daily basis to 
help ensure the accuracy of the protocols and smooth functioning of the 
instrument. The daily maintenance tasks are minimal and require very little time to 
complete.

While PerkinElmer recommends that you perform these operations at least once 
per day, perform them as frequently as needed to keep the instrument in good 
working order.
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Flush the Varispan Pipetting Arm
Flushing the Varispan pipetting arm helps to keep the system free of air bubbles, 
crystals, precipitates, and biological growth that can accumulate in the tubing, 
valves, and syringes. If allowed to accumulate in the liquid path, these items can 
decrease the accuracy and precision of the instrument. To prevent this problem, 
flush the system at the start of each day.

To flush the system:
1. Fill the system liquid container with system liquid appropriate for the 

application.

2. Select Utilities > Diagnostic Tests > Flush and Wash Tips to start the flush 
process (page 415).

3. Set both the Flush and Wash volumes to 10,000 l, when prompted.

4. Flush with enough liquid to remove all air bubbles in the tubing from the 
system liquid container to the tips.

5. After completing the desired number of flush cycles, inspect the tubing for air 
bubbles. If there is any air in the tubing, repeat the flush as many times as 
necessary to purge the air from the system. Gently tapping the tubing or 
syringe plunger can help to dislodge bubbles in the tubing or syringes.

Clean the Deck, Support Tiles, and Racks
Clean the work surface of the instrument at the end of each working day. Remove 
all support tiles and racks from the deck and carefully clean the deck using a soft 
cloth and multi-surface cleaner. Clean all support tiles, racks, and labware locating 
pins before returning the support tiles and racks to the deck.

PerkinElmer recommends 70% ethanol, Lysol® Brand Disinfectant Foam Cleaner 
or a similar cleaner (such as Sani-Cloth® or Rad-ConTM) for multiple surface 
cleaning.

 Caution: If you clean the system with a 1% bleach solution, rinse thoroughly with 
distilled water or clean with surface cleaner immediately after using 
bleach.

Check the Syringe Pump Outlet Tubing
Visually inspect the syringe pump outlet tubing for air bubbles and leaks. If you 
discover leaks, finger tighten the tubing connections to the syringe pump valves.

! WARNING Be careful not to over-tighten the tubing connections.
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Empty the Waste Container
Empty the waste container as needed during daily operation and always empty 
the waste container at the end of the working day. Dispose of all liquid waste 
according to accepted laboratory practices.

Clean the Sampling Tips
Clean the sampling tips with alcohol at the beginning of each day. Gently wipe 
each tip using an alcohol wipe or a soft, lint free cloth and 70% ethanol. Visually 
inspect each sampling tip and replace scratched or damaged tips.

Weekly Preventative Maintenance

Perform the tasks below on a weekly basis. These tasks, along with the Daily 
Maintenance, are designed to keep the instrument in good working order. Perform 
these operations at least once per week or more frequently, if needed.

Flush System if Unused For An Extended Period
Thoroughly flush the system at least once per week if the instrument has not been 
used during the week. Use the Flush and Wash Tips utility (page 415) to remove 
any residue, deposits, and air bubbles.

Visually Check Tubing
Visually inspect the tubing once a week to ensure it is in good condition and 
properly connected to all components. Tighten tubing connections if you find poor 
or loose connections or notice any signs of leakage. Make sure the interior of the 
tubing is clean and free of deposits, residue, air bubbles, and clogs. Thoroughly 
flush the system if you notice the presence of any of these conditions. Refer to the 
Flush and Wash Tips utility (page 415) for more information.

! WARNING Be careful not to over-tighten the tubing connections.

If tightening the tubing connections and flushing the system does not correct the 
leak, you may need to clean the system (page 401) or replace the tubing 
(page 405.)

Visually Check Syringes
Visually inspect the syringes once a week to ensure they are in good working 
order. Syringes should be clean and free of leaks. Replace any damaged, leaking, 
or worn syringes (page 404).
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Monthly Preventative Maintenance

Clean and Fill the System Liquid Container
Inspect the level of the system liquid at the beginning of each working day. 
Completely empty the system liquid container and refill with new system liquid at 
least once a month. PerkinElmer recommends degassed, distilled water, type I, 
type II or type III deionized water, or other liquid appropriate for the application for 
use as the system liquid.

Quarterly Preventative Maintenance

Perform the maintenance procedures below at the end of each quarter or after 
200 hours of operation, whichever comes first. The frequency is only a 
recommendation and you should perform these procedures as frequently as 
needed.

Disinfect the Fluid Path
Clean the fluid path with 70% ethanol, a 0.5% Lysol IC solution, 1% bleach 
solution, or an equivalent fines-free certified cleaner. Rinse well after cleaning, 
especially when using bleach solution, to prevent damage to the instrument. 
Flushing the system helps prevent the growth of bacteria and fungi and the 
formation of crystals and precipitates in the tubing, valves, and syringes. These 
residues can affect the accuracy and precision of the instrument and shorten the 
lifetime of flow path components (see Daily Cleaning on page 414 for more 
information). Also wipe clean the outside of the syringe and peri-pump tubing in 
the system liquid container.

Clean the Waste Tubing
Clean the waste tubing by carefully pouring a solution of laboratory detergent 
(10% bleach) down the wash station drain. The solution cleans the waste tubing 
by running down the drain in the wash station and passing through the waste 
tubing. Flush the waste tubing of any remaining cleaner by pouring clean, distilled 
water down the wash station drain.
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Preventative Maintenance Checklist
Use this checklist to log the Preventative Maintenance activities for the JANUS G3 
system. You can print the checklist, or create a new checklist based on your 
laboratory’s specific maintenance schedule and requirements.

Start-Of-Month
__ Clean and Refill System Liquid Container (see page 401)

Start-Of-Week
__ Visually Check Tubing (see page 400) 
__ Visually Check Syringes (see page 400)

Start-Of-Day
__ Flush Varispan with System Liquid (see page 399)
__ Check Syringe Pump Outlet Tubing (see page 399)

End-Of-Day
__ Clean Sampling Tips (see page 400)
__ Empty Waste Container (see page 400)
__ Clean Deck, Support Tiles, and Racks (see page 399)
__ Daily Cleaning, if desired (see page 414)

End-Of-Week
__ Flush & Wash Tips if unused for an extended period (see page 400)

Quarterly
__ Disinfect the Fluid Path (see page 401)
__ Clean Waste Tubing (see page 401)

Name (print): __________________________________ 

Signature: _________________________________ Date:  ________________
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As-Needed Maintenance
This section describes maintenance routines that do not correspond to a set 
schedule. Perform these procedures as often as necessary to keep the system in 
good working order.

In addition to the procedures listed here, the Diagnostic Tests section (page 408) 
provides additional routines to diagnose and calibrate the system.

• Check Deck Calibration on page 403
• Test the Syringes on page 403
• Test Tip Pickup on page 404
• Test Liquid Level Sense on page 404
• Syringe Replacement on page 404
• Tubing Replacement on page 405
• Sanitize Drip Pans on page 406
• Change the UV Lamp on page 406

Check Deck Calibration

If the sampling tips, dispense head, arms, or gripper hit another arm or anything 
on the deck, verify the deck calibration. The deck does not need to be recalibrated 
unless the instrument is not performing as expected. Verify the deck layout and 
labware definitions are correct before calibrating the deck. Before calibrating the 
deck (see Calibration Procedures on page 292), run the Random Move Test (see 
page 419) to prepare the instrument. Contact PerkinElmer Technical Support (see 
page 2), if assistance is required.

Test the Syringes

The Syringe Test uses gravimetric analysis to determine the accuracy and 
precision of the syringes (see Syringe Test on page 420 for more information.) 
Use the Syringe Test to verify the accuracy and precision of dispense or aspirate 
volumes in one or more tips.

After completing the test, the values for the mean, standard deviation, and percent 
coefficient of variation (%CV) for the tested tip are calculated. To record these 
statistical values, make sure the result window is active and press Alt + Print 
Screen on the keyboard. This saves an image of the screen to the Windows 
clipboard that you can paste into a word processing or graphic editing program.

If you create a new performance file to improve the accuracy and precision, verify 
that all affected protocols use the new performance file.
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Test Tip Pickup

When using disposable tips, the instrument's ability to pick up, sense, and drop 
(strip) tips reliably is important for the overall performance of the system. The 
Pickup Tips Test (page 417) runs through several cycles of picking up, sensing, 
and dropping tips. When the protocol is complete, WinPREP generates a 
summary detailing the tip type, adapter number, number of pickup attempts, and 
number of errors recorded during the test. You can print, save, or delete this report 
as needed. If the system is operating properly, the summary will show zero errors.

Test Liquid Level Sense

The Liquid Sense Test utility (page 416) checks the ability of the system to 
accurately detect liquid, which helps ensure the accuracy and precision of 
pipetting operations. This test detects when the tips contact liquid in the well or 
reservoir and reports the height of the liquid.

 Note The Liquid Level Sense test will report a height of zero in the report if there 
is no liquid in the well or reservoir. To avoid this issue during the liquid level 
sense test, make sure you provide enough liquid in the testing containers.

Syringe Replacement

Replace each syringe as needed. Inspect the syringes for leaks and excessive 
wear at least once a week, as outlined in Visually Check Syringes (page 400.) 
Replace syringes if the glass barrel is scratched or scored or if the syringe leaks 
around the Luer lock fitting at the top of the syringe.

To replace a syringe:
1. Lower the syringe plungers using the Change Syringe test (see page 413). 

While the syringes are lowering, the Reset Pump window opens.

2. Remove the syringe bolt at the base of the syringe. Turn the screw 
counterclockwise.

3. Turn the syringe barrel and Luer lock counter-clockwise. Unscrew using the 
top corrugated section. Do not handle the syringe by the glass to prevent 
breaking the syringe.

4. Gently pull the syringe barrel down.

5. Dispose of the old syringe according to accepted laboratory procedures.

6. To install the new syringe, fasten the Luer lock on the top of the syringe to the 
base of the valve. Turn the Luer lock and syringe barrel clockwise. Assist the 
syringe in an upward motion while turning to prevent stripping the threads on 
the valve. Do not over-tighten.
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7. Secure the syringe bolt onto the syringe pump module connection. Turn the 
syringe bolt clockwise.

8. Click OK in the Reset Pump window AFTER the syringe(s) have been 
replaced. 

9. Complete the Change Syringe test.

Tubing Replacement

Regularly inspect the Marprene® tubing from the System Liquid Container to the 
manifold block. Replace the tubing once every six months or as needed. 
Immediately replace the tubing if it is excessively worn, stiff, or leaks.

To replace the peristaltic pump Marprene tubing:
1. Disconnect the system liquid tubing from the system liquid container.

2. Remove all fluid from the tubing using the Flush and Wash Tips utility 
(page 415).

3. Remove the faceplate on the plastic tubing guide. Starting on the right end, 
simultaneously apply pressure to the top and bottom of the guide to detach the 
clips on the guide from the groove in the faceplate. 

4. Disconnect the Marprene tubing by loosening the connector on the manifold 
block.

5. Remove the tubing from the tubing guide.

6. Feed the new tubing into the tubing guide and out through the bottom of the 
guide to the manifold block.

7. Attach new tubing to the manifold block.

8. Reattach the tubing guide faceplate by inserting the clips on the tubing guide 
into the grooves on the faceplate.

9. Reconnect the system liquid tubing to the system liquid container.

10. Run the Flush and Wash Tips utility as needed to flush the air out of the 
system and fill the lines with system liquid.

11. Check for leaks in the system.
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Sanitize Drip Pans

Drips pans are plastic troughs that occupy the space immediately below the deck. 
These pans help contain spills by catching any liquids that drip or spill onto the 
deck surface. (Note that workstations with recessed decks use non-removable 
metal drip pans.)

To sanitize the drip pans:
1. Remove each of the four screws connecting the deck plate to the frame.

2. Lift the deck plate up and away from the frame.

3. Lift the drip pans up and out of the frame base.

4. Wash and rinse the pans with mild laboratory detergent and water.

5. Drain, dry, and replace the drip pan in the frame base.

6. Place the deck plate on top of the frame. Make sure the deck plate is oriented 
properly.

7. Reattach the deck plate to the frame using the four deck plate screws.

Change the UV Lamp

In the instructions below, “Lamp” refers to the UV Bulb only. The UV Lamp should 
be replaced after 3 years to maintain optimal efficiency.

Supplies required:

To change the UV Lamp, have the following supplies available:

• Replacement UV Lamp
• Gloves (latex, nitrile, or cotton)

To change the UV Lamp:
1. Turn off the JANUS G3 power and unplug the JANUS G3 power cord and the 

UV Light power cord.

! WARNING UV LIGHT. Verify the UV Light is off and the power is disconnected before 
proceeding. Unprotected eyes and skin can be seriously damaged by 
exposure to UVC radiation.

2. Follow the handling and safety instructions included with the new UV lamp 
(light bulb) at all times. Do not touch the lamp without gloves.

3. Carefully remove the UV Lamp from the clips (see Figure B-1 on page 407) by 
pulling the bulb down out of the clips.
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Figure B-1. UV Light Parts

4. Unplug the Lamp Power Cable from the Lamp.

5. Plug the Lamp Power Cable into the new lamp.

6. Press the UV Lamp into the clips. Make sure the clips only contact the white 
end caps on the bulbs. Do not position the lamp with the clips on the glass 
tube.

7. Close the enclosure doors.

8. Plug in the JANUS G3 power cord and the UV Light power cord.

9. Turn the JANUS G3 power switch on (I).

 NOTE UV Lamp contains Mercury. Dispose of in accordance with local 
Disposal Laws.

UV Lamp Clip Power Cable
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Diagnostic Tests
The WinPREP software includes diagnostic tests to help keep the Varispan, MDT, 
Gripper, Plate ID Barcode Reader, and Tube Barcode Reader equipment 
operating properly. Each test performs a specific function such as properly 
positioning the system components for a maintenance task or checking the 
system for mechanical problems. PerkinElmer provides these tests as a 
standardized way for you to calibrate the equipment and identify and correct a 
range of problems. These tests can help ensure the instrument is operating with a 
high degree of accuracy and precision, and is free of several mechanical or 
electrical problems.

To use any of the diagnostic tests, select Utilities > Diagnostic Tests and choose 
the desired test from the list. Figure B-2 shows the Diagnostic Tests menu. Only 
the diagnostic tests for the installed system components display.

Figure B-2. Diagnostic Tests Menu

When you execute any of the diagnostic tests from the Utilities > Diagnostic 
Tests menu, WinPREP displays the window shown in Figure B-3. The test will not 
continue until you click one of the buttons on the window. This pause gives you an 
opportunity to verify that the physical deck configuration matches the deck 
configuration in the test before performing the test.
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While each test has a default deck layout, you can position the labware anywhere 
on the deck. Just make sure the physical deck configuration matches the test 
deck configuration. Either move the physical labware to match the deck layout in 
the test or move the test deck labware to match the locations of the physical 
labware on the deck. Be sure to save the test if you want to change the default 
positioning permanently or save the modified test with a unique name.

Figure B-3. Diagnostic Test Introductory Message

Depending on the size of the screen and the position of the WinPREP main 
window, you may need to move this window to view the entire deck layout. Make 
sure the window is not blocking the view of labware on the deck view.

The sections below provide details about running each of the diagnostic tests 
provided with the instrument.

• Align Tips on page 409
• Change Adapter on page 411
• Change Syringe on page 413
• Daily Cleaning on page 414
• Flush and Wash Tips on page 415
• Liquid Sense Test on page 416
• Pickup Tips Test on page 417
• Random Move Test on page 419
• Syringe Test on page 420
• Random XY Tests on page 421
• Reteach Barcode Read Position on page 421
• Barcode XY Test on page 423
• Barcode Scan Test on page 423
• Random XY Gripper Test on page 424

Align Tips

The Align Tips diagnostic test helps you check and adjust the alignment of the 
Varispan tip adapters. The test moves the Varispan pipetting arm to the tip 
alignment test fixture so you can visually verify the tip alignment.
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To run the Align Tips diagnostic test:
1. Insert the calibration cones into the tip alignment test fixture based on the 

number of tips on the Varispan arm (see Figure B-4).

Figure B-4. Tip Alignment Calibration Fixture

2. Select Utilities > Diagnostic Tests > Align Tips (choose either Standard or 
Shortened VersaTips). The AlignTips.MPT introductory window opens.

 Note: Make sure the physical labware matches the defined test labware, 
including deck locations.

3. If the default test setup is acceptable, position the test fixture and wash bowl at 
the indicated locations on the deck and click the Deck Layout OK button.

OR

If you need to modify the protocol outline or labware positions, click the Deck 
Layout Not OK button, make the necessary modifications, position the test 
fixture and wash bowl in the indicated locations on the deck, and click the Run 
Protocol button on the toolbar.

4. When the system positions the tips over the test fixture, make sure that each 
tip aligns with the associated calibration cone in the fixture. Gently rotate the 
tips around the vertical (Z) axis of the tip to correct any improperly aligned tips.

! WARNING Never bend the VersaTip® adapters. If a VersaTip adapter is out of 
alignment with the calibration cone, try rotating the tip to correct the 
misalignment.

5. Click OK in the message window to complete the alignment. The arm moves 
to the wash bowl position to end the test.
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Change Adapter

Use the Change Adapter diagnostic test to change the Varispan tip adapters, for 
example, to switch from fixed tips to VersaTips. The procedure lowers each tip, 
one at a time, so that you can access the mounting hardware and change the 
adapter.

To run the Change Adapter diagnostic test:
1. Insert the calibration cones into the tip alignment test fixture based on the 

number of tips on the Varispan arm (see Figure B-4).

2. Select Utilities > Diagnostic Tests > Change Adapter (choose either 
Standard or Shortened VersaTips) to open the ChangeAdapter.MPT 
introductory window.

 Note: Make sure the physical labware matches the defined test labware, 
including deck locations.

3. If a tip stripper sleeve is installed in a 4-tip system, remove the tip stripper 
sleeve by pulling it straight down until the guide pin detaches from the tip 
holder. (Refer to Figure B-5 for parts identification.) 
If a tip stripper sleeve is installed in an 8-tip system (not shown), loosen the 
sleeve screw and then remove the tip stripper sleeve. (Failure to loosen the 
sleeve screw can damage the system).

Figure B-5. Tip Adapter Mounting Assembly.



 Appendix B: Caring for the System 412

PerkinElmer, Inc. JANUS G3 User Manual P/N CLS146039 Rev. L.03 

4. If the default test setup is acceptable, position the test fixture and the wash 
bowl at the indicated locations on the deck, and click the Deck Layout OK 
button.

OR

If you need to modify the protocol outline or labware positions, click the Deck 
Layout Not OK button, make the necessary modifications, position the test 
fixture and the wash bowl at the indicated locations on the deck, and click the 
Run Protocol button on the toolbar.

The system positions the tips over the test fixture and the Next Adapter 
window opens.

5. Type the number of the tip adapter that you want to change in the Adapter 
Number text box and click Continue.

6. Loosen the screws that secure the cover to the tip holder and remove the tip 
holder cover. 

7. Disconnect the tubing from the top of the tip adapter by gently pulling the tube 
and adapter apart.

 Note: The number of screws securing the cover to the tip holder differs between 
four and eight tip arms. For the 8-Tip arm, loosen the bottom screw shown 
in Figure B-6. For the 4-Tip arm, loosen the two screws shown in Figure B-
6.

Figure B-6. Tip Holder Cover Screws

8. Connect the tubing to the new tip adapter. 

9. Securely seat the notch in the tip adapter into the holder. 

10. Replace the tip holder cover. Make sure the cover is oriented properly and 
then tighten the screws.

Loosen these

8-tip adapter 4-tip adapter

screws
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11. Reinstall the tip stripper sleeve. Tighten the screw for 8-Tip arms.

12. After the adapter is securely mounted, align it with the corresponding 
calibration cone in the fixture. Gently rotate the tip adapter to align the tip.

13. Click OK on the Change Adapter in Progress window to continue.

14. Repeat Steps 5 through 13 for each of the tip adapters on the system. If you 
do not want to change a tip adapter for a tip, click Continue on the Next 
Adapter window and OK on the Change Adapter in Progress window.

15. When all tips have been changed or skipped, the arm moves to the wash bowl 
position to flush and wash the adapters and the software displays the Change 
Machine Setup window.

16. Take note of the message to update the adapter type for the machine and click 
OK on the Change Machine Setup window to complete the procedure.

Change Syringe

Use the Change Syringe diagnostic test to change Varispan syringes. The 
procedure moves each syringe plunger to its lowest position so that you can 
remove and install syringes as needed.

To run the Change Syringes diagnostic test:
1. Select Utilities > Diagnostic Tests > Change Syringe to open the 

ChangeSyringe.MPT introductory window.

 Note: Make sure the physical labware matches the defined test labware, 
including deck locations.

2. If the default test setup is acceptable, position the wash bowl at the indicated 
location on the deck and click the Deck Layout OK button.

OR

If you need to modify the labware position, click the Deck Layout Not OK 
button, make the necessary modifications, and click the Run Protocol button 
on the toolbar.

The utility moves the syringe plungers to their lowest positions and opens the 
Reset Pump window.

3. Remove the thumbscrew securing the base of the plunger and gently rotate 
the syringe barrel counter-clockwise while exerting a slight downward 
pressure until the tip of the syringe is free from the Luer lock connector.

4. Insert the tip of the new syringe into the Luer lock connector. Turn the syringe 
barrel clockwise while exerting a slight upward pressure, taking care not to 
exert any sideways force. This helps prevent stripping the threads on the valve 
and reduces wear on the syringe seal. Do not over-tighten this connection or 
you could damage the valve, Luer lock connector, or syringe.
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5. Replace the thumbscrew securing the plunger.

6. Repeat Steps 3 and 4 for the remainder of the syringes you want to replace.

7. Click the OK button on the Reset Pump window to complete the procedure. 
The system moves the syringe pumps to the home positions.

8. Take note of the final message to update the syringe volume for the machine 
and click the OK button on the Change Machine Setup window to complete 
the procedure.

Daily Cleaning

Use the Daily Cleaning diagnostic test to clean the Varispan fluid path. This test 
cleans the liquid path between the syringe and the tip adapter by aspirating and 
soaking in a 0.5% Lysol IC solution, 70% ethanol, 1% bleach solution, or similar 
disinfectant.

 Caution: If you clean the system with bleach, perform a subsequent rinse with 
distilled water as described in Flush the Varispan Pipetting Arm on 
page 399.

Since the procedure takes eight hours to complete, PerkinElmer recommends that 
you run the Daily Cleaning test as an end-of-day procedure. The test can be 
shortened to 30 minutes if desired. This ensures the system is sanitized and 
primed with system liquid at the start of the next operating day.

To run the Daily Cleaning diagnostic test:
1. Prepare the required amount ( 20 mL for a 4-tip system or  40 mL for a 8-tip 

system) of cleaning solution. PerkinElmer recommends a 1:200 dilution of 
Lysol IC, 70% ethanol, 1% bleach solution, or similar disinfectant, as the 
cleaning solution.

2. Place a washbowl with one trough on the deck. Fill the trough with the 
cleaning solution.

3.  Select Utilities > Diagnostic Tests > Daily Cleaning (choose either 
Standard or Shortened VersaTips) to open the DailyCleaning.MPT 
introductory window.

 Note: Make sure the physical labware matches the defined test labware, 
including deck locations.

4. If the default test setup is acceptable, click the Deck Layout OK button.

OR

If you need to modify the test, click the Deck Layout Not OK button, make the 
necessary modifications, and click the Run Protocol button.
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The test includes the following sequential steps:

• Preliminary flush/wash
The system performs a standard flush/wash to rinse the tips and tubing with 
system liquid.

• Pre-cleaning aspirate
The system moves to the trough of the wash station and aspirates 2000 L of 
cleaning solution into each tip and tube.

• Pre-cleaning dispense
The system moves to the drain of the wash station and dispenses the 2000 L 
of cleaning solution from each tip as waste.

• Pre-cleaning flush/wash
The system performs another flush/wash with system liquid to rinse the tubing 
and tips.

• Cleaning aspiration
The system moves to the trough of the wash station and aspirates 2000 L of 
cleaning solution into each tip and tube. Once aspirated, the system holds the 
cleaning liquid in the tips and tubing for eight hours to soak the liquid path. 
This time can be shortened to 30 minutes if desired.

• Cleaning dispense
The system moves to the drain of the wash station and dispenses the 2000 L 
of cleaning solution from each tip as waste.

• Post-cleaning flush/wash
The system performs a final flush/wash with system liquid to rinse the cleaning 
solution out of the tips and tubing.

Flush and Wash Tips

The Flush and Wash Tips diagnostic test flushes and washes the Varispan tip 
adapters with system fluid. The system moves the tips to the wash station, flushes 
the tips and tubing with the syringe pumps, and washes the tips and tubing with 
the peristaltic pump.

Use this procedure to clear various liquids out of the Varispan tips and tubing or 
purge air from the liquid column.

To run the Flush and Wash Tips diagnostic test:
1. Select Utilities > Diagnostic Tests > Flush and Wash Tips to open the 

FlushSysLiq.MPT introductory window.

 Note: Make sure the physical labware matches the defined test labware, 
including deck locations.
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2. If the default test setup is acceptable, position the wash bowl at the indicated 
location on the deck and click the Deck Layout OK button.

OR

If you need to modify the protocol outline or labware position, click the Deck 
Layout Not OK button, make the necessary modifications, position the wash 
bowl at the indicated location on the deck, and click the Run Protocol button.

3. When prompted, type the volumes of system liquid to use for the flush and 
wash cycles and click Start. The maximum volume for either field is 
10,000 µL.

Liquid Sense Test

Use the Liquid Sense diagnostic test to check the operation of the Varispan liquid 
sensing circuitry. Problems with the liquid level sensing functionality can greatly 
reduce the accuracy and precision of the instrument.

To run the Liquid Sense diagnostic test:
1. Select Utilities > Diagnostic Tests > Liquid Sense Test (choose either 

Standard or Shortened VersaTips) to open the LiqSenseTest.MPT 
introductory window.

 Note: Make sure the physical labware matches the defined test labware, 
including deck locations.

2. If the default test setup is acceptable, position the test tube cassette and wash 
bowl at the indicated locations on the deck and click the Deck Layout OK 
button.

OR

If you need to modify the protocol outline or labware positions, click the Deck 
Layout Not OK button, make the necessary modifications, position the test 
tube cassette and wash bowl at the indicated locations on the deck, and click 
the Run Protocol button.

3. Click Next on the Liq Sense Test Entries window.
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4. When prompted, type the numbers of the sample positions to test (maximum 
of 16) and the number of times to test each position and click Start. Be sure to 
fill the test tube cassette with tubes containing liquid for the number of sample 
positions that you enter. The sample positions follow the standard well map for 
the labware.

The system positions the tips over the tubes in the cassette and moves each 
tip down into the tube until it detects liquid. This process repeats the number of 
times specified in the Liq Sense Test Entries window. When the test 
completes, WinPREP generates and displays a report of the test results 
(shown in Figure B-7) You can examine the results in the report window and 
print the report, if desired.

Figure B-7. Liquid Sense Test Report window

5. Click Exit to close the window and complete the procedure. The arm moves to 
the wash bowl and flushes and washes the tips to remove any test liquid 
picked up during the test.

Pickup Tips Test

Use the Pickup Tips diagnostic test to check the operation of the Varispan arm’s 
disposable tip handling functions. The test determines the instrument’s ability to 
pickup and release disposable tips by repeating a series of pickup/release 
operations.
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To run the Pickup Tips diagnostic test:
1. Select Utilities > Diagnostic Tests > Pickup Tips Test to open the 

PickupTipTest.MPT introductory window.

 Note: Make sure the physical labware matches the defined test labware, 
including deck locations. If you are using disposable tips that are different 
from the disposable tips identified in the test, modify the test setup to 
match the tip type.

2. If the default test setup is acceptable, position the disposable tip rack and 
wash bowl at the indicated locations on the deck and click the Deck Layout 
OK button.

OR

If you need to modify the protocol outline or labware positions, click the Deck 
Layout Not OK button, make the necessary modifications, position the 
disposable tip rack and wash bowl at the indicated locations on the deck, and 
click the Run Protocol button.

3. Click Next on the Tip Test Entries window.

4. When prompted, type the number of tips to pick up during the test and click 
Start. Be sure to refill the tip box completely before proceeding.

The system positions the tip adapters over the tip rack, moves the tip adapters 
down, picks up disposable tips, and retracts the tip adapters. The system then 
moves the tip adapters down and ejects the disposable tips to their original 
locations. When the test completes, WinPREP generates and displays a 
report of the test results (shown in Figure B-8) You can examine the results in 
the report window and print the report, if desired.

Figure B-8. Pickup Tips Test Results window

5. Click Exit to close the window and complete the procedure. The arm moves to 
the wash bowl to complete the test.
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Random Move Test

Use the Random Move diagnostic test to check the movement of the Varispan 
pipetting arm over the deck. The procedure tests movements in the X, Y, and Z 
directions and reports any errors identified during the movement of the arm.

To run the Random Move diagnostic test:
1. Remove all labware (racks, tubes, plates, etc.) from the deck and the deck 

extension. If present, remove the right angle bracket, the DPC shaker, and the 
IKA shaker.

2. Select Utilities > Diagnostic Tests > Random Move Test to open the 
Random XY Test.MPT introductory window.

3. If the default test setup is acceptable, click the Deck Layout OK button.

OR

If you need to modify the test, click the Deck Layout Not OK button, make the 
necessary modifications, and click the Run Protocol button.

 Caution: Do not add labware to the deck layout in the test. Items left on the deck 
during the random move test can damage the pipetting arm.

4. When prompted, type the number of movements that you want the arm to 
make during the test and click Start. This is the number of horizontal positions 
randomly accessed during the test. At each position, the tips move down to 
the deck and then return to the higher travel position. The default value of 100 
is usually sufficient.

5. Remove any remaining labware from the deck and click OK to start the test. 
The arm moves around the deck randomly and a status window opens to 
show the progress of the test. The status window shows the number of 
random movements completed and the errors encountered for each motor.

6. Click OK at the end of the test to close the status window.

 Note: If you receive any errors during the execution of this test, contact 
PerkinElmer Customer Care (see page 2) for maintenance.
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Syringe Test

Use the Syringe diagnostic test to check the operation, accuracy, and precision of 
the Varispan syringe pumps. The procedure tests the syringe pumps by 
dispensing a specific volume of liquid into several test tubes and calculating the 
actual volume dispensed, by weight. While you can calculate the dispense 
accuracy and precision based on a single test tube, PerkinElmer recommends a 
series of ten tubes in order produce a statistically significant value.

 Note: Wear gloves throughout this procedure as oils and other contaminants 
from your fingers adds weight to the tubes.

To run the Syringe diagnostic test:
1. Select Utilities > Diagnostic Tests > Syringe Test to open the 

SyringeTest.MPT introductory window.

 Note: Make sure the physical labware matches the defined test labware, 
including deck locations.

2. If the default test setup is acceptable, position the test tube cassette and wash 
bowl at the indicated locations on the deck and click the Deck Layout OK 
button.

OR

If you need to modify the test, click the Deck Layout Not OK button, make the 
necessary modifications, and click the Run Protocol button.

3. Type the volume of liquid to dispense during the test, the number of the 
syringe pump to test (tip adapter number), and the number of tubes in which to 
dispense.

4. Click Start to continue. WinPREP displays the Syringe Test window.

5. Record the weights for ten empty test tubes. Place these tubes into the first 
ten positions of the cassette in the order in which you weighed them.

6. Type the weights (in milligrams) of the empty tubes into the Empty (mg) fields 
of the Syringe Test window. After entering the ten weights, click the Start 
Pipetting button to close the Syringe Test window and begin dispensing 
liquid.

The system performs preliminary flush/wash and aspirate/dispense cycles 
before dispensing the defined volume into the ten empty tubes. After 
dispensing into the final tube, the pipetting arm moves to the wash bowl and 
the Syringe Test window opens.

7. Reweigh the ten test tubes, in order, including the dispensed liquid, and record 
the values. Type the values into the Full (mg) fields of the Syringe Test 
window.
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8. Click the Calculate button to display the net weights and actual volumes 
dispensed and a statistical analysis of the values as shown in Figure B-9. You 
can examine the data and print the results, if desired.

 Note: The volume calculation assumes a liquid with a specific gravity of 1.00, 
such as degassed, distilled water. You can use other liquids in the syringe 
test, but you must manually correct for differences in specific gravity.

Figure B-9. Syringe Test window with results

9. Repeat the previous steps for each of the syringes you want to test.

10. Click Exit to close the window and complete the test.

Random XY Tests

Random XY Tests are available for the arms installed on the system. Choose the 
tests for the desired arms. Remove all labware from the decks before running 
random moves tests.

Reteach Barcode Read Position

Use the Reteach Barcode Read Position diagnostic test to check the position of 
the Gripper arm in front of the Plate ID barcode reader. The procedure tests the 
position by gripping a microplate on the deck, moving the Gripper arm to the 
taught location, and attempting to read the barcode on the plate.

To run the Reteach Barcode Read Position diagnostic test:
1. Remove all labware (cassettes, tubes, plates, etc.) from the deck.
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2. Select Utilities > Diagnostic Tests > Reteach Barcode Read Position to 
open the SecondaryBarcodeReteachBarcodeReaderPosition.MPT 
introductory window.

3. If the deck layout shows one plate on the deck and it is positioned correctly, 
click the Deck Layout OK button.

OR

If you need to modify the deck layout, click the Deck Layout Not OK button, 
make the necessary modifications, and click the Run Protocol button. If the 
plate is not shown on the deck, move the plate from the Temporary Labware 
Storage location at the top of the deck layout to the desired deck position.

 Caution: Do not add any other labware to the deck layout. Items on the deck other 
than those specifically requested during the protocol can damage the 
Gripper arm.

4. Place the specified labware at the location indicated in the Deck View on the 
Place tab.

5. On the Run tab, click the Start button. 

6. Verify the labware locations on the deck and then click the OK button at the 
bottom of the Status panel. 

7. The Verify Labware Setup Message displays. Verify the location of the 
barcode label and click the OK button. The Gripper arm picks up the plate 
from the deck location and moves to the position in front of the Plate ID reader.

8. At the next prompt, open the Teach Position window 
(Utilities > Setup > Gripper > Teach > Labware Position) and select the 
Off-Deck position named Barcode-Reader1.

When the Teach Position window opens, a smaller Test Barcode Reader 
window opens to monitor the reading parameters.

9. Use the arrow buttons in the Teach Position window to move the plate forward 
and back to maximize the Decode Rate. The Decode Rate value should be at 
least 500 reads per second.

10. Verify that the Barcode Data value correctly represents the data on the 
barcode label.

11. Update and save the final position, as prompted.

12. Manually close the Teach Positions window and the Test Barcode Reader 
window. 

13. Run the rest of the protocol to return the plate to the deck.
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Barcode XY Test

Use the Barcode XY diagnostic test to check the movement of the barcode arm 
over the barcode cassette area of the deck. The procedure tests the movement of 
the barcode arm in the X and Y directions and reports any errors identified during 
the movement of the arm.

To run the Barcode XY diagnostic test:
1. Remove all barcode cassettes and labware (racks, tubes, plates, etc.) from 

the deck.

2. Select Utilities > Diagnostic Tests > Barcode XY Test to open the 
BarcodeXYTest.MPT introductory window.

3. If the default test setup is acceptable, click the Deck Layout OK button.

OR

If you need to modify the test, click the Deck Layout Not OK button, make the 
necessary modifications, and click the Run Protocol button.

 Caution: Do not add any other labware to the deck layout. Items on the deck during 
the Barcode XY test can interfere with the movement of the barcode arm

4. Specify the number of movements that you want to make during the test. This 
is the number of randomly determined positions that will be accessed during 
the test. 

5. You are reminded to remove ALL of the barcode cassettes from the deck. If 
you have not already done this, DO IT NOW. The barcode arm will move 
randomly around the deck, and any cassettes on the deck will interfere with 
the arm movement.

6. Click the OK button. The barcode arm moves randomly around the barcode 
cassette area of the deck to access the number of positions specified at the 
beginning of the test.

7. At the end of the test, the window displays the number of motions for each 
motor and the number of errors encountered.

8. If any errors occur during the test, reteach the barcode arm or contact 
PerkinElmer Customer Care (see page 2).

Barcode Scan Test

Use the Barcode Scan diagnostic test to verify the scanning of barcode labeled 
test tubes on the deck. The procedure tests the barcode label scanning by 
scanning the barcode labels multiple times and then displaying the resulting 
barcode values in Microsoft Excel.
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To run the Barcode Scan diagnostic test:
1. Load the barcode cassettes to be tested with barcode labeled test tubes. Load 

the cassettes from left to right. 

2. Select Utilities > Diagnostic Tests > Barcode Scan Test to open the 
BarcodeScanTest.MPT introductory window.

3. If the default test setup is acceptable, click the Deck Layout OK button.

OR

If you need to modify the test, click the Deck Layout Not OK button, make the 
necessary modifications, and click the Run Protocol button.

4. Specify the number of cassettes to scan and the number of times to scan the 
cassettes for comparison.

5. Click the OK button. The cassettes are scanned starting with Lane 1 and 
continuing for the number of lanes specified at the beginning of the test. The 
scanned barcode from each tube is written to a file.

6. The cassettes are rescanned as many times as specified at the start of the 
protocol for the number of repeats. Each time a tube is scanned, the new 
barcode is added to the file for later comparison.

7. When all scanning is complete, Microsoft Excel opens and displays the saved 
file. The barcodes from each repeat scan display in a new column. Sort the 
rows as necessary to verify that the barcodes for a single barcode labeled 
tube is always the same.

8. If you receive any errors during the execution of this test, reteach the barcode 
arm or contact PerkinElmer Customer Care (see page 2).

Random XY Gripper Test

Use the Random XY Gripper diagnostic test to check the movement of the Gripper 
arm over the deck. The procedure tests the movement of the gripper arm in the X 
and Y directions, and reports any errors identified during the movement of the 
gripper arm.

To run the Random XY Gripper diagnostic test:
1. Remove all labware (racks, tubes, plates, etc.) from the deck.

2. Select Utilities > Diagnostic Tests > Random XY Gripper Test to open the 
RandomXYGripperTest.MPT introductory window.
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3. If the default test setup is acceptable, click the Deck Layout OK button.

OR

If you need to modify the test, click the Deck Layout Not OK button, make the 
necessary modifications, and click the Run Protocol button.

 Caution: Do not add labware to the deck layout in the test. Items on the deck during 
the gripper arm random move test can damage the Gripper arm.

4. Type the number of movements that you want the arm to make during the test 
and click Next. The Initial User Query: Gripper Motor Velocities and 
Accelerations window opens as shown in Figure B-10.

Figure B-10. Gripper Arm Motor Velocities and Accelerations setup

5. Change the values for the velocities and accelerations, if desired. In most 
cases, the default values are sufficient. All velocities are measured in 
millimeters per second (mm/s) while accelerations are measured in 
millimeters per second per second (mm/s²), except those describing Theta 
movements. Theta velocity and acceleration are measured in degrees per 
second (deg/s) and degrees per second per second (deg/s²), respectively.

6. Remove any remaining labware from the deck and click Start. The gripper 
arm moves around the deck randomly and a status window opens to show the 
progress of the test. The status window shows the number of random 
movements completed and the errors encountered for each motor.

7. Click OK, at the end of the test, to close the status window and complete the 
procedure.

 Note: If you receive any errors during the execution of this test, contact 
PerkinElmer Customer Care (see page 2).
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Removal of Equipment from Use for Repair or Disposal
1. Prepare the instrument for removal from use, transportation, or disposal by 

cleaning the Work Surface, Tiles, and Racks as described on page 399. 

2. Empty any waste bottles, the system liquid container, and the system liquid 
tubing.

3. Conform to all local, state/provincial, or national environmental and health 
regulations when disposing of waste. 

WEEE Do not dispose of the JANUS G3 as unsorted municipal waste. See the 
PerkinElmer website (www.perkinelmer.com) for more information.

http://www.perkinelmer.com
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Appendix C

Troubleshooting
This chapter describes some general troubleshooting techniques that you can 
perform if you are having trouble with the JANUS G3 system.
• Liquid Handling Problems
• Troubleshooting Drops on the Sampling Tip
• Troubleshooting Liquid Level Sense Problems

Liquid Handling Problems
If you experience problems with air in the tubing or leaking syringes, check for the 
following problems:

• Check the fitting connections at valves and syringes. These connections only 
need to be finger tight. Over-tightening the fittings can result in decreased 
valve life.

• Check the syringe for scored glass. Replace if glass barrel is scratched or 
scored.

• Check the plunger cap and replace if it is no longer providing a good seal.
• Check the valves for moisture. Valves need to be replaced if there is any 

evidence of leaking. 

Troubleshooting Drops on the Sampling Tip
If you experience problems with droplets forming on the ends of the tips, check for 
the following problems:

• Prime the system to ensure that there is no air in the lines.
• Check the fitting connections at valves and syringes. These connections only 

need to be finger tight. Over-tightening the fittings can result in decreased 
valve life.

• As a last resort, you can have the valves replaced.
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Troubleshooting Liquid Level Sense Problems
If you experience Liquid level Sense problems, try using these troubleshooting 
procedures to isolate the problem.

• Reset and Initialize the instrument.
• Make sure that the Liquid Level Sense cables are not crossing each other’s 

paths while the tips are in motion.
• If Liquid Level Sense errors follow tip and/or tip holder, swap the tip or tip 

holder to see if the problem follows the tip or the holder. If the problem follows 
the tip, replace the tip. If the problem follows the holder, replace the tip holder. 

• Check that Liquid Level Sense cables are securely connected to the tip 
holders.

• Disconnect the Liquid Level Sense cables from the tip holders and check the 
cables for damage. If the connector body rotates with respect to the cable 
jacket, the cables are defective. The cable assembly will need to be replaced. 

• If Liquid Level Sense error is occurring in a particular labware, check the 
labware definition. Z-start should be as low as possible without being in liquid. 

• Check for drops at the end of the tips. Drops will cause liquid level sense 
problems. Drops may be caused by leaks in the liquid path, including a faulty 
syringe or a faulty valve.

• If the Liquid Level Sense problems are associated with sampling from labware 
that is physically located on an external device, make sure there is a good 
electrical path from the labware holder to the JANUS G3 deck (e.g. a 
continuous ground). If the sample volumes are small and the sample labware 
does not have a good ground mass directly beneath it, Liquid Level Sense 
may not sense the liquid.

• External devices may be interfering with the Liquid Level Sense signal. 
Mechanical vibrations can cause the tubing to strike against one another or 
the tip holders to contact one another. Harmonics can cause large physical 
displacements with very little energy being put into the system.

• If the external devices are connected to the same power source as the JANUS 
G3, electrical noise may be causing Liquid Level Sense errors. Try connecting 
external devices to a separate power source.

• If the problem persists, contact PerkinElmer Customer Care (see page 2).
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